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Digitalni fotoaparat s izmjenjivim objektivom ILME-FR7 / ILME-FR7K

Pregled

Uobičajena upotreba

Konfiguracija sustava [1]

Upravljanje pojedinačnom jedinicom s pomoću isporučenog infracrvenog
daljinskog upravljača [2]

Upravljanje pojedinačnom jedinicom s pomoću tableta ili računala [3]

Upravljanje pojedinačnom jedinicom s pomoću vanjskog daljinskog
upravljača [4]

Upravljanje višestrukim jedinicama s pomoću vanjskog daljinskog
upravljača [5]

Položaj i funkcija dijelova

Prednji prikaz [6]

Stražnji prikaz [7]

Blok priključnice [8]

Bočni prikaz [9]

Gornji prikaz [10]

Donji prikaz [11]

Nosač za objektiv [12]
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Položaj i funkcije dijelova infracrvenog daljinskog upravljača
(isporučen) [13]

Zaslon web-aplikacije

Pregled zaslona web-aplikacije [14]

Struktura zajedničkog područja zaslona [15]

Struktura radnog zaslona uživo [16]

Struktura radnog zaslona reprodukcije [17]

Struktura zaslona postavki [18]

Izbornik fotoaparata [19]

Prikaz zaslona fotoaparata [20]

Priprema

Ugradnja jedinice

Ugradnja prema gore na fiksnom mjestu [21]

Ugradnja prema gore na visokom fiksnom mjestu [22]

Ugradnja na strop [23]

Postavljanje/uklanjanje objektiva

Mjere opreza prilikom pričvršćivanja/uklanjanja objektiva [24]

Provjera prekidača objektiva [25]

Mjere opreza prilikom upotrebe objektiva za zumiranje [26]

Pričvršćivanje objektiva [27]
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Uklanjanje objektiva [28]

Priključivanje kabela [29]

Priključivanje jedinice na mrežni uređaj putem žičane veze [30]

Priključivanje izvora napajanja

Upotreba napajanja izmjeničnom strujom [31]

Upotreba PoE++ napajanja [32]

Ponovno postavljanje pomicanja/nagibanja [33]

Konfiguriranje prije snimanja

Inicijalizacija jedinice s pomoću web-aplikacije

Pristup web-aplikaciji s pomoću web-preglednika [34]

Inicijalizacija jedinice [35]

Konfiguracija osnovnih radnji [36]

Priprema memorijskih kartica

Podržane memorijske kartice [37]

Umetanje memorijskih kartica [38]

Izbacivanje memorijske kartice [39]

Formatiranje (inicijalizacija) memorijskih kartica [40]

Provjera preostalog vremena snimanja [41]

Oporavak memorijske kartice [42]
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Snimanje

Osnovna radnja

Pokretanje/zaustavljanje snimke [43]

Prebacivanje memorijskih kartica [44]

Provjera zvuka [45]

Određivanje podataka o vremenu [46]

Pregled snimke (Rec Review) [47]

Prilagodba okvira

Zaslon prilagodbe okvira [48]

Prilagodba smjera snimanja

Prilagodba smjera snimanja s pomoću web-aplikacije [49]

Postavljanje brzine rada pomicanja/nagibanja [50]

Postavljanje ubrzanja rada pomicanja/nagibanja [51]

Prilagodba smjera snimanja s pomoću isporučenog infracrvenog daljinskog
upravljača [52]

Prilagodba zumiranja

Postavljanje vrste zumiranja [53]

Prilagodba zumiranja s pomoću web-aplikacije [54]

Postavljanje brzine rada zumiranja [55]

Prilagodba zumiranja s pomoću isporučenog infracrvenog daljinskog upravljača
[56]
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Spremanje/oporavak položaja pomicanja / nagibanja / zumiranja
fotoaparata

Kalibracija E-mount objektiva [57]

Spremanje/oporavak pomicanja/nagibanja, položaja zumiranja i postavljanje
fokusa s pomoću web-aplikacije [58]

Preimenovanje unaprijed zadanih položaja s pomoću web-aplikacije [59]

Zamjena spremljenog položaja novim položajem s pomoću web-aplikacije [60]

Brisanje spremljenog položaja s pomoću web-aplikacije [61]

Promjena brzine prijelaza unaprijed zadanih položaja [62]

Spremanje/oporavak pomicanja/nagibanja i položaja zumiranja s pomoću
isporučenog infracrvenog daljinskog upravljača [63]

Prilagodba fokusa

Zaslon prilagodbe fokusa [64]

Ručna prilagodba fokusa (Manual Focus)

Ručna prilagodba s pomoću web-aplikacije [65]

Ručna prilagodba s pomoću isporučenog infracrvenog daljinskog upravljača [66]

Fokusiranje određivanjem položaja fokusa (Spot Focus) [67]

Privremena upotreba automatskog fokusa (Push Auto Focus (AF)) [68]

Upotreba automatskog fokusa za pojedinačno snimanje (Push Auto Focus (AF-S))
[69]

Automatska prilagodba fokusa (Auto Focus)

Automatska prilagodba s pomoću web-aplikacije [70]

Automatska prilagodba s pomoću isporučenog infracrvenog daljinskog upravljača
[71]

Postavljanje područja/položaja automatskog fokusa (Focus Area) [72]

Brza promjena područja fokusa (Focus Setting) [73]

Pomicanje okvira područja fokusa s pomoću dodirne radnje (Touch Focus Area)
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[74]

Prilagodba rada automatskog fokusa (AF Transition Speed, AF Subject Shift
Sensitivity) [75]

Ručno postavljanje cilja automatskog fokusa (AF Assist) s pomoću web-aplikacije
[76]

Ručni fokus tijekom automatskog fokusa s pomoću isporučenog infracrvenog
daljinskog upravljača [77]

Privremena upotreba ručnog fokusa tijekom automatskog fokusa (Push Manual
Focus) [78]

Praćenje s pomoću otkrivanja lica i oka (Face/Eye Detection AF) [79]

Praćenje određenog subjekta (Realtime Tracking AF) [80]

Podešavanje svjetline

Zaslon prilagodbe svjetline [81]

Postavljanje osnovne osjetljivosti [82]

Postavljanje ciljane razine za prilagodbu automatske svjetline [83]

Podešavanje blende

Automatska prilagodba blende [84]

Ručna prilagodba blende [85]

Podešavanje razine signala

Automatska prilagodba razine signala [86]

Ručna prilagodba razine signala [87]

Podešavanje zatvarača

Automatska prilagodba zatvarača [88]

Ručna prilagodba zatvarača [89]

Podešavanje razine svjetline (filtar ND)
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Opis ND filtra [90]

Prilagodba u unaprijed postavljenom načinu [91]

Automatska prilagodba u varijabilnom načinu [92]

Ručna prilagodba u varijabilnom načinu [93]

Podešavanje za prirodne boje (White Balance)

Zaslon prilagodbe ravnoteže bijele boje [94]

Automatska prilagodba ravnoteže bijele boje [95]

Ručna prilagodba ravnoteže bijele boje [96]

Izvođenje automatske ravnoteže bijele boje [97]

Konfiguracija zvuka za snimanje

Zaslon konfiguracije zvuka [98]

Odabir uređaja za ulaz zvuka [99]

Automatska prilagodba razine snimanja zvuka [100]

Ručna prilagodba razine snimanja zvuka [101]

Korisne funkcije

Rad izbornika Direct Menu [102]

Dodjeljivi gumbi [103]

Usporeno i ubrzano snimanje [104]
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Isprekidano snimanje videozapisa (Interval Rec) [105]

Snimanje slika iz predmemorije (Picture Cache Rec) [106]

Istovremeno snimanje na memorijske kartice A i B (2-slot Simul
Rec) [107]

Monitor signala videozapisa [108]

Zastavice isječaka [109]

Kompenzacija žarišne duljine [110]

Snimanje proxyja

Pregled proxy snimanja [111]

Snimanje proxyja [112]

Snimanje sa željenim izgledom

Pregled izgleda [113]

Odabir izgleda [114]

Uvoz željenog temeljnog izgleda [115]

Prilagodba izgleda [116]

Spremanje izgleda [117]

Brisanje temeljnog izgleda [118]

Snimanje s pomoću prilagodbe izgleda u postprodukciji

Snimanje s pomoću prilagodbe izgleda u postprodukciji [119]
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Primjena LUT-a na HDMI izlaz i usmjeravanje [120]

Promjena LUT-a [121]

Promjena distribucije tamnih i svjetlih područja na snimljenoj fotografiji
[122]

RAW snimanje

Snimanje RAW videozapisa [123]

Snimanje RAW videozapisa u usporenom i ubrzanom snimanju [124]

Prilagodba zamućenja (Bokeh Control Function)

Uključivanje/isključivanje funkcije upravljanja zamućivanjem [125]

Prilagodba stupnja zamućivanja [126]

Spremanje i učitavanje podataka za konfiguraciju

Spremanje i učitavanje pregleda konfiguracije podataka [127]

Spremanje ALL datoteke [128]

Učitavanje ALL datoteke [129]

Mrežne funkcije

Prijenos datoteka

Opis prijenosa datoteke [130]

Registracija odredišta prijenosa datoteke [131]

Odabir datoteke i prijenos

Učitavanje proxy datoteke na memorijsku karticu sa zaslona s minijaturama [132]
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Učitavanje originalne datoteke na memorijsku karticu sa zaslona s minijaturama
[133]

Provjera statusa prijenosa datoteke [134]

Učitavanje s pomoću sigurnosnog protokola FTP [135]

Konfiguracija usmjeravanja

Opis usmjeravanja [136]

Postavljanje formata usmjeravanja [137]

Postavljanje kodeka videozapisa za usmjeravanje [138]

Postavljanje kodeka zvuka za usmjeravanje [139]

Pokretanje/zaustavljanje usmjeravanja [140]

Zaslon Thumbnail

Zaslon minijatura [141]

Reprodukcija isječaka i ostale radnje isječaka

Reprodukcija snimljenih isječaka [142]

Rad na snimljenim isječcima [143]

Izbornik fotoaparata i detaljne postavke

Konfiguracija izbornika fotoaparata  [144]
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Rukovanje izbornikom fotoaparata

Rukovanje izbornikom fotoaparata [145]

Unos niza znakova [146]

User Menu

Korisnik [147]

Izbornik Edit User

Uređivanje korisnika [148]

Izbornik Shooting

ISO/Gain/EI [149]

ND Filtar [150]

Shutter [151]

Iris [152]

Auto Exposure [153]

White [154]

Postavka White [155]

Offset White [156]

Fokus [157]

S&Q Motion [158]

LUT On/Off [159]

Noise Suppression [160]

Flicker Reduce [161]

SteadyShot [162]
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Izbornik Project

Base Setting [163]

Rec Format [164]

Postavka Cine EI [165]

Simul Rec [166]

Proxy Rec [167]

Interval Rec [168]

Picture Cache Rec [169]

SDI/HDMI Rec Control [170]

Dodjeljivi gumb [171]

Izbornik Paint/Look

Scene File [172]

Base Look [173]

Postavke Reset Paint [174]

Black [175]

Knee [176]

Detail [177]

Matrix [178]

Multi Matrix [179]

Izbornik Pan-Tilt

P/T Acceleration [180]

Izbornik TC/Media

Timecode [181]
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TC Display [182]

Users Bit [183]

HDMI TC Out [184]

Clip Name Format [185]

Update Media [186]

Format Media [187]

Media Life [188]

Izbornik Monitoring

Output Format [189]

Display On/Off [190]

Monitor signala videozapisa [191]

Marker [192]

Izbornik Audio

Audio Input [193]

Audio Output [194]

Izbornik Thumbnail

Display Clip Properties [195]

Set Clip Flag [196]

Lock/Unlock Clip [197]

Delete Clip [198]

Transfer Clip [199]

Transfer Clip (Proxy) [200]

Filter Clips [201]
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Customize View [202]

Izbornik Technical

Color Bars [203]

Genlock [204]

Tally [205]

Rec Review [206]

Zoom [207]

Lens [208]

APR [209]

Izbornik Network

Wired LAN [210]

File Transfer [211]

Izbornik Maintenance

Language [212]

Clock Set [213]

Hours Meter [214]

Postavke i zadane vrijednosti izbornika Shooting

Postavke ISO / jačine signala i zadane vrijednosti [215]

Postavke ograničenje AGC-a i zadane postavke [216]

Spremljene postavke kvalitete slike za svaki način snimanja [217]
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Web-izbornik i detaljne postavke

Konfiguracija web-izbornika [218]

Rukovanje web-izbornikom [219]

Izbornik Shooting

Fokus [220]

Izbornik Project

Base Setting [221]

Rec Format [222]

Simul Rec [223]

Proxy Rec [224]

Interval Rec [225]

Picture Cache Rec [226]

All File [227]

Izbornik Paint/Look

Base Look [228]

Izbornik Pan-Tilt

P/T Speed [229]

P/T Acceleration [230]

P/T Range Limit [231]
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P/T Direction [232]

P/T Preset [233]

Izbornik Monitoring

Output Format [234]

Output Display [235]

Izbornik Audio

Audio Input [236]

Audio Output [237]

Izbornik Technical

Tally [238]

IR Remote [239]

Izbornik Network

Camera Name [240]

Korisnik [241]

Wired LAN [242]

File Transfer [243]

FTP Server 1 to 3 [244]

SSL [245]

Referer Check [246]

Brute Force Attack Protection [247]

Izbornik Stream
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Stream [248]

Video Stream [249]

Audio Stream [250]

Izbornik Maintenance

Language [251]

Accessibility [252]

Clock Set [253]

Reset [254]

Information [255]

System Log [256]

HTTP Access Log [257]

Service [258]

EULA [259]

Software [260]

Priključenje vanjskog uređaja

Priključivanje vanjskih monitora i uređaja za snimanje [261]

Rukovanje s pomoću daljinskog upravljača RM-IP500 (dodatno)

Opis rukovanja s pomoću daljinskog upravljača RM-IP500 (dodatno) [262]

Priključivanje daljinskog upravljača RM-IP500 [263]

Sinkronizacija s vanjskim uređajem
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Opis sinkronizacije s vanjskim uređajem [264]

Sinkronizacija faze videosignala (Genlock) [265]

Zaključavanje vremenskog koda za ostale uređaje [266]

Priključivanje vanjskog mikrofona ili vanjskog audiouređaja [267]

Upravljanje/uređivanje isječaka s pomoću računala [268]

Slanje signala optičkog kabela [269]

Priključivanje signalizacije [270]

Dodatak

Mjere opreza pri upotrebi [271]

Izlazni formati i ograničenja [272]

Rješavanje problema [273]

Poruke pogrešaka/upozorenja [274]

Popis stavki izbornika [275]

Spremljene stavke položaja unaprijed zadanih postavki [276]
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Blokovski dijagrami [277]

Ažuriranje softvera objektiva E-mount [278]

Pričvršćivanje poklopca gumba za otpuštanje objektiva [279]

Licence [280]

Specifikacije [281]

Zaštitni znakovi [282]

[1] Pregled Uobičajene upotrebe aplikacija

Konfiguracija sustava

Ova se jedinica može kombinirati s perifernim uređajima kako bi se stvorile različite
konfiguracije sustava.
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[2] Pregled Uobičajena upotreba

Objektiv s E-navojem1.

Adapter A-mount LA-EA3 / LA-EA42.

Infracrveni daljinski upravljač (isporučen)3.

Memorijske kartice CFexpress Type A / SDXC4.

Čitač kartica CFexpress Type A / SD5.

Mikrofon ECM-680S, ECM-678*, ECM-674*6.
EC-0.5X3F5M 3-pinski › 5-pinski XLR kabel za adapter je potreban.*

Adapter za izmjeničnu struju (priložen)7.

Videomonitor8.

Daljinski upravljač RM-IP5009.
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Upravljanje pojedinačnom jedinicom s pomoću
isporučenog infracrvenog daljinskog upravljača

Možete udaljeno upravljati pojedinačnom jedinicom s pomoću isporučenog infracrvenog
daljinskog upravljača.

 Videosignal
 Protok signala

[3] Pregled Uobičajena upotreba aplikacija

Upravljanje pojedinačnom jedinicom s pomoću tableta
ili računala

Možete priključiti tablet ili računalo na jedinicu te zatim upravljati jedinicom s pomoću web-
preglednika.

Infracrveni daljinski upravljač (isporučen)1.

Videomonitor2.
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 Videosignal
 Signal daljinskog upravljača

 Protok signala

[4] Pregled Uobičajena upotreba

Upravljanje pojedinačnom jedinicom s pomoću
vanjskog daljinskog upravljača

Možete udaljeno upravljati jedinicom s pomoću daljinskog upravljača.

Videomonitor1.

Tablet2.

Računalo3.

Pristupna točka4.
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 Videosignal
 Signal daljinskog upravljača

 Protok signala

[5] Pregled Uobičajena upotreba

Upravljanje višestrukim jedinicama s pomoću
vanjskog daljinskog upravljača

Možete udaljeno upravljati s najviše 100 jedinica s pomoću jednog daljinskog upravljača (RM-
IP500).

Videomonitor1.

Daljinski upravljač RM-IP5002.
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 Videosignal
 Signal daljinskog upravljača
 Signal Tally/kontakt

 Protok signala

[6] Pregled Položaj i funkcija dijelova

Prednji prikaz

Ova tema opisuje položaj i funkciju dijelova na prednjem dijelu jedinice.

Videomonitor1.

Prebacivanje videozapisa2.

Ethernet čvorište3.

Daljinski upravljač RM-IP5004.
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Savjet

Opis se odnosi na slike jedinice bez pričvršćenog objektiva.

Glava fotoaparata

Note

Nemojte izlagati glavu fotoaparata snažnim udarcima.

1.

Lampica snimanja/signalizacije
Kad je konfigurirana kao žaruljica snimanja, žaruljica svijetli crvenom bojom tijekom
snimanja na memorijsku karticu. Lampica treperi kad je preostali slobodan prostor na
multimedijskom uređaju za snimanje nizak ili kad se pojavi pogreška.

2.
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Pojedinosti pogledajte u odjeljku „Poruke o pogrešci/upozorenju”.

Kad je konfigurirana kao signalna žaruljica, žaruljica svijetli crvenom ili zelenom bojom
ovisno o vanjskoj signalnoj žaruljici.

Pogledajte pojedinosti u odjeljku „Priključivanje signalne žaruljice”.

Slikovni senzor

Napomena

Nemojte izravno dirati rukama.

3.

Tipka za otpuštanje objektiva
Pritisnite za uklanjanje objektiva.

Pogledajte pojedinosti u odjeljku „Uklanjanje objektiva”.

4.

Signalni kontakti objektiva

Napomena

Nemojte izravno dirati rukama.

5.

Žaruljica POWER6.

Žaruljica NETWORK
Status jedinice naveden je kombinacijom boja prikaza i statusa osvijetljenosti (osvijetljeno,
treperi, nije osvijetljeno) žaruljice POWER i NETWORK.

7.

Žaruljica
POWER

Žaruljica
NETWORK Status jedinice

Svijetli
zeleno*1

Svijetli
zeleno

Uključeno (mreža povezana)

Ne svijetli Uključeno (mreža nije povezana)

Treperi
zeleno

Ne svijetli Postupak uključivanja u tijeku

Svijetli
narančasto

Ne svijetli U stanju pripravnosti
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[7] Pregled Položaj i funkcija dijelova

Stražnji pregled

Ova tema opisuje položaj i funkcije dijelova stražnjeg dijela jedinice.

Treperi žuto Ne svijetli Ažuriranje softvera u tijeku

Sporo
treperi
narančasto*2

Sporo
treperi
zeleno*2

Jedinicom se ne može normalno rukovati. Pogledajte
pojedinosti u zapisniku sustava. Ako se problem nastavi čak
nakon postavljanja jedinice u stanje pripravnosti ili
isključivanje napajanja pa ponovnog uključivanja, obratite se
predstavniku za servis tvrtke Sony.

Brzo treperi
narančasto*3

Brzo treperi
zeleno*3

Pojavio se kvar na jedinici. Obratite se predstavniku za
servis tvrtke Sony.

Treperi zeleno kad se naredba primi od isporučenog infracrvenog daljinskog upravljača.*1
Sporo treperi: treperi jednom u sekundi*2
Brzo treperi: treperi četiri puta u sekundi*3

Senzor infracrvenog daljinskog upravljača
Prima kontrolni signal od isporučenog infracrvenog daljinskog upravljača.

8.

Ulaz za zrak

Napomena

Nemojte prekriti izlaz za zrak. Zbog toga može doći do kvara.

9.
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[8] Pregled Položaj i funkcija dijelova

Blok priključnica

Ova tema opisuje položaj i funkcije dijelova na bloku priključnica jedinice.

Poluga zaključavanja glave fotoaparata
Zaključava pokretanje glave fotoaparata prema naprijed/natrag.

Note

Isključite napajanje jedinice i vodoravno zaključajte glavu fotoaparata s pomoću poluge
zaključavanja pomicanja/nagibanja prije rukovanja polugom zaključavanja kako biste izbjegli
priklještenje prstiju. Pojedinosti o polugi zaključavanja pomicanja/nagibanja pogledajte odjeljak
„Poluga zaključavanja pomicanja/nagibanja” u dijelu „Bočni prikaz”.

1.

Pomicanje postolja2.
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priključnica (uzemljenje)
Priključite na uzemljenje priključivanje uzemljenog terminala u strujnu utičnicu ili šipku za
uzemljenje.

1.

DC IN priključnica (standardni DC priključak)
Priključite na adapter za izmjeničnu struju.

Note

Nemojte upotrebljavati nijedan drugi adapter za izmjeničnu struju osim isporučenog.
Priključivanje drugog adapter može uzrokovati požar ili kvar.

2.

Priključnica LAN (mrežna) (RJ-45)
Priključite mrežni kabel (kategorija 5e ili novija) na mrežnu komunikaciju i izvor napajanja
PoE++*.

Brzina prikaza statusa LED
Prikazuje brzinu mrežne veze.

3.

PoE++: napajanje preko Ethernet Plus Plus. Sukladnost s IEEE802.3bt (tip 4, klasa 8). Pojedinosti o
priključivanju pogledajte u uputama za rad za izvor napajanja.

*

Zaslon Brzina veze
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Status prikaza Link/ACT LED
Prikazuje status mrežne veze.

Note

Prilikom povezivanja proizvoda na internet, povežite se putem sustava koji omogućava funkciju
zaštite, poput usmjerivača ili vatrozida. Ako je povezan bez takve zaštite, može doći do
problema sa sigurnošću.

Ne svijetli
10 Mbps

100 Mb/s

Svijetli narančasto 1000 Mbps

Zaslon Status veze

 Ne svijetli Nema veze

Treperi zeleno Veza uspostavljena, podaci aktivni

Svijetli zeleno Aktivna veza

Priključnica TC IN
Unesite vanjsku referencu signala vremenskog koda.

Pogledajte pojedinosti u odjeljku „Zaključavanje vremenskog koda za druge uređaje”.

4.

HDMI priključnica
Emitira videozapis s jedinice kao HDMI signal.

Pojedinosti pogledajte u odjeljku „HDMI priključnica (Type A priključnica)” u dijelu
„Priključivanje vanjskih monitora i uređaja za snimanje”.

5.

Vijak pločice za zadržavanje za ugradnju HDMI kabela
Kako se HDMI kabel ne bi uklonio, pričvrstite pločicu za zadržavanje isporučenog HDMI
kabela s pomoću isporučenog vijka za ugradnju (M2.6×6) i pričvrstite HDMI kabel s pomoću
komercijalno dostupne vezice za kabel ili trake.

Pojedinosti o pričvršćivanju pločice za zadržavanje HDMI kabela pogledajte u odjeljku
„Priključivanje kabela”.

6.

OPTION priključnica7.
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Upotrijebite kako biste priključili signalnu žaruljicu s vanjskog uređaja.

Pogledajte pojedinost u odjeljku „Priključivanje signalne žaruljice”.

Stezaljka za kabel
Upotrijebite kako biste osigurali kabel adaptera za izmjeničnu struju.

8.

Prekidač RESET
Pritisnite barem pet sekundi s pomoću vrha kemijske olovke ili sličnog predmeta kako biste
ponovno postavili postavke jedinice na tvornički zadane vrijednosti.
Možete odabrati ponovno postavljanje mrežnih postavki veze ili sve postavke s pomoću
prekidača 1 SETUP.

9.

Izlazni priključak OPTICAL
Emitira SDI signal pretvoren na optički format kad je SFP+ modul (dodatno) povezan.

Pogledajte pojedinosti u odjeljku „Slanje signala optičkog kabela”.

10.

Prekidači SETUP

Konfiguriraju sljedeće postavke.
Prekidač 1: postavlja koje će se postavke ponovno postaviti kad se pritisne prekidač
RESET.

Prekidač 2: postavlja izvor napajanja od +48 V (fantomsko napajanje) na
uključeno/isključeno kad je ulazni audiouređaj priključen. Postavka se odmah primjenjuje.
Ova je postavka omogućena kad je [Audio] > [Audio Input] > [AUDIO IN Select] postavljeno
na [MIC] u izborniku fotoaparata.

11.

Setting Opis

OFF
(zadano)

Samo ponovno postavlja postavke mrežne veze. Mrežne postavke,
sigurnosne postavke i podaci o korisniku (korisničko ime i lozinka) jedinice
ponovno će se postaviti.

ON Ponovno postavlja sve postavke na tvornički zadane postavke.
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Note

Postavljanje prekidača 2 na položaj ON i priključivanje mikrofona koji nije kompatibilan s izvorom
od +48 V može oštetiti priključeni uređaj. Prije priključenja uređaja provjerite postavku.

Prekidač 3: omogućava/onemogućava VISCA preko IP komunikacije. Postavke se
primjenjuju kad se fotoaparat uključi.
Postavite na položaj ON kako biste upotrijebili jedinicu kad je priključena na daljinski
upravljač (RM-IP500).

Note

Ako se ne konfigurira lozinka administratora, VISCA preko IP komunikacije se onemogućuje bez
obzira na postavku prekidača. Pojedinosti o konfiguraciji lozinke administratora pogledajte u
odjeljku „Inicijalizacija jedinice”.

Prekidač 4: mijenja brzinu radnji pomicanja/nagibanja poslanih s infracrvenog daljinskog
upravljača. Postavka se odmah primjenjuje.

Setting Opis

OFF
(zadano)

Nemojte napajati strujom od +48 V (fantomski izvor napajanja). Konfigurirajte
ovu postavku kad upotrebljavate vanjski audiouređaj (poput miksete),
dinamički mikrofon ili mikrofon s ugrađenom baterijom.

ON
Napajajte strujom od +48 V (fantomski izvor napajanja) na mikrofon
kompatibilan s fantomskim napajanjem priključen na priključnicu AUDIO IN
(CH-1 ili CH-2).

Setting Opis

OFF (zadano) Neće reagirati na VISCA putem IP naredbi.

ON Prihvaća VISCA putem IP naredbi.

Setting Opis

OFF (zadano) Radi normalnom brzinom.

ON Radi maksimalnom brzinom.

Priključnica SDI OUT12.
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[9] Pregled Položaj i funkcija dijelova

Bočni prikaz

Ova tema opisuje položaj i funkcije dijelova na bočnoj strani jedinice.

Savjet

Opis se odnosi na slike jedinice bez pričvršćenog objektiva.

Emitira videozapis s jedinice kao 12G/6G/3G/HD-SDI signal.
Također se jedinica može konfigurirati za RAW izlazni signal.

Pojedinosti o „Priključku SDI OUT (BNC vrsta) potražite u „Priključivanje vanjskih
monitora i uređaja za snimanje”.

Senzor infracrvenog daljinskog upravljača
Infracrveni senzor za isporučeni infracrveni daljinski upravljač.

13.

Ventilator / izlaz za zrak
Emitira toplinu iz unutrašnjosti jedinice.

Note

Nemojte prekriti izlaz za zrak. Zbog toga može doći do kvara.

Imajte na umu da se područje u blizini izlaza zraka može zagrijati.

14.

GENLOCK priključnica
Upotrijebite za ulaz vanjskog signala sinkronizacije.

Pojedinosti pogledajte u „Sinkronizacija faze videosignala (Genlock)”.

15.

AUDIO IN priključnica (XLR vrsta 5 pinskog priključka)
Upotrijebite za ulaz signala s vanjskog mikrofona ili audiouređaja.
Radi kao AUDIO IN CH-1 priključak ili AUDIO IN CH-2 priključak.

Pojedinosti pogledajte u „Priključivanje vanjskog mikrofona ili vanjskog audiouređaja”.

16.
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Poluga zaključavanja pomicanja/nagibanja
Zaključava mehanizam pomicanja/nagibanja jedinice. Upotrijebite u sljedećim slučajevima.

Prilikom prijenosa ili pakiranja jedinice.
Prilikom pričvršćivanja ili uklanjanja jedinice. Pojedinosti pogledajte u odjeljcima
„Pričvršćivanje objektiva” ili „Uklanjanje objektiva”.
Prilikom upotrebe objektiva koji ne podržava radnju pomicanja/nagibanja (poput
objektiva Sony SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM).

Savjet

Pokret pomicanja/nagibanja može se popraviti pri sljedećim kutevima.

1.
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[10] Pregled Položaj i funkcija dijelova

Gornji prikaz

Pomicanje postolja2.

Otvori za vijke vanjskih uređaja (4 mjesta)
Za M3 vijke do 6 mm (1/4 inča) dužine.

Note

Nemojte upotrebljavati vijke dulje od 6 mm (1/4 inča). Zbog toga može doći do kvara.

3.

Indikator pristupa A4.

Indikator pristupa B
Indikator svijetli ili treperi kad se umetne medij za snimanje.

Pojedinosti pogledajte u odjeljku „Umetanje memorijskih kartica”.

5.

Utor za CFexpress Type A / SD kartice (A)6.

Utor za CFexpress Type A / SD kartice (B)
Upotrijebite za umetanje medija za snimanje.

Pojedinosti pogledajte u odjeljku „Umetanje memorijskih kartica”.

7.

QR kod za mrežnu vezu
Upotrijebite prilikom konfiguracije početnih postavki.

Pojedinosti pogledajte u „Pristup web-aplikaciji s pomoću web-preglednika”.

8.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Ova tema opisuje položaj i funkcije dijelova na gornjoj strani jedinice.

Savjet

Opis se odnosi na slike jedinice bez pričvršćenog objektiva.

[11] Pregled Lokacija i funkcija dijelova

Otvori za vijke vanjskih uređaja (2 mjesta)
Kompatibilno s vijcima 1/4-20 UNC za tronožac.
Maksimalna duljina od 6 mm (1/4 inča).

1.

? (oznaka fotografija)
Oznaka fotografija nalazi se na jednakoj ravnini kao i senzor fotografija.
Za ispravno mjerenje udaljenosti između jedinice i subjekta upotrijebite ovu oznaku
fotografija kao referentnu točku.

2.
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Donji prikaz

Ova tema opisuje položaj i funkciju dijelova na donjem dijelu jedinice.

Savjet

Opis se odnosi na slike jedinice bez pričvršćenog objektiva.

Otvori za vijke za montažu nosača na strop (6 mjesta)
Kad montirate jedinicu na strop ili policu na visokoj lokaciji, pričvrstite nosač tijela (dodatno)
na postolje jedinice s pomoću šest vijaka za montiranje nosača tijela u ove otvore za vijke.

Pojedinosti o montiranju pogledajte u odjeljku „Montiranje prema gore na visokoj
fiksiranoj lokaciji” i „Montiranje na strop”.

1.

Vijci za montiranje na strop (2 mjesta)2.
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[12] Pregled Položaj i funkcija dijelova

Nosač za objektiv

Ova tema opisuje položaj i funkciju dijelova nosača za objektiv jedinice.

Savjet

Opis se odnosi na slike jedinice bez pričvršćenog objektiva.

Upotrebljavaju se kad montirate jedinicu na tronožac fotoaparata (dodatno, 1/4-20 UNC
vijaka do 5,5 mm (1/4 inča) dužine).

Note

Nemojte upotrebljavati vijke dulje od 5,5 mm (1/4 inča). Zbog toga može doći do kvara.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Šipka za nosač objektiva (2)
Podržava objektiv.
Također se može upotrebljavati za općenito montiranje dodatne opreme šipke od Ø15.

1.

Jedinica za nosač objektiva
Nosač za objektiv može se umetnuti prema naprijed/natrag u skladu s objektivom i zatim
osigurati.

2.

Vijak za pričvršćivanje postolja za nosač objektiva
Pričvrstite postolje za nosač objektiva. Možete prilagoditi vijak prema gore/dolje da
odgovara visini postolja za nosač objektiva.

3.
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Poluga stezaljki šipke za nosač objektiva (2 mjesta)
Osigurava položaj prema naprijed/natrag jedinice za nosač objektiva.

4.

Poluga stezaljki vijka za pričvršćivanje postolja nosača za objektiv
Osigurava okomiti položaj vijka za pričvršćivanje postolja za nosač objektiva.

Savjet

Ako se poluga stezaljke nalazi u položaju u kojem ju je teško okrenuti, otpustite je i zakrenite pod
kut koji olakšava primjenu. Kad je u željenom položaju, zatvorite polugu stezaljke.

A: poluga stezaljki vijka za pričvršćivanje postolja za nosač objektiva
B: poluga stezaljke šipke za nosač objektiva

Note

Kako jedinica za nosač objektiva ne bi ometala rad pomicanja/nagibanja, pomaknite jedinicu za
podršku objektiva prema gore u odnosu na glavu fotoaparata kad ne upotrebljavate jedinicu za
nosač objektiva te pomaknite vijak za pričvršćivanje postolja za nosač objektiva na najviši
položaj (najbliži objektivu).

5.
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[13] Pregled

Položaj i funkcija dijelova infracrvenog daljinskog
upravljača (isporučen)

Ova tema opisuje položaj i funkciju dijelova infracrvenog daljinskog upravljača (isporučen).

gumb REC? (snimanje START/STOP)
Pritisnite za početak ili zaustavljanje snimanja.

1.

Tipka MENU
Pritisnite za prikaz ili skrivanje izbornika fotoaparata.

2.

Upravljački gumbi GUI
Pritisnite za izvršavanje radnji u izborniku fotoaparata, dijaloške poruke koje uključuju

3.
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gumbe i ostale funkcije prikaza zaslona.

Gumb CANC./BACK
Pritisnite za otkazivanje postavke ili povratak na prethodni zaslon izbornika fotoaparata
jedinice.

4.

Upravljački gumbi za pomicanje i nagibanje
Pritisnite gumb u obliku strelice za upravljanje pomicanjem/nagibanjem fotoaparata.
Pritisnite gumb HOME za povratak na smjer fotoaparata kako bi bio okrenut prema naprijed.

5.

Upravljački gumbi za unaprijed postavljeni položaj
Pritisnite i držite gumb PRESET i pritisnite jedan od gumba 1 do 3 kako biste pohranili
smjer, zumiranje i status prilagodbe fokusa fotoaparata na gumb pritisnutog broja.
Pritisnite gumb broja s pohranjenim postavkama kako biste pozvali spremljeno stanje.

6.

Upravljački gumbi fokusa
Upotrijebite ih za prilagodbu fokusa.
Kako biste automatski prilagodili fokus, pritisnite gumb AF.
Kako biste ručno prilagodili fokus, pritisnite gumb MF, a zatim pritisnite gumb F (Daleko) za
fokusiranje udaljenih subjekata ili gumb N (Blizu) za fokusiranje bližih subjekata.

7.

Dodjeljivi gumbi od 1 do 3
Izvršavaju dodijeljene funkcije dodjeljivim gumbima s pomoću izbornika fotoaparata.
Ako dodijelite funkciju [Direct Menu] dodjeljivom gumbu, možete prilagoditi ekspoziciju,
ravnotežu bijele boje i ostale postavke s pomoću kontrolnih gumba GUI.

Pojedinosti o dodjeli s pomoću izbornika fotoaparata potražite u odjeljku „Dodjeljivi
gumbi”.

Pojedinosti o izravnom izborniku pogledajte u odjeljku „Upotreba izbornika Direct Menu”.

8.

gumb (napajanje)
Pritisnite kako biste uključili jedinicu ili prebacili napajanje na stanje pripravnosti.

9.

gumb THUMBNAIL
Prikazuje zaslon minijatura koji prikazuje snimljene isječke na memorijskoj kartici jedinice.

Pojedinosti o zaslonu minijatura pogledajte u odjeljku „Zaslon Thumbnail”.

Možete odabrati isječke i upravljati reprodukcijom zaslona minijatura s pomoću upravljačkih
gumba GUI.

Pojedinosti o odabiru isječaka i upravljanju reprodukcijom pogledajte u odjeljcima
„Reprodukcija snimljenih isječaka” i „Rad sa snimljenim isječcima”.

10.
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Baterija infracrvenog daljinskog upravljača

Infracrveni daljinski upravljač zahtijeva dvije AA (LR6) baterije.
Umetnite baterije u infracrveni daljinski upravljač kako je prikazano na sljedećem dijagramu.

Note

Nemojte upotrebljavati baterije koje nisu manganske ili alkalne budući da mogu puknuti.

Odložite iskorištene baterije u skladu sa zakonima i uredbama države ili regije.

gumb SLOT SEL (odabir utora memorijske kartice (A)/(B))
Kad se umetnu dvije memorijske kartice, pritisnite gumb kako biste mogli prebacivati
memorijske kartice za snimanje.
Pritisnite gumb dok je prikazan zaslon minijatura kako biste prebacili memorijske kartice za
prikaz.

11.

gumb P/T RESET (ponovno postavljanje pomicanja/nagibanja)
Ponovno postavlja funkcije pomicanja/nagibanja. Pritisnite gumb kad žaruljice POWER i
NETWORK istovremeno trepere ili kad je funkcija [Execute Pan-Tilt Reset] prikazana na
kontrolnoj ploči kadriranja u web-aplikaciji.

12.

Upravljački gumbi zumiranja
Kako biste zumirali, pritisnite gumb T (telefoto).
Kako biste odzumirali, pritisnite gumb W (široko).

13.
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[14] Pregled Zaslon web-aplikacije

Pregled zaslona web-aplikacije

Priključivanjem na tablet ili računalo možete pomicati/nagibati, zumirati, snimati, reproducirati
snimljeni videozapis i konfigurirati jedinicu s web-preglednika (nadalje ova se funkcija naziva
„web-aplikacija”).

Pojedinosti o pokretanju web-aplikacije pogledajte u odjeljku „Pristup web-aplikaciji s
pomoću web-preglednika”.

Note

Web-aplikacija ne podržava audioizlaz fotoaparata.

Kad se web-aplikacija pokrene, sljedeći se zaslon rada uživo pojavljuje.

Zaslon rada uživo

Pojedinosti o zaslonu rada uživo pogledajte u odjeljku „Struktura zaslona rada uživo”.
Zajednički gumbi i ikone zaslona rada uživo i zaslon reprodukcije prikazani su na vrhu
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zaslona.

Pojedinosti o zajedničkom prostoru zaslona pogledajte u odjeljku „Struktura zajedničkih
prostora zaslona”.
Možete prebacivati zaslone pritiskom na kartice prebacivanja zaslona u zajedničkom
prostoru.

Zaslon reprodukcije

Pritisnite karticu [Playback] za prikaz zaslona reprodukcije.

Pojedinosti o zaslonu reprodukcije pogledajte u odjeljku „Struktura zaslona reprodukcije”.

Zaslon Postavke

Pritisnite karticu [Settings] za prikaz zaslona postavki (nadalje se navodi kao web-izbornik).
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Note

U web-izborniku postavke nisu primijenjene sve dok ne pritisnete gumb [OK]. Ako promijenite
postavke na stranici koja ima gumb [OK], pobrinite se da pritisnete gumb [OK].

Pojedinosti o zaslonu postavki pogledajte u odjeljku „Struktura zaslona postavki”.
U ovom vodiču za pomoć zaslon postavki web-aplikacije naziva se web-izbornik.

[15] Pregled Zaslon web-aplikacije

Struktura zajedničkog prostora zaslona

Ova tema opisuje strukturu zajedničkog prostora zaslona.

Naziv fotoaparata1.
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Prikazuje naziv fotoaparata.
Možete promijeniti naziv s pomoću funkcija [Network] > [Camera Name] u web-izborniku.
Boja se pozadine mijenja u skladu s vanjskim signalnim znakom.

Glavni prekidač
Kad je jedinica uključena, prikazuje se [Power ON]. Možete pritisnuti prekidač i odabrati
[Power Standby] za postavljanje izvora napajanja jedinice u stanje pripravnosti.
Kad se [Power Standby] prikaže, možete pritisnuti prekidač i odabrati [Power ON] kako biste
uključili izvor napajanja jedinice.

2.

Kartice za prebacivanje zaslona rada
Pritisnite karticu za prikaz odgovarajućeg zaslona rada.
Kartica [Live]: prikaz zaslona rada uživo.
Kartica [Playback]: prikaz zaslona reprodukcije.
Kartica [Settings]: prikaz zaslona postavki (web-izbornik).

3.

Oznaka obavijesti
Kad poruka stigne, oznaka se mijenja kako je prikazano u nastavku.

 (Uključene obavijesti)
Poduzmite potrebne radnje u skladu s prikazanom porukom na ploči fotografija fotoaparata.

Note

Poruke se ne prikazuju kad je [Monitoring] > [Output Display] > [HDMI] postavljen na [Off] u web-
izborniku. Postavite na [On] kako biste provjerili sadržaj poruke.

4.

Gumb (Camera Status) (Status fotoaparata)
Pritisnite gumb za prikaz informacija o signalu snimljene/emitirane fotografije fotoaparata i
informacija o objektivu na zasebnom zaslonu.

5.
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[16] Pregled Zaslon web-aplikacije

Struktura zaslona rada uživo

Ova tema opisuje strukturu zaslona rada uživo.

Prekidač zaključavanja rada zaslona
 (Operation Unlock) (Otključavanje rada): postavite prekidač u lijevi položaj kako biste

upravljali radom na zaslonu rada uživo i zaslonu reprodukcije.
 (Operation Lock) (Zaključavanje rada): postavite prekidač u desni položaj za

zaključavanje rada na zaslonu rada uživo i zaslonu reprodukcije kako biste spriječili slučajno
krivo upravljanje.

6.

Upravljačka ploča unaprijed postavljenih položaja
Prikazuje registrirani položaj unaprijed postavljenih postavki s pomoću minijature. Dvaput

1.
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pritisnite minijaturu za povratak na položaj pohranjen u unaprijed postavljenim postavkama.

Pojedinosti o položajima unaprijed postavljenim postavkama pogledajte u odjeljku
„Spremanje/pohranjivanje pomicanja/nagibanja, položaj zumiranja i postavka fokusa s
pomoću web-aplikacije”.

Ploča fotografija fotoaparata
Prikazuje trenutne fotografije fotoaparata i status jedinice.
Prikazuje jednake fotografije kao HDMI izlaz.
Sljedeći se status prikazuje iznad fotografije. Crveni ili zeleni okvir prikazuju se oko
fotografije u skladu s primljenim vanjskim signalnim znakom.

2.

Ne. Zaslon Opis

2 –
1

Indikator načina
fokusiranja

Pogledajte „Indikator načina fokusiranja” u odjeljku
„Prikaz zaslona fotoaparata”.

2 –
2

Način snimanja, utor A/B,
indikator intervala snimanja
Interval Rec

Pogledajte odjeljak „Način snimanja, utor A/B,
indikator intervala snimanja Interval Rec” u odjeljku
„Prikaz zaslona fotoaparata”.

2 –
3

Indikator statusa
usmjeravanja

Prikazano tijekom usmjeravanja (samo kad je [Stream
Setting] postavljen na [SRT-Caller])

2 –
4

Indikator statusa rada
RAW izlaza

Prikaz statusa izlaza RAW signala. Pojedinosti o
RAW formatu pogledajte u odjeljku „Snimanje RAW
videozapisa”.

2 –
5

Indikator preostalog
kapaciteta medija

Pogledajte „Indikator preostalog kapaciteta medija” u
odjeljku „Prikaz zaslona fotoaparata”.
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Gumb [Display]
Pritisnite gumb za informacije o prikazu fotoaparata na fotografiji.
Ponovno pritisnite dok su prikazane informacije o fotoaparatu za skrivanje informacija o
fotoaparatu.

Uz oznake, indikator povezan s automatskim fokusom i poruke su prikazane u skladu sa
statusom.

Pojedinosti o prikazanim informacijama o fotoaparatu pogledajte u odjeljku „Prikaz
zaslona fotoaparata”.

Gumb zaustavljanja praćenja AF u stvarnom vremenu
Pritisnite gumb za zaustavljanje praćenja subjekta.

Pojedinosti o praćenju pogledajte u odjeljku „Praćenje određenog subjekta (Realtime
Tracking AF)”.

2 –
6

Indikator položaja zuma
Pogledajte „Indikator položaja zumiranja” u odjeljku
„Prikaz zaslona fotoaparata”.

2 –
7

Indikator načina AE /
razine AE

Prikaz indikatora načina AE / razine AE. Pojedinosti o
AE-u pogledajte „Prilagodba svjetline”.

Gumb za snimanje START/STOP
Pritisnite gumb za početak snimanja. Tijekom snimanja gumbi za snimanje START/STOP
svijetle crvenom bojom.
Pritisnite tijekom snimanja kako biste zaustavili snimanje.
Možete postaviti prekidač Hold (Zadrži) u stanje zadržavanja kako ne biste neispravno
upravljali gumbom START/STOP.

3.

Osnovna ploča konfiguracije fotoaparata
Prikazuje postavke osnovnih funkcija potrebnih za snimanje na gumbima. Pritisnite gumb za
prikaz odgovarajućeg zaslona postavljanja za svaku funkciju u osnovnoj ploči prilagodbe
fotoaparata u nastavku (5).

4.
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4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Pojedinosti pogledajte u opisu svake funkcije.

Function Referenca

FPS „Usporeno i ubrzano snimanje”

ISO/Gain
„Postavljanje osnovne osjetljivosti” i „Automatska prilagodba jačine signala” i
„Ručna prilagodba jačine signala” u odjeljku „Prilagodba jačine signala”

Exposure
Index

„Postavljanje osnovne osjetljivosti”, „Promjena distribucije tamnih i svjetlih
područja na snimljenoj fotografiji”

Shutter
„Automatska prilagodba zatvarača” i „Ručna prilagodba zatvarača” u odjeljku
„Prilagodba zatvarača”

Blenda
„Automatska prilagodba blende” i „Ručna prilagodba bledne” u odjeljku
„Prilagodba blende”

ND Filter „O ND filtru” u odjeljku „Prilagodba razine svjetlosti (ND filtar)”

Scene
File

„Pregled izgleda” i ostale teme u odjeljku „Snimanje sa željenim izgledom”

Base
Look/LUT

„Snimanje s prilagodbom izgleda u postprodukciji”

White
Balance

„Zaslon prilagodbe ravnoteže bijele boje”
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Dodjeljivi gumbi / osnovna ploča prilagodbe konfiguracije fotoaparata
Prikazuje dodjeljive gumbe tijekom normalnog rada. Pritisnite gumb „Camera setup panel”
(Ploča postavljanja fotoaparata) za prikaz odgovarajućih stavki postavljanja. Pritisnite gumb
[X] ili ponovno pritisnite gumb ploče postavljanja fotoaparata za povratak za prikaz
dodjeljivih gumba.

Pojedinosti o dodjeljivim gumbima pogledajte u odjeljku „Dodjeljivi gumbi”.
Pojedinosti o osnovnoj ploči prilagodbe konfiguracije fotoaparata pogledajte u opisu
svake funkcije.

5.

Upravljačka ploča kadriranja / upravljačka ploča GUI
Prebacujte između upravljačke ploče kadriranja / upravljačke ploče GUI s pomoću kartica na
vrhu.
Upotrijebite upravljačku ploču kadriranja za prilagodbu kadra. Pritisnite karticu [Pan-Tilt-
Zoom] za prikaz upravljačke ploče kadriranja.

Pojedinosti o radu pogledajte u odjeljku „Prilagodba kadra”.

Savjet

Prikazana je palica upravljačke ploče kadriranja u nastavku kad je funkcija pomicanja/nagibanja
onemogućena i kad je potrebna inicijalizacija funkcije pomicanja/nagibanja.

Kad je funkcija pomicanja/nagibanja zaključana s pomoću poluge zaključavanja
pomicanja/nagibanja

6.
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Kad funkcija pomicanja/nagibanja nije inicijalizirana

Kad se funkcija pomicanja/nagibanja treba ponovno pokrenuti

Kad je funkcija pomicanja/nagibanja onemogućena

Kad funkcija pomicanja/nagibanja nije inicijalizirana ili se treba ponovno pokrenuti, možete brzo
pristupiti gumbu [Pan-Tilt Reset] na upravljačkoj ploči fotoaparata pritiskom na prikazanu poruku
ispod palice.

Upotrijebite upravljačku ploču GUI kako biste upravljali izbornikom fotoaparata,
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reprodukcijom isječaka i ostalim funkcijama. Pritisnite karticu [Cam GUI] kako biste prikazali
upravljačku ploču GUI.

Pojedinosti o radu pogledajte u odjeljcima „Rukovanje izbornikom fotoaparata” i
„Reprodukcija isječaka i ostale radnje isječaka”.

Upravljačka ploča fotoaparata
Upotrijebite za konfiguraciju potrebnih funkcija za rad fotoaparata.
Prebacujte između zaslona za prikaz s pomoću kartica na vrhu.

Pojedinosti pogledajte u opisu svake funkcije.

Kartica (Main) (Glavne)
Prikazuje stavke postavljanja za često upotrijebljene funkcije.
Funkcije gornjeg i donjeg klizača mogu se promijeniti pritiskom na gumb [ˇ] i odabirom s
prikazanog popisa. Sljedeće se funkcije mogu odabrati.

ND Filter
Blenda
ISO*

Jačina signala*

Indeks ekspozicije*

AE razina
Zoom Speed
Brzina pomicanja/nagibanja

7.

Prikazane u skladu s postavkama izbornika.*
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 Kartica (Focus)
Prikazuje stavke postavljanja povezane s fokusom.

 Kartica (Audio)

Prikazuje stavke postavljanje povezane sa zvukom.

Kartica (Stream)
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[17] Pregled Zaslon web-aplikacije

Struktura zaslona reprodukcije

Prikazuje stavke postavljanja povezane s usmjeravanjem.
Prikazane stavke mogu se razlikovati ovisno o postavki formata usmjeravanja.
Kad je postavljeno na [SRT-Caller], usmjeravanje se može pokrenuti/zaustaviti na ovom
zaslonu.

Pojedinosti pogledajte u odjeljku „O usmjeravanju” i ostale teme u odjeljku „Konfiguracija
usmjeravanja”.

Kartica (Others)
Prikazuje stavke postavljanja povezane s ostalim funkcijama.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Ova tema opisuje strukturu zaslona reprodukcije.

Ploča fotografija fotoaparata
Prikazuje reproduciranu fotografiju i povezane informacije. Kad se reprodukcija zaustavi,
zaslon fotografije fotoaparata se pojavljuje.

1.
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1-1 Vrijeme i datum snimanja
1-2 Indikator stanja reprodukcije
1-3 Indikator formata reprodukcije (veličina slike)
1-4 Indikator formata reprodukcije (kodek)
1-5 Prikaz naziva isječka
1-6 Broj isječaka / ukupni broj isječaka
1-7 Indikator statusa usmjeravanja
1-8 Indikator formata reprodukcije (broj sličica u sekundi i metoda skeniranja)
1-9 Indikator temeljnog izgleda

Upravljačka ploča reprodukcije

Prikazuje upravljačke gumbe reprodukcije.

Gumb [Display]
Pritisnite za prebacivanje između prikaza zaslona na fotografiji.

Gumb [Thumbnail]
Prikazuje snimljene isječke na memorijskoj kartici ploče fotografija fotoaparata kao
minijature.

2.

Ruka koja pritišće gumb Function

Gumb  (Play/Pause)
(Reproduciraj/pauziraj)

Reproducira isječak. Tijekom reprodukcije
pauzira isječak.

Gumb  (Fast Forward) (Brzo premotaj
unaprijed), gumb  (Fast Reverse) (Brzo
premotaj unatrag)

Reproducira isječak pri visokoj brzini. Kad
se gumb pritisne, brzina reprodukcije
mijenja se u tri koraka.

Gumb  (Next) (Sljedeće), gumb 
(Previous) (Prethodno)

Preskače na početak isječka ili
prethodni/sljedeći isječak.

Gumb  (Stop) (Zaustavi) zaustavlja reprodukciju.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Pritiskom gumba [Thumbnail] tijekom prikaza zaslona minijature zatvara zaslon minijature i
vraća se na fotografije fotoaparata.

Pojedinosti o zaslonu minijatura pogledajte u odjeljku „Zaslon Thumbnail”.

Gumb [Slot Select]
Prebacuje između ciljnih medija reprodukcije.

Dodjeljivi gumbi
Prikazuje dodjeljive gumbe koji su dodijeljeni funkcijama jedinice.

Pojedinosti o dodjeljivim gumbima pogledajte u odjeljku „Dodjeljivi gumbi”.

3.

Upravljačka ploča GUI
Upotrijebite upravljačku ploču GUI kako biste upravljali izbornikom fotoaparata,
reprodukcijom isječaka i ostalim funkcijama.

Pojedinosti o radu pogledajte u odjeljku „Rukovanje izbornikom fotoaparata” i
„Reprodukcija snimljenih isječaka”.

4.
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[18] Pregled Zaslon web-aplikacije

Struktura zaslona postavki

Upotrijebite zaslon postavki za konfiguraciju različitih stavki postavljanja jedinice uključujući
početne postavke, mrežne postavke, postavke snimanja/reprodukcije s pomoću web-izbornika.

Note

U web-izborniku postavke se ne primjenjuju sve dok ne pritisnete gumb [OK]. Ako promijenite
postavke na stranici koja ima gumb [OK], pobrinite se da pritisnete gumb [OK].

Pojedinosti o zaslonu postavki pogledajte odjeljak „Web-izbornik i detaljne postavke”.

[19] Pregled Zaslon web-aplikacije

Izbornik fotoaparata

Pritisnite gumb [Menu] na upravljačkoj ploči GUI zaslona rada uživo za prikaz izbornika
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fotoaparata na ploči fotografija fotoaparata.

Možete konfigurirati potrebne postavke za snimanje i reprodukciju s pomoću izbornika
fotoaparata.
Pritisnite gumb [Menu] dok je prikazan izbornik fotoaparata kako biste sakrili izbornik
fotoaparata.
Izbornikom fotoaparata rukujte s pomoću upravljačke ploče GUI.

Pojedinosti o izborniku fotoaparata pogledajte u „Izbornik fotoaparata i detaljne postavke”.

Note

Kad su [Monitoring] > [Output Display] > [HDMI/Stream] postavljene na Off (Isključeno) u web-
izborniku (onemogućava previše informacija na zaslonu prikaza), izbornik fotoaparata više se ne
prikazuje na ploči fotografija fotoaparata. Međutim, imajte na umu da rad izbornika u upravljačkoj
ploči GUI je i dalje aktivan. Kako biste izbjegli nehotične radnje, pobrinite se da ne izvršavate nikakve
radnje izbornika s pomoću upravljačke ploče GUI kad je [HDMI/Stream] postavljen na Off
(Isključeno).

[20] Pregled
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Zaslon prikaza fotoaparata

Možete prikazati status i postavke jedinice prikazane na izlaznoj fotografiji fotoaparata. Možete
postaviti izlaze za koji je prikaz zaslona omogućen s pomoću funkcija [Monitoring] > [Output
Display] u web-izborniku.
Možete prikazati/sakriti informacije s pomoću gumba [Display]. Čak i kad je skriven, prikazat će
se tijekom rada izravnog izbornika.
Možete zasebno prikazati/sakriti stavke s pomoću funkcija [Monitoring] > [Display On/Off] u
izborniku fotoaparata.

Informacije koje se prikazuju na zaslonu tijekom snimanja

Indikator prijenosa/indikator preostalih datoteka

Pojedinosti o prijenosu datoteka pogledajte u odjeljku „O prijenosu datoteke” i ostale
teme u odjeljku „Prijenos datoteka”.

1.

Indikator područja fokusiranja
Prikaz područja fokusa za automatsko fokusiranje.

Pojedinosti o automatskom fokusu pogledajte u odjeljku „Automatska prilagodba s
pomoću web-aplikacije” i ostale teme u odjeljku „Automatska prilagodba fokusa (Auto
Focus)”.

2.

Način snimanja, utor A/B, indikator intervala snimanja Interval Rec3.

Zaslon Značenje
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Pojedinosti o intervalnom snimanju pogledajte u „Isprekidano snimanje videozapisa
(Interval Rec)”.

?Rec Snimanje

Stby Pripravnost za snimanje

Indikator dubine polja4.

Indikator načina skeniranja pretražnika
Ako postoji nepodudaranje veličine kruga slike objektiva i postavke načina skeniranja
pretražnika za efektivnu veličinu slike, prikazuje se oznaka  (nepodudaranje).
Kada je funkcija Imager Scan Mode postavljena na FF, oznaka „C” prikazuje se u načinima
s užim kutom gledanja (izrezano).
Do rezanja dolazi u sljedećim načinima.

Kad je format snimanja 3840×2160 i broj sličica u sekundi za ubrzano i usporeno
snimanje je 100 fps ili 120 fps
Kad je [Codec] postavljen RAW ili RAW & XAVC-I i format RAW izlaza je 3840×2160
Pojedinosti o načinu skeniranja pretražnika možete pogledati u odjeljku „Postavljanje
načina skeniranja pretražnika” u dijelu „Konfiguracija osnovnih radnji”.

5.

Indikator statusa rada RAW izlaza
Prikaz statusa izlaza RAW signala.

Pojedinosti o RAW formatu pogledajte u odjeljku „Snimanje RAW videozapisa”.

6.

Indikator brzine kadrova za snimanje u načinu rada za usporeno i ubrzano snimanje

Pojedinosti o usporenom i ubrzanom snimanju pogledajte u odjeljku „Usporeno i ubrzano
snimanje”.

7.

Indikator položaja fokusiranja

Prikazuje položaj fokusiranja.

8.

Indikator načina fokusiranja9.

Zaslon Značenje

Focus Hold Način Focus Hold

MF Način MF
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Automatsko fokusiranje s prepoznavanjem lica/oči

Pojedinosti o AF prepoznavanju lica/oči pogledajte u odjeljku „Praćenje s pomoću
prepoznavanja lica i oči (Face/Eye Detection AF)”.

AF Način AF

 (Realtime tracking AF mode) (Način AF praćenja u
stvarnom vremenu)

Način AF praćenja u
stvarnom vremenu

Zaslon Značenje

 (Face/eye detection AF) (Automatsko fokusiranje s
prepoznavanjem lica/oči)

Naznačuje da je AF
prepoznavanje lica/oči aktivno

 (face/eye only AF) (automatsko fokusiranje samo
lica/oči)

Naznačuje da je AF samo
lica/oči aktivno

 (saved tracking face) (spremljeno praćeno lice) Naznačuje da je praćeno lice
spremljeno

 (AF paused icon during face/eye detection AF) (AF
ikona pauziranja tijekom AF prepoznavanja lica/oči)

Naznačuje da je AF pauziran
tijekom prepoznavanja lica/oči*

Prikazano kad nema spremljenog praćenog lica i lice nije prepoznato ili kad postoji spremljeno praćeno lice,
ali ciljno lice praćenja nije prepoznato.

*

Indikator položaja zuma
Prikazuje položaj zumiranja u rasponu od 0 (široki kut) do 99 (telefoto) (ako je postavljen
objektiv koji podržava prikaz položaja zumiranja).
Također možete promijeniti indikator na traci prikaza ili prikaz fokalne duljine s pomoću
postavki [Technical] > [Lens] > [Zoom Position Display] u izborniku fotoaparata.
Sljedeće stavke dodane su na prikaz kada je omogućena funkcija zumiranja za jasnu sliku.

10.

Zaslon Značenje

 (Clear Image Zoom is enabled) (Jasno
zumiranje slike je omogućeno)

Omogućena je funkcija zumiranja
za jasnu sliku

Vrijednost povećavanja
Tijekom primjene funkcije Clear
Image Zoom
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Pojedinosti o zumiranju pogledajte u odjeljku „Postavljanje vrste zumiranja” i ostale teme
u odjeljku „Prilagodba zumiranja”.

Indikator načina stabilizacije slike11.

Indikator statusa funkcije Rec Control na SDI/HDMI izlazu
Prikaz statusa izlaza kontrolnog signala REC.

Pojedinosti pogledajte u odjeljku „Priključivanje vanjskih monitora i uređaja za snimanje”.

12.

Indikator izoštravanja

Pojedinosti pogledajte u odjeljku „Upotreba automatskog fokusiranja za pojedinačno
snimanje (Push Auto Focus (AF-S))” u odjeljku „Prilagodba fokusa”.

13.

Indikator preostalog kapaciteta medija
Ikona  (zaštita) pojavljuje se ako je memorijska kartica zaštićena od upisivanja.

14.

Indikator načina za balans bijele boje15.

Zaslon Značenje

 (ATW) Automatski način

 (ATW Hold) (ATW zadržavanje) Automatski način je pauziran

W:P Unaprijed postavljeni način

W:A Način Memory A

Prikaz podataka o indikatoru/vremenu vanjskog zaključavanja vremenskog koda
Prikaz "EXT-LK" kada je zaključano na vremenski kod vanjskog uređaja.

Pojedinosti o vremenskom kodu pogledajte u odjeljku „Određivanje podataka o
vremenu”.

16.

Indikator filtra ND17.

Zaslon Značenje

 (A) Automatski način

 (B) Način upravljanja zamućivanjem
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Pojedinosti u ND filtrima pogledajte u odjeljku „Prilagodba razine svjetlosti (ND filtar)”
Pojedinosti o upravljanju zamućivanjem pogledajte u odjeljku „Prilagodba zamućivanja
(Bokeh Control Function)”

Indikator datoteke scene

Pojedinosti o datotekama scene pogledajte u odjeljku „Pregled izgleda” i ostalim temama
u odjeljku „Snimanje sa željenim izgledom”.

18.

Indikator blende
Prikaz položaja blende (F vrijednost) (ako je postavljen objektiv koji podržava funkciju
prikaza blende).

Pojedinosti o blendi pogledajte u odjeljcima „Automatska prilagodba blende” i „Ručna
prilagodba blende”.

19.

Indikator upozorenja na razinu videozapisa20.

Indikator jačine signala
Prikazuje EI vrijednosti u načinu rada Cine EI.

Pojedinosti o jačini signala pogledajte u odjeljku „Automatska prilagodba jačine signala” i
„Ručna prilagodba jačine signala”.
Pojedinosti o načinu rada Cine EI pogledajte u odjeljku „Postavljanje načina snimanja” u
dijelu „Konfiguracija osnovnih radnji”.

21.

Zaslon Značenje

 (A) Automatski način

L Način Preset L

 (Temporary adjustment mode) (Način privremene
prilagodbe)

Način za privremeno
podešavanje

 (B) Način upravljanja
zamućivanjem

Prikaz naziva isječka
Prikazuje naziv isječka koji se snima ili koji će se sljedeći snimiti.

22.

Indikator zatvarača23.
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Pojedinosti o zatvaraču pogledajte u odjeljcima „Automatska prilagodba zatvarača”i
„Ručna prilagodba zatvarača”.

Indikator načina AE / razine AE

Pojedinosti o automatskoj ekspoziciji (AE) pogledajte u odjeljku „Postavljanje ciljne
razine za automatsku prilagodbu svjetline”.

24.

Indikator libele
Prikaz vodoravne razine do ±15° u koracima od ±1°.

25.

Mjerač razine zvuka
Prikazuje razinu zvuka za svaki kanal.

26.

Nadzor videosignala
Prikaz valnog oblika, vektroskopa i histograma.
Narančasta linija prikazuje postavljenu vrijednost oznake razine svjetline.
U načinu Cine EI prikazuje LUT vrstu signala koji se prati.

Pojedinosti pogledajte u odjeljku „Nadzor videosignala”.
Pojedinosti o načinu rada Cine EI pogledajte u odjeljku „Postavljanje načina snimanja” u
dijelu „Konfiguracija osnovnih radnji”.

27.

Indikator osnovne osjetljivosti / indikator osnovnog ISO
U načinu rada Custom prikazuje osnovnu osjetljivost postavljenu s pomoću gumba
[ISO/Gain / Exposure Index] na osnovnoj ploči konfiguracije fotoaparata ili gumba [Shooting]
> [ISO/Gain/EI] > [Base Sensitivity] u izborniku fotoaparata.
U načinu rada Cine EI prikazuje osnovnu ISO osjetljivost postavljenu s pomoću gumba
[ISO/Gain / Exposure Index] u osnovnoj ploči konfiguracije fotoaparata ili gumba [Shooting]
> [ISO/Gain/EI] > [Base ISO] u izborniku fotoaparata.

Pojedinosti o osnovnoj osjetljivosti pogledajte u odjeljku „Odabir osnovne osjetljivosti”.
Pojedinosti o načinu rada Cine EI pogledajte u odjeljku „Postavljanje načina snimanja” u
dijelu „Konfiguracija osnovnih radnji”.

28.

Indikator nadzora izgleda
U načinu Cine EI prikazuje postavku LUT nadzora.

Pojedinosti o LUT postavki pogledajte u odjeljku „Snimanje s prilagodbom izgleda u
postprodukciji”” i povezane teme.
Pojedinosti o načinu rada Cine EI pogledajte u odjeljku „Postavljanje načina snimanja” u
dijelu „Konfiguracija osnovnih radnji”.

29.
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Informacije koje se prikazuju na zaslonu tijekom reprodukcije

Sljedeće informacije polažu se na sliku reprodukcije.

Indikator osnovnog izgleda / snimanja izgleda
Prikazuje postavku osnovnog izgleda.
U načinu Cine EI prikazuje videosignal za snimanje na memorijsku karticu.

Pojedinosti o osnovnom izgledu pogledajte u odjeljku „Pregled izgleda” u dijelu
„Snimanje sa željenim izgledom”.
Pojedinosti o načinu rada Cine EI pogledajte u odjeljku „Postavljanje načina snimanja” u
dijelu „Konfiguracija osnovnih radnji”.

30.

Indikator statusa videozapisa proxy31.

Indikator formata snimanja (kodek)
Prikaz naziva formata za snimanje na memorijske kartice.
Postavite format snimanja (kodek) s pomoću funkcija [Project] > [Rec Format] > [Codec] u
web-izborniku ili izborniku fotoaparata.

32.

Indikator formata snimanja (broj sličica u sekundi i metoda skeniranja)33.

Indikator formata snimanja (veličina slike)
Prikaz veličine slike za snimanje na memorijske kartice.
Postavite format snimanja (veličina slike) s pomoću funkcija [Project] > [Rec Format] >
[Codec] u web-izborniku ili izborniku fotoaparata.

34.

Indikator signalnog znaka
Prikazuje crveni ili zeleni okvir oko fotografije u skladu s primljenim vanjskim signalnim
znakom.

35.
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Indikator prijenosa/indikator preostalih datoteka1.

Broj isječka/ukupan broj isječaka2.

Indikator stanja reprodukcije3.

Indikator formata reprodukcije (broj sličica u sekundi i metoda skeniranja)4.

Indikator formata reprodukcije (veličina slike)5.

Indikator formata reprodukcije (kodek)6.

Indikator medija
Ikona  (zaštita) pojavljuje se ako je memorijska kartica zaštićena od upisivanja.

7.

Prikaz podataka o vremenu8.

Prikaz naziva isječka9.

Indikator pomoćnog prikaza game10.

Mjerač razine zvuka
Prikaz razine zvuka reprodukcije.

11.

Indikator osnovnog izgleda / snimanja izgleda12.

Indikator signalnog znaka13.
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[21] Priprema Montiranje jedinice

Montiranje prema gore na fiksnom mjestu

Ova tema opisuje montiranje jedinica na radnu površinu ili tronožac.

Napomena o postavljanju
Kako biste zaštitili objektiv i blok priključaka objektiva, objektiv i kapica ili poklopac jedinice
moraju biti pričvršćeni dok pričvršćujete objektiv.
Kako se ne pojavio kvar objektiva, nemojte držati dijelove objektiva dok rade.
Kako se ne bi pojavio kvar jedinice, nemojte držati glavu fotoaparata tijekom rada.

Provjerite prostor za montiranje.

Prilikom montiranja na radnu površinu
Montirajte ovu jedinicu na ravnu površinu, uzmite u obzir potreban prostor za okretanje
objektiva i ožičenje stražnjeg dijela jedinice.

Note

Montirajte na stabilnu lokaciju koja nije podložna vibracijama. Lokacije koje su sklone
vibracijama mogu uzrokovati vibracije na fotografijama.

Ako se jedinica mora postaviti na nagnutu površinu, održavajte je unutar ±15° vodoravne
površine i poduzmite mjere tako da jedinica ne padne.

Prilikom montiranja na tronožac
Pričvrstite tronožac u utor vijka za montiranje tronošca na dnu.

1
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Zatim pričvrstite objektiv. Pogledajte odjeljak „Pričvršćivanje objektiva” uzimajući u obzir
informacije navedene u odjeljku „Mjere opreza prilikom pričvršćivanja/uklanjanja objektiva”,
„Provjera prekidača objektiva” i „Mjere opreza prilikom upotrebe objektiva za zumiranje”.

[22] Priprema Montiranje jedinice

Montiranje prema gore na visokom fiksiranom mjestu

Ova tema opisuje postupak montiranja jedinice prema gore na visokom mjestu s pomoću
nosača za strop (CIB-PCM1 (dodatno)).

Upotrijebite vijak za montiranje tronošca sa sljedećom količinom izbočenosti od površine
za montiranje i zategnite je odvijačem.

A: vijci za montiranje tronošca 1/4-20 UNC, ISO 1222 (6,35 mm)
B: izbočine (4,5 mm do 5,5 mm)

Nemojte upotrebljavati vijke za tronožac za montiranje jedinice na visoko mjesto.

Note

Odaberite tronožac koji se neće preokrenuti čak kad se objektiv okrene.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Za montiranje jedinice na visoko mjesto unajmite profesionalnog izvođača.
Kad montirate na visoko mjesto, pobrinite se da površina za montiranje i materijal za
montiranje (bez dodatne opreme) može podržati 200 kg (440 lb 14,8 oz) ili više, a zatim
montirajte jedinicu kako je opisano u Vodiču za pomoć. Ako montaža nije dovoljno stabilna,
jedinica može pasti i uzrokovati ozbiljne ozljede.
Pričvrstite isporučen konop žice za sprječavanje pada na nosač za strop CIB-PCM1
(dodatno) kako jedinica ne bi pala.
Kad se jedinica montira na visoko mjesto, jednom godišnje provjerite je li se montaža
otpustila. Skratite intervalni pregled u skladu s uvjetima upotrebe.

Napomena o postavljanju
Kako biste zaštitili objektiv i blok priključaka objektiva jedinice, ostavite kapicu i poklopac na
objektiv sve dok ga ne pričvrstite.
Kako se ne pojavio kvar objektiva, nemojte držati dijelove objektiva dok rade.
Kako se ne bi pojavio kvar jedinice, nemojte držati glavu fotoaparata tijekom rada.

Provjerite dodatnu opremu za montiranje na visoko mjesto i prostor za montiranje.

Komplet nosača za strop CIB-PCM1 (dodatno)
Prije početka provjerite da imate sljedeće dijelove.

Nosač tijela (1)
Nosač za strop (1)
Poklopac gumb za otpuštanje objektiva (1)
Konop žice za sprečavanje pada (1)
Vijci +PSW M3×8 (9)
Vijak od nehrđajućeg čelika +PSW M4x8 za konop žice za sprečavanje pada (1)

1
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Note

Konop žice za sprečavanje pada osmišljen je da podržava jedinicu kad je spuštena. Nemojte
dodavati bilo kakvo opterećenje osim onog jedinice.

Prostor za montiranje
Pogledajte sljedeći nacrt kako biste odredili mjesto i smjer montaže, uzimajući u obzir
potreban prostor za okretanje objektiva i ožičenje stražnjeg dijela jedinice.

A: raspon pokreta glave fotoaparata (npr. SEL70200GM2 (s pričvršćenim SEL20TC):
Ø340)
B: nosač za strop (otvor na strani površine za montiranje (Ø60))
C: otvor za poravnavanje montaže

Note

Montirajte na stabilnu lokaciju koja nije podložna vibracijama. Lokacije koje su sklone
vibracijama mogu uzrokovati vibracije na fotografijama.

Ako se jedinica mora postaviti na nagnutu površinu, održavajte je unutar ±15° vodoravne
površine i poduzmite mjere tako da jedinica ne padne.

Povucite polugu zaključavanja pomicanja/nagibanja u položaj LOCK kako biste
zaključali pomicanje/nagibanje glave fotoaparata.

2
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Note

Ako se pomicanje/nagibanje glave fotoaparata ne zaključava kad je poluga zaključavanja u
položaju LOCK, ručno pomaknite glavu fotoaparata dok se ne zaključa na mjestu.

Pričvrstite nosač tijela na dno jedinice s pomoću šest isporučenih vijaka (M3×8).3
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Upotrijebite isporučene vijke. Ako upotrijebite vijke koji nisu isporučeni, možete oštetiti
unutrašnjost jedinice.

Pričvrstite konop žice za sprečavanje pada na nosač tijela.4
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A: isporučeni konop žice
B: isporučeni križni vijak (M4×8)
C: metalna omča konopa žice

Upotrijebite isporučeni vijak. Upotreba drugih vijaka može smanjiti učinkovitost funkcije
konopa žice.

Pričvrstite nosač za strop na površinu, poput police, na koju se može montirati.5
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A: zid
B: oznaka ? (smjer fotoaparata prema naprijed)
C: otvor za priključivanje kabela
D: polica ili druga površina za montiranje

Pričvrstite konop žice za sprečavanje pada na točku u blizini površine za montiranje.

Upotrijebite vijak kapice šesterokutne utičnice M5 (3/16 inča) (dodatno) i pričvrstite ga na
predmet u blizini police ili površine na kojoj je nosač pričvršćen.

6
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A: konop žice
B: vijak kapice šesterokutne utičnice (M5, 3/16 inča)

Poravnajte otvor vijka ? na prednjem tijelu nosača tijela s otvorom nosača za strop
?, umetnite jedinicu i privremeno fiksirajte nosač kućišta na nosač za strop
okretanje jedinice u smjeru kazaljki na satu.

7
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A: otvor ?
B: otvor ?

Pričvrstite nosač tijela i nosač za strop s pomoću tri isporučena vijka za
zaključavanje rotacije (M3×8).

8
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Zatim pričvrstite objektiv. Pogledajte odjeljak „Pričvršćivanje objektiva” uzimajući u obzir
informacije navedene u odjeljku „Mjere opreza prilikom pričvršćivanja/uklanjanja objektiva”,
„Provjera prekidača objektiva” i „Mjere opreza prilikom upotrebe objektiva za zumiranje”.

Note

Nakon pričvršćivanja objektiva provjerite da je sigurno pričvršćen.
Objektiv nema zaštitu od pada. Tvrtka Sony ne preuzima nikakvu odgovornost za pad objektiva s
jedinice.

Provjeriti stanje montiranja.

Točnije provjerite sljedeće stavke. 

Ispravno pričvršćeni vijci za montiranje.
Konop žice za sprečavanje pada je ispravno pričvršćen i nije zakrenut.
Jedinica je montirana u istoj razini (bez naginjanja ili klimanja).
Jedinica se slobodno ne kreće kad se zakrene.

9
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[23] Priprema Montiranje jedinice

Montiranje na stropu

Ova tema opisuje postupak montiranja jedinice na strop s pomoću nosača za strop (CIB-PCM1
(dodatno)).

Za montiranje jedinice na strop unajmite profesionalnog izvođača.
Kad montirate na strop, pobrinite se da površina za montiranje i materijal za montiranje (bez
dodatne opreme) može podržati do 200 kg (440 lb 14,8) ili više, a zatim montirajte jedinicu
kako je opisano u Vodiču za pomoć. Ako montaža nije dovoljno stabilna, jedinica može pasti
i uzrokovati ozbiljne ozljede.
Pričvrstite isporučen konop žice za sprječavanje pada na nosač za strop CIB-PCM1
(dodatno) kako jedinica ne bi pala.
Kad se jedinica montira na strop, jednom godišnje provjerite je li se montaža otpustila.
Skratite intervalni pregled u skladu s uvjetima upotrebe.

Napomena o postavljanju
Kako biste zaštitili objektiv i blok priključaka objektiva jedinice, ostavite kapicu i poklopac na
objektiv sve dok ga ne pričvrstite.
Kako se ne pojavio kvar objektiva, nemojte držati dijelove objektiva dok rade.
Kako se ne bi pojavio kvar jedinice, nemojte držati glavu fotoaparata tijekom rada.

Provjerite dodatnu opremu za montiranje na strop i prostor za montiranje.1
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Komplet nosača za strop CIB-PCM1 (dodatno)
Prije početka provjerite da imate sljedeće dijelove.

Nosač tijela (1)
Nosač za strop (1)
Poklopac gumb za otpuštanje objektiva (1)
Konop žice za sprečavanje pada (1)
Vijci +PSW M3×8 (9)
Vijak od nehrđajućeg čelika +PSW M4×8 za konop žice za sprečavanje pada (1)

Note

Konop žice za sprečavanje pada osmišljen je da podržava jedinicu kad je spuštena. Nemojte
dodavati bilo kakvo opterećenje osim onog jedinice.

Prostor za montiranje
Pogledajte sljedeći nacrt kako biste odredili mjesto i smjer montaže, uzimajući u obzir
potreban prostor za okretanje objektiva i ožičenje stražnjeg dijela jedinice.

A: raspon pokreta glave fotoaparata (npr. SEL70200GM2 (s pričvršćenim SEL20TC):
Ø340)
B: nosač za strop (otvor na stropu (Ø60))
C: otvor za poravnavanje montaže

Note

Montirajte na strop (npr. betonski) dovoljne izdržljivosti.
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Za montiranje jedinice na strop nedovoljne izdržljivosti omogućite dovoljno ojačanje.

Montirajte na stabilnu lokaciju koja nije podložna vibracijama. Lokacije koje su sklone
vibracijama mogu uzrokovati vibracije na fotografijama.

Ako se jedinica mora postaviti na nagnutu površinu, održavajte je unutar ±15° vodoravne
površine i poduzmite mjere tako da jedinica ne padne.

Strana suprotna otvoru ? na nosaču za strop je u smjeru snimanja (prednja strana
fotoaparata).

Povucite polugu zaključavanja pomicanja/nagibanja u položaj UNLOCK kako biste
otključali pomicanje/nagibanje i zakrenuli glavu fotoaparata za 180° u smjeru
nagibanja.

2

Povucite polugu zaključavanja pomicanja/nagibanja u položaj LOCK kako biste
zaključali pomicanje/nagibanje glave fotoaparata.

Glava fotoaparata okrenuta za 180°

Note

Ako se pomicanje/nagibanje glave fotoaparata ne zaključava kad je poluga zaključavanja u
položaju LOCK, ručno pomaknite glavu fotoaparata dok se ne zaključa na mjestu.

3
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Pričvrstite nosač tijela na dno jedinice s pomoću šest isporučenih vijaka (M3×8).

Upotrijebite isporučene vijke. Ako upotrijebite vijke koji nisu isporučeni, možete oštetiti
unutrašnjost jedinice.

4

Pričvrstite nosač za strop na ploču za montiranje (dodatno), a zatim pričvrstite ploču
na strop.

5
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A: nosač za strop
B: strop
C: ploča za montiranje
D: otvor ?
Pričvrstite nosač u skladu sa smjerom nosača za strop
Pobrinite se da je pri montiranju na strop prednji dio fotoaparata na suprotnoj strani od
nosača za strop u odnosu na normalno montiranje prema gore. Ispravno montirajte prema
dijagramu koji označava smjer montaže.

A: prednji dio za montiranje prema gore (smjer otvora ?)
B: prednji dio za montiranje na strop

Note

Materijal površine za montiranje odgovornost je kupca.

Pričvrstite konop žice za sprečavanje pada na strop.6
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A: nosač za strop
B: vijak kapice šesterokutne utičnice (M5, 3/16 inča)
C: konop žice (isporučen)
D: ploča za montiranje
E: strop

Povucite konop žice za sprečavanje pada kroz otvor u sredini nosača za strop, a
zatim ga pričvrstite na nosač za tijelo.

Navedite konop žice za sprečavanje pada kroz metalnu omču nosača za tijelo i sigurno ga
pričvrstite na nosač s pomoću isporučenog vijka od nehrđajućeg čelika (M4×8).

7
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A: isporučeni konop žice
B: isporučeni križni vijak (M4×8)
C: metalna omča konopa žice

Upotrijebite isporučeni vijak. Upotreba drugih vijaka može smanjiti učinkovitost funkcije
konopa žice.

Note

Preporuča se da jedna osoba drži jedinicu, kako je prikazano na sljedećem dijagramu, dok
druga osoba montira jedinicu.
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Nemojte držati glavu fotoaparata ili nosač za objektiv dok montirate jedinicu. Postoji rizik od
štete ili ozljede ako jedinica padne.

Pobrinite se da ne dođe do kratkog spoja ožičenja električnih priključaka i kabela padom
konopa žice za sprečavanje pada.

Montaža može nositi povišenu masu do 8,8 kg (19 lb 6,4 oz) (uključujući objektiv). Kako
jedinica ne bi pala, nemojte premašiti maksimalnu očekivanu masu.

Poravnajte otvor vijka (A) na nosaču za tijelo s otvorom ? (B) na nosaču za strop,
umetnite jedinicu i zakrenite je za 60 stupnjeva u smjeru kazaljki na stopu sve dok
se otvor vijka (A) i otvor vijka (C) ne poravnaju.

8
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A: otvor vijka na nosaču tijela
B: otvor vijka na nosaču za strop (otvor ?)
C: otvor vijka
D: strop
E: ploča za montiranje

Pričvrstite nosač tijela i nosač za strop s pomoću tri isporučena vijka za
zaključavanje rotacije (M3×8).

9
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Zatim pričvrstite objektiv. Pogledajte odjeljak „Pričvršćivanje objektiva” uzimajući u obzir
informacije navedene u odjeljku „Mjere opreza prilikom pričvršćivanja/uklanjanja objektiva”,
„Provjera prekidača objektiva” i „Mjere opreza prilikom upotrebe objektiva za zumiranje”.

Note

Kako biste ispravno rukovali pomicanjem/nagibanjem kad je jedinica montirana na strop, postavite
funkciju [Pan-Tilt] > [Direction] > [Ceiling] na [On] u web-izborniku.

Provjerite stanje montiranja.

Točnije provjerite sljedeće stavke.

Ispravno pričvršćeni vijci za montiranje.
Konop žice za sprečavanje pada je ispravno pričvršćen i nije zakrenut.
Jedinica je montirana u istoj razini (bez naginjanja ili klimanja).
Jedinica se slobodno ne kreće kad se zakrene.

10
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Nakon pričvršćivanja objektiva provjerite da je sigurno pričvršćen.
Objektiv nema zaštitu od pada. Tvrtka Sony ne preuzima nikakvu odgovornost za pad objektiva s
jedinice.

[24] Priprema Pričvršćivanje/uklanjanje objektiva

Mjere opreza prilikom pričvršćivanja/uklanjanja
objektiva

Leću nemojte ostaviti usmjerenu prema suncu. Izravna sunčeva svjetlost može prodrijeti kroz
objektiv, fokusirati se u jedinici te uzrokovati požar.

Note

Objektiv postavite/uklonite dok je jedinica isključena.

Objektiv je precizna komponenta. Objektiv nemojte odlagati na površinu s elementom za montažu
objektiva okrenutim prema dolje. Postavite isporučeni poklopac za element za montažu objektiva.

Savjet

Za detalje o objektivima koje podržava jedinica obratite se prodajnom predstavniku tvrtke Sony.

[25] Priprema Pričvršćivanje/uklanjanje objektiva

Provjera prekidača objektiva

Potrebne su sljedeće provjere i postavke ovisno o vrsti objektiva.

Za objektiv s prekidačem za zumiranje

Postavite prekidač na SERVO.
Ako postavite prekidač na MANUAL, zumiranje se jedino može prilagoditi s pomoću prstena za
zumiranje. Upravljanje zumiranjem jedinice nema učinka.

Za objektiv s prekidačem za način fokusiranja
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Postavite prekidač na AF/MF ili AF.
Ako postavite prekidač na MF, fokusiranje se jedino može prilagoditi s pomoću prstena za
objektiv ili ručno prilagoditi s daljinskog upravljača jedinice. Ako prekidač postavite na Full MF,
fokusiranje se jedino može prilagoditi s pomoću prstena za objektiv.

Note

Kada upotrebljavate objektiva A-mount, ručno podešavanje jedinicom za daljinsko upravljanje može
biti nedostupno.

Za objektiv s prekidačem Auto Iris

Postavite prekidač na AUTO.
Kad nije postavljen na AUTO, blenda se jedino prilagođava s pomoću prstena za objektiv.
Upravljanje blendom na jedinici ne radi.

Za objektiv s prekidačem za stabillizaciju fotografije

Postavite prekidač na OFF.
Ako je prekidač postavljen na ON, neočekivano ponašanje može se pojaviti tijekom
pomicanja/nagibanja.

SELP28135G

A: Postavite prekidač ZOOM na SERVO.
B: Pomaknite prsten za fokusiranje na položaj prema naprijed (način rada AF/MF).
C: Postavite prekidač za stabilizaciju fotografije na OFF.

[26] Priprema Pričvršćivanje/uklanjanje objektiva
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Mjere opreza prilikom upotrebe objektiva za zumiranje

Kad upotrebljavate objektiv za zumiranje koji nije objektiv s motoriziranim zumiranjem, položaj
zumiranja se može promijeniti ovisno o okruženju montiranja. Osigurajte prsten za zumiranje u
položaj s pomoću trake u skladu sa svrhom upotrebe.

Plastična filmska traka: 471 BLA 50 ili jednaka

[27] Priprema Pričvršćivanje/uklanjanje objektiva

Pričvršćivanje objektiva

Ova tema opisuje kako pričvrstiti objektiv E-mount ili A-mount.

Note

Kada upotrebljavate objektiv A-mount, iris se postavlja ručno, a fokusiranje je postavljeno na MF.

Povucite polugu zaključavanja pomicanja/nagibanja u položaj LOCK kako biste
zaključali pomicanje/nagibanje glave fotoaparata.

1
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Note

Ako se pomicanje/nagibanje glave fotoaparata ne zaključava kad je poluga zaključavanja u
položaju LOCK, ručno pomaknite glavu fotoaparata dok se ne zaključa na mjestu.

Okrenite polugu stezaljke za vijak za pričvršćivanje postolja za nosač objektiva u
smjeru suprotnom od kazaljki na satu kako biste otpustili bravu, a zatim pomaknite
vijak za pričvršćivanje postolja za nosač objektiva u položaj koji ne ometa objektiv.

A: ispravno
B: neispravno

2

Okrenite polugu zaključavanja glave fotoaparata u smjeru strelice kako biste
otključali glavu fotoaparata.

3
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Note

Sve dok se fotoaparat zaključa ponovno, postoji opasnost da će se glava fotoaparata
pomaknuti pod vlastitom težinom. Pridržavajte glavu fotoaparata rukom dok izvršavate radnje.

Povucite glavu fotoaparata u prednji položaj.4

Okrenite polugu zaključavanja glave fotoaparata u smjeru strelice kako biste
zaključali glavu fotoaparata.

5
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Uklonite kapicu i poklopac s jedinice i objektiva.6

Poravnajte oznaku montiranja objektiva (bijela) s jedinicom, pažljivo umetnite
objektiv u glavu fotoaparata, a zatim okrenite objektiv u smjeru kazaljki na satu dok
ne sjedne u zaključan položaj.

A: oznake montiranja (bijelo)

Note

Kako biste upotrijebili objektiv A-mount, pričvrstite adapter za montiranje objektiva (dodatno)
na jedinicu i zatim pričvrstite objektiv A-mount.

7

Okrenite polugu zaključavanja glave fotoaparata u smjeru strelice kako biste
otključali glavu fotoaparata.

8
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Note

Sve dok se fotoaparat ne zaključa ponovno, postoji opasnost da će se glava fotoaparata
pomaknuti pod vlastitom težinom. Pridržavajte glavu fotoaparata rukom dok izvršavate radnje.

Održavajte ravnotežu prema natrag/naprijed glave fotoaparata tako da je pomicanje
postolja vodoravno.

Ako upotrebljavate jedan od sljedećih objektiva, možete uravnotežiti jedinicu i objektiv
prema ljestvici na postolju pomicanja.

9

Položaj
ljestvice Naziv objektiva

0,5 SEL70200GM (s pričvršćenim SEL20TC)
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Note

Upotrijebite ljestvicu pomicanja postolja za grubu procjenu.

Kad pričvršćujete objektiv, provedite odgovarajuće prilagodbe za ravnotežu tako da se jedinica
ne nagiba prema naprijed i natrag.

Prilagodite ravnotežu na vodoravnoj površini.

1,7 SEL70200GM

2.0 SEL70200GM2 (s pričvršćenim SEL20TC)

3 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G

5,0 ili više
SEL1224GM, SEL1635GM, SELP1635G, SELP18105G,
SELP1020G

Okrenite polugu zaključavanja glave fotoaparata u smjeru strelice kako biste
zaključali glavu fotoaparata.

10

Okrenite poluge stezaljki za nosač objektiva u smjeru suprotnom od kazaljki na satu
kako biste otpustili jedinicu za nosač objektiva.

11
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A: poluga stezaljke šipke za nosač objektiva (2 mjesta)
B: jedinica za nosač objektiva

Pomaknite jedinicu za nosač objektiva tako da je postolje za nosač objektiva
poravnato s vijkom za pričvršćivanje postolja za nosač objektiva, a zatim okrenite
vijak u smjeru kazaljki na satu kako biste pričvrstili postolje za nosač objektiva.

Note

Pobrinite se da je postolje za nosač objektiva okomito na vijak za pričvršćivanje postolja za
nosač objektiva, a zatim zategnite.

12

Okrenite polugu stezaljke za vijak za pričvršćivanje postolja za nosač objektiva u
smjeru kazaljki na satu kako biste zaključali vijak za pričvršćivanje postolja za
nosač objektiva.

13
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A: vijak za pričvršćivanje postolja za nosač objektiva
B: otvor vijka za pričvršćivanje
C: poluga stezaljke vijka za pričvršćivanje postolja za nosač objektiva

Savjet

Ako se poluga stezaljke nalazi u položaju u kojem ju je teško okrenuti, otpustite je i zakrenite
pod kut koji olakšava primjenu. Kad je u željenom položaju, zatvorite polugu stezaljke.

A: poluga stezaljki vijka za pričvršćivanje postolja za nosač objektiva
B: poluga stezaljke šipke za nosač objektiva

Okrenite dvije poluge stezaljki šipki za nosač objektiva u smjeru kazaljki na satu
kako biste osigurali jedinicu nosača objektiva.

14

Provjerite da su obje poluge zategnute i da nisu labave, objektiv je pričvršćen i da je
objektiv ispravno postavljen.

15
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[28] Priprema Pričvršćivanje/uklanjanje objektiva

Uklanjanje objektiva

Uklonite objektiv s pomoću postupka suprotnog pričvršćivanju objektiva.

Note

Rukom čvrsto prihvatite objektiv kako ne bi ispao.

Ako odmah nećete postaviti drugi objektiv, obavezno postavite poklopac kućišta.

Ako je poluga labava ili objektiv nije ispravno pričvršćen, objektiv može pasti ili se
oštetiti.
Kad upotrebljavate objektiv s motoriziranim zumiranjem E-mount, objektiv također
mora biti zasebno kalibriran kako bi se ispravno ponovno vratili položaji za zumiranje
pohranjeni u fotoaparatu kao unaprijed postavljeni položaji. Pojedinosti pogledajte u
poglavlju „Kalibracija objektiva E-mount”.

Provjerite da je pomicanje/nagibanje zaključano.1

Okrenite polugu stezaljke za vijak za pričvršćivanje postolja za nosač objektiva u
smjeru suprotnom od kazaljki na satu kako biste otpustili vijak.

2

Uklonite vijak za pričvršćivanje postolja za nosač objektiva na jedinici za nosač
objektiva i pomaknite ga u položaj koji ne ometa objektiv.

3

Otključajte glavu fotoaparata i pomaknite glavu fotoaparata u prednji položaj.

Pojedinosti pogledajte u koracima tri do pet u odjeljku „Pričvršćivanje objektiva”.

4

Pritisnite i držite gumb za otpuštanje objektiva i okrenite objektiv u smjeru
suprotnom od kazaljke na satu dok držite objektiv.

5

Kad su oznake za montažu (bijelo) na fotoaparatu i objektivu poravnati, povucite
objektiv prema naprijed.

6
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[29] Priprema

Priključivanje kabela

Ova tema opisuje priključivanje kabela.

[30] Priprema

Povežite potrebne kabele na priključke na stražnjoj ploči.

Kako se HDMI kabel ne bi uklonio, uklonite vijak pločice za zadržavanje za ugradnju HDMI
kabela (M2.6×6, crni) s bloka priključaka i pričvrstite isporučenu pločicu za zadržavanje za
ugradnju HDMI kabela s pomoću vijka za montiranje. Osigurajte HDMI kabel na pločicu za
zadržavanje HDMI kabela s pomoću komercijalno dostupne vezice za kabel ili trake.

A: vijak pločice za zadržavanje za ugradnju HDMI kabela (M2.6×6, crni)
B: komercijalno dostupna vezica za kabel ili traka
C: pločica za zadržavanje HDMI kabela (isporučena)

1
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Priključivanje jedinice na mrežni uređaj putem žičane
veze

Ova tema opisuje povezivanje jedinice na mrežni uređaj putem žičane veze.

[31] Priprema Priključivanje izvora napajanja

Upotreba napajanja izmjeničnom strujom

Ova tema opisuje postupak napajanja jedinice s pomoću izmjenične struje.

Priključite jedinicu na mrežni uređaj (poput Wi-Fi pristupne točke ili mrežnog
prespojnika) s pomoću LAN kabela kategorije 5e ili veće.

1

Povucite polugu zaključavanja pomicanja/nagibanja u položaj LOCK kako biste
zaključali pomicanje/nagibanje glave fotoaparata.

1

Adapter za izmjeničnu struju (isporučen) priključite na priključnicu DC IN na jedinici,
a kabel napajanja (isporučen) na izvor izmjeničnog napajanja.

2
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A: priključnica DC IN
B: kabel napajanja
C: Adapter za napajanje izmjeničnom strujom

Osigurajte kabel adapter za napajanje izmjeničnom strujom s pomoću stezaljke za
kabel ako želite da se kabel ne isključi.

Zaključajte stezaljku za kabel, navedite kabel kroz stezaljku, kako je prikazano u nastavku,
i zaključajte stezaljku.

3
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A: stezaljka za kabel
B: brava za stezaljku za kabel
C: kabel adaptera za napajanje izmjeničnom strujom

Provjerite da žaruljica POWER na prednjem dijelu jedinice mijenja treperenje
zelenom bojom u stalnu zelenu boju i da je pokretanje dovršeno.

Kad jedinica normalno radi i povezana je na mrežu, žaruljica NETWORK svijetli zelenom
bojom.

Kad upotrebljavate objektiv koji ne podržava rad pomicanja/nagibanja, zaključajte
polugu zaključavanja pomicanja/nagibanja i preskočite sljedeće korake. Pojedinosti o
objektivima koji podržavaju pomicanje/nagibanje zatražite od svojeg prodavača ili
prodajnog predstavnika tvrtke Sony.

4

Pomaknite polugu zaključavanja pomicanja/nagibanja na položaj UNLOCK kako
biste otključali pomicanje/nagibanje glave fotoaparata.

5

Ponovno postavite pomicanje/nagibanje.

Pojedinosti pogledajte u odjeljku „Ponovno postavljanje pomicanja/nagibanja”.

6
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Note

Nemojte upotrebljavati adapter za napajanje izmjeničnom strujom ili strujni kabel osim onih koji su
isporučeni s jedinicom. Priključivanjem drugih adaptera ili strujnih kabela može uzrokovati požar ili
kvar.

Adapter za izmjeničnu struju nemojte upotrebljavati u skučenom prostoru, primjerice između zida i
namještaja.

Metalne dijelove priključka adaptera za izmjeničnu struju nemojte kratko spajati. Zbog toga može
doći do kvara.

Adapter za izmjeničnu struju priključite na najbliži izvor izmjeničnog napajanja. Ako se tijekom rada
pojavi problem. kabel napajanja odmah odspojite od izvora izmjeničnog napajanja.

Kada odspajate adapter za izmjeničnu struju iz jedinice, primite priključak i izvucite ga. Povlačenje
kabela može dovesti do kvara.

[32] Priprema Priključivanje izvora napajanja

Upotreba napajanja PoE++

Kad je jedinica priključena na PoE++ kompatibilan uređaj napajanja, napajanje se dovodi na
jedinicu putem komercijalno dostupnog mrežnog kabela.
Ova metoda omogućava da se napajanje dostavi jedinici bez potrebe za ožičenjem izvora
napajanja u okruženjima kad nema strujne utičnice u blizini mjesta za montiranje.

Note

Kad napajanje dostavlja PoE++, funkcije snimanja i reprodukcije se ne mogu upotrebljavati kad je
medij za snimanje umetnut u jedinicu.

Povucite polugu zaključavanja pomicanja/nagibanja u položaj LOCK kako biste
zaključali pomicanje/nagibanje glave fotoaparata.

1

Priključite jedinicu i PoE++ kompatibilni uređaj za napajanje s pomoću komercijalno
dostupnog mrežnog kabela.

2
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A: mrežni kabel
B: PoE++ kompatibilni uređaj za napajanje

Provjerite da žaruljica POWER na prednjem dijelu jedinice mijenja treperenje
zelenom bojom u stalnu zelenu boju i da je pokretanje dovršeno.

Kad jedinica normalno radi i povezana je na mrežu, žaruljica NETWORK svijetli zelenom
bojom.

Note

Kad napajanje dostavlja PoE++, početna autentifikacija se izvršava tijekom intervala sve dok
se pokretanje dovrši.

Kad upotrebljavate objektiv koji ne podržava rad pomicanja/nagibanja, zaključajte polugu
zaključavanja pomicanja/nagibanja i preskočite sljedeće korake. Pojedinosti o objektivima koji
podržavaju pomicanje/nagibanje zatražite od svojeg prodavača ili prodajnog predstavnika
tvrtke Sony.

3
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Note

Jedinica je sukladna IEEE802.3bt vrsta 4 klasa 8. Pojedinosti o odobrenom kompatibilnom PoE++
uređaju za napajanje zatražite od svojeg prodavača ili prodajnog predstavnika tvrtke Sony.

Jedinica je sukladna lakoj autentifikaciji (LLDP), ali možda ćete trebati konfigurirati mrežne uređaje
(sukladno IEEE802.3bt).

Nemojte priključivati adapter za napajanje izmjeničnom strujom kad upotrebljavate PoE++ dostavu
napajanja kad je omogućena laka autentifikacija (LLDP).

Ako su adapter za napajanje izmjeničnom strujom i PoE++ uređaj za napajanje istovremeno
priključeni, napajanje se dostavlja s adaptera za napajanje izmjeničnom strujom.

Kad napajate putem PoE++, upotrijebite mrežni kabel kategorije 5e ili više.

Pričekajte otprilike 10 sekundi te onda ponovno uključite jedinicu kad se napaja putem PoE++.

Kad upotrebljavate PoE++ dostavu napajanja, priključite uzemljeni terminal u uzemljenje.

Kad se povezujete putem PoE++ dostave napajanja, nemojte postavljati ožičenje na vanjskom
prostoru.

[33] Priprema

Ponovno postavljanje pomicanja/nagibanja

Možete ponovno postaviti pomicanje/nagibanje, na primjer kad zamijenite objektiv s pomoću
sljedećeg postupka.

Pomaknite polugu zaključavanja pomicanja/nagibanja na položaj UNLOCK kako
biste otključali pomicanje/nagibanje glave fotoaparata.

4

Ponovno postavite pomicanje/nagibanje.

Pojedinosti pogledajte u odjeljku „Ponovno postavljanje pomicanja/nagibanja”.

5

Pomaknite polugu zaključavanja pomicanja/nagibanja u položaj UNLOCK i provjerite
da je pomicanje/nagibanje glave fotoaparata otključano.

1

Izvršite ponovno postavljanje funkcije pomicanja/nagibanja.

Ponovno postavljanje pomicanja/nagibanja može se izvršiti s infracrvenog daljinskog

2
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[34] Priprema Konfiguracija prije snimanja Inicijalizacija jedinice s pomoću web-aplikacije

Pristup web-aplikaciji s web-preglednika

Priključivanjem jedinice na tablet ili računalo možete rukovati konfigurirati jedinicu s web-
preglednika.

upravljača, web-aplikacije ili daljinskog upravljača RM-IP500 (dodatno).
Rad s pomoću infracrvenog daljinskog upravljača: pritisnite gumb P/T RESET.

Rad s pomoću infracrvenog daljinskog upravljača: pritisnite gumb P/T RESET.
Rad s pomoću web-aplikacije: pritisnite gumb [Pan-Tilt Reset] na kartici  (Ostalo) na
zaslonu rada uživo.
Rad s pomoću daljinskog upravljača RM-IP500: pogledajte upute za rad za RM-IP500.

Note

Izvršavanje ponovnog postavljanja pomicanja/nagibanja uzrokuje okretanje glave fotoaparata i
objektiva. Pobrinite se da objektiv ništa ne smeta prije izvršavanja.

Jedinica ima funkciju koja ograničava raspon pomicanja/nagibanja, ali ova je funkcija
onemogućena kad se jedinici uključi ili kad se izvrši ponovno postavljanje
pomicanja/nagibanja.

Savjet

Kad se dovrši ponovno postavljanje pomicanja/nagibanja, jedinica se vraća u položaj prije
izvršavanja.

Provjerite podržavaju li tablet ili računalo web-aplikaciju.1

Stavka Zahtjevi

Zaslon

1080×810 piksela ili više je
preporučeno 
Veličina zaslona tableta: 10 inča
ili više je preporučeno

Windows

OS Windows 10 ili noviji

Web-
preglednik

Google Chrome
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Note

Ako potrebno okruženje nije zadovoljeno ili ovisi o upotrebi tableta/računala, videoprikaz u
web-pregledniku može biti oštećen.

Web-aplikacija jedinice upotrebljava softver JavaScript. Ako upotrebljavate antivirusni softver
na tabletu/računalu, web-mjesto se možda ispravno neće prikazati.

Podržani operativni sustavi i
web-preglednik

Mac

OS macOS 10.15 ili noviji

Web-
preglednik

Google Chrome 
Safari

iPad

OS iPadOS 15 ili noviji

Web-
preglednik

Google Chrome 
Safari

Android

OS Android 12 ili novija verzija

Web-
preglednik

Google Chrome

Uključite jedinicu, tablet ili računalo i periferne uređaje.2

Provjerite jesu li jedinica i tablet ili računalo povezani putem Wi-Fi mreže ili žičane
LAN lokalne veze.

3

Povežite jedinicu s web-preglednika tableta ili računala.

Povezivanje s pomoću QR koda
Skenirajte QR kod ispisan na poklopcu medija na bočnoj strani jedinice s pomoću
fotoaparata na tabletu.

4
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Note

Ako se HTTP broj ulaza promijeni iz vrijednosti od 80, unesite „http://IP adresa jedinice:broj ulaza” u
traku za adrese.

Kad se povezujete s pomoću QR koda ili unosom URL-a u traku za adrese web-preglednika,
upotrijebite uređaj koji podržava mDNS*.

Savjet

Možete naknadno brzo pristupiti jedinici s pomoću funkcije knjižne oznake web-preglednika.

Otvorite prikazanu poveznicu na tabletu.
Web-preglednik na tabletu se pokreće i prikazuje zaslon web-aplikacije jedinice.

Povezivanje unosom URL-a u traku za adrese web-preglednika
Pokrenite web-preglednik na tabletu ili računalo, unesite URL ispisan na poklopcu medija
na bočnoj strani jedinice.
Web-preglednik bi trebao prikazati zaslon web-aplikacije jedinice.

Povezivanje unosom IP adrese jedinice u traku za adrese web-preglednika
Pokrenite web-preglednik na tabletu ili računalu i unesite „http://IP adresa jedinice” na
traku za adrese.
Web-preglednik bi trebao prikazati zaslon web-aplikacije jedinice.

mDNS: komunikacijski protokol koji se upotrebljava za određivanje IP adrese domaćina lokalne mreže.*



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[35] Priprema Konfiguriranje prije snimanja Inicijalizacija jedinice s pomoću web-aplikacije

Inicijalizacija jedinice

Pobrinite se da ste konfigurirali jedinicu s pomoću sljedećeg postupka kad prvi put
upotrebljavate jedinicu.

Savjet

Ako se rezervna baterija u potpunosti isprazni, trebat ćete ponovno konfigurirati početno
postavljanje.

Povežite jedinicu s tableta ili računala i pokrenite web-aplikaciju.

Kad se jedinica prvi put upotrebljava, zatražit će se od vas da unesete korisničko ime i
lozinku u web-preglednik. Unesite sljedeće postavke.

Korisničko ime: administrator
Lozinka: (ostaviti prazno)

Slijedite upute na zaslonu kako biste konfigurirali početne postavke.

1

Unesite lozinku korisničko ime administratora (Administrator) i lozinku, a zatim
pritisnite gumb [OK].

1: Unesite korisničko ime administratora.

2
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2: Postavite lozinku administratora.
3: Ponovno unesite istu lozinku za potvrdu.

Note

Sljedeći se znakovi mogu upotrijebiti u korisničkom imenu i lozinki. Lozinka mora sadržavati
jedno veliko slovo, jedno malo slovo, jedan broj i mora imati od 8 do 64 znaka.

Alfanumerički znakovi
Simboli (!$%`*+-./<=>?@[]^_{|}~)

Web-preglednik će se ponovno učitati i zatražit će vas da unesete korisničko ime i lozinku.

Unesite korisničko ime i lozinku koje ste konfigurirali u koraku 2.

Pojavljuje se zaslon postavljanja jezika i sata.

3

Odredite sljedeće stavke i pritisnite gumb [OK].

[Language]
Odaberite jezik koji ćete upotrebljavati za zaslon prikaza web-aplikacije i fotoaparata.
Promjenom jezika promijenit će se jezik prikaza web-aplikacije.
[Date & Time Format]
Odaberite format prikaza datuma i vremena među sljedećim opcijama.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
[y] označava godinu [m] označava mjesec, [d] označava dan, [h] označava sat, [m]
označava minutu i [s] označava sekundu.

4



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Pojavljuje se zaslon uživo za snimanje. Nastavite konfigurirati osnovne radnje jedinice u skladu
s načinom rada.

[36] Priprema Konfiguriranje prije snimanja

Osnovne radnje konfiguracije

Ova tema opisuje kako konfigurirati jedinicu za osnovne radnje.

Postavljanje načina snimanja

Možete prebacivati načine snimanja između načina „Custom mode” kako biste izradili fotografije
tijekom snimanja i načina „Cine EI mode” kako biste slično rukovali jedinicom za snimanje filma
s razvijenom snimkom u postprodukciji.
Prebacite način snimanja s pomoću [Project] > [Base Setting] > [Shooting Mode] u web-
izborniku ili izborniku fotoaparata.

Prilagođeni način
U načinu snimanja Custom možete odabrati standard videozapisa.
Prebacite s pomoću [Project] > [Base Setting] > [Target Display] u web-izborniku ili izborniku
fotoaparata.
[SDR(BT.709)]: snimanje u skladu sa standardom za HD emitiranje
[HDR(HLG)]: snimanje u skladu sa standardom 4K emitiranje sljedeće generacije

Pojedinosti pogledajte u odjeljku „Pregled izgleda” i ostalim temama u odjeljku „Snimanje sa
željenim izgledom”.

Način Cine EI
Kada je način snimanja postavljen na način Cine EI, odaberite osnovni prostor boje za signal

[12 h/24 h]
Odaberite [12 h] (12-satno) ili [24 h] (24-satno) za prikaz vremena.
[Time Setting]
Odaberite metodu za postavljanje datuma/vremena.
[Synchronize with PC]: sinkronizacija na datum/vrijeme računala ili tableta.
[Manual setting]: ručno postavite. Kad se odabere metoda, pojavljuju se polja za unos
datuma i vremena.
[Time Zone]
Odaberite vremensku zonu.
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snimanja i izlazni signal. Ovdje odabrani prostor boje je prostor boje za videoizlaz kada je
funkcija [MLUT] isključena postavljanjem na [Off].
Prebacite s pomoću [Project] > [Cine EI Setting] > [Color Gamut] u izborniku fotoaparata.
[S-Gamut3.Cine/SLog3]: jednostavno prilagodite gamut boje za digitalni fotoaparat (DCI-P3).
[S-Gamut3/SLog3]: široka skala boja gamuta tvrtke Sony obuhvaća prostor boje ITU-R
BT.2020.

Pojedinosti pogledajte u odjeljku „Snimanje s prilagodbom izgleda u postprodukciji”.

Note

U načinu Cine EI sljedeće se funkcije ne mogu automatski prilagoditi (praćenje).
Ravnoteža bijele boje
Razina signala
Shutter

U načinu Cine EI postavke sljedećih funkcija ne mogu se prilagoditi.
ISO sensitivity/gain (postavlja se na temeljnu ISO osjetljivost (nepromjenjivo))
Postavke izbornika [Paint/Look] (bez funkcije Base Look)
Scene File (onemogućeno)

Sljedeće funkcije dostupne su samo u načinu Cine EI.
Monitor LUT
Exposure Index

Savjet

U načinu rada Cine EI snimanje se odvija pri osnovnoj ISO osjetljivosti bez upotrebe jačine signala
kako bi se povećala izvedba senzora fotografija. Svjetlina se može prilagoditi s pomoću osvjetljenja i
ND filtra za prilagodbu količine svjetlosti koja doseže do senzora fotografija.

Postavljanje frekvencije sustava

Prebacite s pomoću [Project] > [Rec Format] > [Frequency] u web-izborniku ili izborniku
fotoaparata.. Ovisno o odabranoj vrijednosti, jedinica se nakon promjene može automatski
ponovno pokrenuti.

Note

Tijekom snimanja ili reprodukcije nije moguće promijeniti frekvenciju sustava.

Postavljanje načina skeniranja pretražnika

Moguće je postaviti efektivnu veličinu slike i razlučivost slikovnog senzora.
Prebacite s pomoću [Project] > [Rec Format] > [Imager Scan Mode] web-izborniku ili izborniku
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fotoaparata.
[FF]: veličina punog kadra.
[S35]: veličina super od 35 mm.

Note

Tijekom snimanja ili reprodukcije nije moguće promijeniti način skeniranja pretražnika.

Kada je postavljen na S35, format videozapisa ograničen je na 1920 x 1080.

Postavljanje kodeka

Možete postaviti kodek za snimanje.
Prebacite s pomoću [Project] > [Rec Format] > [Codec] web-izborniku ili izborniku fotoaparata.

Note

Tijekom snimanja ili reprodukcije nije moguće promijeniti kodek.

Postavljanje formata videozapisa

Možete postaviti formata videozapisa za snimanje i format izlaza za izlaz s fotoaparata.

Prebacite format videozapisa za snimanje s pomoću [Project] > [Rec Format] > [Video
Format] web-izborniku ili izborniku fotoaparata.
Prebacite format izlaza s SDI OUT i HDMI OUT priključaka s pomoću [Monitoring] > [Output
Format] web-izborniku ili izborniku fotoaparata.

Note

Tijekom snimanja ili reprodukcije nije moguće promijeniti format videozapisa.

Ovisno o postavci formata videozapisa, moguća su ograničenja signala s priključnica SDI OUT i
HDMI OUT.

[37] Priprema Konfiguracija prije snimanja Priprema memorijskih kartica

Podržane memorijske kartice

Jedinica snima zvuk i videozapise na CFexpress Type A memorijske kartice (dostupne
zasebno) ili SDXC memorijske kartice (dostupne zasebno) umetnute u utore za kartice.
Memorijske se kartice također upotrebljavaju za proxy snimanje.
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CFexpress Type A memorijske kartice

Upotrijebite CFexpress Type A memorijske kartice tvrtke Sony* navedene u odjeljku
„Preporučeni mediji” u jedinici.
Detalje o radu s medijima drugih proizvođača potražite u uputama za rad s medijem ili se
obratite proizvođaču za informacije.

SDXC memorijske kartice

Upotrijebite SDXC memorijske kartice* navedene u odjeljku „Preporučeni mediji” na jedinici.

Preporučeni mediji

Zajamčeni radni uvjeti razlikuju se ovisno o postavkama za Rec Format i Recording.

CFexpress Type A
Sukladno s VPG400
Podržano za sve formate snimanja jedinice.

SDXC
Podržano prema uvjetima iz sljedeće tablice. „Da” označava radnju koja je odobrena, a „Ne”
označava radnju koja nije zajamčena.

RAW Out i XAVC-I, 4096×2160 klasa 300, normalan način rada

RAW Out i XAVC-I, 3840×2160 klasa 300, normalan način rada

Navedene kao „CFexpress cards” u Vodiču za pomoć.*

Navedene kao „SD kartice” u Vodiču za pomoć.*

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

24P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da
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RAW Out i XAVC-I, 3840×2160 klasa 300, S&Q (60 fps ili manje)

RAW Out i XAVC-I, 3840×2160 klasa 300, S&Q (100 fps, 120 fps)
Odobreni medij nije dostupan.

XAVC-I, 4096×2160 Class 300, normalan način rada

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

24P Ne Ne Ne Ne Ne Da Da
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XAVC-I, 4096×2160 Class 300, S&Q (60 fps ili manje)

XAVC-I, 3840×2160 Class 300, normalan način rada

XAVC-I, 3840×2160 Class 300, S&Q (60 fps ili manje)

23,98P Ne Ne Ne Ne Ne Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

24P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da
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XAVC-I, 3840×2160 klasa 300, S&Q (100 fps, 120 fps)
Odobreni medij nije dostupan.

XAVC-I, 1920×1080 Class 100, normalan način rada

XAVC-I, 1920×1080 Class 100, S&Q (60 fps ili manje)

XAVC-I, 1920×1080 klasa 100, S&Q (100 fps, 120 fps)

23,98P Ne Ne Ne Ne Ne Ne Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Ne Da
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XAVC-I, 1920×1080 klasa 100, S&Q (150 fps, 180 fps)
Odobreni medij nije dostupan.

XAVC-I, 1920×1080 klasa 100, S&Q (200 fps, 240 fps)
Odobreni medij nije dostupan.

XAVC-L, 3840×2160 420, normalan način rada

XAVC-L, 3840×2160 420, S&Q (60 fps ili manje)

XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Ne Da
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XAVC-L, 1920×1080 HD50, normalan način rada

XAVC-L, 1920×1080 HD50, S&Q (60 fps ili manje)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Ne

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, normalan način rada

59.94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Da Da Da Da Da Da Da
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XAVC-L, 1920×1080 HD35, S&Q (60 fps ili manje)

XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

50P Da Da Da Da Da Da Da

29,97P Da Da Da Da Da Da Da

25P Da Da Da Da Da Da Da

23,98P Da Da Da Da Da Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da
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XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

[38] Priprema Konfiguracija prije snimanja Priprema memorijskih kartica

Umetanje memorijskih kartica

Ova tema opisuje mjere opreza prilikom umetanja memorijske kartice.

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Frekvencija sustava Klasa 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Ne Da

Otvorite poklopac za medije na dijelu s utorima za kartice.1

Umetnite memorijsku karticu.

Za CFexpress kartice oznaka je okrenuta prema gore.

2
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Note

Na jedinici koja je montirana na strop oznaka je prema dolje.

Za SD kartice oznaka je okrenuta prema dolje.

Note

Na jedinici koja je montirana na strop oznaka je okrenuta prema gore.

Indikator pristupa svijetli crveno, a potom postaje zeleno kada je kartica upotrebljiva.

Note

Ako indikator pristupa neprekidno svijetli crvenom bojom i ne mijenja se u zelenu boju,
privremeno isključite jedinicu i uklonite te ponovno umetnite memorijsku karticu.

Zatvorite poklopac za medije.3
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Note

Memorijska kartica, utor za memorijsku karticu i slikovne datoteke na memorijskoj kartici mogu se
oštetiti ako se kartica pogrešno okrenuta prisilno umetne u utor.

Kad snimate na umetnuti medij u oba utora A i B CFexpress Type A / SD kartice, umetnite medij u
oba utora koji je preporučen za rad s formatom snimanja.

[39] Priprema Konfiguracija prije snimanja Priprema memorijskih kartica

Izbacivanje memorijskih kartica

Otvorite poklopac za medije na dijelu s utorima za kartice i lagano utisnite memorijsku karticu
kako biste je izbacili.

Note

Ako se tijekom pristupa memorijskoj kartici isključi jedinica ili ukloni memorijska kartica, nije moguće
zajamčiti cjelovitost podataka na kartici. Svi podaci snimljeni na karticu mogu biti odbačeni. Prije
isključenja jedinice ili uklanjanja memorijske kartice obavezno provjerite je li indikator pristupa zelen
ili isključen.

Kada uklanjate memorijsku karticu odmah nakon završetka snimanja, memorijska će kartica možda
biti vruća, ali to ne znači da je došlo do problema.

[40] Priprema Konfiguracija prije snimanja Priprema memorijskih kartica

Formatiranje (inicijalizacija) memorijskih kartica

Ako se neformatirana memorijska kartica ili memorijska kartica koja je formatirana prema
drukčijoj specifikaciji umetne, poruka „Media Needs to be Formatted” (Medij je potrebno
formatirati) se pojavi na ploči fotografija fotoaparata.
Karticu formatirajte sljedećim postupkom.

Odaberite [TC/Media] > [Format Media] u izborniku fotoaparata.1

Odaberite Media(A) (utor A) ili Media(B) (utor B), a zatim odaberite metodu
formatiranja (Full Format ili Quick Format).

Prikazuje se potvrdna poruka.

2
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Note

Formatiranjem memorijske kartice brišu se svi podaci, uključujući snimljene podatke videozapisa i
datoteke za postavljanje.

Tijekom izvođenja mogu se pojaviti poruke ovisno o trajanju procesa formatiranja.

Ako je formatiranje neuspješno
Memorijske kartice koje jedinica ne podržava nije moguće formatirati.
Prikazuje se poruka upozorenja. Pratite upute kako biste karticu zamijenili podržanom
memorijskom karticom.

Za upotrebu formatirane kartice na jednici u utoru drugog uređaja
Prvo napravite rezervnu kopiju kartice, a zatim ponovno formatirajte karticu uređaju u kojem je
želite upotrebljavati.

[41] Priprema Konfiguracija prije snimanja Priprema memorijskih kartica

Provjera preostalog vremena za snimanje

Tijekom snimanja (snimanje/pripravnost) možete pratiti preostali kapacitet memorijske kartice u
svakom utoru s pomoću indikatora preostalog medija u utoru A/B na tražilu.
Preostalo vrijeme za snimanje izračunava se iz preostalog kapaciteta medija u svakom utoru i
trenutačnog formata snimanja (brzina snimanja u bitovima), a prikazuje se u minutama.

Vrijeme zamjene memorijske kartice
Kad je preostalo vrijeme snimanja na objema memorijskim karticama kraće od pet minuta,
pojavljuje se poruka „Media Near Full” (Medij je gotovo pun) i žaruljica snimanja / signalizacije
počinje treperiti kako bi vas upozorila.
Zamijenite s medijem na kojem je dostupan slobodan prostor.

[Full Format]: u potpunosti inicijalizira medij, uključujući podatke o regiji i informacije o
upravljanju podacima.
[Quick Format]: samo inicijalizira informacije o upravljanju podacima medija.

Odaberite [Execute].

Tijekom postupka formatiranja prikazuje se poruka, a indikator pristupa svijetli crveno.
Kad formatiranje završi, prikazuje se poruka o dovršetku.

3
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Ako nastavite snimati dok se ukupno preostalo vrijeme za snimanje ne smanji na nulu, poruka
se zamjenjuje s „Media Full” i snimanje se zaustavlja.

Note

Na jednu memorijsku karticu moguće je snimiti do oko 600 isječaka.

[42] Priprema Konfiguracija prije snimanja Priprema memorijskih kartica

Oporavak memorijskih kartica

Ako zbog bilo kojeg razloga dođe do pogreške na memorijskoj kartici, kartica se prije upotrebe
mora oporaviti.
Kad učitate memorijsku karticu koja se treba oporaviti, pojavljuje se poruka na ploči fotografija
fotoaparata s upitom o oporavku.

Oporavak kartice
Odaberite [Execute] s pomoću gumba sa strelicama na upravljačkoj ploči GUI i pritisnite gumb
[Set].
Tijekom postupka formatiranja prikazuje se poruka i status napretka (%), a indikator pristupa
svijetli crveno.
Po dovršetku oporavka prikazuje se poruka o dovršetku.

Ako je oporavak neuspješan
Memorijske kartice na kojima je došlo do pogrešaka u memoriji nije moguće oporaviti.
Prikazuje se poruka upozorenja. Pratite upute za zamjenu memorijske kartice.
Memorijske kartice na kojima je došlo do pogrešaka u memoriji možda se mogu ponovno
upotrijebiti nakon ponovnog formatiranja.
U nekim slučajevima neke je isječke moguće oporaviti, a neke ne. Oporavljene isječke
moguće je normalno reproducirati.

Note

Za oporavak snimljenih medija s jedinicom pobrinite se da upotrebljavate ovu jedinicu.

Medije snimljene drugim uređajem ili drugom verzijom jedinice (čak i istog modela) možda se neće
moći oporaviti ovom jedinicom.

Isječke kraće od 2 sekunde nije moguće oporaviti.
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[43] Snimanje Osnovna radnja

Pokretanje/zaustavljanje snimanja

Ova tema opisuje kako pokrenuti/zaustaviti snimanje.

Note

Snimanje i reprodukcija nisu podržane kad se jedinica napaja putem PoE++ izvora napajanja.

Pričvrstite potrebne uređaje, a zatim provjerite napajaju li se jedinica i periferni
uređaji.

1

Umetnite memorijske kartice.2

Provjerite status napajanja jedinice na gornjem lijevom dijelu zaslona web-
aplikacije.

Kad je izvor napajanja uključen
Kad je jedinica uključena, prikazuje se [Power ON] na prekidaču napajanja na vrhu
zaslona web-aplikacije.

Žaruljica POWER zasvijetli na prednjem dijelu jedinice i fotografija fotoaparata pojavljuje
se na zaslonu rada uživo web-aplikacije.

Note

Ako administratorska lozinka nije konfigurirana, pojavljuje se zaslon koji traži lozinku.
Pogledajte odjeljak „Inicijalizacija jedinice”.

Kad je izvor napajanja u stanju pripravnosti
Kad je izvor napajanja jedinice u stanju pripravnosti, prikazuje se [Power Standby] na
prekidaču napajanja u web-aplikaciji.

3
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U tom stanju pritisnite prekidač napajanja i odaberite [Power ON]. Jedinica se uključuje,
žaruljica POWER zasvijetli na prednjem dijelu jedinice i fotografija fotoaparata pojavljuje se
na zaslonu rada uživo web-aplikacije.

Savjet

Također možete uključiti jedinicu s pomoću gumba za uključivanje na isporučenom
infracrvenom daljinskom upravljaču.

Pritisnite gumb za snimanje START/STOP.

Snimanje započinje i žaruljica snimanja/signalizacije (dva mjesta) jedinice zasvijetli.
Tijekom snimanja svijetli gumb za snimanje START/STOP. Također ikona za ciljni medij za
snimanje i [?Rec] su prikazani.

4
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Za prebacivanje izvora napajanja jedinice u stanju pripravnosti
Pritisnite prekidač napajanja u web-aplikaciji i odaberite [Power Standby] kako biste postavili
izvor napajanja jedinice u stanju pripravnosti.

Savjet

Također možete postaviti izvor napajanja za stanje pripravnosti s pomoću gumb za uključivanje na
isporučenom infracrvenom daljinskom upravljaču.

Za prekid snimanja ponovno pritisnite gumb za snimanje START/STOP.

Snimanje se zaustavlja, a žaruljica snimanja/signalizacije (dva mjesta) se isključuje.
Tijekom stanja pripravnosti za snimanje gumb za snimanje START/STOP ne svijetli.
Također ikona za ciljni medij za snimanje i [Stby] su prikazani.

Savjet

Također možete pokrenuti/zaustaviti snimanje s pomoću gumba za snimanje START/STOP na
isporučenom infracrvenom daljinskom upravljaču.

5
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[44] Snimanje Osnovna radnja

Prebacivanje memorijskih kartica

Kad su umetnute dvije memorijske kartice, možete pritisnuti gumb [Slot Select] na ploči
reprodukcije web-aplikacije kako biste prebacili memorijsku karticu.

Savjet

Također možete pritisnuti gumb SLOT SEL (odabir utora memorijske kartice (A)/(B)) na isporučenom
infracrvenom daljinskom upravljaču kako biste prebacili kartice.

O snimanju s odgodom

Kad snimate, jedinica se automatski prebacuje na drugu memorijsku karticu netom prije nego
što se smanji preostali kapacitet na prvoj kartici (snimanje s odgodom). Kada zamijenite
memorijske kartice, kontinuirano snimanje možete nastaviti zamjenom pune memorijske kartice
s novom memorijskom karticom.

Note

Memorijske kartice ne možete zamijeniti u načinu za reprodukciju. Također, kontinuirana
reprodukcija isječka koji se nalazi na medijima u utoru A i utoru B nije podržana.

O snimljenim podacima

Kada zaustavite snimanje, videozapis, zvučni zapis i popratni podaci od početka do završetka
snimanja spremaju se kao jedan „isječak” na memorijsku karticu.

Naziv isječaka snimljenih podataka

Naziv svakog isječka snimljenog na jedinici automatski se dodjeljuje s pomoću [TC/Media] >
[Clip Name Format] u izborniku fotoaparata.

Maksimalno trajanje isječka

Do šest sati po isječku.
Maksimalno trajanje kontinuiranog snimanje jednako je maksimalnom trajanju isječka. Ako
vrijeme snimanja prekorači maksimalno trajanje isječka, automatski se stvara novi isječak i
snimanje se nastavlja. Novi isječak na zaslonu s minijaturama prikazuje se kao zasebni isječak.
Tijekom prijenosnog snimanja uzastopno se snima više isječaka, no snimanje se zaustavlja
automatski nakon približno 24 sata.
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Note

Nemojte vaditi memorijsku karticu dok je snimanje na nju u tijeku. Pri snimanju možete zamijeniti
samo memorijsku karticu u utoru s isključenim indikatorom pristupa.

Kada se preostali kapacitet memorijske kartice na koju se snima smanji na manje od minute, a u
drugom utoru nalazi se memorijska kartica na koju je moguće snimati, prikazuje se poruka o skoroj
zamjeni utora „Will Switch Slots Soon”. Poruka se uklanja nakon zamjene utora za memorijsku
karticu.

Prijenosno snimanje možda neće raditi ako je preostali kapacitet memorijske kartice manji od minute.
Za ispravno prijenosno snimanje prije početka snimanja provjerite je li preostali kapacitet memorijske
kartice veći od minute.

Stvoreni videozapis s pomoću funkcije odgode snimanja jedinice ne može se besprijekorno
reproducirati na ovoj jedinici.

Kako biste kombinirali videozapise izrađene s pomoću funkcije snimanja s odgodom jedinice,
upotrijebite softver „Catalyst Browse”.

[45] Snimanje Osnovna radnja

Provjera zvuka

Zvuk se emitira s SDI i HDMI priključaka jedinice. Odaberite kombinaciju audiokanala koji se
emitiraju s HDMI priključka s pomoću [Audio] > [Audio Output] > [HDMI/Stream Output CH] u
izborniku fotoaparata.
CH1/CH2: CH1 i CH2 kombinacija
CH3/CH4: CH3 i CH4 kombinacija
Kad nadzirete zvuk u web-aplikaciji, upotrijebite mjerač razine zvuka na donjem desnom dijelu
fotografije fotoaparata.

[46] Snimanje

Određivanje podataka o vremenu

Ova tema opisuje kako postaviti podatke o vremenu.

Postavljanje vremenskog koda

Postavite vremenski kod za snimanje s pomoću [TC/Media] > [Timecode] u izborniku
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fotoaparata.

Postavljanje korisničkih informacija

Snimljenoj slici možete dodati osmeroznamenkasti heksadecimalni broj kao korisničke
informacije. Korisničke informacije također možete postaviti na trenutačno vrijeme. Postavite s
pomoću [TC/Media] > [Users Bit] u izborniku fotoaparata.

Prikaz podataka o vremenu

Postavite prikaz vremenskog koda s pomoću [TC/Media] > [TC Display] > [Display Select] u
izborniku fotoaparata.
Pritiskom jednog dodjeljivog gumba s dodijeljenom funkcijom [DURATION/TC/U-BIT]
zamjenjuje se prikaz vremenskog koda, korisničkih informacija i trajanja u nizu.

[47] Snimanje

Pregled snimke (Rec Review)

Posljednji snimljeni isječak moguće je pregledati na zaslonu (pregled snimke).

Note

Funkcija Rec Review nije podržana ako se format videozapisa promijeni nakon snimanja isječka.

Postavljanje početnog položaja Rec Review

Možete postaviti početni položaj reprodukcije na jedan od sljedećih s pomoću [Technical] > [Rec
Review] u izborniku fotoaparata.

Posljednje tri sekunde isječka
Posljednjih 10 sekundi isječka
Početak isječka

Savjet

Ako nakon snimanja više isječaka želite pregledati određeni isječak, pritisnite gumb [Thumbnail] kako
biste prikazali zaslon s minijaturama, a zatim odaberite isječak za pokretanje reprodukcije.

Također možete pritisnuti gumb THUMBNAIL na isporučenom infracrvenom daljinskom upravljaču za
prikaz zaslona minijatura.
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Metoda Rec Review

Unaprijed dodijelite funkciju Rec Review jednom od dodjeljivih gumba na ploči prilagodbe
osnovne konfiguracije.

Pojedinosti o dodjeli pogledajte u odjeljku „Dodjeljivi gumbi” u „Korisne funkcije”.

Zaustavite snimanje i zatim pritisnite dodjeljivi gumb dodijeljen funkciji Rec Review kako biste
pokrenuli reprodukciju prethodno snimljenog isječka.

Isječak se reproducira do završetka, funkcija Rec Review se zaustavlja, a jedinica vraća se u
način STBY (stanje pripravnosti).

Zaustavljanje funkcije Rec Review
Pritisnite dodjeljivi gumb kojem je dodijeljena funkcija Rec Review ili pritisnite gumb
[Cancel/Back].
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Savjet

Također možete pritisnuti gumb [Cancel/Back] isporučenog infracrvenog daljinskog upravljača kako
biste zaustavili funkciju Rec Review.

[48] Snimanje Prilagodba kadra

Zaslon prilagodbe kadra

Kadar se prilagođava s pomoću sljedećih dijelova zaslona rada uživo.
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Note

Ovisno o smjeru fotoaparata, fokalna duljina objektiva i položaj zumiranja te dio jedinice ili priključeni
kabeli na blok priključaka mogu biti vidljivi. Prije snimanja provjerite kut gledišta za objektiv i fokalnu
duljinu koju upotrebljavate. Također možete upravljati rasponom pomicanja/nagibanja s pomoću
[Pan-Tilt] > [P/T Range Limit] u web-izborniku. Kad se jedinica uključi ili se izvrši ponovno
postavljanje pomicanja/nagibanja, ignorira se postavka ograničenja raspona. Pojedinosti pogledajte
u web-izborniku pod [Pan-Tilt] > [P/T Range Limit].

Savjet

Također možete upravljati kadriranjem s pomoću isporučenog infracrvenog daljinskog upravljača.

[49] Snimanje Prilagodba kadra Prilagodba smjera snimanja

Prilagodba smjera snimanja s pomoću web-aplikacije

Vodoravno pomicanje fotoaparata naziva se pomicanje, a okomito pomicanje fotoaparata

Upravljačka ploča unaprijed postavljenih položaja1.

Kartica (Main) (Glavna) / (Others) (Ostalo)2.

Upravljačka ploča kadra3.
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naziva se nagibanje.
Možete prilagoditi smjer snimanja s pomoću pomicanja/nagibanja.

Savjet

Ako se funkcija [Execute Pan-Tilt Reset] prikaže ispod palice, pojavljuje se nedosljednost u izvornim
informacijama o kontroli pomicanja/nagibanja jedinice. Izvršite ponovno postavljanje funkcije
pomicanja/nagibanja kako biste ažurirali izvorne informacije. Pojedinosti pogledajte u odjeljku
„Ponovno postavljanje pomicanja/nagibanja”.

Okretanje stražnjeg dijela fotoaparata prema naprijed
Pritisnite gumb [Pan-Tilt Home] na kartici  (Ostalo) na upravljačkoj ploči fotoaparata.

Note

Ovisno o smjeru fotoaparata, fokalna duljina objektiva i položaj zumiranja te dio jedinice ili priključeni
kabeli na blok priključaka mogu biti vidljivi. Prije snimanja provjerite kut gledišta za objektiv i fokalnu
duljinu koju upotrebljavate. Također možete upravljati rasponom pomicanja/nagibanja s pomoću
[Pan-Tilt] > [P/T Range Limit] u web-izborniku. Kad se jedinica uključi ili se izvrši ponovno
postavljanje pomicanja/nagibanja, ignorira se postavka ograničenja raspona. Pojedinosti pogledajte
u web-izborniku pod [Pan-Tilt] > [P/T Range Limit].

Pritisnite karticu [Pan-Tilt-Zoom] na upravljačkoj ploči kadriranja za prikaz palice.1

Povucite sredinu palice u smjeru u kojem želite pregledati dok nadzirete ploču
fotografija fotoaparata.

Smjer i brzina fotoaparata mijenja se kao reakcija na smjer povlačenja i razinu.
Možete još preciznije prilagoditi pomicanje/nagibanje pritiskom na periferna područja
palice.

2
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[50] Snimanje Prilagodba kadra Prilagodba smjera snimanja

Postavljanje brzine rada pomicanja/nagibanja

Možete promijeniti brzinu rada pomicanja/nagibanja s pomoću klizača [Pan-Tilt Speed] na
upravljačkoj ploči fotoaparata rukovanjem palice na upravljačkoj ploči kadra.

Note

Ako postoji zid ili neka druga prepreka unutar raspona pokreta fotoaparata, budite oprezni da ne
udarite fotoaparat ili objektiv tijekom rada pomicanja/nagibanja.

Funkcija pomicanja/nagibanja ovisi o fizičkim obilježjima, poput težine objektiva. Možete promijeniti
postavku ubrzanja s pomoću [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] u web-izborniku ili
izborniku fotoaparata.

Pritisnite karticu  (Glavni) na upravljačkoj ploči fotoaparata.1

Odaberite klizač [Pan-Tilt Speed] s popisa.

Ako se klizač [Pan-Tilt Speed] ne prikaže, odaberite jednu od sljedećih dva gumba odabira
funkcije klizača kako biste prikazali klizač.

2

Pomaknite kotačić klizača ulijevo ili udesno.

Pomicanjem kotačića ulijevo smanjuje se brzina rada, a pomicanjem kotačića udesno
povećava se brzina rada.

3
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[51] Snimanje Prilagodba kadra Prilagodba smjera snimanja

Odabir rada ubrzanja za pomicanje/nagibanje

Možete odabrati rad ubrzanja u devet razina s pomoću [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] u web-izborniku ili izborniku fotoaparata. Povećajte vrijednost na još brže promjene
brzine ili smanjite vrijednost za postupnije promjene brzine.
Za veću reaktivnost tijekom rada funkcije pomicanja/nagibanja odaberite vrijednost u rasponu
od 7 do 9.
Za bolju preciznost položaja na početku/kraju kretnji unaprijed postavljenog položaja, preporuča
se vrijednost u rasponu od 1 do 6.

Pojedinosti o unaprijed postavljenom položaju pogledajte u odjeljku „Spremanje/oporavak
funkcije pomicanja/nagibanja i položaj zumiranja”.

Note

Kad je vrijednost postavljena visoko, funkcija možda neće ispravno raditi ako je pričvršćen težak
objektiv. Provjerite rad prije stvarne upotrebe.

Odnos između postavke [Ramp Curve] i rada pomicanja/nagibanja

Kad radi pomicanje/nagibanje

Kad se opozove unaprijed postavljeni položaj
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[52] Snimanje Prilagodba kadra Prilagodba smjera snimanja

Prilagodba smjera snimanja s pomoću isporučenog
infracrvenog daljinskog upravljača

Možete prilagoditi smjer snimanja s pomoću upravljačkih gumba pomicanja/nagibanja na
isporučenom infracrvenom daljinskom upravljaču.

Pritisnite gumbe sa strelicama kako biste upravljali funkcijom pomicanja/nagibanja.

Pritisnite gumbe sa strelicama u smjeru koji želite gledati dok nadzirete fotografiju
fotoaparata.
Za pomicanje kratke udaljenosti kratko pritisnite gumb sa strelicom.
Za pomicanje dulje udaljenosti pritisnite i držite gumb sa strelicom.
Za dijagonalno pomicanje pritisnite i držite gumb  (strelica prema gore) ili  (strelica
prema dolje) i pritisnite gumb  (lijeva strelica) ili  (desna strelica).

1
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Okretanje stražnjeg dijela fotoaparata prema naprijed
Pritisnite gumb HOME.

Note

Ovisno o smjeru fotoaparata, fokalna duljina objektiva i položaj zumiranja te dio jedinice ili priključeni
kabeli na blok priključaka mogu biti vidljivi. Prije snimanja provjerite kut gledišta za objektiv i fokalnu
duljinu koju upotrebljavate. Također možete upravljati rasponom pomicanja/nagibanja s pomoću
[Pan-Tilt] > [P/T Range Limit] u web-izborniku. Kad se jedinica uključi ili se izvrši ponovno
postavljanje pomicanja/nagibanja, ignorira se postavka ograničenja raspona. Pojedinosti pogledajte
u web-izborniku pod [Pan-Tilt] > [P/T Range Limit].

[53] Snimanje Prilagodba kadra Prilagodba zumiranja

Postavljanje vrste zumiranja

Postavite vrstu zumiranja s pomoću [Technical] > [Zoom] > [Zoom Type] u izborniku
fotoaparata.
Vrsta zumiranja varirat će ovisno o postavljenom objektivu.

Vrsta pričvršćenog
objektiva

Postavka [Zoom Type]

[Optical Zoom
Only] [On(Clear Image Zoom)]
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Note

Funkcija zumiranja za jasnu sliku nije podržana u sljedećim slučajevima.
Kad je postavka [Shooting] > [S&Q Motion] > [Setting] postavljena na On i postavka [Frame Rate]
u izborniku fotoaparata nije veća od 60 fps
Kad je postavka [Project] > [Rec Format] > [Codec] u izborniku fotoaparata postavljena na [RAW]
ili na opciju koja uključuje RAW

Rad sklopke za odabir SERVO/MANUAL na objektivu ponovno postavlja povećanje funkcije Clear
Image Zoom na 1×.

Tijekom rada funkcije jasnog zumiranja fotografije područje fokusa postavljeno je na Wide. Također
je onemogućeno prepoznavanje lica/oči.

Kad je postavljeno na [On(Clear Image Zoom)], unaprijed postavljena funkcija pomicanja/nagibanja
je onemogućena.

Clear Image Zoom

Jedinica je opremljena funkcijom zumiranja koja upotrebljava procesuiranje signala fotografije
pod nazivom Clear Image Zoom. Kad omogući zumiranje za jasnu fotografiju, zumiranje je
podržano čak za objektive fiksirane na fokus. Može se upotrebljavati i za proširenje raspona
izvan optičkog raspona na objektivu s električnim zumiranjem.
Maksimalan omjer zumiranja s pomoću funkcije Clear Image Zoom varira ovisno o rezoluciji
snimanja.

Za QFHD/4K razlučivost snimanja: 1,5×
Za HD razlučivost snimanja: 2×

[54] Snimanje Prilagodba kadra Prilagodba zumiranja

Prilagodba zumiranja s pomoću web-aplikacije

Možete prilagoditi zumiranje jedinice s pomoću optičkog zumiranja ili zumiranja za jasnu
fotografiju. Ova tema opisuje kako učiniti prilagodbe s pomoću web-aplikacije. Pojedinosti o
zumiranju za jasnu fotografiju pogledajte u odjeljku „Postavljanje vrste zumiranja”.

Objektiv fiksiran na fokus /
objektiv ručnog zumiranja

Zumiranje nije
podržano.

Funkcija zumiranja za jasnu sliku nije
podržana.

Objektiv s električnim zumom
Samo je podržano
optičko zumiranje.

Podržane su funkcije optičko
zumiranje i zumiranje za jasnu sliku.
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Note

Ovisno o smjeru fotoaparata, fokalna duljina objektiva i položaj zumiranja te dio jedinice ili priključeni
kabeli na blok priključaka mogu biti vidljivi. Prije snimanja provjerite kut gledišta za objektiv i fokalnu
duljinu koju upotrebljavate. Također možete upravljati rasponom pomicanja/nagibanja s pomoću
[Pan-Tilt] > [P/T Range Limit] u web-izborniku. Kad se jedinica uključi ili se izvrši ponovno
postavljanje pomicanja/nagibanja, ignorira se postavka ograničenja raspona. Pojedinosti pogledajte
u web-izborniku pod [Pan-Tilt] > [P/T Range Limit].

[55] Snimanje Prilagodba kadra Prilagodba zumiranja

Postavljanje brzine rada zumiranja

Možete promijeniti brzinu rada zumiranja klizača [Zoom] na upravljačkoj ploči kadra s pomoću
klizača [Zoom Speed] na upravljačkoj ploči fotoaparata.

Pritisnite karticu [Pan-Tilt-Zoom] na upravljačkoj ploči kadra kako biste prikazali
upravljačku ploču pomicanja/nagibanja.

1

Kliznite kotačićem klizača [Zoom] u smjeru [T] (telefoto) ili [W] (široko) kako biste
prilagodili zumiranje.

2

Pritisnite karticu  (Glavni) na upravljačkoj ploči fotoaparata.1

Odaberite klizač [Zoom Speed] s popisa.

Ako klizač [Zoom Speed] nije prikazan, odaberite jedan od dvaju gumba odabira funkcije
klizača za prikaz klizača.

2



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[56] Snimanje Prilagodba kadra Prilagodba zumiranja

Prilagodba zumiranja s pomoću isporučenog
infracrvenog daljinskog upravljača

Možete prilagoditi zumiranje jedinice s pomoću optičkog zumiranja ili zumiranja za jasnu
fotografiju. Ova tema opisuje kako učiniti prilagodbe s pomoću isporučenog infracrvenog
daljinskog upravljača. Pojedinosti o zumiranju za jasnu fotografiju pogledajte u odjeljku
„Postavljanje vrste zumiranja”.

 

Pomaknite kotačić klizača [Zoom Speed] ulijevo ili udesno.

Pomicanjem kotačića ulijevo smanjuje se brzina rada, a pomicanjem kotačića udesno
povećava se brzina rada.

3

Pritisnite gumb za zumiranje za prilagodbu zumiranja.

Pritisnite gumb T (telefoto) ili W (široko) dok nadzirete zaslon za prilagodbu zumiranja.
Kako biste zumirali, pritisnite gumb T.
Kako biste odzumirali, pritisnite gumb W.

1
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Note

Ovisno o smjeru fotoaparata, fokalna duljina objektiva i položaj zumiranja te dio jedinice ili priključeni
kabeli na blok priključaka mogu biti vidljivi. Prije snimanja provjerite kut gledišta za objektiv i fokalnu
duljinu koju upotrebljavate. Također možete upravljati rasponom pomicanja/nagibanja s pomoću
[Pan-Tilt] > [P/T Range Limit] u web-izborniku. Kad se jedinica uključi ili se izvrši ponovno
postavljanje pomicanja/nagibanja, ignorira se postavka ograničenja raspona. Pojedinosti pogledajte
u web-izborniku pod [Pan-Tilt] > [P/T Range Limit].

[57] Snimanje Prilagodba kadra Spremanje/oporavak položaja fotoaparata za
pomicanje/nagibanje

Kalibracija objektiva E-mount

Kalibracija ispravlja razlike položaja zumiranja zbog razlika pojedinih objektiva kad
upotrebljavate objektiv s motoriziranim zumiranjem E-mount.
Za pravilan izračun položaja zumiranja kalibrirajte objektiv kako biste ispravili pojedine razlike
objektiva s pomoću sljedećeg postupka.

Ako objektiv ima prekidač SERVO/MANUAL, postavite položaj SERVO.

Note

Objektiv ne može primati upute zumiranja s jedinice ako je prekidač postavljen na MANUAL.

1

Izvršite kalibraciju s pomoću [Technical] > [Lens] > [Lens Calibration] u izborniku
fotoaparata.

Tijekom kalibracije objektiv zumiranja automatski se pomiče i mjeri.

2
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Podaci o kalibraciji
Podaci o kalibraciji za najviše pet objektiva mogu se spremiti na jedinicu. Najstariji podaci će
se prepisati kad je šesti ili sljedeći objektiv kalibriran.
Možete provjeriti jesu li podaci o kalibraciji dostupni za pričvršćene objektive pritiskom na
gumb  (Status fotoaparata) u zajedničkom području zaslona web-aplikacije i odabirom
[Lens] > [Calibration Data].

[58] Snimanje Prilagodba kadra Spremanje/oporavak položaja pomicanja / nagibanja /
zumiranja fotoaparata

Spremanje/oporavak položaja pomicanja / nagibanja /
zumiranja i postavke fokusa fotoaparata s pomoću
web-aplikacije

Možete spremiti pomicanje/nagibanje, položaj zumiranja i postavku fokusa i pozvati ih kad su
potrebne s pomoću web-aplikacije.

Pojedinosti o stavkama koje se mogu spremiti/oporaviti pogledajte u odjeljku „Spremljene
stavke unaprijed postavljenih položaja”.

Note

Ova je funkcija onemogućena kad su postavke [Technical] > [Zoom] > [Zoom Type] postavljene na
[On(Clear Image Zoom)] u izborniku fotoaparata

Ako je postavka [Pan-Tilt] > [P/T Direction] [Ceiling] u web-izborniku promijenjena, svi spremljeni
unaprijed postavljeni položaji se brišu.

Odredite položaj koji želite spremiti s pomoću pomicanja/nagibanja i rada zumiranja.1

Pritisnite gumb [+] na upravljačkoj ploči unaprijed postavljenih položaja.

Fotografija sa spremljenim položajem prikazuje se na upravljačkoj ploči unaprijed
postavljenih položaja.

2
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Savjet

Ako se upravljačka ploča unaprijed postavljenih položaja ne prikaže, pritisnite gumb  (Open)
(Otvori) kako biste je prikazali.

Položaji se spremaju redoslijedom od [Preset1].

Ako postoji neiskorištenih unaprijed postavljanih postavki u njihovu redoslijedu, položaji će se
spremiti u unaprijed postavljenim postavkama počevši od neiskorištenih. Na primjer ako su
unaprijed postavljeni položaji spremljeni pod [Preset1] i [Preset3], ali nisu na [Preset2], sljedeći
unaprijed postavljeni položaji spremit će se pod [Preset2], a zatim pod [Preset4].

Najviše se može spremiti 100 unaprijed postavljenih položaja.

Možete preimenovati svaki unaprijed postavljeni položaj. Pojedinosti pogledajte u odjeljku
„Preimenovanje unaprijed postavljenih položaja s pomoću web-aplikacije.”

Oporavak spremljenog položaja.

Dvaput pritisnite minijaturu položaju koju želite oporaviti na upravljačkoj ploči unaprijed
postavljenih položaja kako biste oporavili odgovarajući položaj.

Savjet

Također možete oporaviti položaj pritiskom na fotografiju, pritiskom na gumb  (Preset
Position Menu) koji se pojavi i odabirom [Recall].

Brzina prijenosa spremljenog položaja određuje postavka [Pan-Tilt] > [P/T Preset] > [Common
Speed] u web-izborniku kad je položaj spremljen. Također možete promijeniti brzinu prijenosa
nakon spremanja. Pojedinosti pogledajte u odjeljku „Promjena brzine prijenosa unaprijed
postavljenih položaja”.

Stupanj promjene položaja pomicanja/nagibanja prilikom pomicanja unaprijed postavljenog

3
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[59] Snimanje Prilagodba kadra Spremanje/oporavak položaja pomicanja / nagibanja /
zumiranja fotoaparata

Preimenovanje unaprijed postavljenih položaja s
pomoću web-aplikacije

Možete preimenovati unaprijed postavljene položaje.

[60] Snimanje Prilagodba kadra Spremanje/oporavak položaj pomicanja / nagibanja /
zumiranja fotoaparata

Zamjena spremljenog položaja novim položajem s
pomoću web-aplikacije

Možete zamijeniti spremljeni položaj novim položajem.

položaja možete prilagoditi s pomoću brzine prijenosa i postavke [Ramp Curve]. Pojedinosti
pogledajte u odjeljku „Promjena brzine prijenosa unaprijed postavljenih položaja” i
„Postavljanje brzine rada pomicanja/nagibanja”.

Pritisnite unaprijed postavljeni položaj koji želite preimenovati.

Gumb  (Preset Position Menu) se pojavljuje na gornjem desnom dijelu fotografije.

1

Pritisnite gumb  (Preset Position Menu) i odaberite [Rename] s prikazanog
izbornika.

2

Unesite novi naziv unaprijed postavljane postavke.3

Odredite položaj koji želite spremiti s pomoću pomicanja/nagibanja i rada zumiranja.1

Pritisnite fotografiju položaja koji želite zamijeniti na upravljačkoj ploči unaprijed
postavljenih položaja.

Gumb  (Preset Position Menu) se pojavljuje na gornjem desnom dijelu zaslona.

2
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[61] Snimanje Prilagodba kadra Spremanje/oporavak položaja pomicanja / nagibanja /
zumiranja fotoaparata

Brisanje spremljenog položaja s pomoću web-
aplikacije

Možete obrisati unaprijed postavljene položaje.

[62] Snimanje Prilagodba kadra Spremanje/oporavak položaja pomicanja / nagibanja /
zumiranja fotoaparata

Promjena brzine prijenosa unaprijed postavljenih
položaja

Možete promijeniti brzinu prijenosa kad se oporavlja spremljeni položaj.

Pritisnite gumb  (Preset Position Menu) i odaberite [Replace] s prikazanog
izbornika.

Novim položaj zamjenjuje trenutnu postavku.

3

Pritisnite fotografiju položaja koji želite obrisati na upravljačkoj ploči unaprijed
postavljenih položaja.

Gumb  (Preset Position Menu) se pojavljuje na gornjem desnom dijelu fotografije.

1

Pritisnite gumb  (Preset Position Menu) i odaberite [Delete] s prikazanog
izbornika.

Spremljeni je položaj obrisan.

2

Postavite [Pan-Tilt] > [P/T Preset] > [Speed Select] na [Separate] u web-izborniku.1

Pritisnite fotografiju za položaj koji želite promijeniti brzinu prijenosa na
upravljačkoj ploči unaprijed postavljenih položaja.

2
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Savjet

Kad je [Pan-Tilt] > [P/T Preset] > [Speed Select] postavljen na [Common], svi će se položaji oporaviti
pri postavljenoj brzini s pomoću [Pan-Tilt] > [P/T Preset] > [Common Speed].

[63] Snimanje Prilagodba kadra Spremanje/oporavak položaja pomicanja / nagibanja /
zumiranja

Spremanje/oporavak pomicanja/nagibanja i položaj
zumiranja s pomoću isporučenog infracrvenog
daljinskog upravljača

Možete spremiti pomicanje/nagibanje i položaj zumiranja i pozvati ih kad je potrebno s pomoću
infracrvenog daljinskog upravljača.

Gumb  (Preset Position Menu) se pojavljuje na gornjem desnom dijelu fotografije.

Pritisnite gumb  (Preset Position Menu) i odaberite [Speed] s prikazanog
izbornika.

3

Odaberite željenu brzinu prijenosa.

Sljedeći put kad se oporavi spremljeni položaj, fotoaparat će se kretati konfiguriranom
brzinom.

4

Prilagodite pomicanje/nagibanje i zumiranje fotoaparata.1

Pritisnite i držite gumb PRESET i pritisnite jedan od 1 do 3 gumba.

Položaj je spremljen.

2
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[64] Snimanje Prilagodba fokusa

Zaslon prilagodbe fokusa

Fokus se prilagođava s pomoću sljedećih dijelova zaslona rada uživo.

Oporavak spremljenog položaja.

Pritisnite jedan od 1 do 3 gumba sa spremljenim položajem kako biste oporavili položaj.

Savjet

U slučaju infracrvenog daljinskog upravljača fotografija se pomiče na spremljeni položaj pri
maksimalnoj brzini.
Također možete promijeniti brzinu prijenosa nakon spremanja. Pojedinosti pogledajte u
odjeljku „Promjena brzine prijenosa unaprijed postavljenih položaja”.

3
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[65] Snimanje Prilagodba fokusa Ručna prilagodba fokusa (Manual Focus)

Ručna prilagodba s pomoću web-aplikacije

Možete ručno prilagoditi fokus, na primjer u sljedećim slučajima.

Subjekti su djelomično zamućeni kapljicama vode
Objekti sa slabim kontrastom u odnosu na pozadinu
Objekti udaljeniji od bliskih objekata

Ploča fotografija fotoaparata
Možete prilagoditi fokus dodirom na fotografiju fotoaparata. Možete onemogućiti rad dodira
isključivanjem prekidača [Touch Focus] na kartici  (Fokus) na upravljačkoj ploči
fotoaparata.

1.

Upravljačka ploča fotoaparata kartica (Fokus)2.

Upravljačka ploča GUI3.

Ako je objektiv opremljen sklopkom za odabir fokusiranja, postavite je u položaj1
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Savjet

Također možete upotrebljavati automatski fokus kad je ručna prilagodba glavna metoda rada.
Pojedinosti pogledajte u odjeljku „Ručno postavljanje ciljnog automatskog fokusa (AF Assist) s
pomoću web-aplikacije”.

[66] Snimanje Prilagodba fokusa Ručna prilagodba fokusa (Manual Focus)

Ručna prilagodba s pomoću isporučenog infracrvenog
daljinskog upravljača

Možete ručno prilagoditi fokus s pomoću isporučenog infracrvenog daljinskog upravljača.

"AF/MF" ili "AF".

Note

Ako je sklopka postavljena u položaj „Full MF” ili „MF” fokusiranjem objektiva nije moguće
upravljati na jedinici. Pogledajte dio „Prilagodbe fokusa za objektive s prekidačem načina
fokusa” u odjeljku „Provjera prekidača objektiva”.

Kliznite prekidačem [Auto Focus] u lijevi položaj na upravljačkoj ploči fotoaparata
kako biste isključili automatski fokus.

Ručni fokus je aktiviran.

 (MF)

2

Prilagodite s pomoću klizača na dnu kartice  (Fokus).3

Pritisnite gumb MF na infracrvenom daljinskom upravljaču.1

Ručno prilagodite fokus s pomoću gumba F (Daleko) i N (Blizu).

Kako biste se fokusirali na udaljeni subjekt, pritisnite gumb F.
Kako biste se fokusirali na bliži subjekt, pritisnite gumb N.

2
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Savjet

Također možete upotrebljavati automatski fokus kad je ručna prilagodba glavna metoda rada.
Pojedinosti pogledajte u odjeljku „Ručno fokusiranje tijekom automatskog fokusiranja s pomoću
isporučenog infracrvenog daljinskog upravljača”.

[67] Snimanje Prilagodba fokusa Ručna prilagodba fokusa (Manual Focus)

Fokusiranje određivanjem položaja fokusa (Spot
Focus)

U ručnom načinu fokusiranja možete odrediti položaj na koji želite prilagoditi fokus na ploči
fotografija fotoaparata.

Postavite [Shooting] > [Focus] > [Touch Function in MF] na [Spot Focus] u web-
izborniku ili izborniku fotoaparata.

1

Kliznite prekidačem [Touch Focus] na kartici  (Fokus) na desni položaj za
uključivanje.

2

Kliznite prekidačem [Auto Focus] na kartici  (Fokus) u lijevi položaj za
isključivanje.

3

Odredite položaj fokusa.

Oznaka točke fokusa pojavljuje se i fotografija se prilagođava tako je u fokusu pri tom

4
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Note

Funkcija točke fokusa ne radi ako je objektiv postavljen na ručno fokusiranje.

Savjet

U načinu rada točke fokusa možete pritisnuti dodjeljivi gumb dodijeljen funkciji [Push AF/MF] kako
biste privremeno zaustavili točku fokusa i omogućili automatski fokus dok je gumb pritisnut. Po
otpuštanju gumba fokusiranje se vraća na ručno.

[68] Snimanje Prilagodba fokusa Ručna prilagodba fokusa (Manual Focus)

Privremena upotreba automatskog fokusa (AF))

Tijekom ručnog načina fokusa možete prilagoditi fokus privremeno s pomoću automatskog
fokusa pritiskom na gumb [Push AF/MF] za automatsko fokusiranje dok je gumb pritisnut.
To je praktično kada tijekom ručnog fokusiranja fokus želite polako pomaknuti s jednog objekta
na drugi.

položaju.

Primjer određivanja položaja dodirnom radnjom

Postavite [Shooting] > [Focus] > [Push AF Mode] na [AF] u izborniku fotoaparata.1

Kliznite prekidačem [Auto Focus] na kartici  (Fokus) u lijevi položaj za
isključivanje.

2

Pritisnite gumb [Push AF/MF].3
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Note

Funkcija Push Auto Focus ne radi ako je objektiv postavljen na ručno fokusiranje.

Savjet

Istu radnju podržava dodjeljivi gumb kojem je dodijeljena funkcija [Push AF/MF].

[69] Snimanje Prilagodba fokusa Ručna prilagodba fokusa (Manual Focus)

Upotreba automatskog fokusa pojedinačnog snimanja
(AF-S))

Možete pritisnuti gumb [Push AF/MF] kad je u ručnom načinu fokusa na automatski fokus pri
visokoj brzini.
Funkcija je praktična kad se fokusirate na subjekt prije snimanja.

Funkcija automatske fokusa aktivna je kad je gumb pritisnut.

Po otpuštanju gumba fokusiranje se vraća na ručno fokusiranje.

Postavite [Shooting] > [Focus] > [Push AF Mode] na [Single-shot AF(AF-S)] u web-
izborniku ili izborniku fotoaparata.

1

Odredite položaj na koji želite prilagoditi fokus s pomoću [Shooting] > [Focus] >
[Focus Area (AF-S)] u izborniku fotoaparata.

2
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Note

Funkcija Push Auto Focus ne radi ako je objektiv postavljen na ručno fokusiranje.

Okvir područja fokusiranja nije sakriven kada primjenjujete gumb [Display].

Tijekom zumiranja za jasnu sliku položaj kadra [Focus Area (AF-S)] ne može se postaviti. Tijekom
rada funkcije Push Auto Focus radnja AF također daje prioritet središnjem dijelu.

Savjet

Istu radnju podržava dodjeljivi gumb kojem je dodijeljena funkcija [Push AF/MF].

Savjet

Možete promijeniti položaj pritiskom na dodjeljivi gumb dodijeljen postavki [Focus Setting] za
prikaz narančastog kadra oko područja fokusiranja i odabira položaja s pomoću dodirnih radnji.

Kliznite prekidačem [Auto Focus] na kartici  (Fokus) u lijevi položaj za
isključivanje.

3

Pritisnite gumb [Push AF/MF].

Ako otpustite gumb prije dovršetka fokusiranja, gumb Push Auto Focus će se zaustaviti.

Tijekom funkcije Push Auto Focus, status fokusa prikazuje indikator fokusa.
Uključeno: fokus je fiksiran na položaju fokusa.
Treperi: izvan fokusa. Budući da se jedinica neće automatski fokusirati, promijenite
kompoziciju i postavke fokusa kako biste postigli fokus.
Po otpuštanju gumba fokusiranje se vraća na ručno.

4



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Također možete dodijeliti [Push AF Mode] dodjeljivom gumbu.

Funkciju [Focus Area (AF-S)]) također možete dodijeliti i dodjeljivom gumbu.

Možete prikazati/sakriti područje fokusa s pomoću [Monitoring] > [Display On/Off] > [Focus Area Ind.
(AF-S)] na izborniku fotoaparata.

[70] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Automatska prilagodba s pomoću web-aplikacije

Jedinica primjenjuje AF otkrivanje otklona za vrlo brzo fokusiranje te AF kontrast za fokusiranje
velike točnosti.
Kombinacija ove dvije metode za AF osigurava veliku brzinu i visoku točnost automatskog
fokusiranja.

Note

Potreban je objektiv koji podržava automatsko fokusiranje.

Ovisno o uvjetima snimanja, možda nije moguće postići točnost.

Na objektivu A-mount fokus je nemoguće podešavati automatski.

Ako je objektiv opremljen sklopkom za odabir fokusiranja, postavite je u položaj
"AF/MF" ili "AF".

Note

Ako je sklopka postavljena u položaj „Full MF” ili „MF” fokusiranjem objektiva nije moguće
upravljati na jedinici. Pogledajte dio „Prilagodbe fokusa za objektive s prekidačem načina
fokusa” u odjeljku „Provjera prekidača objektiva”.

1

Kliznite prekidačem [Auto Focus] u desni položaj na upravljačkoj ploči fotoaparata
kako biste ga uključili.

Način automatskog fokusa je aktiviran.

 (AF)

2
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Savjet

Tijekom načina automatskog fokusa možete prilagoditi fokus s pomoću klizača fokusa na
upravljačkoj ploči fotoaparata. Pojedinosti pogledajte u odjeljku „Ručno postavljanje ciljnog
automatskog fokusa (AF Assist) s pomoću web-aplikacije”.

[71] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Automatska prilagodba s pomoću isporučenog
infracrvenog daljinskog upravljača

Možete automatski prilagoditi fokus s pomoću isporučenog infracrvenog daljinskog upravljača.

Note

Također možete upotrebljavati automatski fokus kad je ručna prilagodba glavna metoda rada.
Pojedinosti pogledajte u odjeljku „Ručno fokusiranje tijekom automatskog fokusiranja s pomoću
isporučenog infracrvenog daljinskog upravljača”.

[72] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Postavljanje područja/položaja automatskog fokusa

Pritisnite gumb AF na infracrvenom daljinskom upravljaču.

Automatski se prilagođava fokus na subjektu.

1
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(Focus Area)

Možete postaviti ciljno područje automatskog fokusa i prilagoditi fokus za to područje.

Pritisnite gumb [Menu] na upravljačkoj ploči GUI kako biste otvorili izbornik
fotoaparata.

1

Postavite ciljno područje za automatski fokus s pomoću [Shooting] > [Focus] >
[Focus Area] u izborniku fotoaparata.

[Wide]:
pri fokusiranju traži objekt kroz široki kut slike. Okvir se ne prikazuje.

[Zone]:
automatski pretražuje položaj za fokusiranje unutar određene zone.
Nakon odabira odredite položaj s pomoću gumba sa strelicom na upravljačkoj ploči GUI.

2
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Note

Okvir područja fokusa nije skriven kad upotrebljavate gumb [Display] na ploči fotografija fotoaparata.

Tijekom zumiranja za jasnu sliku područje fokusa je postavljeno na [Wide] (fiksirano).

Savjet

Možete prikazati/sakriti okvir područja za fokus s pomoću opcija [Monitoring] > [Display On/Off] >
[Focus Area Indicator] u izborniku fotoaparata.

[73] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Brza promjena područja fokusa (Focus Setting)

Možete se vratiti u središnji položaj pritiskom i držanjem gumba [Set].
[Flexible Spot]:
fokusiranje u određenu točku na slici.
Nakon odabira odredite položaj s pomoću gumba sa strelicom na upravljačkoj ploči GUI.

Možete se vratiti u središnji položaj pritiskom i držanjem gumba [Set].
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Položaj i veličinu područja automatskog fokusiranja tijekom snimanja moguće je brzo promijeniti
dodjelom funkcije [Focus Setting] jednom od dodjeljivih gumba.

Pojedinosti o dodjeljivim gumbima pogledajte u odjeljku „Dodjeljivi gumbi”.

Radnja se razlikuje ovisno o postavci područja fokusiranja.

Kad je [Shooting] > [Focus] > [Focus Area] postavljen na [Flexible Spot]
ili [Zone] u izborniku fotoaparata

Možete promijeniti položaj područja za fokus pritiskom na dodjeljivi gumb koji je dodijeljen
funkciji [Focus Setting] i prilagodbom s pomoću gumba sa strelicama na upravljačkoj ploči
GUI. Možete se vratiti na položaj područja za fokus u sredinu dok prilagođavate položaj
pritiskom na gumb [Set].
Veličina područja fokusiranja mijenja se pritiskanjem i zadržavanjem dodjeljivog gumba
kojem je dodijeljena funkcija [Focus Setting]. Nakon promjene veličine možete promijeniti
položaj područja za fokus pritiskom na gumb [Set]. Nakon dovršetka pritisnite dodjeljivi
gumb s funkcijom [Focus Setting] kako biste se vratili na početni zaslon.

Kad je [Shooting] > [Focus] > [Focus Area] postavljen na [Wide] u
izborniku fotoaparata

Veličinu područja fokusiranja moguće promijeniti samo pritiskanjem i zadržavanjem dodjeljivog
gumba kojem je dodijeljena funkcija [Focus Setting]. Položaj je također moguće promijeniti tako
da najprije vrstu promijenite na [Flexible Spot] ili [Zone].

Savjet

Kad su [Shooting] > [Focus] > [Push AF Mode] postavljeni na [Single-shot AF(AF-S)] u izborniku
fotoaparata i prekidač [Auto Focus] je postavljen na isključeni način (ručni način fokusa), možete
promijeniti položaj područja fokusa [Focus Area (AF-S)].

Okvir područja fokusiranja prikazan je narančastom bojom kada se područje fokusiranja može
promijeniti.

[74] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Pomicanje okvira područja za fokus s pomoću
dodirnih radnji (Touch Focus Area)

Možete promijeniti položaj područja za fokus pritiskom na dodjeljivi gumb koji je dodijeljen
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funkciji [Focus Setting] kako biste promijenili zaslon područja za fokus u narančastu boju, a
zatim pomaknuti okvir područja za fokus s pomoću dodirnih radnji na ploči fotografija
fotoaparata.
Dodirnite zaslon za pomicanje područja fokusiranja tako da je područje fokusiranja centrirano
na položaj koji ste dodirnuli. Povucite na zaslonu kako biste pomaknuli područje za fokus na
položaj koji prati vaš prst.

Savjet

Možete omogućiti/onemogućiti područje dodirnog fokusa na zaslonu snimanja s pomoću dodjeljivih
gumba koji su dodijeljeni funkciji [Focus Setting].

Dodirnite bilo koji položaj.

Dodirnuti položaj postaje središte područja za fokus.

1

Povucite kako biste pomaknuli područje za fokus koje prati položaj prsta.2
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Note

Ako dodirnete položaj ili povučete područje fokusiranja u položaj koji premašuje raspon postavke,
područje fokusiranja postavlja se na gornji / donji / lijevi / desni rub raspona fokusiranja.

Ova funkcija ne radi u sljedećim okolnostima.
Kad je prekidač [Auto Focus] isključen na upravljačkoj ploči fotoaparata
Kad je prekidač [Touch Focus] isključen na upravljačkoj ploči fotoaparata
Kad je okvir područja za fokus prikazan u sivoj boji ili uopće nije prikazan

[75] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Prilagodba rada automatskog fokusa (AF Transition
Speed, AF Subject Shift Sensitivity)

Možete prilagoditi rad automatskog fokusa promjenom brzine prijenosa i osjetljivosti pomicanja
subjekta.

Postavljanje brzine prijenosa automatskog fokusa

Možete postaviti brzinu pogona fokusa kad želite da se subjekt promijeni s pomoću gumba [AF
Transition Speed] na upravljačkoj ploči fotoaparata.
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Odaberite brzinu u rasponu od [Speed 1] (Sporo) do [Speed 7] (Brzo) u razmacima po jedan.
Pritisnite gumb < kako biste smanjili vrijednost (sporije) ili gumb > kako biste povećali vrijednost
(brže).
Kad je postavljena sporija brzina, fokus se sporije pomiče kad se fokusirani subjekt promijeni
što omogućuje snimanje fotografija dojmljive ekspresije.
Kada je postavljen na visoku brzinu, fokus se brzo mijenja između objekata. U primjeru u
nastavku fokus se brzo mijenja sa zgrade u pozadini na osobu koja hoda u prednjem planu.
Objekt koji uđe u kadar trenutačno se fokusira, što postavku čini idealnom za dokumentarističko
snimanje koje zahtijeva brzo fokusiranje.

AF osjetljivost na zamjenu objekta

Osjetljivost za zamjenu objekata možete postaviti s pomoću gumba [AF Subj. Shift Sens.] na
upravljačkoj ploči fotoaparata.
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Odaberite osjetljivost u rasponu od [Sens 1] (Zaključano na) do [Sens 5] (Responzivno) u
razmacima po jedan. Pritisnite gumb < kako biste smanjili vrijednost (spora promjena) ili gumb >
kako biste povećali vrijednost (brza promjena).
Kada je postavljena na malu osjetljivost, fokus se ne mijenja lako čak ni kada se ispred
fokusiranog objekta pomakne drugi objekt.

Kada je postavljena na veliku osjetljivost, fokus se mijenja i dodjeljuje prioritet objektu koji se
pomiče ispred.

Savjet

Ako je funkcija [AF Speed/Sens.] dodijeljena dodjeljivom gumbu, stupci razine za prilagodbu
vrijednosti prikazani su na ploči fotografija fotoaparata sljedećim redoslijedom svaki put kad se
pritisne gumb zbog čega možete promijeniti postavke brzine prijelaza automatskog fokusa i
osjetljivost pomicanja subjekta automatskog fokusa.
Brzina prijelaza automatskog fokusa › Osjetljivost pomicanja subjekta automatskog fokusa › Nema
prikaza...

[76] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)
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Ručno postavljanje cilja automatskog fokusa (AF
Assist) s pomoću web-aplikacije

Nakon ručnog pomicanja i prilagodbe fokusa možete prebaciti upravljanje fokusom na
automatski fokus za finiju prilagodbu fokusa.

Note

U načinu pomoći pri automatskom fokusu pomicanje fokusa je teže, bez obzira na postavke
[Shooting] > [Focus] > [AF Subj. Shift Sens.] u izborniku fotoaparata.

Postavite [Shooting] > [Focus] > [AF Assist] na [On] u izborniku fotoaparata.1

Postavite [Shooting] > [Focus] > [AF Assist Control] na [On] web-izborniku.2

Kliznite prekidačem [Auto Focus] u desni položaj na upravljačkoj ploči fotoaparata
kako biste ga uključili.

Način automatskog fokusa je aktiviran.

3

Postavite cilj fokusa s pomoću klizača [Focus] na upravljačkoj ploči fotoaparata.

[Near]: fokus na bliži subjekt.
[Far]: fokus na dalji subjekt.

U načinu pomoći pri automatskog fokusu subjekt na postavljenoj udaljenosti s pomoću
klizača [Focus] automatski će se fokusirati.

4
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Stanje AF Assist prekida se kada dođe do sljedećeg.
Kad subjekt fokusiran s pomoću klizača [Focus] više nije vidljiv
Pri prebacivanju na ručno fokusiranje
Kada je otkriveno lice

Savjet

Način pomoći pri automatskom fokusu može se brzo otkazati s pomoću dodjeljivih gumba
dodijeljenih funkciji [Push AF/MF].

Upravljanje klizačem [Focus] briše odabrano registrirano lice.

U načinu rada Face/Eye Only AF (automatsko fokusiranje samo lica/oči) automatski fokus izoštrava
lice najbliže položaju fokusa na klizaču [Focus].

[77] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Ručni fokus tijekom automatskog fokusa s pomoću
isporučenog infracrvenog daljinskog upravljača

Kad je [Shooting] > [Focus] > [AF Assist] postavljen na [On] u izborniku fotoaparata, možete
upotrijebiti gumb F (Daleko) i N (Blizu) na isporučenom infracrvenom daljinskom upravljaču čak
tijekom automatskog fokusa kako biste prilagodili fokus na subjektu.

[78] Snimanje Prilagodba fokusa Automatska prilagodba fokusa (Auto Focus)

Privremena upotreba ručnog fokusa tijekom
automatskog fokusa (Push Manual Focus)

Pritisnite gumb [Push AF/MF] kad ste u automatskom fokusu kako biste ručno fokusirali dok je
gumb pritisnut. Po otpuštanju gumba fokusiranje se vraća na automatsko.
To omogućuje privremeno zaustavljanje automatskog fokusiranja te ručno fokusiranje kada
nešto što nije objekt prođe ispred objekta.
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Savjet

Istu radnju podržava dodjeljivi gumb kojem je dodijeljena funkcija [Push AF/MF].

[79] Snimanje Prilagodba fokusa

Praćenje s pomoću prepoznavanja lica/oči (Face/Eye
Detection AF)

Jedinica može prepoznati lica i oči ljudi kao cilj koji prati te zatim prilagoditi fokus na licima i
očima unutar područja za fokus.
Kada se otkriju lica, prikazuju se sivi okviri otkrivanja lica/oka. Kad je automatski fokus moguć,
okviri se mijenjaju u bijelu boju i praćenje započinje. Kada su otkrivene oči i fokus je namješten,
okvir otkrivanja lica/oka prikazuje se na očima. Kada se otkrije više pojedinaca, glavni objekt
određuje se automatski.
Ova je funkcija dostupna jedino kad je način fokusa automatski ili tijekom načina Push Auto
Focus.

Savjet

Kad je područje fokusa postavljeno na [Zone] ili [Flexible Spot] te se lica i oči preklapaju unutar
određenog područja fokusa, okviri prepoznavanja lica/oči mijenjaju se u bijelu boju, a jedinica se
automatski fokusira na ta lica/oči.

Kada se primjenjuje automatsko fokusiranje pritiskanjem (AF-S), okviri otkrivanja lica/oka na
fokusiranim licima postaju zeleni.

Postavljanje s pomoću gumba [Face/Eye Detection AF] na upravljačkoj
ploči fotoaparata



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Pritisnite gumb [Face/Eye Detection AF] i postavite automatski fokus za prepoznavanje lica/oči.

[Face/Eye Only AF]: fotoaparata prepoznaje lica/oči subjekata (ljudi) fokusira se te prati samo
na njihovim licima/očima. Kad se lice ili oko ne prepoznaje, automatski fokus je privremeno
zaustavljen i prikazuje se ikona  (Pauziran je način automatskog fokusa Face/Eye Only AF).
Ovaj je način rada učinkovit ako želite samo automatski fokusirati i pratiti lica/oči.
[Face/Eye Priority AF]: fotoaparata prepoznaje lica/oči subjekata (ljudi) te daje prioritet
fokusiranju/praćenju lica/oči. Kada lice ili oči nisu otkriveni, fokusiranje je u načinu AF (zadana
postavka).
[AF]: automatski fokus prepoznavanja lica/oči je onemogućen.

Note

Tijekom rada funkcije automatskog fokusiranja pritiskanjem opcija, funkcija [Face/Eye Priority AF] je
aktivirana čak ako je opcija [Face/Eye Only AF] trenutno odabrana.

Kad je prekidač [Auto Focus] isključen, automatski fokus prepoznavanja lica/oči je onemogućen
(isključujući tijekom rada funkcije automatskog fokusiranja pritiskanjem opcija).

Ako isključite kamkorder kad je opcija [Face/Eye Only AF] odabrana, način se rada automatski
prebacuje na opciju [Face/Eye Priority AF] kad sljedeći put uključite kamkorder.

Savjet

Možete postaviti automatski fokus prepoznavanja lica/oči s pomoću funkcija [Shooting] > [Focus] >
[Face/Eye Detection AF] u izborniku fotoaparata.

Skrivanje okvira prepoznavanja lica/oči
Možete prikazati/sakriti okvire prepoznavanja lica/oči s pomoću opcije [Monitoring] > [Display
On/Off] > [Face/Eye Detection Frame] u izborniku fotoaparata.

Note
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Zeleni okviri prepoznavanja lica/oči prikazani su za lica i oči koje su u fokusu s pomoću funkcije
automatskog fokusa pritiskanjem (AF-S) te nisu skriveni kad upotrijebite gumb [Display] ili kad je
funkcija [Face/Eye Detection Frame] postavljena na [Off].

Prebacivanje automatskog fokusa prepoznavanja lica/oči s pomoću dodjeljivog
gumba
Funkciju [Face/Eye Detection AF] dodijelite dodjeljivom gumbu. Možete zatim prebaciti
automatski fokus prepoznavanja lica/oči redoslijedom [Face/Eye Priority AF], [Face/Eye Only
AF] i [AF] svaki put kad pritisnete gumb.

Postavljanje u izravnom izborniku

Rad funkcije automatskog fokusa prepoznavanja lica/oči također možete postaviti u izravnom
izborniku.

Pojedinosti o izravnom izborniku pogledajte u odjeljku „Upotreba izbornika Direct Menu”.

[80] Snimanje Prilagodba fokusa

Praćenje određenog subjekta (Realtime Tracking AF)

Možete održavati fokus na subjektu određivanjem subjekta dodirom radnje ili odabirom okvira
prepoznavanja lica na upravljačkoj ploči fotoaparata.
Kad se subjekt odabere, prikazuje se bijeli okvir praćenja i praćenje započinje.

Savjet

Praćenje se događa diljem cijelog područja fotografije bez obzira na postavku područja za fokus.

Kad je funkcija [Shooting] > [Focus] > [Touch Function in MF] postavljena na [Tracking AF] u web-
izborniku ili izborniku fotoaparata, automatski fokus praćenja u stvarnom vremenu je podržan čak
kad je način fokusa u ručnom fokusu.

Sljedeće se radnje događaju za praćeni cilj ovisno o postavki načina rada automatskog fokusa
prepoznavanja lica/oči.
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[Face/Eye Only AF] ili [Face/Eye Priority AF]: fokus i praćenje određenog subjekta.
Ako je cilj praćenja osoba i prepozna se lice/oko, fotoaparat se fokusira na to lice/oko.
Kad se prepozna lice/oko praćenog cilja, lice praćenog cilja se sprema. Kad se spremi,
prikazuje se ikona  (ikona spremljenog praćenog lica).

Note

Ako se automatski fokus praćenja pokrene tijekom ručnog fokusa, ciljno lice praćenja se ne sprema.

[AF]: fokus i praćenje određenog subjekta. Prepoznavanje lica/oči se ne pojavljuje čak ako je
cilj praćenja osoba.

Note

Funkcija automatskog fokusa praćenja u stvarnom vremenu ne radi ako je objektiv postavljen na
ručni fokus.

Pokretanje automatskog fokusa praćenja u stvarnom vremenu

Kad se odredi određeni subjekt kao cilj praćenja, praćenje cilja započinje.

Određivanje dodirnom radnjom
Kliznite prekidačem [Touch Focus] na  (Focus) pomaknite upravljačku ploču fotoaparata
udesno kako biste je uključili, a zatim dodirnite subjekt praćenja za praćenje u bilo kojem od
sljedećih stanja.

Tijekom ručnog fokusa ili fokusa ručnog pritiskanja te kad je funkcija [Shooting] > [Focus] >
[Touch Function in MF] postavljena na [Tracking AF] u web-izborniku ili izborniku
fotoaparata
Tijekom automatskog fokusa ili automatskog fokusa pritiskanjem (AF)

Određivanje odabirom okvira prepoznavanja lica
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Pomaknite birač lica (povučen narančastom bojom) na ciljni subjekt za praćenje s pomoću
gumba sa strelicama u upravljačkoj ploči GUI i pritisnite gumb [Set].

A: okvir prepoznavanja lica (sivo)
B: okvir praćenja
C: birač lica (narančasto)

Note

Tijekom ručnog fokusa, praćenje se ne može pokrenuti odabirom okvira prepoznavanja lica.

Savjet

Također možete promijeniti cilj za praćenje tijekom automatskog fokusa praćenja u stvarnom
vremenu.

Zaustavljanje automatskog fokusa praćenja u stvarnom vremenu

Pritisnite gumb  (automatski fokus praćenja u stvarnom vremenu).

Savjet

Zaustavit će se automatski fokus praćenja u stvarnom vremenu u sljedećim slučajevima:
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Kad je prekidač [Auto Focus] ili kontrola AUTO/MANUAL na objektivu uključena
Kad se promijeni način fokusa
Kada se izvodi funkcija pomoći pri automatskom fokusu
Kad je postavka područja fokusa ili rad automatskog fokusa prepoznavanja lica/oči promijenjena
Kad je dodjeljivi gumb dodijeljen funkciji [Push AF/MF] pritisnut
Kad cilj praćenja nije unutar zaslona snimanja ili kad je subjekt izvan fokusa nekoliko sekundi

Kad se praćeno lice spremi (kad je ikona  (ikona spremljenog praćenog lica) prikazan), nastavit će
se automatski fokus praćenja u stvarnom vremenu kad spremljeno praćeno lice uđe u područje
fotografije. Kako biste obrisali praćeno lice, zaustavite automatski fokus praćenja u stvarnom
vremenu kako je opisano gore.

[81] Snimanje Prilagodba svjetline

Zaslon prilagodbe svjetline

Možete prilagoditi svjetlinu prilagođavanjem blende, jačine signala, brzine okidanja i
prilagodbom razine svjetlosti s pomoću ND filtra na sljedećim upravljačkim pločama zaslon rada
uživo web-aplikacije. Također možete automatski prilagoditi svjetlinu.
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Note

Jačina se signala ne može prilagoditi kad je funkcija [Shooting Mode] postavljena na [Cine EI].
Također, svjetlinu nije moguće automatski podešavati brzinom zatvarača. Automatsko podešavanje
svjetline s iris i filtrom ND je podržano.

Savjet

Cine EI način je rada za snimanje pri osnovnoj osjetljivost bez upotrebe jačine signala kako bi se
povećala izvedba senzora fotoaparata. Svjetlina se može prilagoditi s pomoću osvjetljenja i ND filtra
za prilagodbu količine svjetlosti koja doseže do senzora fotografija. Pojedinosti o indeksu ekspozicije
(EI) pogledajte u odjeljku „Promjena distribucije tamnih i svjetlih područja na snimljenim
fotografijama”.

[82] Snimanje Prilagodba svjetline

Postavljanje osnovne osjetljivosti

Možete postaviti osnovnu osjetljivost prije pokretanja prilagodbe svjetline.

Kad je funkcija [Shooting Mode] postavljena na [Custom]

Pritisnite gumb [ISO/Gain] na osnovnoj ploči konfiguracije fotoaparata i postavite funkciju [Base
Sensitivity] na ploči prilagodbe ISO / jačina signala na [High] ili [Low].
Odaberite [Low] pri uobičajenim uvjetima osvijetljenja, a [High] pri niskim uvjetima osvijetljenja.
Zaslon kad je funkcija [AGC] isključena

Upravljačka ploča fotoaparata – kartica (Glavni)1.

Osnovna ploča konfiguracije fotoaparata
Prikazuje status postavke osnovnih funkcija potrebnih za snimanje na gumbima. Pritisnite
gumb za prikaz odgovarajućeg zaslona postavljanja za svaku funkciju na osnovnoj ploči
prilagodbe konfiguracije fotoaparata u nastavku.

2.

Osnovna ploča prilagodbe konfiguracije fotoaparata
Prikazuje ploču prilagodbe za postavljanje odabrane stavke na osnovnoj ploči konfiguracije
fotoaparata.

3.
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Zaslon kad je funkcija [AGC] uključena

Kad je funkcija [Shooting Mode] postavljena na [Cine EI]

Pritisnite gumb [Base ISO/Exposure Index] na osnovnoj ploči konfiguracije fotoaparata i
postavite [Base ISO] ploči prilagodbe osnovnog ISO-a / indeksa ekspozicije na [ISO 12800] ili
[ISO 800].
Odaberite [ISO 800] pri uobičajenim uvjetima osvijetljenja, a [ISO 12800] pri niskim uvjetima
osvijetljenja.

Savjet

Ovo također možete postaviti na kartici  (Glavni) upravljačke ploče fotoaparata.

Također možete postaviti s pomoću opcije [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] ili [Base
ISO] u izborniku fotoaparata.

Funkciju [Base ISO/Sensitivity] također možete dodijeliti dodjeljivom gumbu.
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[83] Snimanje Prilagodba svjetline

Postavljanje ciljne razine za automatsku prilagodbu
svjetline

Ciljna razina za automatsku prilagodbu svjetline postavlja se s pomoću klizača [AE Level] na
upravljačkoj ploči fotoaparata.

Pritisnite karticu  (Glavni) na upravljačkoj ploči fotoaparata.

Ako se klizač [AE Level] ne prikaže, odaberite jedan od dva funkcijska gumba klizača te
odaberite klizač [AE Level] s popisa.

Pojavljuje se klizač [AE Level].

1

Postavite ciljnu razinu s pomoću klizača.

Pomaknite kotačić klizača ulijevo kako bi slika postala tamnija. Pomaknite kotačić klizača
udesno kako bi slika postala svijetlija.

Savjet

Također se može postaviti s pomoću opcija [Shooting] > [Auto Exposure] > [Level] na izborniku
fotoaparata.

2
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[84] Shooting Prilagodba svjetlina Prilagodba blende

Automatska prilagodba blende

Možete automatski prilagoditi svjetlinu u skladu sa subjektom. Potreban je kompatibilni objektiv.

Note

Na objektivu A-mount iris je nemoguće podešavati automatski.

Savjet

Funkciju [Auto Iris] također možete dodijeliti dodjeljivom gumbu.

[85] Snimanje Prilagodba svjetline Prilagodba blende

Ako je postavljen objektiv s funkcijom Auto Iris (Automatska blenda), prekidač
postavite na AUTO.

1

Pritisnite gumb [Iris] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [Iris] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe blende.

2

Kliznite prekidačem [Auto] udesno kako biste ga uključili.

Blenda se mijenja na način automatske prilagodbe. Vrijednost automatske prilagodbe
blende prikazuje se na desnoj strani prekidača.

3
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Ručna prilagodba blende

Možete ručno prilagoditi svjetlinu.

Ako je postavljen objektiv s funkcijom Auto Iris (Automatska blenda), prekidač
postavite na AUTO.

Note

Kad je prekidač Auto Iris (Automatska blenda) postavljen na MANUAL (Ručno), funkcije [Auto
Iris] i [Push Auto Iris] na jedinici nemaju nikakvog učinka. Ručna prilagodba blende na jedinici
nema učinak.

1

Pritisnite gumb [Iris] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [Iris] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe blende.

2

Kliznite prekidačem [Auto] ulijevo kako biste ga isključili.

Blenda se mijenja na ručni način prilagodbe.

3

Prilagodite blendu s pomoću klizača [Iris] ili gumba prilagodbe [Iris].

Savjet

Postavke klizača i gumba prilagodbe su povezane.

4
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Privremeno automatsko prilagođavanje blende
Također možete pritisnuti gumb [Push Auto] na ploči prilagodbe blende kako biste automatski
prilagodili blendu dok je gumb pritisnut.

Savjet

Pritisnite dodjeljivi gumb dodijeljen funkciji [Push Auto Iris] kako biste automatski prilagodili blendu
dok je gumb pritisnut.
Blenda se vraća u ručni način rada kad otpustite gumb.

[86] Snimanje Prilagodba svjetline Prilagodba jačine signala

Automatska prilagodba jačine signala

Možete automatski prilagoditi svjetlinu s pomoću postavke jačine signala kad je funkcija
[Shooting Mode] postavljena na [Custom].

Također možete dodijeliti blendu klizaču na kartici  (Glavni) na upravljačkoj ploči
fotoaparata.

Postavite funkciju [Project] > [Shooting Mode] na [Custom] u web-izborniku ili
izborniku fotoaparata.

1

Pritisnite gumb [ISO/Gain] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [ISO/Gain] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ISO / jačine signala.

2
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[87] Snimanje Prilagodba svjetline Prilagodba jačine signala

Ručna prilagodba jačine signala

Možete ručno prilagoditi svjetlinu s pomoću postavke jačine signala kad je funkcija [Shooting
Mode] postavljena na [Custom].
Jačinom signala možete upravljati kada želite podesiti ekspoziciju uz fiksnu postavku
ekspozicije ili kada želite spriječiti porast jačine signala zbog funkcije AGC.

Kliznite prekidačem [AGC] udesno kako biste ga uključili.

Jačina se signala mijenja na automatski način prilagodbe. Vrijednost automatske
prilagodbe jačine signala prikazuje se na desnoj strani prekidača.

Savjet

Također možete izvršiti istu radnju postavljanjem funkcija [Shooting] > [Auto Exposure] >
[AGC] na [On] u izborniku fotoaparata.

Funkciju [AGC] također možete dodijeliti dodjeljivom gumbu.

3

Postavite funkciju [Project] > [Shooting Mode] na [Custom] u web-izborniku ili
izborniku fotoaparata.

1

Pritisnite gumb [ISO/Gain] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [ISO/Gain] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ISO / jačine signala.

2

Kliznite prekidačem [AGC] ulijevo kako biste ga isključili.3
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Privremena ručna prilagodba jačine signala
Također možete privremeno prilagoditi jačinu signala dodjeljivanjem funkcije [ISO/Gain] gumbu
odabira funkcije klizača na kartici  (Glavni) na upravljačkoj ploči fotoaparata i s pomoću
klizača.
To je praktično kada želite podesiti ekspoziciju za jedan korak bez promjene dubine polja.
Rezultat prilagodbe vraća se na unaprijed postavljenu vrijednost konfiguriranu s pomoću opcije
[ISO/Gain<L>] nakon izvršavanja bilo koje od sljedećih radnji.

Promjena stavki prilagodbe ISO / jačine signala
Prebacivanje osnovne osjetljivosti
Postavljanje prekidača AGC na uključeni položaj
Prebacivanje izvora napajanja jedinice u stanje pripravnosti

Privremena automatska prilagodba jačine signala s pomoću dodjeljivog gumba
Pritisnite dodjeljivi gumb dodijeljen funkciji [Push AGC] za automatsku prilagodbu jačine signala
dok je gumb pritisnut.
Jačina se signala vraća na ručni način rada kad otpustite gumb.
Rezultat prilagodbe vraća se na unaprijed postavljenu vrijednost konfiguriranu s pomoću opcije
[ISO/Gain<L>] nakon izvršavanja bilo koje od sljedećih radnji.

Promjena stavki prilagodbe ISO / jačine signala
Prebacivanje osnovne osjetljivosti
Postavljanje prekidača AGC na uključeni položaj
Prebacivanje izvora napajanja jedinice u stanje pripravnosti

Jačina se signala mijenja u ručni način rada.

Prilagodite jačinu signala s pomoću klizača [ISO/Gain] ili gumba prilagodbe
[ISO/Gain].

Savjet

Postavke klizača i gumba prilagodbe su povezane.

4
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Note

Ova se funkcija ne može izvršiti kad je funkcija [Shooting] > [Iris] > [Bokeh Control] postavljena na
[On] u izborniku fotoaparata.

[88] Snimanje Prilagodba svjetline Prilagodba zatvarača

Automatska prilagodba zatvarača

Možete automatski prilagoditi zatvarač u odnosu na svjetlinu fotografije.

[89] Snimanje Prilagodba svjetline Prilagodba zatvarača

Ručna prilagodba zatvarača

Pritisnite gumb [Shutter] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [Shutter] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe zatvarača.

1

Pritisnite gumb [Shutter Type] i odaberite [Auto] s popisa.

Savjet

Također možete izvršiti istu radnju postavljanjem funkcije [Shooting] > [Auto Exposure] > [Auto
Shutter] na [On] u izborniku fotoaparata.

Funkciju [Auto Shutter] također možete dodijeliti dodjeljivom gumbu.

2
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Možete ručno prilagoditi zatvarač.

Pritisnite gumb [Shutter] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumb [Shutter] (Zatvarač) mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe zatvarača.

1

Pritisnite gumb [Shutter Type] i odaberite [Speed] s popisa.2

Prilagodite zatvarač s pomoću klizača [Speed] ili gumba prilagodbe [Speed].

Za prilagodbu vremena ekspozicije prema intervalu kadra odaberite [Off] u 2. koraku.
Također možete postaviti fiksnu vrijednost s pomoću funkcije [ECS] (učestalost) ili
automatski prilagoditi s pomoću funkcije [Auto].
Primjer: postavite s pomoću funkcije [ECS] (učestalost)

Savjet

Postavke klizača i gumba prilagodbe su povezane.

Kako biste upotrijebili funkciju [Angle] umjesto funkcije [Speed] ili [Off], postavite funkciju
[Shooting] > [Shutter] > [Mode] na [Angle] u izborniku fotoaparata.

3
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[90] Snimanje Prilagodba svjetline Prilagodba razine svjetlosti (ND Filter)

O ND filtru

U uvjetima u kojima je svjetlo prejako, odgovarajući svjetlinu možete postaviti promjenom filtra
ND.
Pri snimanju jako osvijetljenog objekta prejako zatvaranje irisa može uzrokovati zamućenje
zbog prelamanja, zbog čega slika gubi fokus (uobičajena pojava na videokamerama).
Suzbijanjem ovog efekta primjenom filtra ND možete ostvariti bolje rezultate snimanja.
Jedinica ima sljedeće načine ND filtra.
Unaprijed postavljeni način

Pogledajte odjeljak „Prilagodba u unaprijed postavljenom načinu”.

Varijabilni način rada (automatska prilagodba)

Pogledajte odjeljak „Automatska prilagodba u varijabilnom načinu rada”.

Varijabilni način rada (ručna prilagodba)

Pogledajte odjeljak „Ručna prilagodba u varijabilnom načinu rada”.

[91] Snimanje Prilagodba svjetline Prilagodba razine svjetlosti (ND Filter)

Prilagodba u unaprijed postavljenom načinu

Možete unaprijed odabrati tri vrijednosti prozirnosti ND filtra i brzo ih mijenjati tijekom snimanja.

Postavite funkciju [Shooting] > [ND Filter] > [Mode] na [Preset] u izborniku
fotoaparata.

1

Pritisnite gumb [ND Filter] na osnovnoj ploči konfiguracije fotoaparata.2
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Savjet

Kad je dodjeljivi gumb dodijeljen funkciji [ND Filter Position] pritisnut, ND filtar se mijenja
redoslijedom [Clear] › [Preset1] › [Preset2] › [Preset3] › [Clear].

[92] Snimanje Prilagodba svjetline Prilagodba razine svjetlosti (ND Filter)

Automatska prilagodba u varijabilnom načinu rada

Možete omogućiti prilagodbu automatske ekspozicije s pomoću ND filtra.

Okvir gumba [ND Filter] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ND filtra.

Pritisnite gumb [ND Filter] i odaberite jedno od sljedećeg s popisa.

[Clear]: nema ND filtra.
[Preset1]: postavljena prozirnost funkcijom [Shooting] > [ND Filter] > [Preset1] u izborniku
fotoaparata.
[Preset2]: postavljena prozirnost funkcijom [Shooting] > [ND Filter] > [Preset2] u izborniku
fotoaparata.
[Preset3]: postavljena prozirnost funkcijom [Shooting] > [ND Filter] > [Preset3] u izborniku
fotoaparata.

Kad je od [Preset1] do [Preset3] odabran za ND filtar, vrijednost prozirnosti se prikazuje
pokraj naziva ND filtra.

3

Postavite funkciju [Shooting] > [ND Filter] > [Mode] na [Variable] u izborniku
fotoaparata.

1
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Note

Kad se ND filtar prebaci na funkciju ili s funkcije [Clear] tijekom snimanja, prikazuje se okvir ND filtra
na fotografiji i emitira se zvuk rada.

Savjet

Također možete dodijeliti funkciju [Auto ND Filter] dodjeljivom gumbu i pritisnuti gumb kako biste
prebacili između [Auto] i [Manual].

[93] Snimanje Prilagodba svjetline Prilagodba razine svjetlosti (ND Filter)

Ručna prilagodba u varijabilnom načinu rada

Možete izvršiti ručnu prilagodbu ekspozicije s pomoću ND filtra.

Pritisnite gumb [ND Filter] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [ND Filter] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ND filtra.

2

Pritisnite gumb [ND Filter] i odaberite [Auto] s popisa.

Automatski prilagođena vrijednost prozirnosti ND filtra prikazuje se pokraj gumba [ND
Filter].

3

Postavite funkciju [Shooting] > [ND Filter] > [Mode] na [Variable] u izborniku
fotoaparata.

1
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Privremena automatska prilagodba
Možete dodijeliti funkciju [Push Auto ND] dodjeljivom gumbu i privremeno uključiti automatski
ND filtar dok je gumb pritisnut. Otpuštanje gumba isključuje automatski ND filtar.
Postavite ND filtar na [Manual].

Note

Kad se ND filtar prebaci na funkciju ili s funkcije [Clear] tijekom snimanja, prikazuje se okvir ND filtra
na fotografiji i emitira se zvuk rada.

Savjet

Pritisnite gumb [ND Filter] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [ND Filter] (ND filtar) mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ND filtra.

2

Pritisnite gumb [ND Filter] i odaberite [Manual] s popisa.3

Prilagodite prozirnost ND filtra s pomoću klizača [ND Filter] ili gumba prilagodbe
[ND Filter].

Savjet

Postavke klizača i gumba prilagodbe su povezane.

Također možete prilagoditi ND filtar na kartici  (Glavni) na upravljačkoj ploči fotoaparata.

4
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Možete također dodijeliti funkciju [ND Filter Position] dodjeljivom gumbu i pritisnuti gumb kako biste
prebacivali između [Manual] i [Clear].

Također možete pritisnuti gumb [Push Auto] na ploči prilagodbe ND filtra kako biste uključili
automatski ND filtar dok je gumb pritisnut.

[94] Snimanje Prilagodba za prirodne boje (White Balance)

Zaslon prilagodbe ravnoteže bijele boje

Možete prilagoditi ravnotežu bijele boje s pomoću zaslona rada uživo web-aplikacije kako biste
dobili ravnotežu bijele boje zbog koje će izgled fotografije izgledati prirodnije.

Osnovna ploča konfiguracije fotoaparata1.

Osnovna ploča prilagodbe konfiguracije fotoaparata
Prikazuje ploču prilagodbe za postavljanje odabrane stavke na osnovnoj ploči konfiguracije
fotoaparata.

2.
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[95] Snimanje Prilagodba za prirodne boje (White Balance)

Automatska prilagodba ravnoteže bijele boje

Možete dobiti odgovarajuću prilagođenu ravnotežu bijele boje cijelo vrijeme s pomoću funkcije
ATW (automatsko praćenje ravnoteže bijele boje).
Kad je funkcija ATW omogućena, ravnoteža se bijele boje automatski prilagođava kako se
temperatura boje izvora svjetlosti mijenja.

Note

ATW se ne može upotrebljavati kad je funkcija [Shooting Mode] postavljena na [Cine EI].

Ovisno o osvjetljenju i uvjetima objekta, podešavanje na odgovarajuću boju funkcijom ATW može biti
nemoguće.
Primjeri:

Ako jedna boja dominira objektom, poput neba, mora, tla ili cvijeća.
Kada je temperatura boje iznimno visoka ili iznimno niska.

Ako je ATW automatska brzina praćenja spora ili se odgovarajući učinak ne može ostvariti, pritisnite
gumb [WB SET] kako biste pokrenuli automatsku ravnotežu bijele boje.

Savjet

Pritisnite gumb [White Balance] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [White Balance] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ravnoteže bijele boje.

1

Pritisnite gumb [White Mode] i odaberite [ATW] s popisa.2
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Možete odabrati pet koraka (1, 2, 3, 4, 5) brzine odziva kad je u ATW načinu rada s pomoću funkcije
[Shooting] > [White Setting] > [ATW Speed] u izborniku fotoaparata. Što je broj niži, brža je brzina
odziva.

Trenutačnu postavku ravnoteže bijele možete zamrznuti postavljanjem funkcije [ATW Hold]
dodjeljivom gumbu te pritiskom dodjeljivog gumba privremeno pauzirati način ATW.

[96] Snimanje Prilagodba za prirodne boje (White Balance)

Ručna prilagodba ravnoteže bijele boje

Možete ručno prilagoditi ravnotežu bijele boje.

Pritisnite gumb [White Balance] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [White Balance] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ravnoteže bijele boje.

1

Pritisnite gumb [White Mode] i odaberite jedno od sljedećeg s popisa.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[97] Snimanje Prilagodba za prirodne boje (White Balance)

Pokretanje automatske ravnoteže bijele boje

Na memoriji A ravnoteža bijele boje za spremanje automatski se prilagođava.

Prilagodite ravnotežu bijele boje s pomoću klizača ili gumba prilagodbe.

Savjet

Postavke klizača i gumba prilagodbe su povezane.

Razlika između [Memory A(T/T)] i [Memory A(R/B)] je u tome što je os prilagodbe drukčija, ali
povezani su rezultati prilagodbe.

Za [Memory A(T/T)]
Ovaj način rada prilagođava ravnotežu bijele boje spremljene na memoriju A prilagodbom
temperature boje (Temp) i nijanse Tint.
Možete postaviti temperaturu boje u razmacima od 20 K u rasponu do 2000 K do 5600 K.
Vrijednosti iznad 5600 K mogu se postaviti u intervalima jednakima iznosu promjene boje
(mired) od 5580 K do 5600 K.
Pritiskom gumba [Reset] spremaju se postavke [Temp] (temperatura boje) ili [Tint] na
drukčiju vrijednost.
Za [Memory A(R/B)]
Ova način rada prilagođava ravnotežu bijele boje spremljenu na memoriju A prilagodbom
jačine signala R i B.
Pritiskom gumba [Reset] vraća se postavka odgovarajuće jačine signala na zadanu
vrijednost.
Za [Preset]
Ovaj način rada prilagođava temperaturu boje na unaprijed zadanu vrijednost.
Možete postaviti vrijednost u razmacima od 100 K.
U unaprijed postavljenom načinu također možete dodijeliti [Preset White Select]
dodjeljivom gumbu i pritisnite gumb za promjenu unaprijed konfigurirane vrijednosti.
Način rada [Custom]: 3200 K › 4300 K › 5600 K › 6300 K › 3200 K…
Način rada [Cine EI]: 3200 K › 4300 K › 5500 K › 3200 K…

3

Pritisnite gumb [White Balance] na osnovnoj ploči konfiguracije fotoaparata.1
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Okvir gumba [White Balance] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe ravnoteže bijele boje.

Pritisnite gumb [White Mode] i odaberite funkciju [Memory A(T/T)] ili [Memory
A(R/B)] s popisa.

[Memory A(T/T)]

[Memory A(R/B)]

2

Postavite bijeli papir (ili drugi predmet) na lokaciju s izvorom svjetlosti i uvjetima
jednakima onima kojima je izložen objekt, a zatim zumirajte papir kako biste
prikazali bijelu na zaslonu.

3

prilagodba svjetline.

Prilagodite blendu s pomoću postupka u odjeljku „Ručna prilagodba blende”.

4

Pritisnite gumb [WB SET] na ploči prilagodbe ravnoteže bijele boje.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Note

Ako je podešavanje neuspješno, na zaslonu se na oko tri sekunde prikazuje poruka o pogrešci. Ako
se poruka o pogrešci nastavlja pojavljivati nakon uzastopnih pokušaja postavljanja balansa bijele
boje, obratite se servisnom predstavniku tvrtke Sony.

Savjet

Možete također pokrenuti način rada ATW. Možete ovo upotrijebiti kad želite brzo prilagoditi
ravnotežu bijele boje tijekom ATW rada. Nakon prilagodbe način rada vraća se u uobičajeni ATW
rad.

[98] Snimanje Konfiguracija zvuka za snimanje

Zaslon konfiguracije zvuka

Možete prilagoditi razinu zvuka za snimanje na zaslonu rada uživo web-aplikacije. Konfigurirajte
prekidače na bloku priključaka jedinice i konfigurirajte zvuk s pomoću web-aplikacije.

Ako se pokrene automatska ravnoteža bijele boje, rezultat automatske prilagodbe sprema
se na memoriju A.
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[99] Snimanje Konfiguracija zvuka za snimanje

Odabir uređaja za ulaz zvuka

Postavite sljedeće prekidače u odnosu na priključeni uređaj na priključak AUDIO IN.

Upravljačka ploča fotoaparata –  Kartica (Zvuk)1.

Kad je mikrofon priključen, postavite prekidač SETUP (Postavljanje) 2 na blok
priključaka na stražnjem dijelu jedinice.

CH-1 i CH-2 imaju zajedničke postavke.

1

Setting Opis

OFF
(zadano)

Odaberite kad odaberite dinamički mikrofon ili mikrofon koji radi na bateriju.
Ovo isključuje fantomski izvor napajanja od +48 V i postavljanje ulaz LINE
(Linija) ili MIC (Mikrofon) kao izvor zvuka CH-1 i CH-2.

Odaberite kad upotrebljavate kompatibilni mikrofon fantomskog izvora
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Note

Zvuk se ne snima u načinu Interval Rec ili načinu Slow & Quick Motion.

[100] Snimanje Konfiguracija zvuka za snimanje

Automatska prilagodba razine snimanja zvuka

Postavite kanal na koji želite automatski prilagoditi razinu snimanja zvuka na [Auto] na stranici
[Audio] web-izbornika ili s pomoću funkcija [Audio] > [Audio Input] > [CH1 Level Control] na
[CH4 Level Control] u izborniku fotoaparata.
Određeni kanali za automatsku prilagodbu navedeni su ikonom  (Automatski) pokraj
odgovarajućih kanala na kartici  (Zvuk) na zaslonu rada uživo.

[101] Snimanje Konfiguracija zvuka za snimanje

Ručna prilagodba razine snimanja zvuka

Možete ručno prilagoditi razinu snimanja zvuka.

ON
napajanja od +48 V. Ovo uključuje fantomski izvor napajanja od +48 V i
postavlja kompatibilni mikrofon fantomskog izvora napajanja od +48 V kao
izvor zvuka CH-1 i CH-2.

Postavlja vrstu priključenog uređaja s pomoću funkcija [Audio] > [Audio Input] >
[AUDIO IN Select] u izborniku fotoaparata.

2

Odaberite ulaz zvuka s pomoću funkcija [Audio] > [Audio Input] > [CH1 Input Select]
na [CH4 Input Select] u web-izborniku ili izborniku fotoaparata.

3

Postavite kanal na kojem želite ručno prilagoditi razinu snimanja zvuka na [Manual]
na stranici [Audio] web-izbornika ili s pomoću funkcije [Audio] > [Audio Input] >
[CH1 Level Control] na [CH4 Level Control] izbornika fotoaparata.

1

Pritisnite karticu  (Zvuk) na upravljačkoj ploči fotoaparata.2
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[102] Korisne funkcije

Rad izravnog izbornika

Možete provjeriti status i postavke jedinice prikazane preko fotografije i odabrati i promijeniti
postavke s pomoću upravljačkih gumbi GUI na infracrvenom daljinskom upravljaču.
Moguće je konfigurirati sljedeće stavke.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]

Na zaslonu [Audio] upravljačke ploče fotoaparata, postavite razinu snimanja zvuka s
pomoću klizača ili gumba prilagodbe za kanal čiju razinu snimanja zvuka želite
ručno postaviti.

Note

Kanali za koje je ikona  (Automatski) prikazana automatski se prilagođavaju. Mijenja
vrijednosti s pomoću klizača ili gumbi koji nisu primijenjeni na snimljeni zvuk.

Savjet

Postavke klizača i gumba prilagodbe u svakom redu su povezane.

Možete provjeriti razinu ulaza zvuka u stvarnom vremenu s pomoću zaslona mjerača razine
zvuka na zaslonu snimanja.

3
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[Scene File]
[ND Filter Position]
[Auto ND Filter]
Vrijednost [ND Filter]
[Auto Iris]
Vrijednost [Iris]
[AGC]
Vrijednost [Gain]
Vrijednost [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] i [Frame Rate]

Savjet

Također izvršite istu funkciju s pomoću dodjeljivih gumba i upravljačke ploče GUI web-izbornika.

Pritisnite dodjeljivi gumb dodijeljen funkciji [Direct Menu] na infracrvenom
daljinskom upravljaču.

Gumb [Direct Menu] dodijeljen je dodjeljivom gumbu 1 prema tvorničkim postavkama.
Samo stavke na zaslonu moguće je konfigurirati i odabrati narančastim pokazivačem u
izravnom izborniku.

1

Pomaknite pokazivač na stavku koju želite postaviti s pomoću gumba sa strelicama
na upravljačkoj ploči GUI i pritisnite gumb [Set].

Prikazuje se izbornik ili se stavka prikazuje na bijeloj pozadini.

2

Odaberite postavku s pomoću gumba sa strelicama i pritisnite gumb [Set].

Izbornik ili bijela pozadina nestaju, a prikazuje se nova postavka s narančastim
pokazivačem.
Za napuštanje izravnog izbornika pritisnite dodjeljivi gumb kojem je dodijeljena funkcija
[Direct Menu] (Izravni izbornik) ili pričekajte tri sekunde bez provođenja radnji.

3
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[103] Korisne funkcije

Dodjeljivi gumbi

Postoji deset dodjeljivih gumbi u web-aplikaciji jedinice kojoj možete dodijeliti funkcije.
Dodjeljivi gumbi prikazani su na zaslonu rada uživo i zaslonu reprodukcije.

Note

Popis dodjeljivih gumba se ne prikazuje kad konfigurirate postavke na osnovnoj ploči rada
fotoaparata zaslona rada uživo. Za kraj rada pritisnite gumb [X] na gornjem desnom dijelu ploče
prilagodbe.

Sljedeće funkcije dodijeljene su gumbima prema tvorničkim postavkama.
Gumb 1: [Direct Menu]
Gumb 2: [Focus Setting]
Gumb 3: [Rec Review]

Gumbi od 1 do 3 jednaki su istom broju gumba na isporučenom infracrvenom daljinskom
upravljaču.

Gumb 4: [Push Auto ND]
Gumb 5: [Crop Select]
Gumb 6: [Marker]
Gumb 7: [Video Signal Monitor]
Gumb 8: [Clip Flag OK]
Gumb 9: [Color Bars]
Gumb Zadržavanja fokusa: [Focus Hold]

Gumb Focus Hold (Zadrži fokus) jednak je gumbu Focus Hold (Zadrži fokus) na objektivu E-
mount.

Promjena funkcija gumba
Upotrijebite funkciju [Project] > [Assignable Button] u izborniku fotoaparata.
Kad promijenite dodjelu, prikaz popisa dodjeljivih gumba se mijenja.
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Pojedinosti o dodjeljivim gumbima pogledajte u odjeljku „Dodjeljivi gumbi” u dijelu „Izbornik
fotoaparata i detaljne postavke”.

[104] Korisne funkcije

Usporeno i ubrzano snimanje

Kada je format snimanja postavljen na sljedeće vrijednosti, broj sličica u sekundi za snimanje i
broja sličica u sekundi za reprodukciju.
Sljedeća tablica prikazuje brzinu sličica koja se može konfigurirati.

Frekvencija sustava: 59.94/50/29.97/25/23.98, način skeniranja pretražnika: FF

Frekvencija sustava: 59.94/50/29.97/25/23.98, način skeniranja pretražnika: S35

Frekvencija sustava: 24, način skeniranja pretražnika: FF

Kodek Format videozapisa Brzina sličica koja se može konfigurirati

RAW 3840×2160P 1 – 60, 100, 120

RAW i XAVC-I 3840×2160P 1 – 60, 100, 120

XAVC-I

4096×2160P 1 – 60

3840×2160P 1 – 60, 100, 120

1920×1080P 1 – 60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1 – 60, 100, 120

1920×1080P 1 – 60, 100, 120, 150, 180, 200, 240

Kodek Format videozapisa Brzina sličica koja se može konfigurirati

XAVC-I 1920×1080P 1 – 60, 100, 120

XAVC-L 1920×1080P 1 – 60, 100, 120
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Note

Način Slow & Quick Motion nije moguće postaviti tijekom snimanja, reprodukcije ili tijekom prikaza
zaslona s minijaturama.

U načinu Slow & Quick Motion snimanje zvuka nije podržano.

Funkcija automatskog fokusiranja, funkcija automatskog irisa i funkcija automatskog zatvarača
onemogućena je u načinu Slow & Quick Motion. Međutim, funkcija automatskog fokusiranja može se
upotrebljavati kada je broj sličica u sekundi postavljen na sljedeće.

Brzina sličica kad je frekvencija sustava postavljena na 59.94/29.97/23.98: 30, 60, 120, 240
Brzina sličica kad je frekvencija sustava postavljena na 50/25: 25, 50, 100, 200

Pojedinosti o upotrebi RAW ulaza pogledajte u odjeljku „Snimanje RAW videozapisa”.

[105] Korisne funkcije

Isprekidano snimanje videozapisa (Interval Rec)

Funkcija Interval Rec (Intervalno snimanje) omogućava vam isprekidano snimanje videozapisa
na unutarnju memoriju jedinice. Funkcija predstavlja učinkovit način snimanja sporih objekata.
Kad započnete snimanje, jedinica automatski snima određeni broj kadrova (broj kadrova) pri
određenom vremenskom intervalu (Interval Time).

A: intervalno snimanje (Interval Time)

Kodek Format videozapisa Brzina sličica koja se može konfigurirati

XAVC-I 4096×2160P 1 – 60
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B: broj kadrova odjednom (Number of Frames)

Note

Različite posebne funkcije snimanja, kao što je Interval Rec, nije moguće primjenjivati istovremeno.

Ako se tijekom primjene funkcije Interval Rec omogući drugi poseban način snimanja, Interval Rec
automatski se otpušta.

Način Interval Rec automatski se otpušta nakon promjena postavki sustava, primjerice formata
videozapisa.

Postavke za Interval Rec nije moguće promijeniti tijekom snimanja, reprodukcije ili tijekom prikaza
zaslona s minijaturama.

Ograničenja tijekom snimanja
Zvuk se ne snima.
Pregled snimke (Rec Review) nije moguć.

Ako je jedinica isključena tijekom snimanja
Ako je prekidač napajanja na jedinici postavljena na stanje pripravnosti, mediju se pristupa
nekoliko sekundi za snimanje fotografija pohranjenih u memoriji sve do tog trenutka, a zatim
se jedinica automatski prebacuje na stanje pripravnosti.
Ako je isključena DC kabel, napajanje se isključuje s adaptera za napajanje izmjeničnom
strujom ili PoE++ dostava napajanja se isključuje, a zatim se snima snimka do trenutka do
kojeg se mogu izgubiti (maksimalno 10 sekundi). Trebate pažljivo postupati.

Postavljanje broja sličica i intervala između snimanja

Postavite [Project] > [Interval Rec] > [Setting] na [On] u web-aplikaciji i postavite [Number of
Frames] i [Interval Time].
Jedinica izlazi iz načina rada Interval Rec (Intervalno snimanje) kad se isključuje, ali postavke
[Number of Frames] i [Interval Time] se zadržavaju. Pri sljedećem snimanju u načinu Interval
Rec nije ih potrebno ponovno postavljati.

Savjet

Također se može postaviti s pomoću funkcija [Project] > [Interval Rec] u izborniku fotoaparata.

Pokretanje snimanja

Pritisnite gumb za snimanje START/STOP za početak snimanja. Izmjenično se pojavljuju „Int?
Rec” i „Int?Stby”.

Prekidanje snimanja
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Prekinite snimanje.
Po završetku snimanja podaci videozapisa, koji su se do tada zapisivali u memoriju, zapisuju se
na medij.
Za izlazak iz načina Interval Rec (Intervalno snimanje) učinite jedno od sljedećeg.

Postavite izvor napajanja jedinice na stanje pripravnosti.
U načinu stanja pripravnosti za snimanje, postavite funkciju [Project] > [Interval Rec] >
[Setting] na [Off].

Također, način Interval Rec (Intervalno snimanje) automatski se otpušta kad se jedinica
ponovno pokrene.

[106] Korisne funkcije

Snimanje fotografija iz predmemorije (Picture Cache
Rec)

Funkcija Picture Cache Rec omogućava vam retroaktivno snimanje videozapisa kad započnete
snimanje održavanjem unutarnje predmemorije određenog trajanja tijekom snimanja.

Postavljanje veličine predmemorije

Postavite funkciju [Project] > [Picture Cache Rec] > [Setting] to [On] u web-izborniku i postavite
veličinu predmemorije s pomoću opcije [Cache Size].

Note

Funkcija Picture Cache Rec ne može se upotrebljavati u kombinaciji s funkcijom Interval Rec,
istovremenim snimanjem u dva utora ili proxy snimanjem. Kad postavite Picture Cache Rec na On
(Uključeno), ostali posebni načini snimanja prisilno se stavljaju na Off (Isključeno).

Postavka [Cache Size] Vrijeme predmemorije (približno)

[Short] 5 sekundi

[Medium] 10 sekundi

[Long] 20 sekundi

[Max] Maksimalna vrijednost za svaki format snimanja
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Način Picture Cache Rec nije moguće odabrati tijekom snimanja ili izvedbe funkcije Rec Review.

Kad je Picture Cache Rec postavljen na On (Uključeno), vremenski kod se snima na način [Free
Run] čak kad postavite na [Regen] ili [Rec Run].

Postavku [Output Format] nije moguće konfigurirati u načinu Picture Cache Rec. Ako se to dogodi,
privremeno isključite Picture Cache Rec postavljanjem na Off, a zatim promijenite postavku.

Savjet

Vrijeme predmemorije može biti kraće ovisno o formatu snimanja. Provjerite prikazano vrijeme u
funkciji [Project] > [Picture Cache Rec] > [Cache Rec Time] u web-izborniku.

Također možete postaviti s pomoću funkcije [Project] > [Picture Cache Rec] u izborniku fotoaparata.

Također možete prebaciti postavku [Picture Cache Rec] na On (Uključeno) i Off (Isključeno) s
pomoću dodjeljivog gumba.

Pokretanje funkcije Picture Cache Rec

Kad je funkcija [Picture Cache Rec] postavljena na On (Uključeno), pojavljuje se „?Cache” (? je
zelene boje).
Kad pritisnete gumb START/STOP, započinje snimanje i upisuje se videozapis na memorijske
kartice koji započinje od pohranjenog videozapisa u predmemoriji.

Note

Promjenom formata snimanja ili osnovnog izgleda briše se videozapis iz predmemorije pohranjenje
do tog trenutka i započinje novi videozapis predmemorije. Stoga je snimanje slika nastalih prije
promjene formata u predmemoriju slika nemoguće, čak i ako snimanje započnete neposredno nakon
promjene formata.

Ako se funkcija Picture Cache Rec postavi na On (Uključeno) ili Off (Isključeno) odmah nakon
umetanja memorijske kartice, podaci predmemorije se možda neće snimiti na karticu.

Videozapis se sprema u predmemoriju kada je funkcija Picture Cache Rec uključena s On.
Videozapisi iz razdoblja prije uključenja funkcije postavljanjem na On ne spremaju se u
predmemoriju.

Videozapisi se ne pohranjuju u predmemoriju tijekom pristupa memorijskoj kartici, primjerice tijekom
reprodukcije, izvođenja funkcije Rec Review ili prikaza zaslona minijatura. Snimanje videozapisa u
predmemoriju slika tijekom tog razdoblja nije moguće.

Otkazivanje funkcije Picture Cache Rec

Postavite funkciju [Project] > [Picture Cache Rec] > [Setting] na [Off] u web-izborniku ili pritisnite
dodjeljivi gumb dodijeljen funkciji [Picture Cache Rec].
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[107] Korisne funkcije

Istovremeno snimanje na memorijsku karticu A i B (2-
slot Simul Rec)

Možete istovremeno snimati na obje memorijske kartica A i B postavljanjem funkcije [Project] >
[Simul Rec] > [Setting] na [On] u web-izborniku ili izborniku fotoaparata.

Zasebno snimanje na memorijsku karticu A i B

Možete pokrenuti/zaustaviti snimanje zasebno na svaku memorijsku karticu s pomoću gumba
za snimanje START/STOP ili gumba [2nd Rec START/STOP] na kartici  (Ostalo).
Tvornički zadano oba su gumba postavljena za pokretanje/zaustavljanje snimanja na obje
kartice, A i B.
Kad su gumbi postavljeni na upravljanje snimanjem za drukčiju memorijsku karticu, snimanje
kontrole pokretanje/zaustavljanje [SDI/HDMI Rec Control] slijedi stanje snimanja utora A.

Promjena postavki

Postavite sljedeće s pomoću funkcija [Project] > [Simul Rec] > [Rec Button Set] u izborniku
fotoaparata.

Postavka
[Rec

Button
Set]

Gumbi i memorijske kartice

Gumb
Rec:
[SlotA
SlotB] 
2. gumb
Rec:
[SlotA
SlotB]

Pokreće/zaustavlja istovremeno snimanje na memorijske kartice A i B s jednim
od gumba.

Gumb
Rec:
[SlotA] 
2. gumb
Rec:
[SlotB]

Gumb snimanja START/STOP pokreće/zaustavlja snimanje na memorijsku
karticu A i gumb [2nd Rec START/STOP] na karticu  (Ostalo)
pokreće/zaustavlja snimanje na memorijsku karticu B.
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[108] Korisne funkcije

Monitor videosignala

Možete postaviti vrstu videosignala za prikaz na ploči fotografija fotoaparata za valni oblik,
vektroskop ili histogram s pomoću funkcije [Monitoring] > [Video Signal Monitor] > [Setting] u
izborniku fotoaparata.
Narančasta linija naznačuje postavljene vrijednosti funkcija [Level Marker 1] i [Level Marker 2].
Također možete dodijeliti funkciju [Video Signal Monitor] dodjeljivom gumbu.

Zaslon za praćenje mete
U načinu Cine EI postavka informacije o prostoru boje ili postavci LUT monitora u gornjem
desnom dijelu monitora za videosignal za prikaz mete nadzora.

[109] Korisne funkcije

Oznake isječaka

Možete dodati oznake isječaka [OK] isječku pritiskom na dodjeljivi gumb dodijeljen funkciji [Clip
Flag OK] i odabirom [Add OK].
Možete obrisati oznaku isječka [OK] dvostrukim pritiskom i odabirom [Delete Clip Flag].

Savjet

Gumb
Rec:
[SlotB] 
2. gumb
Rec:
[SlotA]

Gumb snimanja START/STOP pokreće/zaustavlja snimanje na memorijsku
karticu B i gumb [2nd Rec START/STOP] na kartici  (Ostalo)
pokreće/zaustavlja snimanje na memorijsku karticu A.
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Također možete postaviti oznaku isječka s pomoću funkcija [Thumbnail] > [Set Clip Flag] u izborniku
fotoaparata.

Zaslon minijatura može se prikazati raspodjelom vrste oznake isječka (zaslon minijatura filtriranog
isječka). Pojedinosti pogledajte u odjeljku „Operations on Recorded Clips” u dijelu „Zaslon
minijatura”.

[110] Korisne funkcije

Kompenzacija promjene žarišne duljine

Možete postaviti hoće li se izvršiti kompenzacija promjene žarišne daljine za objektiv s pomoću
funkcije [Technical] > [Lens] > [Breathing Compensation] u izborniku fotoaparata.
Ova funkcija ispravlja fenomen kojim se događaju promjene kuta gledišta kako se razlikuje
položaj fokusa.
Kad se izvrši kompenzacija promjene žarišne duljine, dio se fotografije elektronički obrezuje
kako bi se održao stalni kut gledišta tako da se fenomen promjene žarišne duljine ne pojavljuje.

Note

Kad se omogući kompenzacija promjene žarišne duljine, kut gledišta i kvaliteta fotografija se može
blago promijeniti.

Ovisno o objektivu možda neće biti moguće ispraviti promjenu kuta gledišta kad se omogući
kompenzacija promjene žarišne duljine.

Kompenzacija nije moguća kad objektiv koji ne podržava kompenzaciju promjene žarišne duljine se
pričvrsti.

Ova funkcija se postavlja na Off (Isključeno) (fiksirano) u sljedećim slučajevima.
Kad je funkcija [Technical] > [Lens] > [Distortion Comp.] postavljena na [Off] u izborniku
fotoaparata
Kad je funkcija [Shooting] > [S&Q Motion] > [Setting] postavljena na [On] u web-izborniku ili
izborniku fotoaparata
Kad je funkcija [Project] > [Rec Format] > [Codec] postavljena na [RAW] ili [RAW & XAVC-I] u
web-izborniku ili izborniku fotoaparata

[111] Korisne funkcije Proxy snimanje

Pregled proxy snimanja
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Ova funkcija omogućuje vam da istovremeno snimate proxy podatke niske rezolucije i izvorne
podatke videozapisa u visokoj rezoluciji.

Pojedinosti o podržanim memorijskim karticama, formatiranju memorijskih kartica i provjeri
preostalog kapaciteta pogledajte u odjeljku „Podržane memorijske kartice” u dijelu
„Priprema memorijskih kartica”.

O snimljenoj datoteci
Nastavak naziva datoteke je ".mp4".
Istovremeno se snima i vremenski kod.

Odredište za pohranu snimljene datoteke
Snimljena datoteka sprema se u sljedeći direktorij.

O nazivu datoteke
Naziv datoteke sastoji se od naziva isječka snimljenog na memorijsku karticu i sufiksa
„S03”.
Nazive isječaka pogledajte u odjeljku [TC/Media] > [Clip Name Format] u izborniku
fotoaparata.

[112] Korisne funkcije Proxy snimanje

Snimanje proxyja

Možete pokrenuti snimanje kad se proxy snimanje omogući.

Medij za snimanje Put mape

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

Postavite [Project] > [Proxy Rec] > [Setting] na [On] u web-izborniku ili izborniku
fotoaparata.

1

Umetnite memorijsku karticu u utor kartice CFexpress Type A / SD.

Za kartice CFexpress umetnite ih s oznakom prema gore.
Za SD kartice umetnite s oznakom prema dolje s nakošenim rubom prema dolje.

2
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Prekidanje snimanja
Prekinite snimanje.

Postavljanje kanala zvuka za proxy snimanje
Postavite kanal zvuka za podatke proxy snimanja s pomoću funkcija [Project] > [Proxy Rec] >
[Audio Channel] u izborniku fotoaparata.

[113] Korisne funkcije Snimanje sa željenim izgledom

Pregled izgleda

Kad je jedinica u načinu Custom, možete dodati prilagodbe na crnu boju, matricu i ostale
parametre kako biste izradili „izgled” na temelju osnovnog izgleda.

Note

Funkciju Proxy Rec nije moguće postaviti na On u isto vrijeme kao i funkciju S&Q Motion ili
Interval Rec. Kada se funkcija Proxy Rec uključi postavljanjem na On, ovi drugi načini
snimanja prisilno se isključuju postavljanjem na Off.

Pritisnite gumb za snimanje START/STOP.

Započinje proxy snimanje.

Note

Ako se tijekom pristupa memorijskoj kartici isključi jedinica ili ukloni memorijska kartica, nije
moguće zajamčiti cjelovitost podataka na kartici.
Svi podaci snimljeni na memorijsku karticu mogu biti odbačeni. Uvijek se pobrinite da je
indikator pristupa memorijske kartice isključen prije isključivanja jedinice ili uklanjanja
memorijske kartice.

Provjerite da memorijska kartica ne iskače kad je umećete ili uklanjate.

3
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Možete i brzo odabrati drugačiji izgled spremanjem različitih kombinacija postavki u datotekama
kadra.
Jedinica ima ukupno šest unaprijed postavljenih izgleda.

[114] Korisne funkcije Snimanje sa željenim izgledom

Odabir izgleda

Ova tema opisuje kako se odabere izgled.

Provjerite da je funkcija [Project] > [Base Setting] > [Shooting Mode] postavljena na
[Custom] u web-izborniku ili izborniku fotoaparata.

Savjet

U načinu rada [Custom] gumb [ISO/Gain] i gumb [Scene File] prikazuju se na osnovnoj ploči
konfiguracije fotoaparata.

1

Pritisnite gumb [Scene File] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [Scene File] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe datoteke scene.

2

Pritisnite gumb [Scene File] ploči prilagodbe i odaberite datoteku scene željenog
izgleda s popisa.

Tvornički su postavljene i konfigurirane sljedeće unaprijed postavljene postavke.

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]
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[115] Korisne funkcije Snimanje sa željenim izgledom

Uvoz željenog osnovnog izgleda

Možete uvesti 3D LUT datoteku stvorenu na računalu ili drugom uređaju kao temeljni izgled.
Moguće je uvesti do 16 datoteka.
Format datoteke: CUBE datoteka (*.cube) za 3D LUT datoteku od 17 točaka ili 33 točke s
pomoću aplikacija Catalyst Browse, RAW Viewer ili DaVinci Resolve* (razvila tvrtka Blackmagic
Design Pty. Ltd.).

Ulazni prostor boja / gama: [S-Gamut3.Cine/S-Log3] ili [S-Gamut3/S-Log3]

Savjet

Također možete odabrati izgled s pomoću funkcija [Paint/Look] > [Scene File] > [Recall] u
izborniku fotoaparata. Možete opozvati unaprijed postavljeni izgled s pomoću funkcija [Scene
File] > [Preset Recall].

Datoteka kadra 1 [S-Cinetone] [HLG Live]

Datoteka kadra 2 [Standard] [HLG Natural]

Datoteka kadra 3 [Still] (Nije registrirano

Datoteka kadra 4 [ITU709] (Nije registrirano

Datoteke scena od 5 do 16 (Nije registrirano (Nije registrirano

Provjereno u skladu s Resolve V9.0, V10.0 i V11.0.*

Spremite 3D LUT datoteku na uređaj koji pokreće web-aplikaciju.1

Otvorite [Paint/Look] > [Base Look] u web-izborniku.

Popis registriranih osnovnih izgleda se pojavljuje.

2
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Prilagodba nedovoljne ekspozicije
Ako postoji tendencija za nedovoljnu ekspoziciju kad je odabrana automatska ekspozicija
prilikom upotrebe uvezenog osnovnog izgleda, prilagodite izgled s pomoću funkcija [Paint/Look]
> [Base Look] > [AE Level Offset] u web-izborniku.

Note

Sami uvoz 3D LUT datoteke ne utječe na sliku. Učitajte uvezenu 3D LUT datoteku s pomoću funkcije
[Paint/Look] > [Base Look] > [Select] u izborniku fotoaparata.

Ako funkcija [Input] nije ispravno postavljena, nećete dobiti odgovarajući izgled.

Postavke stavke izbornika [Input], [Output] i [AE Level Offset] primjenjuju se na osnovni izgled

Pritisnite gumb [Import] u red u kojem želite uvesti datoteku.

Pojavljuje se dijaloški okvir odabira datoteke.

3

Odaberite pripremljenu 3D LUT datoteku.

Uvezena 3D LUT datoteka postaje osnovni izgled jedinice.

4

Odaberite uvezenu 3D LUT datoteku s pomoću funkcija [Paint/Look] > [Base Look] >
[Select] u izborniku fotoaparata.

5

Konfigurirajte [Paint/Look] > [Base Look] > [Input] i [Output] u izborniku fotoaparata
kako biste uskladili atribute uvezene 3D LUT datoteku.

6
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odabran s pomoću funkcije [Select]. Ako se uveze više 3D LUT datoteka, odaberite svaku 3D LUT
datoteku s pomoću funkcije [Select] i konfigurirajte s pomoću [Input], [Output] te funkciju [AE Level
Offset] zasebno za svaku datoteku.

Konfigurirane postavke [Input], [Output] i [AE Level Offset] spremljene su za svaku 3D LUT datoteku.

Opcije osnovnog izgleda / LUT odabira za uvezene 3D LUT datoteke zajedničke su funkcijama
[SDR(BT.709)], [HDR(HLG)] i načinima rada Cine EI, ali prostor boje i konverzija game se ne
izvršavaju u skladu s tim načinima rada.

3D LUT datoteke se ne brišu kad je funkcija [Maintenance] > [Reset] > [All Reset (except for Network
Settings)] izvršena u web-izborniku.

[116] Korisne funkcije Snimanje sa željenim izgledom

Prilagođavanje izgleda

Možete prilagoditi izgled na temelju osnovnog izgleda s pomoću klizača [Master Black], [R
Black] i [B Black] na ploči prilagodbe datoteke scene na osnovnoj ploči konfiguracije fotoaparata
te funkcija [Paint/Look] > [Matrix] i ostale stavke postavljanja u izborniku fotoaparata.
Povežite jedinicu s televizorom ili monitorom i namjestite kvalitetu slike dok gledate sliku na
televizoru ili zaslonu monitora.

1: klizač / gumbi prilagodbe [R Black]
2: klizač / gumbi prilagodbe [B Black]
3: klizač / gumbi prilagodbe [Master Black]

Note

Kad uvezete 3D LUT datoteku i primijenite na fotografiju, željeni izgled definiran u 3D LUT datoteki
neće se dobaviti ako funkcije [Paint/Look] > [Matrix] i postavke koje nisu postavke osnovnog izgleda
u izborniku fotoaparata se promijene.

Možete ponovno postaviti sve prilagođene postavke s pomoću funkcije [Paint/Look] > [Reset Paint
Settings] > [Reset without Base Look] u izborniku fotoaparata.
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[117] Korisne funkcije Snimanje sa željenim izgledom

Spremanje izgleda

Možete spremiti trenutni izgled kao datoteku scene u unutarnju memoriju s pomoću funkcije
[Paint/Look] > [Scene File] > [Store] u izborniku fotoaparata.
Možete brzo pozvati spremljeni izgled s pomoću ploče prilagodbe datoteke scene ili s pomoću
rada izravnog izbornika.

Note

Ako odaberete drugi izgled bez spremanja trenutačnog izgleda, trenutačni izgled se odbacuje.

Savjet

Možete prepisati unaprijed postavljene datoteke kadra. Za oporavak unaprijed postavljene datoteke
scene učitajte izgled koji će se oporaviti s pomoću funkcija [Paint/Look] > [Scene File] > [Preset
Recall] u izborniku fotoaparata i zatim spremite datoteku scene s pomoću funkcija [Scene File] >
[Store].

Brisanje spremljenog izgleda
Možete obrisati datoteku scene spremljenu u unutarnju memoriju s pomoću funkcija
[Paint/Look] > [Scene File] > [Delete] u izborniku fotoaparata.

Savjet

Kad se obrišu, više se ne prikazuje na ploči prilagodbe datoteke scene ili izravnom izborniku.

[118] Korisne funkcije Snimanje sa željenim izgledom

Brisanje osnovnog izgleda

Možete obrisati uvezene 3D LUT datoteke zasebno s pomoću [Paint/Look] > [Base Look] >
[Delete] u izborniku fotoaparata.
Možete obrisati sve uvezene 3D LUT datoteke s pomoću [Paint/Look] > [Base Look] > [Delete
All] u izborniku fotoaparata.

Note
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Prije brisanja provjerite da se temeljni izgled ne upotrebljava u bilo kojim datotekama kadra. Ako se
izbriše temeljni izgled koji se upotrebljava, izgled odgovarajućih datoteka kadra neće biti točan.

Uvezene 3D LUT datoteke ne brišu se kad je funkcija [Maintenance] > [Reset] > [All Reset (except
for Network Settings)] izvršena u web-izborniku.

Obrisani osnovni izgled više se ne može upotrebljavati kao LUT u načinu radu Cine EI.

[119] Korisne funkcije Snimanje s prilagodbom izgleda u postprodukciji

Snimanje s prilagodbom izgleda u postprodukciji

Upotrebom jedinice u načinu Cine EI i ravnomjernim snimanjem gradacija od tamnih područja
do svijetlih možete učiniti fine izmjene, poput lokalnog obnavljanja gradacije tamnih i svijetlih
područja u postprodukciji.
Međutim, kada gledate snimljene slike na konvencionalnom monitoru, cjelokupni kontrast bit će
nizak zbog čega će namještanje fokusa i ekspozicije biti teže.
Možete primijeniti LUT na metu praćenja na jedinici kako bi vam pomogao pri raznim
prilagodbama tijekom snimanja. LUT možete primijeniti i na reprodukciju videozapisa kako biste
provjerili konačan rezultat.
LUT-ove primjenjuju sljedeći sustavi. Međutim, moguće je primijeniti samo jedan LUT.

SDI izlaz
HDMI izlaz i usmjeravanje
Proxy isječak se snima na mediju za snimanje
Isječak visoke razlučivosti (glavni) snima se na mediju za snimanje

[120] Korisne funkcije Snimanje s prilagodbom izgleda u postprodukciji

Primjena LUT-a na HDMI izlaz i usmjeravanje

Možete primijeniti LUT na HDMI izlaz i usmjeravanje.

Provjerite da su funkcije [Project] > [Base Setting] > [Shooting Mode] postavljene na
[Cine EI] u web-izborniku ili izborniku fotoaparata.

Savjet

U načinu [Cine EI] gumb [Base ISO/Exposure Index] i gumb [Base Look/LUT] prikazani su na
osnovnoj ploči konfiguracije fotoaparata.

1
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Note

Fotografija na ploči fotografija fotoaparata web-aplikacije također je uključena na fotografiji koja se
usmjerava.

Savjet

Ovo također možete postaviti s pomoću funkcija [Shooting] > [LUT On/Off] > [HDMI/Stream] u
izborniku fotoaparata.

SDI izlaz može se postaviti na jednak način.

Za videozapise na mediju za snimanje ovo možete postaviti s pomoću funkcija [Shooting] > [LUT
On/Off] > [Internal Rec] i [Proxy] u izborniku fotoaparata.

[121] Korisne funkcije Snimanje s prilagodbom izgleda u postprodukciji

Promjena LUT-a

Možete promijeniti LUT za primjenu.

Pritisnite gumb [Base Look/LUT] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [Base Look/LUT] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe osnovnog izgleda / LUT-a.

2

Odaberite [HDMI/Stream] > [MLUT].3

Pritisnite gumb [Base Look/LUT] na osnovnoj ploči konfiguracije fotoaparata.1
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Savjet

Jedinica omogućava [s709], [709(800%)] i [S-Log3] kao unaprijed postavljene LUT-ove.

Također možete uvesti i primijeniti 3D LUT datoteku. Pojedinosti pogledajte u odjeljku „Uvoz željenog
osnovnog izgleda” i „Brisanje osnovnog izgleda”.

Ovo se također može postaviti s pomoću opcija [Paint/Look] > [Base Look] > [Select] u izborniku
fotoaparata.

[122] Korisne funkcije Snimanje s prilagodbom izgleda u postprodukciji

Promjena distribucije tamnih i svijetlih područja na
snimljenoj fotografiji

Možete promijeniti distribuciju tamnih i svijetlih područja, primjerice, ako želite prioritet dati tonu
tamnih područja u odnosu na svijetla područja promjenom funkcije Exposure Index iz osnovne
osjetljivosti.

Okvir gumba [Base Look/LUT] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe osnovnog izgleda / LUT-a.

Pritisnite gumb [Base Look/LUT] i odaberite osnovni izgled za primjenu.2

Pritisnite gumb [Base Look/LUT] na osnovnoj ploči konfiguracije fotoaparata.

Okvir gumba [Base Look/LUT] mijenja se u narančastu boju.

1
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Savjet

Ovo se također može postaviti s pomoću [Shooting] > [ISO/Gain/EI] > [Exposure Index] u izborniku
fotoaparata.

Pojavljuje se ploča prilagodbe osnovnog izgleda / LUT-a.

Odaberite [HDMI/Stream] > [MLUT].

LUT se primjenjuje na HDMI izlaz i usmjeravanje.

2

Pritisnite gumb [Base ISO/Exposure Index] na osnovnoj ploči konfiguracije
fotoaparata.

Okvir gumba [Base ISO/Exposure Index] mijenja se u narančastu boju.

Pojavljuje se ploča prilagodbe osnovnog ISO-a / indeksa ekspozicije.

3

Prilagodite indeks ekspozicije u skladu sa željenom distribucijom tamnih i svijetlih
područja s pomoću klizača [Exposure Index] ili gumba prilagodbe [Exposure Index].

4

Prilagodite svjetlost i/ili ND filtar tako da emitirana fotografija s [HDMI/Stream] ima
primjerenu ekspoziciju.

5
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SDI izlaz upotrebljava se na jednak način.

Druga numerička vrijednost postavke navodi koliko je koraka informacija o svjetlini dodijeljeno za
svijetla područja (svjetlina viša od 18 % sive boje). Područja svjetlija od ovih imaju prejaku
ekspoziciju.
Primjer: u „400EI/5.0E”, koraci od 5,0 dodjeljuju se svijetloj strani.

To možete upotrebljavati i kao vodič za provjeru tona tamnih i svijetlih područja tijekom snimanja.
Zapamtite da trebate vratiti izvornu EI vrijednost nakon provjere ekspozicije.

[123] Korisne funkcije RAW snimanje

Snimanje RAW videozapisa

Možete snimiti izlazni RAW videosignal s SDI OUT priključka jedinice na podržani vanjski
snimač.
Podržani RAW izlazni formati prikazani su u nastavku.

Frekvencija sustava [Codec] [RAW Output Format]

59,94 / 50 / 29,97 / 25 / 23,98

RAW 4096×2160

RAW 3840 × 2160

RAW i XAVC-I 4096×2160

RAW i XAVC-I 3840 × 2160

24
RAW 4096×2160

RAW i XAVC-I 4096×2160

Priključite vanjski RAW snimač na SDI OUT priključak jedinice.1

Postavite funkciju [Project] > [Base Setting] > [Shooting Mode] na [Cine EI] u web-
izborniku ili izborniku fotoaparata.

2

Postavite kut gledišta (samo FF) s pomoću funkcija [Project] > [Rec Format] >
[Imager Scan Mode] u web-izborniku ili izborniku fotoaparata.

3
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Note

Kad se započne snimanje na vanjskom snimaču bez upotrebe gumba snimanja START/STOP na
zaslonu rada uživo, isječci se možda neće ispravno snimiti.

[124] Korisne funkcije RAW snimanje

Snimanje RAW videozapisa u usporenom i ubrzanom

Postavite funkciju [Project] > [Rec Format] > [Codec] na [RAW] u web-izborniku ili
izborniku fotoaparata.

Odabirom funkcije [RAW&XAVC-I] istovremeno će se snimati videozapis na vanjskom
RAW snimaču i videozapis na memorijsku karticu jedinice.

4

Postavite razlučivost s pomoću funkcije [Project] > [Rec Format] > [RAW Output
Format] u web-izborniku ili izborniku fotoaparata.

5

Provjerite da je vanjski snimač uključen, a zatim pritisnite gumb snimanja
START/STOP na zaslonu rada uživo.

Status snimanja RAW videozapisa naveden je ikonom na ploči fotografija fotoaparata.

Note

Signal kontrole snimanja emitira se na SDI OUT priključku jedinice, ali nije moguće primiti
status vanjskog snimača. Sukladno tome jedinica može navoditi snimanje RAW videozapisa
da je u tijeku dok vanjski snimač zapravo ne snima. Provjerite indikatore na vanjskom snimaču
kako biste dobili točan status rada.

6
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snimanju

Možete snimiti RAW videozapis u načinu usporenog i ubrzanog snimanja.

Pojedinosti o podržanim brzinama sličica za snimanje pogledajte u odjeljku „Usporeno i
ubrzano snimanje”.

[125] Korisne funkcije Prilagodba zamućenja (Bokeh Control Function)

Uključivanje/isključivanje funkcije zamućivanja

Jednostavno možete prilagoditi stupanj zamućivanja povezivanjem ND filtra i jačine signala na
rad blende.

Uključivanje/isključivanje funkcije zamućivanja

Ova se funkcija može omogućiti samo kad se ekspozicija ručno prilagođava. Postavite ND filtar
na varijabilni način rada, a zatim postavite blendu, jačinu signala, zatvarač i ND filtar na ručnu
prilagodbu.
Možete uključiti/isključiti funkciju zamućivanja s pomoću opcija [Shooting] > [Iris] > [Bokeh
Control] u izborniku fotoaparata.
Kad je funkcija zamućivanja uključena, prikazuje se ikona  (B) na indikatorima ND filtra i
jačine signala.

Note

Ova se funkcija omogućava samo na objektivima E-mount koji komuniciraju s jedinicom.

Maksimalni učinak ove funkcije može se dobiti s pomoću objektiva E-mount tvrtke Sony.

Također možete dodijeliti funkciju [Bokeh Control] dodjeljivom gumbu i uključivati te isključivati
funkciju zamućivanja s pomoću gumba.

Funkcija zamućivanja postavlja se na isključeno kad je jedna od sljedećih radnji izvršena.
Kad je jedinica isključena
Kad je blenda, jačina signala, zatvarač ili ND filtar postavljen na Automatski
Kad je način snimanja prebačen
Kad je ND filtar postavljen na jasni način te unaprijed postavljeni način
Kada je objektiv uklonjen
Kad se jedinica pokrene, na primjer nakon promjene frekvencije
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[126] Korisne funkcije Prilagodba zamućivanja (Bokeh Control Function)

Prilagodba stupnja zamućivanja

Note

Izgled se može razlikovati ovisno o brzini rada, objektivu, postavki snimanja i subjektu te također se
može promijeniti svjetlina. Preporuča se izvršavanje testa fotoaparata prije snimanja.

Svjetlina se može promijeniti kad se smjer rada blende promijeni, poput toga kad se otvara blenda
nakon zatvaranja ili kad se zatvara blenda nakon otvaranja. U tom slučaju blago unaprijed prilagodite
više nego što je potrebno, a zatim se malo udaljite, promijenite svjetlinu i onda počnite snimati. Na
primjer, ako želite otvoriti blendu na F8 otvor blende i zamutiti pozadinu, prvo zatvorite otvor blende
nakon F8 i zatim se vratite na F8, provjerite svjetlinu i počnite snimati.

Polako izvršite rad upravljanja zamućenosti. Ako trebate ubrzati rad, pokušajte postupno prilagoditi
dok provjeravate promjene na fotografiji.

Savjet

Kad je funkcija zamućivanja uključena, ND filtar i jačina signala rade zajedno za promjenu pomaka u
ekspoziciji zbog prilagodbe blende, što vam omogućava da promijenite stupanj zamućenosti.

Upravljanje zamućivanjem prvo je povezano s ND filtrom kao reakcija na rad blende. Kad se ND filtar
više ne može promijeniti, jačina je signala povezana.

U MF načinu preporuča se da prvo otvorite blendu, a zatim prilagodite fokus.

Ako upotrebljavate automatski ND filtar umjesto funkcije zamućivanja, ND filtar slijedi promjene
svjetline subjekta.

Prikaz tijekom rada povezivanja jačine signala
Kad je funkcija zamućivanja uključena, jačina se signala može promijeniti kako se blenda
prilagođava.
Kad je povezivanje jačine signala aktivno i on se promijeni, pojavljuje se poruka na vrhu zaslona

Postavite funkciju zamućivanja na uključeno.1

Prilagodite ND filtar i jačinu signala kako biste odredili ekspoziciju.2

Podešavanje blende.

Mijenja se stupanj zamućivanja.

3
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i ikona  (B) na indikatoru jačine signala treperi.

[127] Korisne funkcije Spremanje i učitavanje podataka za konfiguraciju

Pregled spremanja i učitavanja podataka za
konfiguraciju

Možete spremiti postavke jedinice kao podatke za konfiguraciju s pomoću web-aplikacije. To
omogućuje brzo pozivanje odgovarajućeg kompleta postavki za trenutačnu situaciju.
S ovom jedinicom možete spremiti gotovo sve postavke povezane s funkcijama fotoaparata,
osim sljedeće napomene, kao ALL datoteke (datoteka sa svim postavkama).

Note

Postavke mrežne funkcije i informacije o autentifikaciji se ne spremaju. Pojedinosti o spremljenim
stavkama pogledajte u odjeljku „Popis stavki izbornika”.

[128] Korisne funkcije Spremanje i učitavanje podataka za konfiguraciju

Spremanje ALL datoteke

Ova tema opisuje kako spremiti ALL datoteku.

[129] Korisne funkcije Spremanje i učitavanje podataka za konfiguraciju

Otvorite [Project] > [All File] u web-izborniku.1

Pritisnite gumb [Save All File] > [Save].

Web-preglednik preuzet će datoteku pod imenom all-file.ALL.

2

Odredite lokaciju i naziv datoteke za preuzetu datoteku all-file.ALL te spremite
datoteku.

Pojedinosti o radu datoteka pogledajte u uputama za rad uređaja.

3
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Učitavanje ALL datoteke

Ova tema opisuje kako učitati ALL datoteku.

Note

Nakon učitavanja podataka za konfiguraciju jedinica se automatski ponovno pokreće. Nakon
ponovnog pokretanja, ponovno učitajte web-preglednik.

[130] Mrežne funkcije Prijenos datoteka

O prijenosu datoteka

Možete učitati proxy datoteku ili izvornu datoteku koja je snimljena na jedinici na poslužitelju na
internetu ili na poslužitelju na lokalnoj mreži.

Note

Kad je izvor napajanja u stanju pripravnosti, prijenosi datoteka stavljeni su na čekanje iako se
jedinica i dalje napaja.

Otvorite [Project] > [All File] u web-izborniku.1

Pritisnite gumb [Load All File] > [Load].

Pojavljuje se otvoreni dijaloški okvir datoteke na uređaju koji pokreće web-aplikaciju.

2

Otvorite datoteku koju želite učitati.

Pojedinosti o radu datoteka pogledajte u uputama za rad uređaja.

3

Kad se pojavi zaslon potvrde naziva učitane datoteke, pritisnite gumb [OK].4

Kad se pojavi zaslon rezultata izvršavanja, pritisnite gumb [OK].5

Pričekajte da se jedinica ponovno pokrene, a zatim ponovno povežite web-
aplikaciju.

6
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[131] Mrežne funkcije Prijenos datoteka

Registracija odredišta za prijenos datoteke

Možete registrirati poslužitelj odredišta prijenosa prije početka prijenosa datoteke.

Odaberite [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1]
(ili [Server Settings2], [Server Settings3]) u web-izborniku.

Savjet

Naziv odabrane opcije promijenit će se u skladu s konfiguriranom funkcijom [Display Name] u
sljedećem koraku.

1

Konfigurirajte sljedeće stavke za [Network] > [FTP Server 1] na [FTP Server 3] u
web-izborniku.

[Display Name]
Unesite naziv poslužitelja za prikaz u popisu prijenosa kad odabirete poslužitelj odredišta
prijenosa.
[Service]
Prikazuje vrstu poslužitelja.
[FTP]: FTP poslužitelj
[Host Name]
Unesite adresu ili naziv domaćina poslužitelja.
[Port]
Unesite broj ulaza na koji se priključuje poslužitelj.
[User Name]
Unesite korisničko ime.
[Password]
Unesite lozinku.
[Passive Mode]
Uključite/isključite pasivni način rada.
[Destination Directory]
Unesite naziv mape na odredišnom poslužitelju.

Note

Ako pod [Destination Directory] unesete znakove koji nisu valjani na odredišnom poslužitelju,
datoteke se prenose u početnu mapu korisnika. Znakovi koji nisu valjani razlikuju se ovisno o
poslužitelju.

2
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[132] Mrežne funkcije Prijenos datoteka Odabir datoteke i učitavanje

Učitavanje proxy datoteke na memorijsku karticu sa
zaslona minijatura

Možete zasebno učitati proxy datoteke na memorijsku karticu sa zaslona minijatura.

[Using Secure Protocol]
Postavite hoće li izvršiti sigurni FTP prijenos.
[Root Certificate]
Učitavanje/brisanje certifikata.
[Load]: učitajte CA certifikat. Učitava certifikate formata PEM.
[Clear]: obrišite CA certifikat.
[None]: nemojte učitati ili obrisati certifikat.

Note

Postavite sat jedinice na ispravno vrijeme prije učitavanja CA certifikata.

Pri snimanju u formatu XAVC-I 4096×2160P/3840×2160P 59.94/50P, [Load] nije moguće
odabrati.

[Root Certificate Status]: prikazuje status učitavanja certifikata.
[Reset]: ponovno postavlja postavke poslužitelja na zadane postavke.

Pritisnite gumb [Thumbnail] na zaslonu rada uživo web-aplikacije.

Zaslon se mijenja s fotografije na zaslon minijature.

1

Odaberite [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] u izborniku
fotoaparata.

Kako biste istovremeno prenijeli sve proxy datoteke, odaberite [Transfer Clip (Proxy)] > [All
Clips].
Isječke je moguće prenositi sa zaslona s minijaturama ili zaslona s minijaturama filtriranih
isječaka.

2

Odaberite isječak koji želite prenijeti s pomoću gumba [Set] i pritisnite gumb [Menu].3
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Note

Moguće je registrirati do 200 zadataka prijenosa.

[133] Mrežne funkcije Prijenos datoteka Odabir datoteke i učitavanje

Učitavanje izvorne datoteke na memorijsku karticu sa
zaslona minijatura

Možete učitati izvornu datoteku na memorijsku karticu sa zaslona minijatura.

Na zaslonu se prikazuje potvrda za prijenos.

Odaberite [Execute].

Datoteka proxy koja odgovara odabranom isječku registrira se kao zadatak prijenosa i
započinje prijenos.
Po uspješnoj registraciji zadatka prijenosa prikazuje se zaslon s rezultatima prijenosa.

4

Pritisnite gumb [OK].5

Pritisnite gumb [Thumbnail] na zaslonu rada uživo web-aplikacije.

Zaslon se mijenja s fotografije na zaslon minijature.

1

Odaberite [Thumbnail] > [Transfer Clip] > [Select Clip] na izborniku fotoaparata.

Kako biste istovremeno prenijeli sve izvorne datoteke, odaberite [Transfer Clip] > [All
Clips].
Isječke je moguće prenositi sa zaslona s minijaturama ili zaslona s minijaturama filtriranih
isječaka.

2

Odaberite isječak koji želite prenijeti s pomoću gumba [Set] i pritisnite gumb [Menu].

Na zaslonu se prikazuje potvrda za prijenos.

3

Odaberite [Execute].4
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Note

Moguće je registrirati do 200 zadataka prijenosa.

[134] Mrežne funkcije Prijenos datoteka Odabir datoteke i učitavanje

Provjera statusa prijenosa datoteke

Možete provjeriti status prijenosa datoteke odabirom [Network] > [File Transfer] > [View Job
List] u izborniku fotoaparata.

Note

Moguće je registrirati do 200 zadataka prijenosa.

Prijenosi se zadržavaju kad se jedinica prebaci na stanje pripravnosti, ali najviše se 10 minuta
nedavnih informacija o napretku može izgubiti ako se isključi napajanje bilo kojim drugim načinom.

Ako se dogodi pogreška tijekom prijenosa datoteka, prijenos isječka s istim nazivom kao i preneseni
isječak neće se nastaviti ovisno o postavkama i statusu poslužitelja odredišta prijenosa. U tom
slučaju provjerite postavke i status poslužitelja odredišta prijenosa.

Savjet

Ako je funkcija [Network] > [File Transfer] > [Auto Upload (Proxy)] postavljena na [On] u izborniku
fotoaparata i postoji mrežna veza, proxy datoteke automatski se učitavaju na određeni poslužitelj s
pomoću funkcija [Default Upload Server] kad snimanje započne.

[135] Mrežne funkcije Prijenos datoteka

Učitavanje s pomoću sigurnog protokola FTP

Primjenom funkcije FTPS u načinu Explicit (FTPES) za vezu s odredišnim podatkovnim

Izvorna datoteka odabranog isječka registrira se kao prijenos, a zatim počinje učitavanje.
Po uspješnoj registraciji zadatka prijenosa prikazuje se zaslon s rezultatima prijenosa.

Pritisnite gumb [OK].5
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poslužiteljem možete prenositi šifrirane datoteke.
Za sigurni FTP prijenos postavite funkciju [Using Secure Protocol] na [On] u postavkama
poslužitelja datoteke odredišta i učitajte certifikat.

Pojedinosti po konfiguraciji pogledajte u odjeljku „Registracija odredišta za prijenos
datoteke”.

[136] Mrežne funkcije Konfiguracija usmjeravanja

O usmjeravanju

Jedinica može istovremeno usmjeravati videozapis i zvuk koji se emitira s HDMI priključka.

Note

Kako biste upotrijebili usmjeravanje kao glavni videozapis, postavite funkciju [Monitoring] > [Output
Display] > [SDI] na [On] i [HDMI/Stream] na [Off] u web-izborniku i nadzirite status fotoaparata na
SDI monitoru.

Ako monitor povezan HDMI priključkom ne podržava format HDMI izlaza konfiguriranog s pomoću
izbornika [Monitoring] u web-izborniku ili izborniku fotoaparata, fotografija fotoaparata neće se
emitirati na web-aplikaciju. Također se ne može emitirati usmjeravanje videozapisa.

Razlučivost usmjeravanja ne može se postaviti više nego što je razlučivost signala HDMI izlaza.

Kad gleda više korisnika, slika može postati izobličena ovisno o postavkama kodeka.

Jedinica podržava sljedeće metode usmjeravanja. Dostupni kodeki videozapisa za odabir
prikazani su zagradama.

RTSP (H.264, H.265)
SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Konfigurirajte postavku formata usmjeravanja, postavku kodeka videozapisa i postavku kodeka
zvuka ovim redoslijedom.

Format
usmjeravanja

Postavka kodeka

Usmjeravanje
videozapisa 1

Usmjeravanje
videozapisa 2

Usmjeravanje
videozapisa 3

Usmjeravanje
zvuka

? ? 
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?: omogućeno, –: onemogućeno

Savjet

fotografija na ploči fotografija fotoaparata web-aplikacije također je sustav usmjeravanja.

[137] Mrežne funkcije Konfiguracija usmjeravanja

Postavljanje formata usmjeravanja

Postavite format usmjeravanja s pomoću funkcije [Stream] > [Stream] > [Stream Setting] >
[Setting] u web-izborniku.

Kad je funkcija [Setting] postavljena na [RTSP]

Tijekom RTSP usmjeravanja fotografiju s jednog fotoaparata može istovremeno pregledati
najviše pet korisnika.
Možete postaviti najviše dva načina kodeka videozapisa.
[Port Number]
Postavlja broj priključka za upotrebu RTSP usmjeravanja. Zadana vrijednost je 554.
Promjenom postavke ponovno će se pokrenuti RTSP poslužitelj.
[Time Out]
Određuje vrijeme isteka komande Keep-Alive za RTSP usmjeravanje. Vrijeme isteka može se
postaviti u rasponu od 0 sekundi do 600 sekundi. Zadana je vrijednost 60 sekundi.
Kad se postavi na 0 sekundi, ne događa se istek zbog komande Keep-Alive.
[Authentication]
Postavlja je li autentifikacija potrebna.
[Video Port Number 1], [Video Port Number 2]
Određuje broj priključka komunikacije podataka fotografija za upotrebu jednoodredišnog
usmjeravanja. Vrijednost zadane postavke za Video Port Number 1 je 51 000. Vrijednost
zadane postavke za Video Port Number 2 je 53 000. Odredite parni broj u rasponu od 1024 do

RTSP
videozapis 1 videozapis 2

– ?

SRT ? – – ?

NDI|HX
? 
Glavni

? 
Pod

– ?

Web-
aplikacija

– – ? –
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65 634. Broj koji je postavljen ovdje i sljedeći neparni broj, koji se dobiva dodavanjem jednog,
postaju dva broja priključka koji se upotrebljavaju za komunikaciju i kontrolu podataka
fotografija.
[Video Port Number 1] i [Video Port Number 2] odgovaraju funkcijama [Stream] > [Video
Stream] > [Video Stream 1] i [Video Stream 2].
[Audio Port Number]
Određuje broj priključka komunikacija podataka zvuka za upotrebu jednoodredišnog snimanja.
Zadana vrijednost je 57000. Odredite parni broj u rasponu od 1024 do 65 634. Broj koji je
postavljen ovdje i sljedeći neparni broj, koji se dobiva dodavanjem jednog, postaju dva broja
priključka koji se upotrebljavaju za komunikaciju i kontrolu podataka zvuka.

Kad je funkcija [Setting] postavljena na [SRT-Caller] ili [SRT-Listener]

Način kodeka videozapisa je samo H.264.
[Destination]
Prikazuje se kad je način usmjeravanja postavljen na [SRT-Caller]. Postavlja odredište veze
URL-a.
[Port Number]
Prikazuje se kad način usmjeravanja postavljen na [SRT-Listener]. Postavlja broj priključka koji
će se slušati. Zadana vrijednost je 4201.
[Latency]
Postavlja latentnost u rasponu od 20 ms do 8000 ms. Zadana vrijednost je 120.
[TTL]
Postavlja TTL vrijednost u rasponu od 1 do 255. Zadana vrijednost je 64.
[Encryption]
Postavlja metodu šifriranja. Odaberite isključeno, AES128 ili AES256. Zadana je vrijednost
isključeno.
[Passphrase]
Postavlja pristupni izraz za šifriranje. Pritiskom na gumb [Reset] ponovno će se postaviti
konfigurirani izraz za šifriranje.
[ARC]
Kako biste omogućili funkciju kontrole adaptivne brzine, postavite je na uključeno.
Kad se omogući funkcija kontrole adaptivne brzine, mogu se smanjiti prekidi fotografija koje
uzrokuje zagušenje linije komunikacije.

Kad je funkcija [Setting] postavljena na [NDI|HX]

Jedinica je u skladu s verzijom 2 NDI|HX od NewTek.
Za upotrebu NDI|HX mora se kupiti licencirani ključ.
Kupnja licenciranog ključa
Kupite na sljedećem URL-u tvrtke NewTek.
http://new.tk/ndi_sony

Note
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Preuzmite najnoviji pogon NDI|HX i instalirajte ga u NewTek proizvod.

Pojedinosti o registraciji pogona NDI|HX i radu pogledajte upute za rad NewTek proizvoda.

[License]
Prikazuje informacije o licenci za omogućenu licencu.
[Source Name]
Prikazuje naziv izvora.
[Group]
Za omogućavanje NDI funkcije grupiranja postavite na uključeno.
[Group Name]: postavlja NDI naziv grupe. Više se postavki može konfigurirati zasebno
zarezom.
[Discovery Server 1], [Discovery Server 2]
Postavlja Ndi poslužitelj otkrivanja 1 i NDI poslužitelj otkrivanja 2.
[Reliable UDP Mode]
Za omogućavanje pouzdanog UDP načina postavite na uključeno.
[Multicast Mode]
Za omogućavanje višestrukog usmjeravanja postavite na uključeno.
[Multicast Prefix]: postavlja prefiks za upotrebu za višestruko usmjeravanje.
[Multicast Netmask]: postavlja mrežnu masku koja određuje raspon adresa višestrukog
usmjeravanja.
[Multicast TTL]: postavlja TTL vrijednost za višestruko usmjeravanje u rasponu od 1 do 256.
Zadana vrijednost je 3.
[Multi-TCP Mode]
Za omogućavanje Multi-TCP načina postavite na uključeno.
[Unicast UDP Mode]
Za omogućavanje Unicast UDP načina postavite na uključeno.

O uslugama trećih strana i softveru
Mogu se primjenjivati drukčiji uvjeti.

Pružanje usluga i ažuriranja softvera mogu se prekinuti ili ukinuti bez prethodne obavijesti.
Opis usluga i softvera podložan je promjeni bez prethodne obavijesti.
Zasebna registracija i prijava će možda biti potrebna.

Tvrtka Sony nije odgovorna za bilo kakve odštetne zahtjeve koje podnesu korisnici ili treća
strana za upotrebu usluga i softvera drugih tvrtki.

[138] Mrežne funkcije Konfiguracija usmjeravanja

Postavljanje kodeka videozapisa za usmjeravanje
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Postavite kodek videozapisa s pomoću funkcije [Stream] > [Video Stream] u web-izborniku.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Možete postaviti do tri načina rada kodeka za fotografije. Konfigurirajte sljedeće postavke
zasebno za svaki način fotografija.
[Video Stream 3] se upotrebljava za prikaz ploče fotografija fotoaparata web-aplikacije.

Note

Kad je funkcija [Stream] > [Stream Setting] > [Setting] postavljena na [SRT-Caller] ili [SRT-Listener],
neke od postavki [Video Stream 1], [Video Stream 2] i [Video Stream 3] postavke ([Codec], [Size],
[Frame Rate], [Bit Rate Compression Mode]) imaju zadane vrijednosti.

[Codec 1], [Codec 2], [Codec 3]
Odaberite [H.264], [H.265] ili [Off]. Imajte na umu da se [Codec 1] ne može postaviti na [Off].
Također je [Codec 3] postavljen na [JPEG] (fiksno).

Note

Sljedeći se simptomi mogu pojaviti ovisno o kombinaciji različitih postavki, poput veličine fotografije,
brzine sličica i brzine bitova funkcija [Codec 1], [Codec 2] i [Codec 3].

Povećana latentnost videozapisa.
Preskakanje kadrova tijekom reprodukcije videozapisa.
Isprekidani zvuk.
Spor odziv fotoaparata na različite komande.
Spor odziv fotoaparata na radnje s daljinskog upravljača.
Spor prikaz zaslona monitora i rad konfiguracije.

Ako iskusite neke od tih simptoma, smanjite vrijednosti parametara veličine slike, brzine sličica i
brzine bitova ili promijeniti vrijednosti ostalih postavki kako biste riješili problem.

Kad je funkcija [Stream] > [Stream Setting] > [Setting] postavljena na [SRT-Caller] ili [SRT-Listener],
[Codec 1] je postavljen na [H.264] (fiksno). [Codec 2] je postavljen na [Off] (fiksno).

Kad je veličina slike ili frekvencija sustava HDMI izlaza promijenjena, [Codec 2] je postavljen na [Off].

[Size 1], [Size 2], [Size 3]
Odabire veličinu slike za usmjeravanje s fotoaparata.
Dostupne opcije veličine slike razlikovat će se ovisno o veličini slike HDMI izlaza.

Note

Kad se veličina slike ili frekvencija sustava HDMI izlaza promijeni, odabrat će se maksimalna veličina
slike.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Postavlja brzinu sličica za fotografiju.
Jedinice „fps” označavaju broj kadrova usmjerenih po sekundi.
Dostupne opcije brzine sličica razlikovat će se ovisno o veličini slike HDMI izlaza.

Note

Kad se veličina slike ili frekvencija sustava HDMI izlaza promijeni, odabrat će se maksimalna brzina
sličica.

[I-Picture Mode 1], [I-Picture Mode 2]
Postavlja metodu za određivanje intervala umetanja I-slike za H.264 i H.265 na [Time] ili
[Frame].
Ne može se postaviti za [Codec 3].
[Time]: postavlja interval umetanja I-slike kao vrijeme.
[Frame]: postavlja interval umetanja I-slike kao broj kadrova.
[I-Picture Interval 1], [I-Picture Interval 2]
Postavlja interval umetanja I-slike u jedinici sekunde. Postavlja vrijednost raspona od 1 sekunde
od 5 sekundi. Zadana je vrijednost 1 sekunda.
Ne može se postaviti za [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Postavlja interval umetanja I-slike za H.264 i H.265 kao broj kadrova u rasponu od 15 do 300.
Zadana je vrijednost 300 kadrova.
Ne može se postaviti za [Codec 3].
[Profile 1], [Profile 2]
Postavlja profil kodeka fotografije H.264 i H.265.
[H.264]: Odaberite profil [high], [main] ili [baseline].
[H.265]: Odaberite profil [main] ili [main10]. Kad se omoguće dva kodeka videozapisa, samo je
dostupna opcija odabira profila [main].
Učinkovitost kompresije fotografije povećavanja se redoslijedom [high], [main] i [baseline].
Odaberite profil koji podržava vaš sustav.
Kad je funkcija [H.265] postavljena na [main10], rad je u [main10] kad je HDMI izlaz YCrCb ili
[main] kad je HDMI izlaz RGB.
Ne može se postaviti za [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Odaberite [CBR] ili [VBR].
Za održavanje stalne brzine bitova odaberite [CBR]. Za održavanje kvalitete slike odaberite
[VBR].
Ne može se postaviti za [Codec 3].

Note

Brzina sličica i brzina bitova koja se zapravo usmjerava može se razlikovati od postavljenih
vrijednosti ovisno o veličini slike, sceni snimanja, mrežnom okruženju i ostalim čimbenicima.
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Kad je funkcija [Stream] > [Stream Setting] > [Setting] postavljena na [SRT-Caller] ili [SRT-Listener],
[Bit Rate Compression Mode 1] je postavljen na [CBR] (fixed).

[Bit Rate 1], [Bit Rate 2]
Možete postaviti brzinu bitova po usmjeravanju videozapisa kad je funkcija [Bit Rate
Compression Mode] postavljena na [CBR]. Postavljanje visoke brzine bitova omogućava vam
da usmjeravate videozapise visoke kvalitete.
Ne može se postaviti za [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Postavlja kvalitetu slike u rasponu od 1 do 10. Vrijednost 10 postavlja najveću kvalitetu slike.
Zadana vrijednost je 6.
Za funkcije [Quality 1] i [Quality 2], možete postaviti kvalitetu slike H.264 postavljanjem opcije
[Bit Rate Compression Mode] na [VBR] i [Codec] na [H.264]. Možete postaviti kvalitetu slike
H.265 postavljanjem funkcije [Bit Rate Compression Mode] na [VBR] i [Codec] na [H.265].

[139] Mrežne funkcije Konfiguracija usmjeravanja

Postavljanje kodeka zvuka za usmjeravanje

Postavite kodek zvuka s pomoću funkcije [Stream] > [Audio Stream] u web-izborniku.
[Setting]
Za omogućavanje usmjeravanja zvuka postavite na uključeno.
[Codec]
Odabire vrstu kodeka koji će se upotrebljavati za usmjeravanje zvuka.
[AAC (256kbps)]: odaberite kako biste dali prioritet kvaliteti zvuka.
[AAC (128kbps)]: odaberite kako biste dali prioritet kapacitetu podataka.
Ova postavka nema nikakav učinak isječak koji snima jedinica ili na signal zvuka uključen u
HDMI/SDI signalu.

[140] Mrežne funkcije Konfiguracija usmjeravanja

Pokretanje/zaustavljanje usmjeravanja

Za [RTSP], [SRT-Listener] i [NDI|HX]

Jedinica čeka zahtjev za dostavu usmjeravanja.
Pokrenite aplikaciju za klijenta za pregled usmjeravanja i pristup URL-u prikazanom na sljedećoj
tablici.
Unesite vrijednosti za korisničko ime i lozinku koji su konfigurirani na jedinici.
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<camera_address>: IP adresa jedinice
<Port>: priključak slušanja konfiguriran s pomoću funkcije [Port Number]

Primjer RTSP usmjeravanja
Najviše dva usmjeravanja mogu se omogućiti na jedinici. URL svakog usmjeravanja je kako je
prikazan u nastavku.
rtsp://<camera_address>:<Port>/video1 ([Video Stream 1])
rtsp://<camera_address>:<Port>/video2 ([Video Stream 2])

Note

Reprodukcija na svim aplikacijama ili uređajima nije zajamčena.

Za [SRT-Caller]

Pritisnite gumb [Stream now] na kartici  (Stream) na zaslonu rada uživo za početak
usmjeravanja. Oznaka gumba mijenja se u [Stop stream], a ikona [Stream] pojavljuje se na ploči
fotografija fotoaparata.
Pritisnite gumb [Stop stream] tijekom usmjeravanja kako biste zaustavili usmjeravanje. Oznaka
gumba ponovno se mijenja u [Stream now], a ikona [Stream] na vrhu ploče fotografija
fotoaparata nestaje.

Primjer usmjeravanja SRT slušanja
URL usmjeravanja prikazan je u nastavku.
srt://<camera_address>:<Port>
<camera_address>: IP adresa jedinice
<Port>: priključak slušanja konfiguriran s pomoću funkcije [Port Number]

Note

Format usmjeravanja URL

RTSP

Usmjeravanje
videozapisa 1

rtsp://<camera_address>:<Port>/video1

Usmjeravanje
videozapisa 2

rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX
Pogledajte upute za rad za NDI|HX kompatibilni uređaj za
klijenta.
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Reprodukcija na svim aplikacijama ili uređajima nije zajamčena.

[141] Zaslon minijatura

Zaslon minijatura

Kad pritisnete gumb [Thumbnail] na zaslonu reprodukcije ili gumb THUMBNAIL na infracrvenom
daljinskom upravljaču, snimljeni isječci na memorijski kartici se prikazuju na ploči fotografija
fotoaparata. Ovaj zaslon na ploči fotografija fotoaparata navodi se kao zaslon minijatura.
Na zaslonu s minijaturama možete odabrati isječak i pokrenuti njegovu reprodukciju.
Pritiskom gumba [Thumbnail] tijekom prikaza zaslona minijatura zatvara se zaslon minijatura i
vraća se na zaslon snimanja fotografija.

Note

Na zaslonu s minijaturama prikazuju se samo isječci snimljeni u trenutačno odabranom formatu
snimanja. Ako se očekivani snimljeni isječak ne prikazuje, provjerite format snimanja. Posebnu
pažnju na ovo obratite prije formatiranja (inicijaliziranja) medija.
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Raspored na zaslonu

Minijatura odabranog isječka prikazana je na narančastoj pozadini.
Informacija za odabrani isječak prikazana je na dnu zaslona.

Odabrana memorijska kartica
Zaključana se ikona prikazuje na desnoj strani ako je memorijska kartica zaštićena od
pisanja.

1.

Broj isječka/ukupan broj isječaka2.

Minijatura (indeksna slika)
Prikaz indeksne slike isječka. Kada se snimi isječak, prvi kadar automatski se odabire za
indeksnu sliku.
Informacije o isječku/kadru prikazuju se ispod minijature. Možete promijeniti prikazane
informacije s pomoću funkcija [Thumbnail] > [Customize View] > [Thumbnail Caption] na
izborniku fotoaparata.

3.

Naziv isječka
Prikaz naziva odabranog isječka.

4.

Format snimanja
Prikaz formata datoteke odabranog isječka.

5.

Posebne informacije o snimanju
Prikaz načina snimanja, samo ako je isječak snimljen u posebnom načinu snimanja.
Brzina prijenosa u bitovima isječaka Slow & Quick Motion prikazuje se na desnoj strani.

6.

Trajanje isječka7.
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[142] Zaslon minijatura Reprodukcija isječaka i ostale radnje isječaka

Reprodukcija snimljenih isječaka

Snimljene isječke moguće je reproducirati kada je jedinica u načinu pripravnosti za snimanje
(Stby).
Ova tema opisuje kako reproducirati snimljene isječke s pomoću upravljačke ploče GUI.

Datum izrade8.

Umetnite memorijsku karticu za reprodukciju.1

Pritisnite gumb [Thumbnail].

Pojavljuje se minijatura isječka.

2

Upotrijebite gumbe sa strelicama na upravljačkoj ploči GUI kako biste pomaknuli
pokazivač na minijatura za isječak koji želite reproducirati.

3
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Note

Isječci se ne mogu odabrati dodirnom radnjom.

Pritisnite gumb [Set] na upravljačkoj ploči GUI.

Započinje reprodukcija od početka odabranog isječka.

4

Rukujte pločom reprodukcije po potrebi.

Savjet

Također možete upravljati radom s pomoću upravljačke ploče GUI.
Reprodukcija: pritisnite gumb [Set].
Pauziranje reprodukcije: pritisnite gumb [Set] tijekom reprodukcije. Ponovno pritisnite za

5

Ruka koja pritišće gumb Function

Gumb  (Play/Pause)
(Reproduciraj/pauziraj)

Reproducira isječak. Tijekom reprodukcije
pauzira isječak.

Gumb  (Fast Forward) (Brzo premotaj
unaprijed), gumb  (Fast Reverse)
(Brzo premotaj unatrag)

Reproducira isječak pri visokoj brzini. Kad
se gumb pritisne, brzina reprodukcije
mijenja se u tri koraka.

Gumb  (Prethodno), gumb 
(Sljedeće)

Preskače na početak isječka ili
prethodni/sljedeći isječak.

Gumb  (Stop) (Zaustavi) zaustavlja reprodukciju.
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Note

Na granici između isječaka može doći do trenutnog prekida slike ili prikaza fotografije. Tijekom ovog
razdoblja ne možete rukovati jedinicom.

Kada odaberete isječak na zaslonu s minijaturama i pokrenete reprodukciju, može doći do trenutnog
prekida slike na početku isječka. Za pregled početka isječka bez prekida stavite jedinicu na način
reprodukcije, pauzirajte, pritisnite gumb  (Prethodno) za povratak na početak isječka, a zatim
ponovno pokrenite reprodukciju.

[143] Zasloni minijatura Reprodukcija isječaka i ostale radnje isječaka

Rad na snimljenim isječcima

Na zaslonu minijatura možete rukovati isječcima ili provjeriti svojstva isječaka s pomoću
izbornika [Thumbnail] u izborniku fotoaparata.
Pritisnite gumb [Menu] na zaslonu reprodukcije za prikaz izbornika fotoaparata na ploči
fotografija fotoaparata.
Možete izvršiti sljedeće radnje s pomoću izbornika [Thumbnail] na izborniku fotoaparata.

povratak na normalnu reprodukciju.
Preskočite na početak isječka / pokrenite sljedeći isječak: pritisnite lijevi/desni gumb.
Ubrzavanje prema naprijed/natrag: pritisnite i držite lijevi/desni gumb. Reprodukcija se vraća
na normalnu brzinu kad otpustite gumb.
Zaustavljanje reprodukcije: pritisnite gumb [Cancel/Back].
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Savjet
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Također možete pritisnuti gumb [Menu] na zaslonu rada uživo za prikaz izbornika fotoaparata.

Radnje s pomoću izbornika [Thumbnail] u izborniku fotoaparata

Odaberite funkciju za rad s pomoću gumba sa strelicama na upravljačkoj ploči GUI i pritisnite
gumb [Set].
Pritisnite gumb [Cancel/Back] za povratak na prethodni zaslon.

Note

Ovisno o stanju pri prikazu izbornika, neke stavke nemoguće je odabrati.

Stavke izbornika za rad s isječcima

Izbornik [Thumbnail] u izborniku fotoaparata ima sljedeće stavke izbornika povezane s radom
isječaka.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Pojedinosti o svakoj stavki zbornika pogledajte u dijelu „Izbornik [Thumbnail]”.

Prikaz zaslona svojstva isječaka
Odaberite [Thumbnail] > [Display Clip Properties] na izborniku fotoaparata za prikaz zaslona
svojstva isječaka.
Pritisnite gumb  (Prethodno) ili  (Sljedeće) za preskakanje na prethodni/sljedeći isječak.

Dodavanje zastavica isječcima
Možete dodati zastavice za isječak (OK, NG ili KP oznake) isječcima za filtriranje prikaza
isječaka na temelju zastavica za isječak.
Odaberite minijatura za isječak kojem želite dodati zastavicu za isječak, a zatim odaberite
zastavicu za isječak s pomoću funkcije [Thumbnail]] > [Set Clip Flag] na izborniku fotoaparata.

Setting Dodana zastavica za isječak

[Add OK] OK

[Add NG] NG
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Savjet

Također možete upotrijebiti dodjeljivi gumb dodijeljen funkciji zastavice za isječak za dodavanje
zastavica za isječke.

Prikaz zaslon minijatura filtriranog isječka
Odaberite funkciju [Thumbnail] > [Filter Clips] na izborniku fotoaparata i odaberite vrstu
zastavice za isječak kako biste prikazali samo one isječke koji imaju određenu zastavicu.
Za prikaz svih isječaka odaberite [All].
Također možete pritisnuti gumb [Display] za sortiranje zaslona minijatura prema zastavicama.

Brisanje isječaka
S memorijske kartice moguće je izbrisati isječke.
Odaberite [Thumbnail] > [Delete Clip] > [Select Clip] ili [All Clips] u izborniku fotoaparata.
[Select Clip]: briše odabrani isječak. Podržan je odabir više isječaka.
[All Clips]: briše sve prikazane isječke.

Promjena prikazanih informacija na zaslonu minijatura
Informacije o isječku/kadru ispod minijature moguće je promijeniti.
Odaberite [Thumbnail] > [Customize View] > [Thumbnail Caption] na izborniku fotoaparata i
odaberite informacije za prikaz.
[Date Time]: prikazuje datum i vrijeme isječka kad je izrađen i zadnji put izmijenjen.
[Time Code]: prikazuje vremenski kod.
[Duration]: prikazuje trajanje isječka.
[Sequential Number]: prikazuje sekvencijalni broj svake minijature.

[144] Izbornik fotoaparata i detaljne postavke

Konfiguracija izbornika fotoaparata 

Kad je gumb [Menu] na upravljačkoj ploči GUI ili gumb MENU na infracrvenom daljinskom
upravljaču pritisnut, izbornik fotoaparata za konfiguraciju različitih potrebnih postavki za
snimanje i reprodukciju se prikazuje na ploči fotografija fotoaparata.

[Add KEEP] KP
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Izbornik se sastoji od sljedećih izbornika.

Konfiguracija izbornika

Izbornik [User]
Sadrži stavke izbornika koje je konfigurirao korisnik.
Može se uređivati s pomoću funkcije [Edit User Menu].
Izbornik [Edit User]
Obuhvaća stavke izbornika za uređivanje izbornika [User].
Izbornik [Shooting]
Obuhvaća postavke za snimanje.
Izbornik [Project]
Obuhvaća osnovne postavke projekta.
Izbornik [Paint/Look]
Obuhvaća postavke za kvalitetu slike.
Izbornik [Pan-Tilt]
Sadrži postavke povezane s pomicanjem/nagibanjem.
Izbornik [TC/Media]
Obuhvaća postavke za vremenske kodove i medije za snimanje.
Izbornik [Monitoring]
Obuhvaća postavke za unos videozapisa i prikaz zaslona.
Izbornik [Audio]
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Obuhvaća postavke za zvuk.
Izbornik [Thumbnail]
Obuhvaća postavke za prikaz minijatura.
Izbornik [Technical]
Obuhvaća postavke za tehničke stavke.
Izbornik [Network]
Obuhvaća postavke za mreže.
Izbornik [Maintenance]
Obuhvaća postavke uređaja, primjerice sat i jezik.

Hijerarhija i konfiguracija izbornika fotoaparata

razina 1 razina 2

User
(tvorničke postavke)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Gumb za dodjelu

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom
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Objektiv

Izbornik Edit User

Snimanje

ISO/Gain/EI

ND Filter

Shutter

Blenda

Auto Exposure

Bijeli

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Gumb za dodjelu
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Paint/Look

Scene File

Base Look

Ponovno postavljanje postavki boje

Crni

Komprimiranje

Detalj

Matrix

Multi Matrix

Pan-Tilt P/T Acceleration

TC/Media

Vremenski kod

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Prikaz - uključeno/isključeno

Video Signal Monitor

Marker

Audio
Audio ulaz

Audio Output

Display Clip Properties

Set Clip Flag
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[145] Izbornik fotoaparata i detaljne postavke Rukovanje izbornikom fotoaparata

Rukovanje izbornikom fotoaparata

Kad je gumb [Menu] na upravljačkoj ploči GUI ili gumb MENU na infracrvenom daljinskom
upravljaču pritisnut, izbornik fotoaparata za konfiguraciju različitih potrebnih postavki za
snimanje i reprodukciju se prikazuje na ploči fotografija fotoaparata.
Izbornikom se rukuje s pomoću gumba na upravljačkoj ploči GUI.

Thumbnail (Sličica)

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Objektiv

APR

Network
Wired LAN

File Transfer

Održavanje

Language

Clock Set

Hours Meter
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Gumb [Menu]: pritisnite za prikaz izbornika fotoaparata. Ponovno pritisnite dok je izbornik
fotoaparata prikazan za skrivanje izbornika.
Gumbi za strelicama: pritisnite gumbe sa strelicama za pomicanje pokazivača prema gore /
dolje / lijevo / desno na izborniku fotoaparata za odabir stavki izbornika ili postavki.
Gumb [Set]: pritisnite za primjenu odabrane stavke.
Gumb [Cancel/Back]: pritisnite za povratak na prethodni izbornik. Nedovršena promjena se
odbacuje.

Note

Ovisno o stanju pri prikazu izbornika, neke stavke nemoguće je odabrati.

Stavke izbornika za postavljanje

Pomaknite pokazivač na stavku koju želite postavi s pomoću gumba sa strelicama na
upravljačkoj ploči GUI i pritisnite gumb [Set] za primjenu te postavke.

U području za odabir stavki izbornika prikazuje se do osam redaka. Ako istovremeni prikaz
dostupnih opcija za stavku nije moguć, listajte kroz prikaz pomicanjem pokazivača
gore/dolje.
Za podstavke s velikim rasponom postavljanja (primjerice od -99 do +99), područje za
postavljanje ne prikazuje se. Trenutačna postavka istaknuta je kako bi se prikazala
mogućnost promjene vrijednosti.
Odabirom [Execute] za funkciju izvodi se odgovarajuća funkcija.
Pri odabiru stavke koju je potrebno potvrditi prije izvođenja privremeno se sakriva izbornik i
prikazuje potvrdna poruka. Provjerite poruku i zatim odaberite želite li izvesti ili odbaciti
funkciju.

[146] Izbornik fotoaparata i detaljne postavke Rukovanje izbornikom fotoaparata

Unos niza znakova
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Kada odaberete stavku koja zahtjeva unos znakova, primjerice naziv datoteke, prikazuje se
zaslon sa znakovima.

[147] Izbornik fotoaparata i detaljne postavke Izbornik korisnika

Korisnik

Ova tema opisuje funkciju i postavke svake stavke izbornika.

Pritisnite gumbe sa strelicama na upravljačkoj ploči GUI za odabir vrste znakova i
primjene te postavke.

[ABC]: velika početna slova abecede
[abc]: mala slova abecede
[123]: numerički znakovi
[!#$]: posebni znakovi

1

Odaberite znak i pritisnite gumb [Set] za primjenu postavke.

Pokazivač prelazi na sljedeće polje.
[Space]: unos znaka razmaka u položaj pokazivača.
[‹] [›]: pomicanje položaja pokazivača.
[BS]: brisanje znaka lijevo od pokazivača (backspace).

2

Kad ste dovršili, pritisnite gumb [Done] za primjenu postavke.

Niz znakova potvrđuje se i uklanja se zaslon za unos znakova.

3
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Note

Možete dodati i ukloniti stavke izbornika u izborniku [User] s pomoću izbornika [Edit User]. Moguće je
konfigurirati do 20 stavki.

Stavka Opis

Base Setting Project > Base Setting item

Focus Shooting > Focus item

S&Q Motion Shooting > S&Q Motion item

LUT On/Off Shooting > LUT On/Off item

Simul Rec Project > Simul Rec item

Proxy Rec Project > Proxy Rec item

Interval Rec Project > Interval Rec item

Picture Cache Rec Project > Picture Cache Rec item

Gumb za dodjelu Project > Assignable Button item

Scene File Project > Scene File item

Base Look Paint/Look > Base Look item

P/T Acceleration Pan-Tilt > P/T Acceleration item

Clip Name Format TC/Media > Clip Name Format item

Format Media TC/Media > Format Media item

Video Signal Monitor Monitoring > Video Signal Monitor item

Marker Monitoring > Marker item

Zoom Technical > Zoom item

Objektiv Technical > Lens item

Izbornik Edit User Displays the Edit User menu.
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[148] Izbornik fotoaparata i detaljne postavke Izbornik Uređivanja korisnika

Uređivanje korisnika

Izbornik [Edit User] prikazuje se na gornjoj razini kad je odabran izbornik [Edit User Menu] u
izborniku [User].

[149] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

ISO / Jačina signala / EI

Postavljanje postavki jačine signala.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Dodavanje stavke
Dodajte stavku izborniku
[User]

– –
Dodaje drugu razinu stavke
izbornika izborniku [User].

Prilagođeno ponovno
postavljanje
Ponovno postavite stavke
u izborniku [User]

– –
Vraća stavke izbornika registriranih
u izborniku [User] na tvorničke
postavke.

Odabrana stavka izbornika
druge razine tijekom
uređivanja

Delete –
Briše registriranu stavku izbornika
druge razine iz izbornika [User].

Move –
Mijenja raspored registriranih stavki
izbornika unutar izbornika [User].

Edit Sub
Item

–
Uređuje (registrira/briše) registrirane
podstavke izbornika treće razine
izbornika [User].

Stavka Postavka podstavke Tvorničke
postavke Opis

Mode ISO/dB dB
Odabir načina za
postavljanje jačine
signala.
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ISO/Gain<L>

Pojedinosti o postavkama
pogledajte u odjeljku
„Postavke ISO / jačine
signala i zadane
vrijednosti”.

–

Postavlja pojačanje
signala <L> na
unaprijed postavljenu
vrijednost.

Exposure
Index<L>

Kad je osnovni ISO
postavljen na ISO 800: 
200EI / 4.0E 
250EI / 4.3E 
320EI / 4.7E 
400EI / 5.0E 
500EI / 5.3E 
640EI / 5.7E 
800EI / 6.0E 
1000EI / 6.3E 
1250EI / 6.7E 
1600EI / 7.0E 
2000EI / 7.3E 
2500EI / 7.7E 
3200EI / 8.0E
Kad je osnovni ISO
postavljen na ISO 12800: 
3200EI / 4.0E 
4000EI / 4.3E 
5000EI / 4.7E 
6400EI / 5.0E 
8000EI / 5.3E 
10000EI / 5.7E 
12800EI / 6.0E 
16000EI / 6.3E 
20000EI / 6.7E 
25600EI / 7.0E 
32000EI / 7.3E 
40000EI / 7.7E 
51200EI / 8.0E

Kad je osnovni
ISO postavljen na
ISO 800: 800EI /
6.0E 
Kad je osnovni
ISO postavljen na
ISO 12800:
12800EI / 6.0E

Postavlja indeks
ekspozicije
vrijednosti <L>.

Shockless
Gain

On / Off Off
Uključenje/isključenje
funkcije postupnog
pojačanja signala.

Base
Sensitivity

High / Low Low
Postavlja osnovnu
osjetljivost za način
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[150] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

ND filtar

Postavlja unaprijed postavljenu vrijednost za filtar ND.

[151] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Zatvarač

Postavlja rad elektroničkog zatvarača.

Custom.

Base ISO ISO 12800 / ISO 800 ISO 800
Postavlja temeljnu
ISO osjetljivost za
način Cine El.

Stavka Postavka podstavke Tvorničke
postavke Opis

Mode
Unaprijed postavljeno /
varijabilno

Promjenjivo Odabire način ND filtra.

Preset1
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/4
Postavlja unaprijed postavljenu
vrijednost 1 za filtar ND.

Preset2
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/16
Postavlja unaprijed postavljenu
vrijednost 2 za filtar ND.

Preset3
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/64
Postavlja unaprijed postavljenu
vrijednost 3 za filtar ND.

Stavka Postavka podstavke Tvorničke
postavke Opis

Odabir načina rada
elektroničkog
zatvarača.
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Mode Speed / Angle Speed

Brzina: način rada
za postavljanje
brzine zatvarača u
sekundama.
Odaberite za jasno
snimanje subjekata
koji se brzo pomiču.
Kut: način rada za
postavljanje brzine
zatvarača kao kut
zatvarača.

Shutter
Speed
On/Off

On / Off Off

Postavlja prati li
vrijeme ekspozicije
kada je odabran
način Speed
vrijednost funkcije
[Shutter Speed] ili je
postavljena na punu
ekspoziciju.

Shutter
Speed

64F do 1/8000 
dostupne postavke razlikuju se ovisno o
frekvenciji kadra odabranog formata
videozapisa.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60
/ 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F /
6F / 5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 /
1/50 / 1/60 / 1/96 / 1/100 / 1/120 / 1/125 /

59.94P: 
1/60
50P: 1/50
29.97P:
1/30
25P: 1/25
24P/23.98P:
1/24

Postavljanje brzine
zatvarača kad je
odabran način rada
Speed.
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[152] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Blenda

Postavlja postavke blende.

[153] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Automatska ekspozicija

1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 360.0° / 300.0° / 270.0° / 240.0°
/ 216.0° / 210.0° / 180.0° / 172.8° /
150.0° / 144.0° / 120.0° / 90.0° / 86.4° /
72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180,0°
Postavljanje kuta
zatvarača kad je
odabran način Angle.

ECS
On/Off

On / Off Off
Uključenje/isključenje
funkcije External
Clear Scan.

ECS
Frequency

23,99 do 8000 
dostupne postavke razlikuju se ovisno o
frekvenciji kadra odabranog formata
videozapisa.

59.94P:
60.00
50P: 50.00
29.97P:
30.00
23.98P:
23.99
25P: 25.02
24P: 24.02

Postavlja frekvenciju
ECS kada je način
Mode postavljen na
ECS.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Upravljanje
zamućivanjem

On / Off Off
Uključuje/isključuje funkciju
zamućivanja.
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Postavljanje postavki za prilagodbu automatske ekspozicije.

Stavka Postavka podstavke Tvorničke
postavke Opis

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 /
+1.75 / +1.5 / +1.25 / +1.0 / +0.75 /
+0.5 / +0.25 / ±0 / -0.25 / -0.5 / -0.75 /
-1.0 / -1.25 / -1.5 / -1.75 / -2.0 / -2.25 /
-2.5 / -2.75 / -3.0

±0
Postavlja razinu svjetline za
automatski otkrivenu
ekspoziciju.

Mode Backlight / Standard / Spotlight Standard

Postavlja način rada za
automatsko podešavanje
ekspozicije.
Pozadinska rasvjeta:
način Backlight
(Pozadinska rasvjeta)
(način za smanjivanje
tamnjenja subjekta kad je
subjekt osvijetljen)
Standardno: način
Standard
Reflektor: način Spotlight
(Reflektor) (način za
smanjene izrezane bijele
dijelove kad je subjekt
osvijetljen reflektorom)

Speed od -99 do +99 ±0

Postavlja brzinu
podešavanja za
automatsko podešavanje
ekspozicije.

AGC On / Off Off

Uključenje/isključenje
funkcije automatskog
pojačanja signala, (AGC,
auto gain control).

AGC
Limit

Pojedinosti o postavkama
pogledajte u odjeljku „Postavke
AGC ograničenja i zadane
vrijednosti”.

–
Postavlja maksimalno
pojačanje signala za
funkciju AGC.

Postavlja vrijednost F-stop
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AGC
Point

F2.8 / F4 / F5.6 F2.8
irisa kada započinje
operacija AGC uz funkciju
AGC uključenu
postavljanjem na On.

Auto
Shutter

On / Off Off
Uključenje/isključenje
funkcije automatskog
upravljanja zatvaračem.

A.SHT
Limit

1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Postavlja najveću brzinu
zatvarača za funkciju
automatskog zatvarača.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Postavlja vrijednost F-stop
irisa pri pokretanju rada
automatskog zatvarača.

Clip High
light

On / Off Off

Uključenje/isključenje
funkcije koja zanemaruje
najsvjetlije površine kako bi
se dobio plošniji odgovor
na visoku osvijetljenost.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Postavlja raspon mjerenja
svjetlosti za automatsko
podešavanje ekspozicije
sukladno svjetlini objekta.
(Nedostupno pri ručnom
podešavanju ekspozicije)

Detect
Window
Indication

On / Off Off
Uključenje/isključenje
raspona mjerenja svjetlosti.

Custom
Width

od 40 do 999 500
Postavlja širinu raspona za
mjerenje svjetlosti.

Custom
Height

od 70 do 999 500
Postavlja visinu raspona za
mjerenje svjetlosti.

Custom
H
Position

od -479 do +479 ±0
Postavlja vodoravni položaj
raspona za mjerenje
svjetlosti.

Custom
V od -464 do +464 ±0

Postavlja okomiti položaj
raspona za mjerenje
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[154] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Bijela boja

Postavljanje postavki balansa bijele boje.

Position svjetlosti.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Preset
White

od 2000 K
do 15 000
K

3200K Postavlja zadanu vrijednost balansa bijele boje.

Color
Temp
<A>

od 2000 K
do 15 000
K

3200K

Postavlja temperaturu balansa bijele boje koja se
sprema u memoriju A.

Note

Budući se temperatura boje izrezuje pri 2000 K i 15
000 K tijekom rada R/B jačine signala, možda neće biti
moguće prikazati ispravnu temperaturu boje za
vrijednost R/B jačine signala.

Tint<A>
od -99 do
+99

±0

Postavlja vrijednost nijanse balansa bijele boje koja se
sprema u memoriju A.

Note

Budući da se nijansa boje izrezuje pri +99 tijekom rada
R/B jačine signala, možda neće biti moguće ispravno
prikazati vrijednost nijanse za vrijednost R/B jačine
signala.

R Gain
<A>

od -99,0
do +99,0

±0,0
Postavlja vrijednost pojačanja signala R balansa bijele
boje koja se sprema u memoriju A.

B Gain
<A>

od -99,0
do +99,0

±0,0
Postavlja vrijednost pojačanja signala B balansa bijele
boje koja se sprema u memoriju A.
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[155] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Postavka bijele boje

Podešava postavke balansa bijele boje.

[156] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Pomak bijele boje

Postavljanje postavki pomaka balansa bijele boje.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Shockless
White

Off / 1 / 2 / 3 2

Postavlja brzinu odziva balansa bijele boje pri
promjeni načina balansa bijele boje.
Isključeno: odmah se prebacuje.
1 do 3: što je veći broj to se sporije prebacuje.

ATW
Speed

1 / 2 / 3 / 4 /
5

3
Postavlja brzinu odziva u načinu ATW. 
Najbrža brzina odziva je 1, a najsporiji odziv je 5.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Offset White
<A>

On / Off Off
Odabire treba li dodati (On) ili ne treba dodati (Off)
vrijednost pomaka balansu bijele boje u memoriji
A.

Offset Color
Temp<A>

od -99 do
+99

±0
Postavlja pomak temperature boje koji se dodaje
ravnoteži bijele boje u memoriji A kada je funkcija
[Offset White <A>] uključena.

Offset
Tint<A>

od -99 do
+99

±0
Postavlja vrijednost nijanse Tint koja se dodaje
ravnoteži bijele boje u memoriji A kada je funkcija
[Offset White <A>] uključena.

Offset
White<ATW>

On / Off On
Odabire treba li dodati (On) ili ne treba dodati (Off)
vrijednost pomaka balansu bijele boje ATW.
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[157] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Fokus

Postavljanje postavki za fokusiranje.

Offset Color
Temp<ATW>

od -99 do
+99

±0
Postavlja pomak temperature boje koji se dodaje
ravnoteži bijele boje ATW kada je funkcija [Offset
White<ATW>] uključena.

Offset
Tint<ATW>

od -99 do
+99

±0
Postavlja vrijednost nijanse Tint koja se dodaje
ravnoteži bijele boje ATW kada je funkcija [Offset
White<ATW>] uključena.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

AF
Transition
Speed

1(Slow) / 2 / 3
/ 4 / 5 / 6 /
7(Fast)

5
Postavlja brzinu pogona za fokusiranje za
promjene objekta tijekom automatskog
fokusiranja.

AF Subj.
Shift
Sens.

1(Locked On)
/ 2 / 3 / 4 /
5(Responsive)

5(osjetljivo)
Postavlja osjetljivost za promjenjivo izoštravanje
objekta tijekom automatskog fokusiranja.

Focus
Area

Wide / Zone /
Flexible Spot

Wide

Postavlja ciljno područje automatskog fokusiranja
i automatskog fokusiranja pritiskanjem (AF).

Pogledajte odjeljke „Automatska prilagodba
fokusa (Auto Focus)” i „Postavljanje
područja/položaja automatskog fokusa (Focus
Area).”

Široko pri fokusiranju traži objekt kroz široki kut
slike.
Zona automatski pretražuje točku za fokusiranje
unutar određene zone.
Fleksibilna točka: fokusira se na određeni
položaj na fotografiji.

Focus
Area (AF-

Fleksibilni
spot

Fleksibilni
spot

Postavlja ciljno područje automatskog fokusiranja
pritiskanjem (AF-S).
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[158] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Usporeno i ubrzano snimanje

Postavlja postavke načina usporenog i ubrzanog snimanja (pogledajte odjeljak „Usporeno i
ubrzano snimanje”).

S)

Face/Eye
Detection
AF

Face/Eye
Only AF / 
Face/Eye
Priority AF /
Off

Face/Eye
Priority AF

Omogućivanje/onemogućivanje automatskog
fokusiranja s otkrivanjem lica.

Pogledajte odjeljak „Praćenje s pomoću
prepoznavanja lica/oči (Face/Eye Detection
AF).”

Push AF
Mode

AF / Single-
shot AF(AF-S)

AF
Postavlja način za automatsko fokusiranje
pritiskanjem.

Dodirna
funkcija u
ručnom
fokusu

Praćenje
automatskog
fokusa / fokus
točke

AF za
praćenje

Postavlja rad kad se zaslon fotografije fotoaparata
dodirne u načinu ručnog fokusa.

AF Assist On / Off On

Kada je funkcija postavljena na On, omogućuje
privremeno premoštenje automatskog fokusiranja
i ručno postavljanje fokusa.

Pogledajte odjeljke „Ručno postavljanje
automatskog fokusiranja mete (AF Assist) s
pomoću web-aplikacije” i „Ručni fokus tijekom
automatskog fokusa s pomoću isporučenog
infracrvenog daljinskog upravljača”.

Stavka Postavka podstavke Tvorničke
postavke Opis

Setting On / Off Off
Uključenje/isključenje načina Slow &
Quick Motion.

Postavlja brzinu prijenosa za snimanja
u načinu Slow & Quick Motion.
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[159] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Uključivanje/isključivanje LUT-a

Postavljanje postavki za LUT.

[160] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Uklanjanje buke

Frame
Rate

1fps do 60fps / 100fps /
120fps / 150fps / 180fps /
200fps / 240fps

–

Note

Dostupne postavke razlikuju se
ovisno o odabranoj frekvenciji
sustava, kodeku i formatu
videozapisa.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

SDI
MLUT On / MLUT
Off

MLUT Off
Odabir hoće li se primijeniti nadzor LUT-
a za SDI izlaz videozapisa.

HDMI/Stream
MLUT On / MLUT
Off

MLUT Off
Odabir hoće li se nadzirati LUT za
videozapis s HDMI izlazom i izlazom
usmjeravanja.

Proxy
MLUT On / MLUT
Off

MLUT Off
Odabire hoće li se primijeniti nadzor
LUT-a za proxy snimanje videozapisa.

Internal Rec
MLUT On / MLUT
Off

MLUT Off
Odabire hoće li se primijeniti nadzor
LUT-a za glavno snimanje videozapisa.

LUT On/Off
Button Target

SDI /
HDMI/Stream /
SDI &
HDMI/Stream

HDMI/Stream
Postavlja ciljni izlaz kojim upravlja
dodjeljivi gumb dodijeljen funkciji LUT
On/Off (Uključi/Isključi LUT).



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Postavljanje postavki za uklanjanje buke.

Savjet

Postavke [Setting(Custom)] i [Level(Custom)] odražene su postavkom [Target Display].

[161] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Smanjivanje treperenja

Postavljanje postavki za ispravljanje treperenja.

[162] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

SteadyShot

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting(Custom) On / Off On
Uključenje/isključenje funkcije uklanjanja
buke u načinu Custom.

Level(Custom)
Low / Mid /
High

Mid
Postavlja razinu uklanjanja buke u načinu
Custom.

Setting(Cine EI) On / Off Off
Uključenje/isključenje funkcije uklanjanja
buke u načinu Cine El.

Level(Cine EI)
Low / Mid /
High

Mid
Postavlja razinu uklanjanja buke u načinu
Cine El.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Mode
Auto / On /
Off

Off Postavljanje načina za ispravljanje treperenja.

Frekvencija 50Hz / 60Hz 60Hz
Postavljanje frekvencije izvora napajanja za
svjetlo koje uzrokuje treperenje.
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Postavljanje postavki stabilizacije.

[163] Izbornik fotoaparata i detaljne postavke Izbornik projekt

Osnovna postavka

Postavljanje osnovnih postavki.

[164] Izbornik fotoaparata i detaljne postavke Izbornik projekt

Format snimanja

Postavljanje postavki za format snimanja.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting
Active /
Standard /
Off

Off

Postavlja funkciju stabilizacije slike.

Note

Omogućuje se kada je priključen kompatibilan objektiv.

Kad je postavljen na aktivno ili standardno, može se
pojaviti neočekivano ponašanje tijekom
pomicanja/nagibanja.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Shooting
Mode

Custom /
Cine EI

Custom

Postavlja način snimanja.
Pogledajte dio „Postavljanje načina snimanja”
u odjeljku „Konfiguracija osnovnih radnji”.

Target
Display

SDR(BT.709)
/ HDR(HLG)

SDR(BT.709)
Postavlja prostor boje za snimanje/emitiranje
načina Custom (Prilagođeno).
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Postavke [RAW Output Format]

Stavka Postavka podstavke Tvorničke
postavke Opis

Frekvencija
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59,94 Odabir frekvencije sustava.

Imager
Scan Mode

FF / S35 FF Odabir veličine pretražnika.

Kodek
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

Postavlja kodek isječka za
snimanje/reprodukciju.

Note

Kad je funkcija [Imager Scan
Mode] postavljena na [S35],
[RAW] i [RAW & XAVC-I] se
ne mogu odabrati.

RAW
Output
Format

Dostupne postavke razlikovat
će se ovisno o postavki
[Frequency].

Pogledajte „Postavke
[RAW Output Format]” u
nastavku.

–

Postavlja veličinu RAW
fotografije za emitiranje na
vanjski RAW snimač.

Note

Kad je funkcija [Codec]
postavljena na [RAW &
XAVC-I], postavka [Video
Format] prebacuje se u vezi
s postavkom [RAW Output
Format].

Format
videozapisa

Dostupne postavke razlikovat
će se ovisno o postavkama
[Frequency], [Imager Scan
Mode] i [Codec].

Pogledajte dio „Postavke
[Video Format]” u
nastavku.

–
Postavlja veličinu slike i brzinu
bitova.

Frekvencija Imager Scan Mode Kodek Setting
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Zadane su vrijednosti podebljane.
Uvjeti prema kojima se funkcija [RAW Output Format] ne smije izostaviti.

Postavke [Video Format]

Zadane su vrijednosti podebljane.

59,94 / 50 / 29,97 / 25 / 23,98 FF RAW / RAW & XAVC-I
4096×2160 
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160

Frekvencija Imager Scan
Mode Kodek Setting

59,94 / 50 / 29,97 / 25 /
23,98

FF

RAW –

RAW i XAVC-I
4096×2160P 
3840×2160P

XAVC-I
4096×2160P 
3840×2160P 
1920×1080P

XAVC-L

3840×2160P 
1920×1080P
50 
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50 
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
XAVC-I

4096×2160P
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[165] Izbornik fotoaparata i detaljne postavke Izbornik projekt

Postavka Cine EI

Postavlja postavke načina Cine EI (pogledajte dio „Postavljanje načina snimanja” u odjeljku
„Konfiguracija osnovnih radnji”).

[166] Izbornik fotoaparata i detaljne postavke Izbornik snimanja

Istovremeno snimanje

Postavlja postavke načina istovremenog snimanja u dva utora (pogledajte odjeljak „Istovremeno
snimanje na memorijsku karticu A i B (2-slot Simul Rec)”).

[167] Izbornik fotoaparata i detaljne postavke Izbornik projekt

Proxy snimanje

Postavlja postavke načina proxy snimanja (pogledajte odjeljak „Proxy snimanje”).

Stavka Postavka podstavke Tvorničke
postavke Opis

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Postavljanje prostora boje
u načinu Cine El.

Stavka Postavka podstavke Tvorničke
postavke Opis

Setting On / Off Off
Uključuje/isključuje
način istovremenog
snimanja u dva utora.

Rec
Button
Set

Gumb Rec: [SlotA SlotB] 2. gumb Rec:
[SlotA SlotB] / Gumb Rec: [SlotA] 2.
gumb Rec: [SlotB] / gumb Rec: [SlotB] 2.
gumb Rec: [SlotA]

Gumb Rec:
[SlotA SlotB]
2. gumb Rec:
[SlotA SlotB]

Dodjela gumba za
snimanje za
upravljanje pojedinim
medijima za snimanje.
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[168] Izbornik fotoaparata i detaljne postavke Izbornik projekt

Intervalno snimanje

Postavlja postavke načina intervalnog snimanja (pogledajte odjeljak „Isprekidano snimanje
videozapisa (Interval Rec)”).

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off Off
Uključenje/isključenje načina za snimanje
proxy.

Audio
Channel

CH1/CH2 /
CH3/CH4

CH1/CH2
Odabir zvučnog kanala za snimanje
podataka proxy.

Stavka Postavka podstavke Tvorničke postavke Opis

Setting On / Off Off

Uključenje/isključenje
načina za snimanje s
intervalima. (Uključenjem
ovog načina postavljanjem
na On svi drugi posebni
načini isključuju se
postavljanjem na Off).

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (sek) 
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (min) 
1 / 2 / 3 / 4 / 6 / 12 / 24
(sati)

1

Postavljanje intervala
između snimanja u načinu
snimanja Interval Rec
recording (kada je način
Interval Rec uključen s
On).

Number

1 kadar / 2 kadra / 3
kadra / 
6 kadrova / 9 kadrova /
12 kadrova 
Dostupne postavke
razlikovat će se ovisno o 59.94P/50P: 2 kadra

Postavljanje broja kadrova
po snimanju u načinu
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[169] Izbornik fotoaparata i detaljne postavke Izbornik projekt

Snimanje predmemorije fotografije

Postavlja postavke načina snimanja predmemorije fotografija (pogledajte odjeljak „Snimanje
fotografija iz predmemorije (Picture Cache Rec)”).

[170] Izbornik fotoaparata i detaljne postavke Izbornik projekt

SDI/HDMI kontrola snimanja

Postavljanje postavki za upravljanje snimanjem putem SDI/HDMI.

of
Frames

učestalosti kadrovi
odabranog formata
videozapisa. 
59.94P/50P: 2 kadra / 6
kadrova / 12 kadrova 
29.97P/25P/24P/23.98P:
1 kadar / 3 kadra / 6
kadrova / 9 kadrova

29.97P/25P/24P/23.98P:
1 kadar

snimanja Interval Rec
recording (kada je način
Interval Rec uključen s
On).

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off Off
Uključenje/isključenje funkcije fotografija u
predmemoriju.

Veličina
predmemorije

Kratko /
srednje / dugo
/ maksimalno

Maks.
Postavljanje vremena za nakupljanje slika u
predmemoriji za slike (vrijeme snimanja u
predmemoriju za slike).

Cache Rec
Time

– –
Prikaz vremena za nakupljanje slika u
predmemoriji za fotografije (vrijeme snimanja u
predmemoriju za fotografije).

Stavka Postavka
podstavke

Tvorničke
postavke Opis
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[171] Izbornik fotoaparata i detaljne postavke Izbornik projekt

Dodjeljivi gumbi

Postavlja funkciju dodjele dodjeljivim gumbima (<1> do <9>) i [Focus Hold Button].
Sljedeće se funkcije mogu dodijeliti.
[Off]: nema dodjele funkcije.
[Base ISO/Sensitivity]: prebacuje osnovnu osjetljivost senzora fotografija.
[AGC]: uključuje/isključuje AGC funkciju.
[Push AGC]: omogućava AGC funkciju kad je gumb pritisnut.
[ND Filter]

U varijabilnom načinu rada: prilagođava prozirnost ND filtra. Pritisnite i držite prekidač
između Jasno / Ručno / Automatski.
U unaprijed postavljenom načinu: pritisnite i držite kako biste prebacili unaprijed postavljene
postavke.

[ND Filter Position]: prebacuje ND filtre.
[Auto ND Filter]: uključuje/isključuje automatsku funkciju ND filtra.
[Push Auto ND]: omogućava automatsku funkciju ND filtra kad je gumb pritisnut.
[Auto Iris]: uključuje/isključuje funkciju blende.
[Push Auto Iris]: omogućava automatsku funkciju blende kad je gumb pritisnut.

Setting

Off /
SDI/HDMI
Remote I/F
/ Parallel
Rec

Off

Postavljanje upravljanja pokretanjem/zaustavljanjem
snimanja povezanog vanjskog uređaja putem izlaznog
signala SDI/HDMI.
Isključeno: nemojte upotrebljavati daljinski upravljač.
SDI/HDMI daljinski I/F: upravljanje snimanjem
zaustavljanja/pokretanja vanjskog povezanog uređaja
kad nijedan medij nije umetnut u jedinicu. Nije
sinkronizirano s točnosti kadrova na medij jedinice.
Paralelno snimanje: kontrola snimanja
zaustavljanja/pokretanja vanjskog povezanog uređaja
kad je medij umetnut u jedinicu. Sinkronizirano s točnosti
kadrova na mediju jedinice.

Note

Za upravljanje s pomoću HDMI izlaznog signala
postavite funkciju [TC/Media] > [HDMI TC Out] >
[Setting] na [On] u izborniku fotoaparata.
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[Bokeh Control]: uključuje/isključuje način zamućivanja.
[Auto Shutter]: uključuje/isključuje automatsku funkciju zatvarača.
[AE Level/Mode]: prilagođava AE razinu. Pritisnite i držite za prebacivanje AE načina.
[Backlight]: prebacuje između pozadinske rasvjete i standardnog.
[Spotlight]: prebacuje između reflektora i standardnog.
[Preset White Select]: prebacuje vrijednost unaprijed postavljenog načina ravnoteže bijele
boje.
[ATW]: uključuje/isključuje ATW funkciju.
[ATW Hold]: pauzira rad funkcije ATW.
[AF Speed/Sens.]: prebacuje postavku brzine AF prijelaza i postavku osjetljivosti pomicanja AF
subjekta.
[Focus Setting]: postavlja područje fokusa.
[Face/Eye Detection AF]: prebacuje postavke AF prepoznavanja lica.
[Push AF Mode]: prebacuje postavku načina Push AF.
[Push AF/MF]: u načinu ručnog fokusa aktivira AF dok je gumb pritisnut. U načinu automatskog
fokusiranja uključuje ručno fokusiranje dok je gumb pritisnut.
[Focus Hold]: u automatskom načinu fokusa fokus je fiksiran kad je gumb pritisnut.
[S&Q Motion]: uključuje/isključuje funkciju usporenog i ubrzanog snimanja. Postavljanje brzine
prijenosa snimanja, ako se pritisne i zadrži gumb.
[LUT On/Off] uključuje/isključuje funkciju LUT-a. Cilj prebacivanja postavlja se s pomoću
funkcije [Shooting] > [LUT On/Off] > [LUT On/Off Button Target].
[SteadyShot]: prebacuje se između aktivnog, standardnog i isključenog.
[Crop Select]: prebacuje se na način skeniranja pretražnika. Prebacivanje je omogućeno kad
je unutar raspona bez promjene formata snimanja.
[Rec] pokretanje/zaustavljanje snimanja.
[Picture Cache Rec]: uključuje/isključuje način snimanja fotografija za predmemoriju.
[Rec Review]: uključuje/isključuje funkciju pregleda snimanja.
[Clip Flag OK]: izvršava funkciju Add OK (Dodaj OK). Pritisnite dva puta za izvođenje Delete
Clip Flag.
[Clip Flag NG]: izvršava funkciju Add NG (Dodaj NG). Pritisnite dva puta za izvođenje Delete
Clip Flag.
[Clip Flag Keep]: izvršava funkciju Add KEEP (Dodaj KEEP). Pritisnite dva puta za izvođenje
Delete Clip Flag.
[Slot Select] prebacuje se između utora za memoriju (A) i (B).
[Color Bars]: uključuje/isključuje trake boja.
[DURATION/TC/U-BIT]: prebacuje se između vremenskog koda, korisničkih informacija i
trajanja.
[Display]: uključuje/isključuje indikatore zaslona.
[Lens Info]: prebacuje indikator dubine polja.
[Video Signal Monitor]: prebacuje nadzor signala videozapisa.
[Marker]: uključuje/isključuje funkciju markera.
[Thumbnail]: prikazuje/izlazi iz zaslona minijature.
[Auto Upload (Proxy)]: uključuje/isključuje automatski prijenos proxy snimanja.
[Direct Menu]: prikazuje/izlazi iz izravnog izbornika.
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[User Menu]: prikazuje/izlazi iz izbornika User (Korisnik).

[172] Izbornik fotoaparata i detaljne postavke Izbornik Boja/izgled

Datoteka scene

Postavlja postavke povezane s datotekama scena (pogledajte odjeljak „Snimanje sa željenim
izgledom”).

[173] Izbornik fotoaparata i detaljne postavke Izbornik Boja/izgleda

Stavka Postavka podstavke Tvorničke
postavke Opis

Pozivanje – –

Učitavanje datoteke
kadra pohranjene u
internu memoriju i
primjena postavki kao
trenutačnih postavki za
kvalitetu slike.

Pohrana – –

Sprema trenutačno
stanje kvalitete slike kao
datoteku kadra u internu
memoriju.

Delete – –
Brisanje datoteke kadra
pohranjene u internu
memoriju.

Opoziv
unaprijed
postavljene
postavke

Kad je način snimanja postavljen na
Custom (Prilagođeno) i Target
Display (Prikaz cilja) postavljen na
SDR(BT.709): S-Cinetone / Standard /
Still / ITU709
Kad je način snimanja postavljen na
Custom (Prilagođeno) i Target
Display (Prikaz cilja) postavljen na
HDR(HLG): HLG Live / HLG Natural

–

Primjenjuje unaprijed
postavljene postavke
kvalitete slike (ponovno
ispisivanje nije moguće)
kao trenutačne postavke
kvalitete slike.
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Osnovni izgled

Postavljanje postavki povezanih s temeljnim izgledom.

Stavka Postavka podstavke Tvorničke postavke Opis

Select

Kad je način snimanja
postavljen na Custom
(Prilagođeno) i Target Display
(Prikaz cilja) postavljen na
SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / User1 to
User16
Kad je način snimanja
postavljen na Custom
(Prilagođeno) i Target Display
(Prikaz cilja) postavljen na
HDR(HLG): HLG Live / HLG
Natural / User1 to User16
Kad je način snimanja
postavljen na Cine EI: s709 /
709(800) / S-Log3 / User1 to
User16

Kad je način snimanja
postavljen na Custom
(Prilagođeno) i Target
Display (Prikaz cilja)
postavljen na
SDR(BT.709): S-
Cinetone
Kad je način snimanja
postavljen na Custom
(Prilagođeno) i Target
Display (Prikaz cilja)
postavljen na
HDR(HLG): HLG Live
Kad je način snimanja
postavljen na Cine EI:
s709

Odabire temeljni
izgled.

Delete – –
Briše odabrani
temeljni izgled.

Delete
All

– –
Briše sve
temeljne izglede.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3

Postavlja ulazni
gamut za osnovni
izgled odabran s
pomoću funkcije
[Select].

Izlaz BT.709 / HLG BT.709

Postavlja gamut
izlazne boje za
osnovni izgled
odabran s
pomoću funkcije
[Select].
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[174] Izbornik fotoaparata i detaljne postavke Izbornik Boja/Izgled

Ponovno postavljanje postavki boje

Ponovno postavlja postavke izbornika [Paint/Look], bez osnovnog izgleda.

[175] Izbornik fotoaparata i detaljne postavke Izbornik Boja/izgleda

Crna boja

Postavljanje postavki za crnu boju.

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV
/ 5/3EV / 2EV

0EV

Postavlja
vrijednost
referentne
ekspozicije za
osnovni izgled
odabran s
pomoću funkcije
[Select].

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Ponovno postavljanje
bez funkcije Base Look

Execute /
Cancel

–
Ponovno postavlja postavke izbornika
[Paint/Look], bez osnovnog izgleda.
Izvrši: Izvršite funkciju.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Master
Black

od -99,0 do +99,0 ±0,0
Postavljanje glavne razine crne
boje.

R Black od -99,0 do +99,0 ±0,0 Postavljanje razine R crne boje.

B Black od -99,0 do +99,0 ±0,0 Postavljanje razine B crne boje.
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[176] Izbornik fotoaparata i detaljne postavke Izbornik Boja/izgleda

Komprimiranje

Postavljanje postavki za korekciju komprimiranja.

Stavka Postavka podstavke Tvorničke postavke Opis

Setting

Kad je Target Display
(Prikaz cilja) postavljen
na SDR(BT.709):
Uključeno / Isključeno / --
-
Kad je Target Display
(Prikaz cilja) postavljen
na HDR(HLG):
Uključeno / Isključeno / --
-

Kad je Target Display
(Prikaz cilja)
postavljen na
SDR(BT.709):Isključeno
Kad je Target Display
(Prikaz cilja)
postavljen na
HDR(HLG):Isključeno

Uključenje/isključenje
funkcije korekcije
komprimiranja.

Note

Omogućeno je samo
kad je funkcija [Base
Look] > [Select]
postavljena na
[Standard], [ITU709],
[HLG Live] ili [HLG
Natural].

Auto
Knee

Kad je Target Display
(Prikaz cilja) postavljen
na SDR(BT.709):
Uključeno / Isključeno / --
-
Kad je Target Display
(Prikaz cilja) postavljen
na HDR(HLG):
Uključeno / Isključeno / --
-

Kad je Target Display
(Prikaz cilja)
postavljen na
SDR(BT.709):Uključeno
Kad je Target Display
(Prikaz cilja)
postavljen na
HDR(HLG):Isključeno

Uključenje/isključenje
funkcije automatskog
komprimiranja.

Note

Omogućeno samo kad
je funkcija [Base Look]
> [Select] postavljena
na [Standard] ili
[ITU709].

Point Od 75 % do 109 % 90 %
Postavljanje podešavanja
pojedinosti u osvijetljenim
područjima.

Slope od -99 do +99 ±0
Postavljanje podešavanja
pojedinosti u osvijetljenim
područjima nagiba.
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[177] Izbornik fotoaparata i detaljne postavke Izbornik Boja/izgled

Detalj

Postavlja postavke namještanja detalja.

[178] Izbornik fotoaparata i detaljne postavke Izbornik Boja/izgled

Matrica

Postavljanje postavki za korekciju matrice.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off On Uključenje/isključenje funkcije detalja.

Level od -7 do +7 ±0 Postavljanje razine detalja.

Ručne
postavke

Uključeno/isključeno/
---

Off
Uključenje/isključenje funkcije ručnog
namještanja detalja.

Balans V/H od -2 do +2 ±0
Postavljanje balansa između okomitog (V)
i vodoravnog detalja (H) za ručno
namještanje detalja.

Balans B/W
Vrsta 1 / Vrsta 2 /
Vrsta 3 / Vrsta 4 /
Vrsta 5

Type3

Postavlja balans između crnog (B) detalja
za slabo osvijetljena područja i bijelog (W)
detalja za visoko osvijetljena područja za
ručno namještanje detalja.

Ograničenje od 0 do 7 7
Postavljanje razine ograničenja detalja za
ručno namještanje detalja.

Crispening od 0 do 7 0
Postavljanje razine crispeninga za ručno
namještanje detalja.

Visoko
osvijetljeni
detalj

od 0 do 4 0
Postavljanje razine detalja visoke
osvijetljenosti za ručno namještanje
detalja.
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[179] Izbornik fotoaparata i detaljne postavke Izbornik Boja/izgled

Višestruka matrica

Postavljanje postavki za korekciju višestruke matrice.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

User Matrix On / Off Off
Uključenje/isključenje funkcije korekcije
korisničke matrice.

User Matrix
Level

od -99 do +99 ±0 Podešavanje zasićenja boje na cijeloj slici.

User Matrix
Phase

od -99 do +99 ±0
Podešavanje tona boje (faze) na cijeloj
slici.

User Matrix
R-G

od -99 do +99 ±0
Postavljanje korisnički definirane
korisničke matrice R-G.

User Matrix
R-B

od -99 do +99 ±0
Postavljanje korisnički definirane
korisničke matrice R-B.

User Matrix
G-R

od -99 do +99 ±0
Postavljanje korisnički definirane
korisničke matrice G-R.

User Matrix
G-B

od -99 do +99 ±0
Postavljanje korisnički definirane
korisničke matrice G-B.

User Matrix
B-R

od -99 do +99 ±0
Postavljanje korisnički definirane
korisničke matrice B-R.

User Matrix
B-G

od -99 do +99 ±0
Postavljanje korisnički definirane
korisničke matrice B-G.

Stavka Postavka podstavke Tvorničke
postavke Opis

Setting On / Off Off
Uključenje/isključenje funkcije
korekcije višestruke matrice.

Ponovno postavljanje nijanse i
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[180] Izbornik fotoaparata i detaljne postavke Izbornik pomicanje/nagibanje

P/T ubrzanje

Postavlja postavke povezane s ubrzanjem rada pomicanja/nagibanja.

[181] Izbornik fotoaparata i detaljne postavke Izbornik vremenski kod / medij

Vremenski kod

Postavljanje postavki vremenskog koda.

Reset Execute / Cancel – zasićenja svake boje osi na
zadane vrijednosti.

Axis
B / B+ / MG- / MG / MG+ / R /
R+ / YL- / YL / YL+ / G- / G / G+
/ CY / CY+ / B-

B Odabir osovine.

Hue od -99 do +99 ±0
Postavljanje nijanse boje koja
se upotrebljava za korekciju
višestruke matrice.

Zasićenost od -99 do +99 ±0
Postavljanje zasićenja boje
koja se upotrebljava za
korekciju višestruke matrice.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Krivulja
nagiba

od 1 do 9 8
Odabire ubrzavanje / usporavanje pomicanja /
nagibanja. Što je taj broj veći, to je veće ubrzanje.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Preset /

Postavljanje načina izvođenja vremenskog koda.
Unaprijed postavljeno: pokreće izvođenje od
unaprijed postavljene vrijednosti.
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[182] Izbornik fotoaparata i detaljne postavke Izbornik vremenski kod / medij

Prikaz vremenskog koda

Postavljanje postavki prikaza podataka o vremenu.

[183] Izbornik fotoaparata i detaljne postavke Izbornik vremenskog koda / medija

Korisničke informacije

Postavljanje postavki za korisničke informacije.

Mode Regen /
Clock

Preset Regeneracija: pokretanje izvođenja od vremenskog
koda do završetka prethodnog isječka.
Sat: upotrebljava interni sat kao vremenski kod.

Pokreni
Rec Run /
Free Run

Rec Run
Izvršavanje snimanja: izvršava samo snimanje.
Slobodno izvršanje: uvijek se izvršava bez obzira na
snimanje.

Setting – –
Postavljanje vremenskog koda na proizvoljnu
vrijednost.
Postavljanje: postavlja vrijednost.

Reset
Execute /
Cancel

–
Ponovno postavljanje vremenskog koda na
00:00:00:00.
Izvrši: Izvršite funkciju.

TC
Format

DF / NDF DF
Postavljanje formata vremenskog koda.
DF: ispadanje kadra
NDF: neispadanje kadra

Stavka Postavka podstavke Tvorničke
postavke Opis

Display
Select

Timecode / Users Bit /
Duration

Vremenski kod
Zamjena prikaza podataka o
vremenu.
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[184] Izbornik fotoaparata i detaljne postavke Izbornik vremenskog koda / medija

HDMI TC izlaz

Postavljanje postavki za izvoz vremenskog koda pri primjeni priključnice HDMI.

[185] Izbornik fotoaparata i detaljne postavke Izbornik vremenskog koda / medija

Format naziva isječka

Postavljanje postavki za dodjelu naziva i brisanje isječaka.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Mode Fix / Time Primjena

Postavljanje načina za korisničke informacije.
Fiksno: upotreba proizvoljne fiksne vrijednosti u
korisničkim informacijama.
Vrijeme: upotrebljava trenutni sat, minutu i sekundu
u korisničkim informacijama.

Setting – –
Postavljanje korisničkih informacija na proizvoljnu
vrijednost.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off Off
Postavljenja izvoza vremenskog koda na uređaje za
druge svrhe putem priključnice HDMI.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Title
Prefix

nnn_ (nnn su
zadnje tri
znamenke
serijskog broja)
(maks. prikaz od

nnn

Postavljanje dijela naslova (od 4 do 46 znakova) u
nazivu isječka. 
Otvaranje zaslona za unos niza znakova.

Pojedinosti po naslovima postavki i zaslonu
unosa znakova pogledajte u odjeljcima
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Postavljanje naslova

[186] Izbornik fotoaparata i detaljne postavke Izbornik vremenskog koda / medija

Ažuriranje medija

Ažurira datoteku upravljanja na memorijskim karticama (pogledajte odjeljak „Oporavak
memorijske kartice”).

sedam
znamenki)

„Postavljanje naslova” i „Struktura zaslona
unosa niza znakova”.

Number
Set

od 0001 do
9999

0001
Postavljanje četveroznamenkastog brojčanog
sufiksa za naziv isječka.

Odaberite znak koji ćete umetnuti na položaj pokazivača u području [Title Prefix] iz
područja odabira znakova s pomoću gumba sa strelicama na upravljačkoj ploči GUI
(označen je znak) i pritisnite gumb [Set] na upravljačkoj ploči GUI.

Odabrani znak se umeće, a pokazivač se pomiče udesno.

1

Ponovite 1. korak za postavljanje naslova.

Po potrebi primijenite [BS].

2

Nakon postavljanja naslova odaberite [Done] kako biste zatvorili zaslon za unos niza
znakova.

Pojedinosti o radu na zaslonu unosa znakova pogledajte u odjeljku „Unos niza
znakova”.

Mogu se odabrati sljedeći znakovi.
!#$%()+,-.;=@[ ]^_~ space 
0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3

Stavka Postavka
podstavke

Tvorničke
postavke Opis
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[187] Izbornik fotoaparata i detaljne postavke Izbornik vremenskog koda / medija

Formatiranje medija

Formatira (inicijalizira) memorijske kartice (pogledajte odjeljak „Formatiranje (inicijalizacija)
memorijskih kartica”).

[188] Izbornik fotoaparata i detaljne postavke Izbornik vremenskog koda / medija

Trajanje medija

Prikazuje preostalo trajanje memorijskih kartica.

Media(A)
Execute /
Cancel

–
Ažuriranje datoteke za upravljanje na
memorijskoj kartici u utoru A.
Izvrši: Izvršite funkciju.

Media(B)
Execute /
Cancel

–
Ažuriranje datoteke za upravljanje na
memorijskoj kartici u utoru B.
Izvrši: Izvršite funkciju.

Stavka Postavka podstavke Tvorničke
postavke Opis

Media(A)
Puni format / brzi format /
otkazivanje

–
Formatiranje memorijske kartice
u utoru A.

Media(B)
Puni format / brzi format /
otkazivanje

–
Formatiranje memorijske kartice
u utoru B.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Media(A) – –
Prikazuje preostalo trajanje memorijske
kartice u utoru A.

Media(B) – –
Prikazuje preostalo trajanje memorijske
kartice u utoru B.
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Note

Potrebne su memorijske kartice koje podržavaju prikaz preostalog trajanja medija.

[189] Izbornik fotoaparata i detaljne postavke Izbornik nadzora

Izlazni format

Postavljanje postavki za izlazni format.

[190] Izbornik fotoaparata i detaljne postavke Izbornik nadzora

Uključivanje/isključivanje prikaza

Postavljanje prikaza postavki za stavke.
Za prikaz stavke prikaza odaberite On (Uključeno). Za skrivanje stavke prikaza odaberite Off
(Isključeno).

Stavka Postavka podstavke Tvorničke
postavke Opis

SDI Pojedinosti o postavkama pogledajte u
odjeljku „Izlazni formati i ograničenja”.

– Postavljanje izlazne
razlučivosti za SDI i
HDMI.HDMI –

Stavka Postavka podstavke Tvorničke postavke

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On
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Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Vremenski kod On / Off On

ND Filter On / Off On

Blenda On / Off On
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[191] Izbornik fotoaparata i detaljne postavke Izbornik nadzora

Nadzor videosignala

Postavlja postavke nadzora videosignala.

[192] Izbornik fotoaparata i detaljne postavke Izbornik nadzora

Oznaka

Postavljanje postavki za oznake za zaslonu.

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On

Stavka Postavka podstavke Tvorničke
postavke Opis

Setting
Off / Waveform / Vector
/ Histogram

Off
Postavlja vrstu nadzora
videosignala.

Razina
oznake 1

Od 0 % do 109 % 70 %
Postavlja razinu osvijetljenosti na
razinu oznake 1.

Razina
oznake 2

Od 0 % do 109 % 100 %
Postavlja razinu osvijetljenosti na
razinu oznake 2.

Stavka Postavka podstavke Tvorničke Opis
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postavke

Setting On / Off On
Uključenje/isključenje svih
oznaka na zaslonu.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

Bijeli Odabir boje signala oznaka.

Center
Marker

1 / 2 / 3 / 4 / Off Off Odabir oznake središta.

Safety
Zone

On / Off Off
Uključenje/isključenje oznake
sigurnog područja.

Safety
Area

80% / 90% / 92.5% / 95% 90 %

Odabir veličine oznake
sigurnog područja (kao
postotak ukupne veličine
zaslona).

Aspect
Marker

Line / Mask / Off Off Odabir vrste oznake omjera.

Aspect
Mask

od 0 do 15 12
Odabir razine videosignala
izvan oznake.

Aspect
Safety
Zone

On / Off Off
Uključenje/isključenje oznake
omjera u sigurnom području.

Aspect
Safety
Area

80% / 90% / 92.5% / 95% 90 %

Odabir veličine oznake
omjera sigurnog područja
(kao postotak ukupne veličine
zaslona).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / Custom (Prilagođeno)

2.39:1
Odabir način za prikaz
oznake omjera.

Custom
Aspect
Ratio

Unesite arbitranu vrijednost. 01.00:01,00

Postavljanje razmjera
proporcija na proizvoljnu
vrijednost.

Note

Omogućeno kad je
funkcija [Aspect Select]
postavljena na [Custom].
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[193] Izbornik fotoaparata i detaljne postavke Izbornik zvuka

Ulaz zvuka

Postavljanje postavki za ulazni zvuk.

Guide
Frame

On / Off Off
Uključenje/isključenje prikaza
okvira za navođenje.

100%
Marker

On / Off Off
Uključenje/isključenje oznake
za 100 %.

User
Box

On / Off Off
Uključenje/isključenje oznake
korisničke kutije.

User
Box
Width

od 3 do 479 240

Postavljanje širine oznake
korisničkog okvira (udaljenost
od sredine do lijevog i desnog
ruba).

User
Box
Height

od 3 do 269 135

Postavljanje visine oznake
korisničkog okvira (udaljenost
od sredine do gornjeg i
donjeg ruba).

User
Box H
Position

od -476 do +476 0
Postavljanje vodoravnog
položaja sredine oznake
korisničkog okvira.

User
Box V
Position

od -266 do +266 0
Postavljanje okomitog
položaja sredine oznake
korisničkog okvira.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Odaberite
AUDIO IN

MIC / LINE MIC
Odabire vrstu uređaja povezanog na priključak
AUDIO IN.

Fantomsko
napajanje On / Off Off

Prikazuje status fantomskog izvora napajanja od
+48 V.
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od +48 V

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

Prikazuje ulazni izvor za snimanja na kanal 1.

CH2 Input
Select

AUDIO IN CH1
/ AUDIO IN
CH2

AUDIO IN
CH2

Uklapanje izvora unosa za snimanje na kanalu
2.

CH3 Input
Select

Off / AUDIO IN
CH1

AUDIO IN
CH1

Uklapanje izvora unosa za snimanje na kanalu
3.

CH4 Input
Select

Off / AUDIO IN
CH1 / AUDIO
IN CH2

AUDIO IN
CH2

Uklapanje izvora unosa za snimanje na kanalu
4.

AUDIO IN
CH1 MIC
Ref.

-80 dB / -70 dB
/ -60 dB / -50
dB / -40 dB / –
30 dB

-50dB
Postavlja razinu reference snimanja za XLR ulaz
mikrofona s AUDIO IN CH1.

AUDIO IN
CH2 MIC
Ref.

-80 dB / -70 dB
/ -60 dB / -50
dB / -40 dB / –
30 dB

-50dB
Postavlja razinu reference snimanja za XLR ulaz
mikrofona s AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB /
-3dB / EBUL

+4dB
Postavlja razinu referentnog ulaza kad je
funkcija [AUDIO IN Select] postavljena na LINE.

Reference
Level

-20dB / -18dB /
-16dB / -12dB /
EBUL

-20 dB
Odabir razine snimanja za referentni tonski
signal od 1 kHz.

CH1 Wind
Filter

On / Off Off
Omogućivanje/onemogućivanje filtar za
smanjenje vjetra za snimanje na kanalu 1.

CH2 Wind
Filter

On / Off Off
Omogućivanje/onemogućivanje filtar za
smanjenje vjetra za snimanje na kanalu 2.

CH3 Wind
Filter

On / Off Off
Omogućivanje/onemogućivanje filtar za
smanjenje vjetra za snimanje na kanalu 3.

CH4 Wind
Filter

On / Off Off
Omogućivanje/onemogućivanje filtar za
smanjenje vjetra za snimanje na kanalu 4.

CH1 Level
Auto / Manual Auto

Odabire automatsku prilagodbu razine ulaza
zvuka ili ručnu prilagodbu za snimanje na kanalu
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Control
1.

CH2 Level
Control

Auto / Manual Auto
Odabire automatsku prilagodbu razine ulaza
zvuka ili ručnu prilagodbu za snimanje na kanalu
2.

CH3 Level
Control

Auto / Manual Auto
Odabire automatsku prilagodbu razine ulaza
zvuka ili ručnu prilagodbu za snimanje na kanalu
3.

CH4 Level
Control

Auto / Manual Auto
Odabire automatsku prilagodbu razine ulaza
zvuka ili ručnu prilagodbu za snimanje na kanalu
4.

CH1 Input
Level

od 0 do 99 49
Postavljanje razine unosa za snimanje na kanalu
1.

CH2 Input
Level

od 0 do 99 49
Postavljanje razine unosa za snimanje na kanalu
2.

CH3 Input
Level

od 0 do 99 49
Postavljanje razine unosa za snimanje na kanalu
3.

CH4 Input
Level

od 0 do 99 49
Postavljanje razine unosa za snimanje na kanalu
4.

Master
Input Level

od 0 do 99 99 Postavlja glavnu razinu ulaza zvuka.

Limiter
Mode

Off / -6dB /
-9dB / -12dB /
-15dB / -17dB

Off
Odabir karakteristika limitatora za velike ulazne
signale pri ručnom podešavanju razine ulaza
zvuka.

CH1&2
AGC Mode

Mono / Stereo Stereo

Postavljanje načina za automatsko podešavanje
razine za kanal za snimanje 1 i kanal 2. Kada je
postavljena na Stereo, funkcija AGC povezuje
se između kanala.

CH3&4
AGC Mode

Mono / Stereo Stereo

Postavljanje načina za automatsko podešavanje
razine za kanal za snimanje 3 i kanal 4. Kada je
postavljena na Stereo, funkcija AGC povezuje
se između kanala.

AGC Spec
-6dB / -9dB /
-12dB / -15dB /
-17dB

-6 dB Odabir karakteristika za AGC.
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[194] Izbornik fotoaparata i detaljne postavke Izbornik zvuka

Ulaz zvuka

Postavljanje postavki za izlazni zvuk.

[195] Izbornik fotoaparata i detaljne postavke Izbornik minijatura

Prikaz svojstva isječaka

Prikaz zaslona sa svojstvima isječka.

[196] Izbornik fotoaparata i detaljne postavke Zaslon minijatura

1kHz Tone
on Color
Bars

On / Off Off

Uključenje/isključenje referentnog tonskog
signala od 1 kHz pri prikazu stupaca boje.

Note

Kad je postavljen na [On], referentni ton
signala od 1 kHz postavljen za snimanja na
kanalu 3 i kanalu 4, čak ako su [CH3 Input
Select] i [CH4 Input Select] postavljeni na [Off].

Stavka Postavka
podstavke

Tvorničke
postavke Opis

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Postavljanje kombinacije zvučnih kanala na
izlazu HDMI/usmjeravanje.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Display Clip
Properties

– –
Prikaz zaslona sa svojstvima
isječka.
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Postavljanje zastavice isječka

Postavljanje postavki za zastavice za isječak.

[197] Izbornik fotoaparata i detaljne postavke Zaslon minijature

Zaključavanje/otključavanje isječka

Postavljanje postavki za zaštitu isječka.

[198] Izbornik fotoaparata i detaljne postavke Izbornik minijatura

Brisanje isječka

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Add OK – – Dodavanje zastavice OK.

Add NG – – Dodavanje zastavice NG.

Add KEEP – –
Dodavanje zastavice
KEEP.

Delete Clip
Flag

– – Brisanje svih zastavica.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Select Clip – –
Odabir i zaključavanje/otključavanje
isječka.

Lock All
Clips

– – Zaključavanje svih isječaka.

Unlock All
Clips

– – Otključavanje svih isječaka.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Brisanje isječaka.

[199] Izbornik fotoaparata i detaljne postavke Izbornik minijatura

Prijenos isječka

Prijenos isječaka.

[200] Izbornik fotoaparata i detaljne postavke Izbornik minijatura

Prijenos isječka (Proxy)

Prijenos isječaka proxy.

Stavka Postavka podstavke Tvorničke postavke Opis

Select Clip – – Brisanje odabranog isječka.

All Clips – – Brisanje svih isječaka.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Select
Clip

– – Prijenos odabranih isječaka.

All Clips – –

Prijenos svih isječaka.

Note

Moguće je registrirati do 200 zadataka
prijenosa.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Select
– –

Prijenos isječaka proxy koji odgovaraju
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[201] Izbornik fotoaparata i detaljne postavke Izbornik minijatura

Filtriranje isječaka

Postavljanje postavki za prikaz isječaka.

[202] Izbornik fotoaparata i detaljne postavke Izbornik minijatura

Prilagodba prikaza

Zamjena prikaza zaslona s minijaturama.

Clip odabranim isječcima.

All
Clips

– –

Prijenos isječaka proxy koji odgovaraju svim
isječcima.

Note

Moguće je registrirati do 200 zadataka
prijenosa.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

OK – – Prikaz samo isječaka sa zastavicom OK.

NG – – Prikaz samo isječaka sa zastavicom NG.

KEEP – –
Prikaz samo isječaka sa zastavicom
KEEP.

None – – Prikaz samo isječaka bez zastavice.

All – –
Prikaz svih isječaka, neovisno o
zastavicama.

Stavka Postavka podstavke Tvorničke
postavke Opis
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[203] Izbornik fotoaparata i detaljne postavke Tehnički izbornik

Trake boja

Postavljanje postavki stupca boje.

[204] Izbornik fotoaparata i detaljne postavke Tehnički izbornik

Genlock

Konfigurira prikaz statusa genlocka (pogledajte odjeljak „Sinkronizacija faze videosignala
(Genlock)”).

[205] Izbornik fotoaparata i detaljne postavke Tehnički izbornik

Signalno svjetlo

Thumbnail
Caption

Date Time / Time Code /
Duration / Sequential Number

Time Code
Zamjena informacija koje se
prikazuju ispod minijatura.

Stavka Postavka podstavke Tvorničke
postavke Opis

Setting On / Off Off
Uključenje/isključenje stupaca
boje.

Vrsta
ARIB / 100% / 75% /
SMPTE

ARIB Odabir vrste stupca boje.

Stavka Postavka podstavke Tvorničke
postavke Opis

Referenca
Interno / Eksterno (HD) /
Eksterno (SD)

–
Prikazuje vrstu referentnog
signala genlocka.
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Postavlja žaruljicu snimanja / signalnog svjetla (pogledajte odjeljak „Priključivanje signalizacije”).

[206] Izbornik fotoaparata i detaljne postavke Tehnički izbornik

Pregled snimanja

Postavlja postavke pregleda snimanja (pogledajte odjeljak „Pregled snimke Rec Review)”).

[207] Izbornik fotoaparata i detaljne postavke Tehnički izbornik

Zumiranje

Postavlja postavke zumiranja („Postavka zumiranja”).

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Svjetlina
signalizacije

Jako / Slabo
/ Isključeno

High
Postavlja svjetlinu žaruljice
snimanja/signalizacije.

Žaruljica
signalizacije
G

Enable /
Disable

Enable
Omogućava/onemogućava žaruljicu
signalizacije G.

Upravljanje
signalizacijom

Eksterno /
interno

Interno

Odabire cilj za prihvaćanje informacija
upravljanja žaruljicom snimanja/signalizacije.
Eksterno: upravljanje signalizacijom izvan
fotoaparata.
Interno: upravljanje putem snimanja
fotoaparatom.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting
3 s / 10 s /
Isječak

3s
Postavlja vrijeme za reprodukciju netom snimljenih
isječaka za pregled snimke.

Tvorničke



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[208] Izbornik fotoaparata i detaljne postavke Tehnički izbornik

Objektiv

Postavljanje postavki za objektive.

Stavka Postavka podstavke postavke Opis

Vrsta
zumiranja

Samo optičko zumiranje / Uključeno
(Jasno zumiranje slike)

Samo optički
zum

Postavljanje vrste
zumiranja.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Kalibracija
objektiva

Execute /
Cancel

–

Izvršava funkciju koja ispravlja
razlike u položaju zumiranja zbog
razlika pojedinih objektiva koji
upotrebljavaju objektiv s
motoriziranim zumiranjem.

Zoom Ring
Direction

Left(W)/Right(T)
/
Right(W)/Left(T)

Lijevo(W)/Desno(T)

Postavljanje smjera za upotrebu
prstena za zumiranje.

Note

Omogućeno samo pri primjeni
objektiva E-mount koji podržava
zamjenu smjera prstena za
zumiranje.

Shading
Compensation

Auto / Off Auto
Postavlja automatsku
kompenzaciju sjene.

Chroma
Aberration
Comp.

Auto / Off Auto
Postavlja automatsku
kompenzaciju kromatske aberacije.

Komp.
iskrivljenja

Auto / Off Auto
Postavlja automatsku
kompenzaciju izobličenja.

Postavlja kompenzaciju promjene
žarišne duljine objektiva.
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[209] Izbornik fotoaparata i detaljne postavke Tehnički izbornik

APR

Izvodi APR.

[210] Izbornik fotoaparata i detaljne postavke Mrežni izbornik

Žičani LAN

Postavljanje postavki za žične veze LAN.

Kompenzacija
promjene
žarišne duljine

Auto / Off Off Pogledajte odjeljak
„Kompenzacija promjene
žarišne duljine”.

Distance
Display

Meter / Feet Metar
Postavljanje prikazanih jedinica za
informacije o objektivu i položaj
fokusa.

Zoom Position
Display

Focal Length /
Number / Bar

Number
Postavljanje formata prikaza za
položaj zuma.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

APR
Execute /
Cancel

–

Izvodi APR (Automatic Pixel Restoration) za
automatsko podešavanje slikovnog senzora.
Izvrši: Izvršite funkciju.

Note

Prije izvođenja funkcije APR uvijek postavite
poklopac objektiva.

Stavka Postavka Tvorničke Opis
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[211] Izbornik fotoaparata i detaljne postavke Mrežni izbornik

Prijenos datoteka

Postavlja postavke povezane s prijenosima datoteka „O prijenosu datoteka”).

podstavke postavke

HTTP
ulaz

– 80 Prikazuje pristupni priključak HTTP.

Detail
Settings

– – Prikazuje svojstva žičane LAN veze.

DHCP 
On (Uključeno) /
Off (Isključeno)

On
Prikazuje je li DHCP omogućen (On
(Uključeno)) ili onemogućen (Off (Isključeno)).

IP Address –
Prikazuje IP adresu jedinice kad je funkcija
[DHCP] postavljena na [Off].

Subnet Mask –
Prikazuje masku podmreže jedinici kad je
funkcija [DHCP] postavljena na [Off].

Gateway –
Prikazuje zadani pristupnik kad je funkcija
[DHCP] postavljena na [Off].

DNS Auto
On (Uključeno) /
Off (Isključeno)

On
Prikazuje postavku automatskog dohvaćanja
DNS-a.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Auto
Upload
(Proxy)

On / Off Off
Uključuje/isključuje automatsko učitavanje proxy
datoteke.

Default
Upload
Server

Server
Settings1
to 3 >
Display
Name

–

Odabir poslužitelja za prijenos datoteka. Ovdje
odabran poslužitelj postaje automatsko odredište za
prijenos datoteka proxy, kao i odredište za prijenos
datoteka sa zaslona s minijaturama. 
Prikazuje postavke [Display Name] konfigurirane u
postavki [Server Settings1 to 3].
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[212] Izbornik fotoaparata i detaljne postavke Izbornik održavanja

Jezik

Postavljanje jezika prikaza.

[213] Izbornik fotoaparata i detaljne postavke Izbornik održavanja

Postavljanje sata

Postavljanje postavki unutarnjeg sata.

Clear
Completed
Jobs

Execute /
Cancel

–
Brisanje dovršene zadatke prijenosa s popisa.
Izvrši: Izvršite funkciju.

Clear All
Jobs

Execute /
Cancel

–
Brisanje svih zadataka prijenosa s popisa.
Izvrši: Izvršite funkciju.

View Job
List

– – Prikaz popisa sa zadacima prijenosa.

Stavka Postavka podstavke Tvorničke postavke Opis

Select – –
Postavljanje jezika prikaza.
Postavljanje: postavlja vrijednost.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Time
Zone

od UTC – 12:00 do
UTC + 14:00

–
Postavljanje vremenske razlike od UTC u
jedinicama od 30 minuta.

Date
Mode

YYMMDD /
MMDDYY /
DDMMYY

YYMMDD

Odabir formata prikaza datuma.
YYMMDD: godina, mjesec, dan
MMDDYY: mjesec, dan, godina
DDMMYY: dan, mjesec, godina



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[214] Izbornik fotoaparata i detaljne postavke Izbornik održavanja

Mjerač sati

Prikaz ukupnog vremena rada.

[215] Izbornik fotoaparata i detaljne postavke Postavke izbornika snimanja i zadane
vrijednosti

Postavke ISO-a / jačine signala i zadane vrijednosti

Raspon postavki [ISO/Gain<L>] i zadanih vrijednosti razlikovat će se ovisno o postavkama
[Mode], [Base Look] > [Select] i [Base Sensitivity].
Zadane su vrijednosti u tablama podebljane.

Kad je funkcija [Mode] postavljena na [ISO]

12H/24H 12H / 24H 24 h
Odabir formata prikaza sata.
12H: 12-satni način
24H: 24-satni način

Date – –
Postavljanje trenutačnog datuma.
Postavljanje: postavlja vrijednost.

Time – –
Postavljanje trenutačnog vremena.
Postavljanje: postavlja vrijednost.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Sati (Sustav) – –
Prikaz ukupnih radnih sati (nije moguće
ponovno postaviti).

Sati (Ponovno
postavljanje)

– –
Prikaz ukupnih radnih sati (moguće je
ponovno postaviti).

Reset
Execute /
Cancel

–
Ponovno postavlja akumulirano vrijeme
izvršavanja na 0.
Izvrši: Izvršite funkciju.
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Kad je funkcija [Base Look] > [Select] postavljena na [S-Cinetone], [Standard],
[ITU709] ili [Still]

Kad je funkcija [Base Look] > [Select] postavljena na [HLG Live] ili [HLG
Natural]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [Low]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [High]

ISO 320 
ISO 400 
ISO 500 
ISO 640 
ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [Low]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [High]

ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 

ISO 128000 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
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Kad je funkcija [Base Look] > [Select] postavljena od [User1] do [User16]

Kad je funkcija [Mode] postavljena na [dB]

Vrijednost u rasponu od -3 dB do +30 dB u pomacima od 1 dB se može konfigurirati.
Zadana je vrijednost 0 dB.

[216] Izbornik fotoaparata i detaljne postavke Postavke izbornika snimanja i zadane
vrijednosti

Postavke ograničavanja AGC-a i zadane vrijednosti

Raspon postavki izbornika [AGC Limit] i zadane vrijednosti razlikovat će se ovisno o

ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [Low]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [High]

ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600
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postavkama [Mode], [Base Look] > [Select] i [Base Sensitivity].
Zadane su vrijednosti u tablama podebljane.

Kad je funkcija [Mode] postavljena na [ISO]

Kad je funkcija [Base Look] > [Select] postavljena na [S-Cinetone], [Standard],
[ITU709] ili [Still]

Kad je funkcija [Base Look] > [Select] postavljena na [HLG Live] ili [HLG
Natural]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [Low]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [High]

ISO 400 
ISO 500 
ISO 640 
ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [Low]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [High]

ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 

ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
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Kad je funkcija [Base Look] > [Select] postavljena od [User1] do [User16]

Kad je funkcija [Mode] postavljena na [dB]

Odaberite između 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Zadana je vrijednost 15 dB.

[217] Izbornik fotoaparata i detaljne postavke

Spremljene postavke kvalitete fotografije za svaki
način snimanja

ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [Low]

Kad je funkcija [ISO/Gain/EI] > [Base
Sensitivity] postavljena na [High]

ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600
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Trenutni status stavki konfiguracije povezanih s kvalitetom fotografije spremljen je za svaki od
sljedećih načina snimanja. Kad promijenite način snimanja, odgovarajuće postavke koje se
spremaju za ciljni način snimanja se primjenjuju.

Prikaz cilja prilagođenog načina SDR(BT.709)
Prikaz cilja prilagođenog načina HDR(HLG)
Način Cine EI

Stavke konfiguracije povezane s kvalitetom fotografije koje se spremaju za svaki način snimanja
prikazuju se u sljedećoj tablici.
„Da” označava da je postavka spremljena, a „Ne” označava da postavka nije spremljena. „Da”
stupci višestrukog protezanja označava zajedničke postavke.

Stavka

Režim snimanja

Prilagođeni način Način
Cine

EISDR(BT.709) HDR(HLG)

Izbornik
Shooting

ISO/Gain/EI

ISO/Gain Da1) Ne

Exposure Index Ne Da

Base Sensitivity Da Ne

Base ISO Ne Da

Bijeli

Preset White Da Da

Drugačije od
navedenog

Da

White Setting Da

Offset White Da Ne

LUT On/Off Ne Da

Noise
Suppression

Setting(Custom) Da Da Ne

Level(Custom) Da Da Ne

Setting(Cine EI) Ne Da

Level(Cine EI) Ne Da

Select Da Da Da
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[218] Web-izbornik i detaljne postavke

Konfiguracija web-izbornika

Pritisnite zaslon prebacivanja kartica [Settings] za prikaz zaslona postavki.
Upotrijebite zaslon postavki za konfiguraciju različitih stavki postavljanja jedinice uključujući
početne postavke, mrežne postavke, postavke snimanja/reprodukcije s pomoću web-izbornika.

Izbornik
Paint/Look

Base Look
Input2) Da

Output2) Da

AE Level Offset2) Da

Crni Da Da Ne

Komprimiranje

Auto Knee Da Ne Ne

Drugačije od
navedenog

Da Da Ne

Detalj Da Da Ne

Matrix Da Da Ne

Multi Matrix Da Da Ne

Zasebne postavke ISO osjetljivosti spremaju se na prilagođeni način [SDR(BT.709)] i [HDR(HLG)].1)
Postavke se spremaju za svaki [Base Look], ali ne ovise o načinu snimanja.2)
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Izbornik se sastoji od sljedećih izbornika.

Hijerarhija i konfiguracija izbornika

razina 1 Opis razine 1 razina 2

Snimanje Obuhvaća postavke za snimanje. Focus

Project Obuhvaća osnovne postavke projekta.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Obuhvaća postavke za kvalitetu slike. Base Look
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Pan-Tilt
Sadrži postavke povezane s
pomicanjem/nagibanjem.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Obuhvaća postavke za unos videozapisa i prikaz
zaslona.

Output Format

Output Display

Audio Obuhvaća postavke za zvuk. Audio

Technical Obuhvaća postavke za tehničke stavke.
Tally

IR daljinski upravljač

Network Obuhvaća postavke za mreže.

Naziv fotoaparata

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Provjera reference

Zaštita od nasilnog
napada

Usmjeravanje Sadrži postavke povezane s usmjeravanjem.

Usmjeravanje

Usmjeravanje
videozapisa

Usmjeravanje zvuka

Language
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Note

[Accessibility] jedino je dostupno za modele u Sjevernoj Americi.

[219] Web-izbornik i detaljne postavke

Rad web-izbornika

Pritisnite zaslon prebacivanja kartica [Settings] za prikaz zaslon postavki za konfiguraciju
različitih stavki postavljanja jedinice, uključujući početne postavke, mrežne postavke, postavke
snimanja/reprodukcije s pomoću web-izbornika.
Konfigurirajte postavke u web-izborniku na tabletu s pomoću dodirnih radnji ili računala s
pomoću miša.
Pritisnite izbornik za stavke koje želite konfigurirati za prikaz stavki postavljanja i njihovih
postavki u tom izborniku.

Održavanje Obuhvaća postavke uređaja, primjerice sat i jezik.

Pristupačnost

Clock Set

Reset

Information

Zapisnik sustava

HTTP zapisnik pristupa

Service

EULA

Softver
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Način konfiguracije

Odabir vrijednosti

Pritisnite gumb radija za stavku. Gumb radija za odabrane stavke prikazuje se u narančastoj
boji.

Uključivanje/isključivanje stavke

Izbornik (razina 1)1.

Izbornik (razina 2)2.

Settings3.
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Pritisnite prekidač kako biste uključili/isključili stavku. Prekidač je narančaste boje kad se stavka
uključi, a bijele boje kad se isključi.

Odabir vrijednosti s popisa

Pritisnite padajući gumb i odaberite stavku s prikazanog popisa.

Odabir numeričke vrijednosti

Pritisnite < or > za promjenu numeričke vrijednosti. Ako je numerička vrijednost podcrtana,
također možete izravno unijeti numeričku vrijednost.

Unos znakova/brojeva

Konfiguracija na zasebnom zaslonu
Pritisnite gumb za izvršavanje radnji na zasebnom zaslonu.

Poruka usmjeravanja

Informacije koje vam pomažu pri konfiguraciji određenih postavki i poruke koje obraćaju
pozornost na korisnika su prikazane.

Spremanje postavke

Kad dovršite konfiguraciju postavke, pritisnite gumb [OK] za spremanje postavke.
Pritisnite gumb [Cancel] kako biste odbacili promjene postavke i vratili se na prethodnu
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postavku.
Pritisnite gumb [Reload] za ažuriranje prikaza zaslona.

Note

Ako pritisnete gumb [Reload] prije spremanja postavke, odbacit će se promjene postavke.

Ako se prebacite na drugu stranicu prije spremanja postavke, odbacit će se promjene postavke.

[220] Web-izbornik i detaljne postavke Izbornik snimanja

Fokus

Postavljanje postavki za fokusiranje.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Push AF
Mode

AF / Single-
shot AF(AF-S)

AF
Postavlja način za automatsko fokusiranje
pritiskanjem.

Dodirna
funkcija u
ručnom
fokusu

Praćenje
automatskog
fokusa / fokus
točke

AF za
praćenje

Postavlja rad kad se zaslon fotografije
fotoaparata dodirne u načinu ručnog fokusa.

AF Assist
Control

On / Off On

Kad je funkcija postavljena na [On], možete
upotrijebiti klizač fokusa u web-aplikaciji tijekom
automatskog fokusa za prilagodbu položaja
fokusa.

Pojedinosti pogledajte u odjeljku „Ručno
postavljanje ciljnog automatskog fokusa (AF
Assist) s pomoću web-aplikacije”.

Note

Ova se stavka omogućava samo kad je
funkcija [AF Assist] postavljena na [On] u
izborniku fotoaparata.
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[221] Web-izbornik i detaljne postavke Izbornik projekt

Osnovno postavljanje

Postavljanje osnovnih postavki.

[222] Web-izbornik i detaljne postavke Izbornik projekt

Format snimanja

Postavljanje postavki za format snimanja.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Shooting
Mode

Custom / Cine
EI

Custom

Postavlja način snimanja.
Pogledajte „Način snimanja” u odjeljku
„Konfiguracija osnovnih radnji”.

Target
Display

SDR(BT.709) /
HDR(HLG)

SDR(BT.709)
Postavlja prostor boje za snimanje/emitiranje
načina Custom (Prilagođeno).

Stavka Postavka podstavke Tvorničke
postavke Opis

Frekvencija
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59,94

Odabir frekvencije sustava.

Note

Ako se promijeni frekvencija,
fotoaparat će se ponovno
pokrenuti. Nakon ponovnog
pokretanja, ponovno učitajte
web-preglednik.

Imager
Scan Mode

FF / S35 FF Odabir veličine pretražnika.

Postavlja kodek isječka za
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Postavke [RAW Output Format]

Zadane su vrijednosti podebljane.
Uvjeti prema kojima se funkcija [RAW Output Format] ne smije izostaviti.

Postavke [Video Format]

Kodek
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

snimanje/reprodukciju.

Note

Kad je funkcija [Imager Scan
Mode] postavljena na [S35],
[RAW] i [RAW & XAVC-I] se
ne mogu odabrati.

RAW
Output
Format

Dostupne postavke razlikovat
će se ovisno o postavki
[Frequency].

Pogledajte „Postavke
funkcije RAW Output
Format]” u nastavku.

–

Postavlja veličinu RAW
fotografije za emitiranje na
vanjski RAW snimač.

Note

Kad je funkcija [Codec]
postavljena na [RAW &
XAVC-I], postavka [Video
Format] prebacuje se u vezi
s postavkom [RAW Output
Format].

Format
videozapisa

Dostupne postavke razlikovat
će se ovisno o postavkama
[Frequency], [Imager Scan
Mode] i [Codec].

Pogledajte „Postavke
funkcije [Video Format]” u
nastavku.

–
Postavlja veličinu slike i brzinu
bitova.

Frekvencija Imager Scan Mode Kodek Setting

59,94 / 50 / 29,97 / 25 / 23,98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Zadane su vrijednosti podebljane.

[223] Web-izbornik i detaljne postavke Izbornik projekt

Istovremeno snimanje

Postavlja postavke načina istovremenog snimanja u dva utora (pogledajte odjeljak „Istovremeno
snimanje na memorijsku karticu A i B (2-slot Simul Rec)”).

Frekvencija Imager Scan
Mode Kodek Setting

59,94 / 50 / 29,97 / 25 /
23,98

FF

RAW –

RAW i XAVC-I
4096×2160P 
3840×2160P

XAVC-I
4096×2160P 
3840×2160P 
1920×1080P

XAVC-L

3840×2160P 
1920×1080P
50 
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50 
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
XAVC-I

4096×2160P

Stavka Postavka
podstavke

Tvorničke
postavke Opis
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[224] Web-izbornik i detaljne postavke Izbornik projekt

Proxy snimanje

Postavlja postavke načina proxy snimanja (pogledajte odjeljak „Proxy snimanje”).

[225] Web-izbornik i detaljne postavke Izbornik projekt

Intervalno snimanje

Postavlja postavke načina intervalnog snimanja (pogledajte odjeljak „Isprekidano snimanje
videozapisa (Interval Rec)”).

Setting On / Off Off
Uključenje/isključenje funkcije istovremenog
snimanja i postavljanje odredišnog medija za
snimanje.

Rec
Button

Utor A / Utor B
/ Utor A/Utor B

Utor A /
Utor B

Prikazuje dodjelu gumba snimanja za svaki medij
za snimanje. 
Postavite funkciju [Project] > [Simul Rec] > [Rec
Button Set] u izborniku fotoaparata.

2. gumb
snimanja

Utor A / Utor B
/ Utor A/Utor B

Utor A /
Utor B

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off Off
Uključenje/isključenje načina za snimanje
proxy.

Stavka Postavka podstavke Tvorničke postavke Opis

Setting On / Off Off

Uključenje/isključenje
načina za snimanje s
intervalima. (Uključenjem
ovog načina postavljanjem
na On svi drugi posebni
načini isključuju se
postavljanjem na Off).
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[226] Web-izbornik i detaljne postavke Izbornik projekt

Snimanje predmemorije fotografije

Postavlja postavke načina snimanja predmemorije fotografija (pogledajte odjeljak „Snimanje
fotografija iz predmemorije (Picture Cache Rec)”).

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (sek) 
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (min) 
1 / 2 / 3 / 4 / 6 / 12 / 24
(sati)

1

Postavljanje intervala
između snimanja u načinu
snimanja Interval Rec
recording (kada je način
Interval Rec postavljen na
On (Uključeno)).

Number
of
Frames

1 kadar / 2 kadra / 3
kadra / 6 kadrova / 9
kadrova / 12 kadrova 
Dostupne postavke
razlikovat će se ovisno o
učestalosti kadrova
odabranog formata
videozapisa.
59.94P/50P: 2 kadra / 6
kadrova / 12 kadrova
29.97P/25P/24P/23.98P:
1 kadar / 3 kadra / 6
kadrova / 9 kadrova

59.94P/50P: 2 kadra
29.97P/25P/24P/23.98P:
1 kadar

Postavljanje broja kadrova
po snimanju u načinu
snimanja Interval Rec
recording (kada je način
Interval Rec postavljen na
On (Uključeno)).

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off Off
Uključenje/isključenje funkcije fotografija u
predmemoriju.

Veličina
predmemorije

Kratko /
srednje / dugo
/ maksimalno

Maks.
Postavljanje vremena za nakupljanje slika u
predmemoriji za slike (vrijeme snimanja u
predmemoriju za slike).

Cache Rec
– –

Prikaz vremena za nakupljanje slika u
predmemoriji za fotografije (vrijeme snimanja u
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[227] Web-izbornik i detaljne postavke Izbornik projekt

Sve datoteke

Izvršava rad datoteke ALL (pogledajte odjeljak „Spremanje i učitavanje podataka za
konfiguraciju”).

[228] Web-izbornik i detaljne postavke Izbornik Boja/izgled

Osnovni izgled

Možete učitati osnovni izgled na jedinicu.
Popis dostupnih osnovnih izgleda prikazuje se na zaslonu. Trenutno primijenjeni osnovni izgled
označen je oznakom ? na lijevoj strani broja osnovnog izgleda.

Time
predmemoriju za fotografije).

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Učitajte
sve
datoteke

– –

Učitajte datoteku ALL na jedinicu s uređaja koji
pokreće web-aplikaciju.

Note

Kad se datoteka ALL učita na jedinicu, jedinica će se
ponovno pokrenuti. Nakon ponovnog pokretanja,
ponovno učitajte web-preglednik.

Spremite
sve
datoteke

– –
Spremite postavke jedinice na uređaj koji pokreće
web-aplikaciju kao datoteku ALL.
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[No.]: broj osnovnog izgleda
[Base Look Name]: naziv osnovnog izgleda
[Input]: ulazni signal osnovnog izgleda
[Output]: izlazni signal osnovnog izgleda
[AE Level Offset]: referentna vrijednost ekspozicije osnovnog izgleda

Dodavanje osnovnog izgleda
Pritisnite gumb [Import] za uvoz novog osnovnog izgleda. Slijedite upute na zaslonu.
Nakon uvoza postavite odgovarajuće vrijednosti za funkcije [Input], [Output] i [AE Level Offset].
Pojedinosti pogledajte u odjeljku „Uvoz željenog osnovnog izgleda”.

[229] Web-izbornik i detaljne postavke Izbornika pomicanja/nagibanja

Brzina pomicanja/nagibanja

Postavlja postavke povezane s brzinom pomicanja/nagibanja.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Postavlja broj pomaka brzine pogona
pomicanja/nagibanja.
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[230] Web-izbornik i detaljne postavke Izbornik pomicanja/nagibanja

Ubrzanje pomicanja/nagibanja

Postavlja postavke povezane s brzinom pomicanja/nagibanja.

[231] Web-izbornik i detaljne postavke Izbornik pomicanja/nagibanja

Ograničenja raspona pomicanja/nagibanja

Postavlja postavke povezane s ograničavanjem raspona rada pomicanja/nagibanja.
Postavlja ograničenje raspona rada pomicanja/nagibanja s pomoću sljedećeg zaslona.

Note

Pomaci
brzine

Normalno/prošireno Prošireno

Normalno: brzina se može odrediti s pomoću
raspona od 24 pomaka. Upotrijebite ovu
postavku za kompatibilnost postojećim
udaljenim fotoaparatima tvrtke Sony.
Prošireno: brzina se može odrediti s pomoću
raspona od 50 pomaka.

Način
brzine

Normalno/sporo Normal

Postavlja način brzine pogona
pomicanja/nagibanja. 
Omogućeno je samo kad je funkcija [Speed
Step] postavljena na [Normal].
Normalno: radi rasponom normalne brzine
(minimalno do maksimalnog (60
stupnjeva/sekundi)).
Sporo: radi rasponom spore brzine (minimalno
do maksimalnog (40 stupnjeva/sekundi)).

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Ubrzanje od 1 do 9 8
Odabire ubrzavanje/usporavanje
pomicanja/nagibanja. Što je taj broj veći, to je veće
ubrzanje.
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Kad se jedinica uključi ili se izvrši ponovno postavljanje pomicanja/nagibanja, ignorira se postavka
ograničenja raspona. Ova se funkcija ne može upotrebljavati za izbjegavanje prepreka u blizini
jedinice.

Prekidač [Setting] postavite u položaj za uključivanje.

Omogućava se funkcija ograničavanja raspona rada pomicanja/nagibanja.

1

Provjerite sliku s pomoću kontrola za pomicanje/nagibanje fotoaparata.2

Za postavljanje položaja pri kojima se ograničava rad pritisnite gumb [Left], [Right],
[Up], [Down] > [Set Current Value] na tim položajima.

[Left]: lijeva strana fotoaparata
[Right]: desna strana fotoaparata
[Up]: gornja strana fotoaparata
[Down]: donja strana fotoaparata

3
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Note

Položaji fotoaparata izvan položaja ograničavanja ne mogu se spremiti kao unaprijed postavljene
postavke.

Ako se postavka [Pan-Tilt] > [P/T Direction] > [Ceiling] promijeni, postavke konfiguriranog položaja
ograničavanja vraćaju se na tvorničke postavke.

Postavka se ne može promijeniti tijekom reprodukcije, tijekom prikaza minijatura, kad se pojavi
pogreška pomicanja/nagibanja, kad se pomicanje/nagibanje ne inicijalizira i kad je
pomicanje/nagibanje zaključano.

[232] Web-izbornik i detaljne postavke Izbornik pomicanja/nagibanja

Smjer pomicanja/nagibanja

Postavlja postavke povezane sa smjerom pomicanja/nagibanja.

Položaji ograničavanja postavljaju se i prikazuju kao numeričke vrijednosti (kut).
Za otkazivanje ograničavanja pritisnite gumb [Reset] za pojedine položaje.

Pritisnite gumb [OK].

Rad pomicanja/nagibanja ograničen je da ostaje unutar konfiguriranih položaja
ograničavanja.

4

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Strop On / Off Off

Kad se jedinica montira na radnu površinu, postavite
na [Off]. Kad se jedinica montira na strop, postavite
na [On]. Kad je funkcija [Ceiling] postavljena na [On],
[Pan Direction] automatski se postavlja na [Opposite].
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Note

Kad se promijenjena postavka [Ceiling] primijeni, svi unaprijed postavljeni položaji se brišu budući da
će se koordinate pomicanja/nagibanja obrnuti.

Raspon pogona pomicanja/nagibanja mijenja se kako je prikazano sljedećim dijagramom ovisno
postavki [Ceiling].

A: Kad se funkcija [Ceiling] (Strop) postavi na [Off] (Isključeno)
B: Kad se funkcija [Ceiling] (Strop) postavi na [On] (Uključeno)

[233] Web-izbornik i detaljne postavke Izbornik pomicanja/nagibanja

Unaprijed postavljeno pomicanje/nagibanje

Postavlja postavke povezane s unaprijed postavljenim postavkama fotoaparata.

Smjer
pomicanja

Normal /
Opposite

Normal
Postavlja smjer pomicanja. Kad se postavka
promijeni, smjer pogona se obrne.

Smjer
nagibanja

Normal /
Opposite

Normal
Postavlja smjer nagibanja. Kad se postavka
promijeni, smjer pogona se obrne.

Stavka Postavka
podstavke

Tvorničke
postavke Opis
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[234] Web-izbornik i detaljne postavke Izbornik nadzora

Izlazni format

Postavljanje postavki za izlazni format.

[235] Web-izbornik i detaljne postavke Izbornik nadzora

Izlazni prikaz

Postavlja postavke povezane s izlaznim signalima.

Odabir
brzine

Zasebno/zajedničko Zasebno
Postavlja hoće li se unaprijed postavljene
brzine konfigurirati zasebno ili upotrijebiti
zajedničku postavku.

Zajednička
brzina

od 1 do 50 50

Postavlja zajedničku brzinu za unaprijed
postavljene postavke.

Note

Maksimalna brzina pogona od 24
upotrebljava se ako je vrijednost od 25 ili
veća postavljena kad je funkcija [Pan-Tilt]
> [P/T Speed] > [Speed Step] postavljena
na [Normal].

Stavka Postavka podstavke Tvorničke
postavke Opis

SDI Pojedinosti o postavkama pogledajte u
odjeljku „Izlazni formati i ograničenja”.

– Postavljanje izlazne
razlučivosti za SDI i
HDMI.HDMI –

Stavka Postavka
podstavke

Tvorničke
postavke Opis

SDI On / Off Off
Postavlja hoće li se izbornik i status ugraditi
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Note

Ova se postavka također primjenjuje na HDMI izlazni signal fotografije, usmjeravanje izlazne
fotografije i fotografiju u web-aplikaciji ploče fotografija fotoaparata.

[236] Web-izbornik i detaljne postavke Izbornik zvuka

Ulaz zvuka

Postavlja postavke povezane s ulazom zvuka CH1 do CH4.

Postavlja glavnu razinu ulaza zvuka. Glavna razina ulaza zvuka upotrebljava se za sve kanale
od 1 do 4.

u SDI izlazni signal.

HDMI/Stream On / Off On
Postavlja hoće li se izbornik i status ugraditi
u HDMI izlazni signal.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Level
Control

Auto / Manual Auto
Odabire automatsku prilagodbu razine
ulaza zvuka ili ručnu prilagodbu.

Level od 0 do 99 49 Postavlja razinu ulaza.

Odabir
ulaza

AUDIO IN CH1 /
AUDIO IN CH2 / Off

CH1 i CH3:
AUDIO IN CH1
CH2 i CH4:
AUDIO IN CH2

Postavlja izvor ulaza zvuka.

Note

CH1 je [AUDIO IN CH1] (fiksno).

Filtar
vjetra

On / Off Off
Uključivanje/isključivanje filtra smanjenja
buke vjetra.

Stavka Postavka podstavke Tvorničke postavke Opis

Glavno od 0 do 99 99 Postavlja glavnu razinu ulaza.



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[237] Web-izbornik i detaljne postavke Izbornik zvuka

Izlaz zvuka

Postavlja postavke povezane s izlazom zvuka.

Note

Ova se postavka također primjenjuje na izlaz zvuka usmjeravanja.

[238] Web-izbornik i detaljne postavke Tehnički izbornik

Signalizacija

Postavlja žaruljicu snimanja / signalnog svjetla (pogledajte odjeljak „Priključivanje signalizacije”).

[239] Web-izbornik i detaljne postavke Tehnički izbornik

Stavka Postavka
podstavke

Tvorničke
postavke Opis

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Postavljanje kombinacije zvučnih kanala na
izlazu HDMI/usmjeravanje.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Svjetlina
signalizacije

Jako / Slabo
/ Isključeno

High
Postavlja svjetlinu žaruljice
snimanja/signalizacije.

Žaruljica
signalizacije
G

Enable /
Disable

Enable
Omogućava/onemogućava žaruljicu
signalizacije G.

Upravljanje
signalizacijom

Eksterno /
interno

Interno
Odabire cilj za prihvaćanje informacija
upravljanja žaruljicom snimanja/signalizacije.
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Infracrveni daljinski upravljač

Postavlja postavke povezane s infracrvenim daljinskim upravljačem.

[240] Web-izbornik i detaljne postavke Mrežni izbornik

Naziv fotoaparata

Postavlja postavke povezane s nazivom fotoaparata (naziv jedinice).

Najviše osam (od 0 do 8) sljedećih znakova može se unijeti kao naziv fotoaparata.
Alfanumerički znakovi
Simboli (space !#$`*+-./;<=>?@[\]^_`{|})

[241] Web-izbornik i detaljne postavke Mrežni izbornik

Korisnik

Postavlja postavke povezane s korisničkim pristupom jedinici.

Postavke povezane s administratorskim korisnicima (Administrator) (potrebno)

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off On
Omogućava/onemogućava rad jedinice s
infracrvenog daljinskog upravljača.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Naziv
fotoaparata

– FR7
Postavlja naziv
fotoaparata.

Stavka Postavka
podstavke

Tvorničke
postavke Opis
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Postavke povezane s općim korisnicima (Korisnik 1 do Korisnik 9) (dodatno)

[242] Web-izbornik i detaljne postavke Mrežni izbornik

Žičani LAN

Status
Prikazuje status mreže.

User Name – admin Postavlja korisničko ime.

Trenutna lozinka – –
Kad mijenjate lozinku, unesite
trenutnu lozinku.

Nova lozinka – – Unesite novu lozinku.

Ponovno upišite
novu lozinku

– –
Ponovno unesite novu lozinku za
potvrdu.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

User Name – – Postavlja korisničko ime.

Trenutna lozinka – –
Kad mijenjate lozinku, unesite
trenutnu lozinku.

Nova lozinka – – Unesite novu lozinku.

Ponovno upišite
novu lozinku

– –
Ponovno unesite novu lozinku za
potvrdu.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Host Name – – Prikazuje ime domaćina.

MAC Address – – Prikazuje MAC adresu jedinice.

Status Etherneta – –
Prikazuje trenutnu brzinu
komunikacije.
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IPv4
Postavlja postavke povezane s IPv4 mrežom.

IPv6
Postavlja postavke povezane s IPv6 mrežom.

IP Address – – Prikazuje IP adresu jedinice.

Subnet Mask – –
Prikazuje masku podmreže
jedinice.

Gateway – –
Prikaze IPv4 zadani pristupnik
jedinice.

Primary DNS
Server

– –
Prikazuje primarni DNS poslužitelj
jedinice.

Secondary DNS
Server

– –
Prikazuje sekundarni DNS
poslužitelj jedinice.

IPv6 adresa 1 – – Prikazuje IPv6 adresu 1 jedinice.

IPv6 adresa 2 – – Prikazuje IPv6 adresu 2 jedinice.

IPv6 zadani
pristupnik

– –
Prikaze IPv6 zadani pristupnik
jedinice.

Lokalna veza IPv6
adrese

– –
Prikazuje IPv6 lokalnu vezu
adrese jedinice.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

DHCP On / Off On Uključenje/isključenje funkcije [DHCP].

IP
Address

– –
Postavlja IPv4 adresu kad je funkcija [DHCP]
postavljena na Off (Isključeno).

Subnet
Mask

– –
Postavlja masku podmreže kad je funkcija [DHCP]
postavljena na Off (Isključeno).

Gateway – –
Postavlja IPv4 zadani pristupnik kad je funkcija
[DHCP] postavljena na Off (Isključeno).
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Zajedničko
Postavlja zajedničke postavke za IPv4/IPv6 mreže.

[243] Web-izbornik i detaljne postavke Mrežni izbornik

Prijenos datoteka

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Automatsko
dohvaćanje IP
adrese

On / Off On
Uključivanje/isključivanje dohvaćanja IPv6
adrese.

IP Address – –
Postavlja IPv6 adresu kad je funkcija [Obtain an
IP Address Automatically] postavljena na Off
(Isključeno).

Dužina
prefiksa

– –
Postavlja prefiks kad je funkcija [Obtain an IP
Address Automatically] postavljena na Off
(Isključeno).

Gateway – –
Postavlja IPv6 zadani pristupnik kad je funkcija
[Obtain an IP Address Automatically] postavljena
na Off (Isključeno).

Stavka Postavka
podstavke

Tvorničke
postavke Opis

HTTP ulaz
80, 1024
do 65 534

80 Postavlja HTTP broj ulaza.

DNS Auto On / Off On
Postavlja hoće li se dohvatiti DNS adrese iz DHCP
poslužitelja.

Primary
DNS
Server

IPv4/IPv6
adresa

–
Unos primarnog poslužitelja za DNS kada je funkcija
[DNS Auto] postavljena na Off (Isključeno).

Secondary
DNS
Server

IPv4/IPv6
adresa

–
Unos sekundarnog poslužitelja za DNS kada je
funkcija [DNS Auto] postavljena na Off (Isključeno).
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Postavljanje postavki za prijenose.

[244] Web-izbornik i detaljne postavke Mrežni izbornik

FTP poslužitelj 1 do 3

Postavlja postavke povezane s datotekom FTP prijenosa.
Postavke su zajedničke za FTP poslužitelj 1 do 3.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Auto
Upload
(Proxy)

On / Off Off
Uključuje/isključuje automatsko učitavanje proxy
datoteke.

Default
Upload
Server

Server
Settings1
to 3 >
Display
Name

Server
Settings1

Odabir poslužitelja za prijenos datoteka. Ovdje odabran
poslužitelj postaje automatsko odredište za prijenos
datoteka proxy, kao i odredište za prijenos datoteka sa
zaslona s minijaturama. 
Prikazuje postavke [Display Name] konfigurirane u
postavki [Server Settings1 to 3].

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Display
Name

– –
Postavljanje naziva za prikaz koji se prikazuje u
izborniku za postavljanje odredišta za prijenos.

Service – – Prikaz vrste poslužitelja.

Host Name – –
Postavljanje naziva domaćina odredišnog
poslužitelja za prijenos.

Port
21, 990,
1024 do
65 534

21
Postavljanje broja ulaza odredišnog poslužitelja za
prijenos.

User Name – –
Postavljanje korisničkog imena za provjeru
autentičnosti za vezu s odredišnim poslužiteljem za
prijenos.
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[245] Web-izbornik i detaljne postavke Mrežni izbornik

SSL

Postavlja postavke povezane s SSL-om.

SSL
Omogućuje/onemogućuje funkciju SSL.

Password – –
Postavljanje lozinku za provjeru autentičnosti veze s
odredišnim poslužiteljem.

Passive
Mode

On / Off Off Uključuje/isključuje pasivni način rada.

Destination
Directory

– – Postavlja naziv odredišne mape za prijenos.

Using
Secure
Protocol

On / Off Off
Postavlja hoće li se upotrijebiti (On (Uključeno)) ili se
neće upotrijebiti (Off (Isključeno)) sigurni FTP
prijenos.

Root
Certificate

– –

Učitava korijenski certifikat za sigurni FTP prijenos. 
Pritisnite funkciju [Load] i odaberite korijenski
certifikat na prikazanom zaslonu. 
Pritisnite gumb [Delete] za brisanje učitanog
korijenskog certifikata.

Root
Certificate
Status

– – Prikazuje status učitavanja korijenskog certifikata.

Reset – –
Ponovno postavlja postavke [Server Settings] na
zadane.

Stavka Postavka podstavke Tvorničke
postavke Opis

Function
Onemogući / Omogući / Omogući
(Omogućite HTTP vezu za iste klijente)

Disable
Omogućuje/onemogućuje
funkciju SSL.
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Autentifikacija SSL poslužitelja
Postavlja postavke povezane s autentifikacijom SSL poslužitelja.

Stavka Postavka podstavke Tvorničke
postavke Opis

Mogućnosti
certifikata

Upotrijebite certifikat za
samostalnu prijavu (za
testnu upotrebu) /
Upotrijebite vanjski
certifikat

–
Postavlja metodu instalacije certifikata
SSL poslužitelja.

Status – –

Prikazuje valjanost certifikata SSL
poslužitelja kad je funkcija [Certificate
Options] postavljena na [Use a self-
signed certificate (For test use)].

DN izdavač – –

Prikazuje istaknuti naziv izdavača
certifikata SSL poslužitelja kad je
funkcija [Certificate Options]
postavljena na [Use a self-signed
certificate (For test use)].

DN subjekt – –

Prikazuje istaknuti naziv subjekta
certifikata SSL poslužitelja kad je
funkcija [Certificate Options]
postavljena na [Use a self-signed
certificate (For test use)].

Dostupno
razdoblje

– –

Prikazuje valjano razdoblje certifikata
SSL poslužitelja kad je funkcija
[Certificate Options] postavljena na
[Use a self-signed certificate (For test
use)].

Produljena
upotreba
ključa

– –

Prikazuje metodu produljene upotrebe
ključa kad je funkcija [Certificate
Options] postavljena na [Use a self-
signed certificate (For test use)].

Delete – –

Ovaj se gumb prikazuje kad je funkcija
[Certificate Options] postavljena na
[Use a self-signed certificate (For test
use)]. 
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[246] Web-izbornik i detaljne postavke Mrežni izbornik

Provjera reference

Postavlja postavke povezane s provjerom reference.

Popis iznimaka
Postavlja postavke povezane s popisom iznimki provjere reference.

Briše sve instalirane certifikate SSL
poslužitelja.

Uvezi – –

Instalira vanjski certifikat SSL
poslužitelja s popisa kad je funkcija
[Certificate Options] postavljena na
[Use an external certificate].

Lozinka
privatnog
ključa

– –

Postavlja lozinku za informacije
privatnog ključa certifikata SSL
poslužitelja kad je funkcija [Certificate
Options] postavljena na [Use an
external certificate].

Reset – –
Ovaj gumb briše sve prikaze lozinka
privatnog ključa za unos nove lozinke.

Generiranje
certifikata
za
samostalnu
prijavu

– –

Pritisnite gumb [Generate] kako bi se
generirao certifikat za samostalnu
prijavu kad je funkcija [Certificate
Options] postavljena na [Use a self-
signed certificate (For test use)].

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off On
Omogućava/onemogućava funkciju provjere
reference.
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[247] Web-izbornik i detaljne postavke Mrežni izbornik

Zaštita od nasilnog napada

Postavlja postavke povezane sa zaštitom od nasilnog napada.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Ne. od 1 do 10 – Postavlja broj iznimki s popisa.

Host
Name

– – Postavlja naziv domaćina iznimke.

Broj
ulaza

– – Postavlja broj ulaza iznimke.

Postavi – –
Pritisnite za registraciju konfigurirane iznimke s popisa
iznimaka.

Delete – –
Odaberite iznimku koju želite obrisati i pritisnite gumb za
brisanje registrirane iznimke s popisa iznimaka.

Stavka Postavka Tvorničke Opis
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Kad se otkrije napadač, prikazuje se popis napadača.

[248] Web-izbornik i detaljne postavke Izbornik usmjeravanja

Usmjeravanje

Postavlja postavke usmjeravanja (pogledajte odjeljak „O usmjeravanju”).

Postavke usmjeravanja
Postavlja postavke povezane s protokolom usmjeravanja.

podstavke postavke

Setting On / Off On
Uključuje/isključuje funkciju [Brute Force Attack
Protection].

Broj od 3 do 100 8
Postavlja broj pokušaja koji se smatraju napadom. 
Omogućeno kad je [Setting] postavljena na On
(Uključeno).

Način
otpuštanja

Uvijek/brojač
Mjerač
vremena

Postavlja uvjete otpuštanja. 
Omogućeno kad je [Setting] postavljena na On
(Uključeno).
Uvijek: nemojte obrisati s popisa napadača.
Brojač: obrišite s popisa napadača nakon što je
vrijeme otpuštanja postavljeno s pomoću funkcije
[Release Time] isteklo.

Vrijeme
otpuštanja

od 30 do 86
400 s

60

Postavlja vrijeme otpuštanja. 
Omogućeno kad je [Setting] postavljena na On
(Uključeno). 
Kad je funkcija Release Mode: postavljena na
[Timer], unosi se brišu s popisa napadača nakon
što je proteklo vrijeme otpuštanja.

Stavka Postavka podstavke Tvorničke
postavke Opis

Setting
RTSP / SRT-Caller / SRT-Listener /
NDI|HX / Off

RTSP
Odabire protokol
usmjeravanja.
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RTSP
Prikazuju se sljedeće stavke kad je funkcija [Stream Setting] postavljena na [RTSP].
Postavlja postavke povezane s RTSP usmjeravanjem.

SRT
Prikazuju se sljedeće stavke kad je funkcija [Stream Setting] postavljena na [SRT-Caller] ili
[SRT-Listener].
Postavlja postavke povezane s SRT usmjeravanjem.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Broj ulaza
554, 1024
do 65 534

554 Postavlja RTSP broj ulaza.

Vremenska
granica

od 0 do
600

60
Postavlja vremensku granicu komande [Keep
Alive] za RTSP usmjeravanje.

Autentifikacija On / Off On Uključuje/isključuje funkciju RTSP autentifikacije.

Videoulaz
broj 1

od 1024 do
65534

51000
Postavlja broj ulaza za slanje videozapisa 1 za
RTSP jednoodredišno usmjeravanje.

Videoulaz
broj 2

od 1024 do
65534

53000
Postavlja broj ulaza za slanje videozapisa 2 za
RTSP jednoodredišno usmjeravanje.

Broj ulaza
zvuka

od 1024 do
65534

57000
Postavlja broj ulaza za slanje zvuka za RTSP
jednoodredišno usmjeravanje.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Destination – –
Postavlja odredište URL veze kad jedinica
radi kao pozivatelj.

Broj ulaza
od 1024 do
65534

4201
Postavlja broj ulaza za slušanje kad jedinica
radi kao slušatelj.

Latencija
od 20 do 8000
ms

120 Postavlja latentnost.

TTL od 1 do 255 64 Postavlja TTL vrijednost.

Off / AES128 / Omogućava/onemogućava šifriranje i
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NDI|HX
Prikazuju se sljedeće stavke kad je funkcija [Stream Setting] postavljena na [NDI|HX].
Postavlja postavke povezane s funkcijom NDI|HX.

Šifriranje
AES256

Off
postavlja metodu šifriranja.

Izraz za
šifriranje

0 ili niz od 10 do
79 znakova

0
Postavlja pristupni izraz za šifriranje. 
Pritisnite Reset (Ponovno postavi) za brisanje
unesenih izraza za šifriranje.

ARC On / Off On
Uključuje/isključuje funkciju [Adaptive Rate
Control].

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Licenca – –
Prikazuje status instalacije NDI ključa za
licencu.

Naziv izvora – – Prikazuje NDI naziv izvora.

Grupa On / Off Off
Uključuje/isključuje NDI funkciju
grupiranja.

Naziv grupe – –
Prikazuje kad je NDI funkcija grupiranja
uključena. 
Postavlja naziv grupe.

Discovery Server 1 – – Postavlja NDI Discovery Server 1.

Discovery Server 2 – – Postavlja NDI Discovery Server 2.

Pouzdani UDP način
rada

On / Off On
Uključuje/isključuje pouzdani UDP način
rada.

Način višestrukog
usmjeravanja

On / Off Off
Uključuje/isključuje višestruko
usmjeravanje.

Prefiks višestrukog
usmjeravanja

239.255.0.0 239.255.0.0

Prikazuje se kad je funkcija [Multicast
Mode] postavljena na On (Uključeno). 
Postavlja prefiks za upotrebu za
višestruko usmjeravanje.

Maska mreže
Prikazuje se kad je funkcija [Multicast
Mode] postavljena na On (Uključeno). 
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[249] Web-izbornik i detaljne postavke Izbornik usmjeravanja

Usmjeravanje videozapisa

Postavlja postavke povezane s kodekom usmjeravanja videozapisa.

Usmjeravanje videozapisa 1
Postavlja postavke povezane s kodekom 1 videozapisa.

višestrukog
usmjeravanja

255.255.0.0 255.255.0.0
Postavlja masku mreže koja određuje
raspon adresa višestrukog usmjeravanja.

Višestruko
usmjeravanje TTL

od 1 do 256 3

Prikazuje se kad je funkcija [Multicast
Mode] postavljena na On (Uključeno). 
Postavlja TTL vrijednost za višestruko
usmjeravanje.

Način rada Multi-
TCP

On / Off Off
Uključivanje/isključivanje načina rada
Multi-TCP.

Jednoodredišni
način rada UDP

On / Off On
Uključuje/isključuje jednoodredišni način
UDP.

Stavka Postavka podstavke Tvorničke
postavke Opis

Kodek 1 H.264 / H.265 H.264
Postavlja kodek
fotografije 1.

Veličina 1
4096×2160 / 3840×2160 / 2048×1080
/ 1920×1080 / 1280×720 / 640×360

1920×1080
Postavlja veličinu slike
za fotografiju 1.

Frekvencija
okvira 1

Pojedinosti o podržanim brzinama
sličica pogledajte u odjeljku
„Postavljanje kodeka videozapisa
za usmjeravanje.”

–
Postavlja brzinu sličica
fotografije 1.

Način I-
slike 1

Vrijeme/kadar Time

Postavlja interval
umetanja [IDR-Frame]
za fotografiju 1 kao
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Usmjeravanje videozapisa 2
Postavlja postavke povezane s kodekom 2 videozapisa.

vrijeme ili broj kadrova.

Interval I-
slike 1

1 / 2 / 3 / 4 / 5 s 1

Prikazuje se kad je
funkcija [I-Picture Mode
1] postavljena na Time. 
Postavlja umetanje
intervala IDR kadra za
H.264 i H.265 kao
vrijeme.

Omjer I-
slike 1

od 15 do 300 kadrova 30

Prikazuje se kad je
funkcija [I-Picture Mode
1] postavljena na
Frame. 
Postavlja interval
umetanja IDR kadra za
H.264 i H.265 kao broj
kadrova.

Profil 1
H.264: visoko / glavno / osnovna linija
H.265: glavno / glavno 10

H.264:
visoko

Postavlja profil H.264 i
H.265.

Način rada
kompresije
stope
bitova 1

CBR / VBR VBR
Postavlja način
kompresije stope bitova
fotografije 1.

Stopa
bitova 1

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16 000 / 24
000 / 32 000 / 50 000 / 64 000 / 80 000
kbps

16.000

Prikazuje se kad je
funkcija [Bit Rate
Compression Mode 1]
postavljena na On
(Uključeno). 
Postavlja vrijednost
ciljne stope bitova kad
je način kompresije
stope bitova postavljen
na CBR.

Kvaliteta 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 10 6
Postavlja kvalitetu
H.264 i H.265.
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Stavka Postavka podstavke Tvorničke
postavke Opis

Kodek 2 H.264 / H.265 / Off (Isključeno) Off Postavlja kodek fotografije 2.

Veličina 2

4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 /
1280×720 / 640×360 /
512×270

1920×1080
Postavlja veličinu slike za
fotografiju 2.

Frekvencija
okvira 2

Pojedinosti o podržanim
brzinama sličica pogledajte
u odjeljku „Postavljanje
kodeka videozapisa za
usmjeravanje.”

–

Prikazuje se kad funkcija
[Codec 2] nije postavljena na
Off (Isključeno). 
Postavlja brzinu sličica
fotografije 2.

Način I-
slike 2

Vrijeme/kadar Time

Prikazuje se kad funkcija
[Codec 2] nije postavljena na
Off (Isključeno). 
Postavlja interval umetanja IDR
kadra za fotografiju 2 kao
vrijeme ili broj kadrova.

Interval I-
slike 2

1 / 2 / 3 / 4 / 5 s 1

Prikazuje se kad funkcija
[Codec 2] nije postavljena na
Off (Isključeno) i funkcija [I-
Picture Mode 2] je postavljena
na [Time]. 
Postavlja umetanje intervala
IDR kadra za H.264 i H.265 kao
vrijeme.

Omjer I-
slike 2

od 15 do 300 kadrova 30

Prikazuje se kad funkcija
[Codec 2] (Kodek 2) nije
postavljena na Off (Isključeno) i
funkcija [I-Picture Mode 2] je
postavljena na [Frame]. 
Postavlja interval umetanja IDR
kadra za H.264 i H.265 kao broj
kadrova.

Profil 2
H.264: visoko / glavno /
osnovna linija
H.265: glavno

– Postavlja profil H.264 i H.265.
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Usmjeravanje videozapisa 3
Postavlja postavke povezane s kodekom 3 videozapisa.

Način rada
kompresije
stope
bitova 2

CBR / VBR VBR

Prikazuje se kad funkcija
[Codec 2] nije postavljena na
Off (Isključeno). 
Postavlja način kompresije
stope bitova fotografije 2.

Stopa
bitova 2

512 / 768 / 1000 / 2000 / 3000
/ 4000 / 5000 / 6000 / 7000 /
8000 / 16 000 / 24 000 / 32
000 / 50 000 / 64 000 / 80 000
kbps

8000

Prikazuje se kad funkcija
[Codec 2] nije postavljena na
Off (Isključeno) i kad je funkcija
[Bit Rate Compression Mode 2]
postavljena na [On]
(Uključeno). 
Postavlja vrijednost ciljne stope
bitova kad je način kompresije
stope bitova postavljen na
CBR.

Kvaliteta 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Prikazuje se kad je funkcija
[Codec 2] postavljena na H.264
i funkcija [Bit Rate
Compression Mode 2]
postavljena na Off (Isključeno). 
Postavlja kvalitetu H.264 i
H.265.

Stavka Postavka podstavke Tvorničke
postavke Opis

Kodek 3 JPEG JPEG
Postavlja
kodek
fotografije 3.

Veličina 3 1280×720 / 1024×540 / 640×360 1280×720

Postavlja
veličinu slike
za fotografiju
3.

Frekvencija
okvira 3

Pojedinosti o podržanim brzinama sličica
pogledajte u odjeljku „Postavljanje kodeka
videozapisa za usmjeravanje.”

–
Postavlja
brzinu sličica
fotografije 3.
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[250] Web-izbornik i detaljne postavke Izbornik usmjeravanja

Usmjeravanje zvuka

Postavlja postavke povezane s kodekom usmjeravanja zvuka.

[251]Web-izbornik i detaljne postavke Izbornik održavanja

Jezik

Postavljanje jezika prikaza.

Note

Dostupni jezici mogu se razlikovati ovisno o državi ili regiji.

[252] Web-izbornik i detaljne postavke Izbornik održavanja

Kvaliteta 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Postavlja
kvalitetu.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Setting On / Off Off
Uključuje/isključuje izlaz usmjeravanja
zvuka.

Kodek
AAC (128kbps) /
AAC (256kbps)

AAC
(128kbps)

Prikazuje se kad je funkcija [Setting]
postavljena na On (Uključeno). 
Postavlja kodek zvuka za usmjeravanje.

Stavka Postavka podstavke Tvorničke postavke Opis

Language – – Postavljanje jezika prikaza.
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Pristup

Postavlja postavke povezane s čitanjem zvuka (tekst u govor).

Note

Ova je funkcija dostupna samo na modelima koji se prodaju u Sjevernoj Americi. Funkcija čitača
zaslona može se samo upotrebljavati kad je jezik postavljen na engleski (od datuma izdanja).

Omogućite funkciju čitača zaslona web-preglednika na uređaju koji pokreće web-aplikaciju.

[253] Web-izbornik i detaljne postavke Izbornik održavanja

Postavljanje sata

Postavljanje postavki unutarnjeg sata.

Stavka Postavka podstavke Tvorničke
postavke Opis

Čitač
zaslona

On / Off Off 
Uključuje/isključuje funkciju čitača
na ploči fotografija fotoaparata web-
aplikacije.

Brzina
govora

Sporo 2 / Sporo 1 / Normalno
/ Brzo 1 / Brzo 2 / Brzo 3 /
Brzo 4

Normal

Postavlja brzinu funkcije čitača
zaslona. 
Uzorak ulomka čita se naglas pri
konfiguriranoj brzini.

Jačina
zvuka
govora

od 1 do 15 7

Postavlja jačinu zvuka funkcije
čitača zaslona web-aplikacije. 
Uzorak ulomka čita se naglas pri
konfiguriranoj jačini zvuka.

Stavka Postavka podstavke Tvorničke
postavke Opis

Trenutni
datum i
vrijeme

– –
Postavlja trenutno vrijeme koje je
konfigurirano na jedinici.
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Sat
računala

– –
Prikazuje trenutno vrijeme tableta ili
računala koje se upotrebljava za
konfiguraciju.

Format
datuma i
vremena

gggg-mm-dd hh:mm:ss /
mm-dd-gggg hh:mm:ss / dd-
mm-gggg hh:mm:ss

gggg-mm-
dd

Postavlja format prikaza datuma i
vremena.

12 h / 24
h

12 h / 24 h 24 h
Postavlja vrijeme na format prikaza
12-satnog / 24-satnog vremena.

Postavka
vremena

Zadrži trenutnu postavku /
Sinkroniziraj s računalom /
Ručna postavka /
Sinkroniziraj s NTP-om

–
Postavlja metodu konfiguracije
datuma i vremena.

gg-mm-
dd
hh:mm:ss

gg: 19 do 37 
mm: 01 do 12 
dd: 01 do 31 
hh: 00 do 23 
mm: 00 do 59 
ss: 00 do 59 (sekundi)

–

Prikazuje se kad je funkcija [Time
Setting] postavljena na Manual
setting. 
Ručno postavlja datum i vrijeme.

NTP Auto On / Off Off

Prikazuje se kad je funkcija [Time
Setting] postavljena na Synchronize
with NTP. 
Postavlja hoće li se dohvatiti IP
adresa NTP poslužitelja s DHCP
poslužitelja.

NTP
poslužitelj

IPv4/IPv6 adrese ili naziv
domaćina

–

Prikazuje se kad je funkcija [Time
Setting] postavljena na
[Synchronize with NTP] i funkcija
[NTP Auto] postavljena na Off
(Isključeno). 
Određuje NTP poslužitelj koji se
upotrebljava za sinkronizaciju
vremena.

Time
Zone

od UTC – 12:00 do UTC +
14:00

– Odabire vremensku zonu.
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[254] Web-izbornik i detaljne postavke Izbornik održavanja

Ponovno postavljanje

Inicijalizira jedinicu.

Ponovno pokretanje
Ponovno pokreće jedinicu.

Reset
Ponovno postavlja postavke jedinice.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Ponovno
pokretanje

Izvršavanje –

Ponovno pokreće jedinicu.
Izvrši: Izvršite funkciju.

Note

Nakon ponovnog pokretanja, ponovno
učitajte web-preglednik.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Ponovno postavi
sve (osim
mrežnih
postavki)

Izvršavanje –

Postavlja postavke jedinice (osim mrežnih
postavki).
Izvrši: Izvršite funkciju.

Note

Uvezeni osnovni izgledi i LUT datoteke se
ne brišu.

Network Reset Izvršavanje –

Ponovno postavlja mrežne postavke jedinice.
Izvrši: Izvršite funkciju.

Note

Nakon izvršavanja ponovnog postavljanja
mreže, jedinica će se ponovno pokrenuti.
Nakon ponovnog pokretanja, ponovno
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[255] Web-izbornik i detaljne postavke Izbornik održavanja

Informacije

Prikazuje informacije o fotoaparatu i objektivu. Također se upotrebljava za ažuriranje softvera.

Fotoaparat
Prikazuje informacije o fotoaparatu i ažuriranju softvera.

učitajte web-preglednik.

Tvorničke
postavke

Izvršavanje –

Vraća postavke jedinice na tvorničke postavke.
Izvrši: Izvršite funkciju.

Note

Nakon izvršavanja tvorničkih postavki,
jedinica će se ponovno pokrenuti. Nakon
ponovnog pokretanja, ponovno učitajte web-
preglednik.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Model
Name

– – Prikazuje naziv modela fotoaparata.

Serijski
broj

– – Prikazuje serijski broj fotoaparata.

Version
Number

– – Prikaz verzije softvera kamere.

Version
Up

– –

Pritisnite gumb [Choose File] i slijedite upute na zaslonu
za ažuriranje softvera fotoaparata.

Note

Nakon ažuriranja jedinica će se ponovno pokrenuti.
Nakon ponovnog pokretanja, ponovno učitajte web-
preglednik.
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Objektiv
Prikazuje informacije o objektivu i ažuriranju softvera.

[256] Web-izbornik i detaljne postavke Izbornik održavanja

Zapisnik sustava

Postavlja postavke povezane sa zapisnikom sustava.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Model
Name

– – Prikazuje naziv modela objektiva.

Serijski
broj

– – Prikazuje serijski broj objektiva.

Version
Number

– – Prikazuje verziju softvera objektiva.

Version
Up

– –

Pritisnite gumb [Choose File] i slijedite upute na zaslonu
za ažuriranje softvera objektiva.

Pojedinosti pogledajte u odjeljku „Ažuriranje softvera
objektiva E-mount”.

Note

Nakon ažuriranje objektiva jedinica će se ponovno
pokrenuti. Nakon ponovnog pokretanja, ponovno
učitajte web-preglednik.

Stavka Postavka podstavke Tvorničke
postavke Opis

Razina
zapisnika

Kritično, upozorenje i
informacije / Kritično i
upozorenje / Kritično

Kritično,
upozorenje
i informacije

Postavlja razinu dodavanja snimki
zapisniku sustava.
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Očitani zapisnik prikazuje se kako je prikazano u nastavku.

[257] Web-izbornik i detaljne postavke Izbornik održavanja

HTTP zapisnik pristupa

Postavlja postavke povezane s HTTP zapisnikom pristupa.

Veličina
zapisnika

od 200 do 1024 1024
Postavlja veličinu zapisnika za
spremanje u zapisnik sustava.

Preuzmi
kao
datoteku

– –
Pritisnite gumb [Download] i spremite
zapisnik sustava na tablet ili računalo s
prikazanog zaslona.

Stavka Postavka podstavke Tvorničke
postavke Opis

Razina
zapisnika

Kritično, upozorenje i
informacije / Kritično i
upozorenje / Kritično

Kritično,
upozorenje
i
informacije

Postavlja razinu dodavanja snimki HTTP
zapisniku pristupa.

Veličina
zapisnika

od 200 do 1024 1024
Postavlja veličinu zapisnika za
spremanja u HTTP zapisnik pristupa.

Preuzmi
kao – –

Pritisnite gumb [Download] i spremite
HTTP zapisnik pristupa na tablet ili
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[258] Web-izbornik i detaljne postavke Izbornik održavanja

Servis

Dohvaća informacije uređaja o jedinici. Upotrijebite prilikom obraćanja predstavniku za servis
tvrtke Sony.

[259] Web-izbornik i detaljne postavke Izbornik održavanja

EULA

Prikazuje Ugovor o licenci s krajnjim korisnikom (EULA).

[260] Web-izbornik i detaljne postavke Izbornik održavanja

Softver

Prikazuje licencu softvera.

datoteku računalo s prikazanog zaslona.

Stavka Postavka
podstavke

Tvorničke
postavke Opis

Pristajem
preuzeti
informacije o
uređaju.

– –

Označite potvrdnom oznakom ovdje kako biste
pristali preuzeti informacije o uređaju, a zatim
pritisnite gumb [OK]. 
Pritisnite prikazani gumb [Download]. Web-
preglednik preuzet će datoteku pod nazivom
deviceinformation.dat.

Note

Nakon preuzimanja jedinica će se ponovno
pokrenuti. Nakon ponovnog pokretanja,
ponovno učitajte web-preglednik.
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[261] Priključivanje vanjskih uređaja

Priključivanje vanjskih monitora i uređaja za snimanje

Kako biste prikazali snimljene/reproducirane slike na vanjskom monitoru, postavite vrstu izlaza
videozapisa za vanjski monitor i upotrijebite odgovarajući kabel za monitor koji treba priključiti.
Također možete priključiti vanjski snimač i snimati izlazni signal s jedinice.
Možete prikazati iste informacije koje su vidljive na ploči fotografija fotoaparata, poput
informacija o statusu i izbornika, na vanjskom monitoru. Postavite željenu vrstu sustava za
prikaz zaslona na On (Uključeno) s pomoću funkcija [Monitoring] > [Output Display] u web-
izborniku.

Note

Ako monitor povezan HDMI priključkom ne podržava format HDMI izlaza konfiguriranog s pomoću
izbornika [Monitoring] u web-izborniku ili izborniku fotoaparata, fotografija fotoaparata neće se
emitirati na web-aplikaciju. Također se ne može emitirati usmjeravanje videozapisa.

Možete postaviti funkcije [Output Display] > [SDI] i [HDMI/Stream] na [Off], ali tako ćete spriječiti
upotrebu izbornika fotoaparata i funkcija koje ovise o prikazu zaslona. Uz to obavijesti o pogreškama
jedinice bit će ograničene na žaruljice (svijetle ili trepere) jedinice i prikaz oznake obavijesti na
gornjem desnom dijelu web-aplikacije. Kako biste vidjeli detaljni status, postavite funkciju [Output
Display] na [On].

Savjet

Funkcija [Output Display] > [SDI] je postavljena na [Off] i funkcija [HDMI/Stream] je postavljena na
[On] prema tvornički zadanim postavkama. Kako biste upotrijebili usmjeravanje kao glavni
videozapis, postavite funkciju [SDI] na [On] i funkciju [HDMI/Stream] na [Off], a zatim nadzirite status
fotoaparata na SDI monitoru.

Priključak SDI OUT (vrsta BNC)

Postavite izlazni format s pomoću izbornika [Monitoring] u web-izborniku ili izborniku
fotoaparata.
Za povezivanje upotrijebite komercijalno dostupan koaksijalni kabel od 75 ?.

Note

Prije uključivanja uređaja provjerite je li veza jedinice i vanjskog uređaja uzemljena.
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Preporuča se da se jedinica i vanjski uređaj uključe nakon priključivanja koaksijalnog
kabela od 75 ?.
Ako je vanjski uređaj nužno priključiti dok je jedinica uključena, koaksijalni kabel od 75 ? prvo
priključite na vanjski uređaj, a potom na jedinicu.

Istovremeno pokretanje snimanja jedinicom i vanjskim uređajem
Kad je omogućen SDI izlazni signal, postavite funkciju [Project] > [SDI/HDMI Rec Control] >
[Setting] na [SDI/HDMI Remote I/F] ili [Parallel Rec] u izborniku fotoaparata kako biste
omogućili emitiranje signala okidača Rec na vanjski uređaj priključen SDI OUT priključkom.
Tako se sinkronizira snimanje na vanjski uređaj s jedinicom.

Note

Ako priključeni vanjski uređaj ne podržava pokretački signal REC, uređaj ne može raditi.

Kad je funkcija [Project] > [SDI/HDMI Rec Control] > [Setting] postavljena na [SDI/HDMI Remote I/F]
u izborniku fotoaparata, samo signal okidača REC se emitira kad nema trenutno umetnutog medija
za snimanja i rukuje se gumbom za snimanje START/STOP.

HDMI OUT priključak (priključak vrste A)

Postavite izlaznu postavku On/Off (Uključeno/Isključeno) i izlazni format u izborniku [Monitoring]
u izborniku fotoaparata.

Istovremeno pokretanje snimanja jedinicom i vanjskim uređajem
Kad je HDMI izlazni signal omogućen, postavite funkciju [TC/Media] > [HDMI TC Out] >
[Setting] na [On] i funkciju [Project] > [SDI/HDMI Rec Control] > [Setting] na [SDI/HDMI Remote
I/F] ili [Parallel Rec] u izborniku fotoaparata kako biste omogućili emitiranje signala okidača
REC na vanjski uređaj priključen HDMI OUT priključkom. Tako se sinkronizira snimanje na
vanjski uređaj s jedinicom.

Note

Ako priključeni vanjski uređaj ne podržava pokretački signal REC, uređaj ne može raditi.

Kad je funkcija [Project] > [SDI/HDMI Rec Control] > [Setting] postavljena na [SDI/HDMI Remote I/F]
u izborniku fotoaparata, samo signal okidača REC se emitira kad nema trenutno umetnutog medija
za snimanja i rukuje se gumbom za snimanje START/STOP.

[262] Priključivanje vanjskih uređaja Rukovanje s pomoću daljinskog upravljača RM-IP500
(dodatno)

O rukovanju s pomoću daljinskog upravljača RM-IP500
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(dodatno)

Možete rukovati jedinicom s pomoću daljinskog upravljača RM-IP500 tvrtke Sony kojeg pokreće
verzija softvera 2.2 ili novija. Uređaji komuniciraju s pomoću VISCA over IP (LAN).
Ovisno o ciljnoj stavci za rukovanje možda ćete trebati pregledati prikaz zaslona jedinice.
Pripremite monitor koji će se upotrebljavati za provjeru prikaza zaslona.
Sljedeće su radnje podržane za daljinski upravljač RM-IP500.

Odabir ciljnog fotoaparata
Prilagodba kadra (pomicanje, nagibanje, zumiranje)
Prilagodba fokusa (bez dodirnih radnji)
Registracija i pozivanje unaprijed postavljenih položaja
Rukovanje izbornikom jedinice (bez web-izbornika)
Prilagođavanje svjetline
Prilagodba ravnoteže bijele boje
Prilagodba ravnoteže crne boje
Prilagodba razine ulaza zvuka
Pokretanje/zaustavljanje snimanja
Izvršavanje funkcija dodjeljivih gumba jedinice

Pojedinosti o radu upravljača RM-IP500 pogledajte u uputama za rad upravljača RM-IP500.

Savjet

Kad upotrebljavate RM-IP500, upotrijebite list ploče za ovu jedinicu koji je isporučen s daljinskim
upravljačem RM-IP500.
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RM-IP500 (upotreba lista ploče za ovu jedinicu)

[263] Priključivanje vanjskih uređaja Rukovanje s pomoću daljinskog upravljača RM-IP500
(dodatno)

Priključivanje daljinskog upravljača RM-IP500

Postavite prekidač SETUP (Postavljanje) 3 jedinice na položaj ON (Uključeno) kako
biste omogućili komunikaciju VISCA over IP.

Note

Postavka prekidača primjenjuje se kad se jedinica sljedeći put uključi.

1

Povežite RM-IP500 na istu mrežu na kojoj je jedinica.2
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Pojedinosti o dodjeljivanju funkcija pogledajte u uputama za rad upravljača RM-IP500.

[264] Priključivanje vanjskih uređaja Sinkronizacija s vanjskim uređajem

O sinkronizaciji s vanjskim uređajem

Kad snimate s više jedinica, jedinice se mogu sinkronizirati na određeni referentni signal ili
vremenski kod putem priključka GENLOCK jedinice.

Pojedinosti o priključku genlock pogledajte u odjeljku „Sinkroniziranje faze videosignala
(Genlock)”.
Pojedinosti o sinkronizaciji vremenskih kodova pogledajte u odjeljku „Zaključavanje
vremenskog koda za druge uređaje”.

[265] Priključivanje vanjskih uređaja Sinkronizacija s vanjskim uređajem

Sinkronizacija faze videosignala (Genlock)

Možete dostaviti referentni signal priključku GENLOCK kako biste omogućili funkciju genlock.
Referentni ulazni signali koje je moguće primijeniti ovise o frekvenciji sustava za odabrani
format snimanja.

Slijedite postupak u uputama za rad za RM-IP500 kako biste konfigurirali vezu
VISCA over IP (LAN) na upravljaču RM-IP500.

Dodijelite ovu jedinicu s pomoću RM izbornika > AUTO IP SETUP > ASSIGN CAM.

3

Dodijelite funkcije ove jedinice gumba i kotačićima s pomoću sljedećih stavki RM
izbornika upravljača RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4

Frekvencija sustava za format snimanja Podržani ulazni referentni signali

59.94P
1920×1080 59.94i 



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Možete provjeriti status vanjske sinkronizacije s pomoću funkcija [Technical] > [Genlock] >
[Reference] u izborniku fotoaparata.

Note

Ako je referentni signal nestabilan, nije moguće postići genlock.

Podnosilac nije sinkroniziran.

[266] Priključivanje vanjskih uređaja Sinkronizacija s vanjskim uređajem

Zaključavanje vremenskog koda za druge uređaje

Jedinicu koja osigurava vremenski kod postavite u način u kojem se vremenski kod stalno izvozi
(poput Free Run ili Clock).

720×486 59.94i

50P
1920×1080 50i 
720×576 50i

29,97P
1920×1080 59.94i 
720×486 59.94i

25P
1920×1080 50i 
720×576 50i

24P 1920×1080 24PsF

23,98P 1920×1080 23,98PsF

59.94i
1920×1080 59.94i 
720×486 59.94i

50i
1920×1080 50i 
720×576 50i

Postavite sljedeće u [TC/Media] > [Timecode] u izborniku fotoaparata.

Postavite [Mode] na [Preset].
Postavite [Run] na [Free Run].

1
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Note

Provjerite jesu li dostavljeni referentni vremenski kod i referentni videosignal međusobno u fazi koja
odgovara standardu za vremenski kod SMPTE.

Tijekom rada s vanjskim zaključavanjem, vremenski kod trenutačno se zaključava na vanjski
vremenski kod, a vrijednost vanjskog vremenskog koda prikazuje se na zaslonu prikaza vremenskih
podataka. Međutim, nemojte odmah pokrenuti snimanje. Prije snimanje pričekajte nekoliko sekundi
na stabilizaciju generatora vremenskog koda.

Ako frekvencija referentnog videosignala i frekvencija kadra na jedinici nisu jednake, zaključavanje je
nemoguće postići i jedinica će raditi neispravno. Ako se to dogodi, vremenski kod neće se uspješno
zaključati na vanjski vremenski kod.

Ako odspojite izvor vanjskog vremenskog koda, vremenski kod može odstupati za jedan kadar na sat
u odnosu na referentni vremenski kod.

Otpuštanje vanjskog zaključavanja
Promijenite postavku [TC/Media] > [Timecode] u izborniku fotoaparata.
Vanjska sinkronizacija također se otpušta ako se promijenite frekvencija sustava te pri
pokretanju snimanja u posebnom načinu snimanja (Slow & Quick Motion ili Interval Rec).

[267] Priključivanje vanjskog uređaja

Priključivanje vanjskog mikrofona ili vanjskog
audiouređaja

Možete emitirati signal s vanjskog mikrofona ili vanjskog audiouređaja i ugraditi zvuk u snimljeni
videozapis ili emitirani videozapis jedinice.

Pritisnite dodjeljivi gumb kojem je dodijeljena funkcija [DURATION/TC/U-BIT] kako
biste vremenski kod prikazali na zaslonu.

2

Dostavite HD ili SD referentni videosignal priključku GENLOCK i referentni
vremenski kod TC IN priključku.

Generator vremenskog koda na jedinici zaključava se s referentnim vremenskim kodom, a
na zaslonu se prikazuje „EXT-LK”.
Deset sekundi nakon zaključavanja vremenskog koda vanjsko stanje zaključanosti
održava se čak i ako se odspoji vanjski izvor referentnog vremenskog koda.

3
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Priključite vanjski mikrofon ili vanjski audiouređaj s pomoću XLR kabela.

Kad je zvuk postavljen na funkciju [LINE] s pomoću opcije [Audio] > [Audio Input] >
[AUDIO IN Select] u izborniku fotoaparata, funkcije priključka su kao one AUDIO IN kao
priključka AUDIO IN CH-1 i AUDIO IN CH-2.

1

Broj izvoda Function

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1- (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2- (COLD)

Isključite jedinicu i priključite XLR kabel u priključak AUDIO IN.2

Postavite prekidač SETUP (Postavljanje) 2 na fantomski izvor napajanja prema
potrebi.

Prebacite izvor napajanja od +48 V (fantomsko napajanje) kako je opisano u nastavku.
Prekidač 2
Postavlja hoće li se izvor napajanja od +48 V (fantomsko napajanje) uključiti ili isključiti kad
se priključi uređaj ulaznog zvuka.

3

Setting Opis
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[268] Priključivanje vanjskih uređaja

Upravljanje/uređivanje isječaka na računalu

Možete upravljati/uređivati isječke s pomoću računala.

Uvoz isječaka s pomoću čitača kartice (dodatno)

Priključite CFexpress Type A čitač kartice ili čitač SD kartice na računalo i upotrijebite softver
koji podržava format snimanja ove jedinice, poput softvera Catalyst Browse, kako biste uvezli
isječke.

Upotreba nelinearnih sustava uređivanja

U nelinearnim sustavima uređivanja potreban je softver za uređivanje (u opciji) koji podržava
formate snimljene jedinicom.

[269] Priključivanje vanjskih uređaja

Emitiranje signala optičkog kabela

Možete emitirati SDI signal pretvoren u optički signal priključivanje SDP+ modula (dodatno) na

Note

Postavljanje ovog prekidača na položaj ON (Uključeno) i priključivanje mikrofona koji nije
kompatibilan s izvorom od +48 V može oštetiti priključeni uređaj. Prije priključenja uređaja
provjerite postavku.

OFF
(zadano)

Ovo isključuje fantomski izvor napajanja od +48 V i postavljanje ulaz LINE
(Linija) ili MIC (Mikrofon) kao izvor zvuka CH-1 i CH-2.

ON
Ovo uključuje fantomski izvor napajanja od +48 V i postavlja kompatibilni
mikrofon fantomskog izvora napajanja od +48 V kao izvor zvuka CH-1 i CH-
2.

Uključite jedinicu i postavite vrstu priključenog uređaja s pomoću funkcije [Audio] >
[Audio Input] > [AUDIO IN Select] u izborniku fotoaparata.

4
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priključak OPTICAL jedinice. Upotrijebite SFP+ modul koji odgovara pojasu signala svakog
formata.
Pojas signala

4K (59.94p, 50p): 12G
4K (koji nisu 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (koji nisu 59.94p, 50p): 1.5G

Note

Upotrijebite modul koji je u skladu sa sljedećim standardima.
SFF standardi
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI standardi
ST297/ST292/ST424/ST425/ST2081/ST2082

Isti signal SDI izlaznog priključka emitira se na SFP+ modul.

Jedinica ne podržava izlazni signal optičkog kabela.

Upotrijebite SFP+ modul za izlazni signal optičkog kabela. Za pojedinosti o ovlaštenim SFP+
modulima obratite se svojem prodavaču ili prodajnom predstavniku tvrtke Sony.

[270] Priključivanje vanjskih uređaja

Priključivanje signalizacije

Ova tema opisuje upravljanje signalizacijom.

Osvijetljivanje žaruljice signalizacije s pomoću signala s daljinskog
upravljača

Možete osvijetliti žaruljicu signalizacije putem komande VISCA over IP s vanjskog uređaja
poput upravljača RM-IP500.
Postavite funkciju [Technical] > [Tally] > [Tally Control] na [External] u web-izborniku ili izborniku
fotoaparata.

Osvijetljenje žaruljice signalizacije s vanjskog uređaja

Možete osvijetliti žaruljicu signalizacije jedinice crvenom ili zelenom bojom s vanjskog uređaja
poput upravljača RM-IP500 ili prekidača. Možete upravljati signalizacijom s pomoću komandi

* Razina napajanja I (1,0 W)
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poslanih preko mreže ili s pomoću ulaza signala signalizacije na priključku OPTION jedinice.
Postavite funkciju [Technical] > [Tally] > [Tally Control] na [External] u web-izborniku ili izborniku
fotoaparata.
Kad emitirate signal signalizacije na priključku OPTION, učinite kratki spoj izvoda 7 na GND
(izvod 4 ili 5) kako biste osvijetlili žaruljicu signalizacije zelenom bojom ili izvod 8 na GND (izvod
4 ili 5) kako biste osvijetlili žaruljicu signalizacije crvenom bojom.

Note

Kad je funkcija [Tally Control] (Upravljanje signalizacijom) postavljena na [External] (Vanjsko), status
snimanja jedinice nije označen žaruljicom signalizacije.

Kad je signalizacija istovremeno crvene i zelene žaruljice, žaruljica signalizacije svijetli crvenom
bojom.

Specifikacije izvoda priključka OPTION

Broj
izvoda

Smjer
signala Specifikacije signala

1 – Rezervirano

2 – Rezervirano

3 OUT

Izlazna zelena žaruljica signalizacije
Niska razina emitiranja kad zelena žaruljica signalizacije svijetli.
Hi-Z (otvoreni izlaz) kad zelena žaruljica signalizacije ne svijetli.

4 – GND (Uzemljenje)

5 – GND (Uzemljenje)

6 OUT

Izlazna crvena žaruljica signalizacije
Niska razina emitiranja kad crvena žaruljica signalizacije svijetli.
Hi-Z (otvoreni izlaz) kad crvena žaruljica signalizacije ne svijetli.
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Osvjetljenje žaruljice signalizacije vanjskog uređaja s pomoću signala
jedinice

Možete osvijetliti žaruljicu signalizacije vanjskog uređaja s pomoću signala jedinice
priključivanjem izvoda 3 ili 6 priključka OPTION kako je prikazano u nastavku.
Primjer priključivanja izvoda 3 i 6 priključka OPTION

Note

Nemojte primjenjivati napon na izvode 7 i 8.

Nemojte priključivati vanjski uređaj koji primjenjuje napon na priključak OPTION.

Ako jakost ili obrnuti napon koji premašuje nazivni napon se primijeni na izvod 3 ili 6, može se
pojaviti kvar, dim ili požar.

Postavite izlazni signal s pomoću funkcije [Technical] > [Tally] > [Tally Control] u web-izborniku ili
izborniku fotoaparata.
[Internal]: status snimanja jedinice
[External]: Logical-AND crvene/zelene žaruljice signalizacije koji prima od jedinice putem signala IN i
daljinskih upravljača.

7 IN
Vanjska kontrola ulaza zelene žaruljice 
Kratki spoj na uzemljenju (izvod 4 ili 5) uzrokuje da žaruljica
signalizacije svijetli zelenom bojom.

8 IN
Vanjska kontrola ulaza crvene žaruljice 
Kratki spoj na uzemljenju (izvod 4 ili 5) uzrokuje da žaruljica
signalizacije svijetli crvenom bojom.
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[271] Dodatak

Mjere opreza pri upotrebi

Kondenzacija
Ako se jedinica brzo prenese s hladne na toplu lokaciju, ili ako dođe do naglog porasta okolne
temperature, na vanjskoj površini i/ili u unutrašnjosti jedinice može se nakupiti vlaga. Ta pojava
naziva se kondenzacija. Ako dođe do kondenzacije, isključite jedinicu i nemojte je upotrebljavati
dok se kondenzacija ne raščisti. Rad s jedinicom na kojoj ima kondenzata može uzrokovati
njeno oštećenje.

Pojava na slikovnom senzoru CMOS kamere

Note

Na slikama može doći do sljedeće pojave, specifične za slikovne senzore. To se ne smatra
neispravnim radom.

Bijele mrlje
Premda se slikovni senzori proizvode tehnologijom visoke preciznosti, na zaslonu se u rijetkim
slučajevima mogu pojaviti fine bijele mrlje uzrokovane kozmičkim zračenjem itd.
To je povezano s principom slikovnog senzora i ne smatra se kvarom.
Bijele mrlje posebno su vidljive u sljedećim slučajevima:

tijekom rada na visokim temperaturama okoline
pri povećanju jačine signala (osjetljivost).

Treperenje
Ako snimate pod fluorescentnom rasvjetom, natrijevim svjetiljkama, živinim svjetiljkama ili LED
svjetiljkama, zaslon može treperiti ili se boje mogu razlikovati.

Jedinice objektiva i pogona pomicanja/nagibanja
Ako se mehanizam objektiva i pogona pomicanja/nagibanja ne upotrebljavaju dulje vremensko
razdoblje, viskoznost primijenjene masti unutar jedinica može se povećati zbog čega se
mehanizam neće pomicati. Redovito rukujte mehanizmom objektiva i pomicanja/nagibanja.

Potrošni dijelovi
Ventilator i ugrađena punjiva baterija potrošni su dijelovi koje treba povremeno zamijeniti.
Kada rade na sobnoj temperaturi, uobičajeni ciklus zamjene je oko pet godina. Međutim,
ovaj ciklus zamjene opća je smjernica i ne jamči vijek trajanja ovih dijelova.
Za detalje o zamjenskim dijelovima obratite se distributeru.
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Očekivani vijek trajanja adaptera za izmjeničnu struju i elektrolitskog kondenzatora je, pod
normalnim radnim temperaturama i pri normalnoj upotrebi (8 sati dnevno; 25 dana
mjesečno), oko pet godina. Ako upotreba prekoračuje navedenu normalnu učestalost,
očekivani vijek trajanja smanjuje se sukladno upotrebi.

Preporučuju se periodički pregledi radi održavanja jedinice u radnom stanju te produljenja
iskoristivog vijeka trajanja. Obratite se prodajnom predstavniku tvrtke Sony za više informacije o
pregledima.

Ugrađena punjiva baterija
Jedinica ima ugrađenu punjivu bateriju za spremanje datuma, vremena i drugih postavki čak i
kada je jedinica isključena. Ugrađena punjiva baterija treba se napuniti nakon što je proteklo 24
sata ako je jedinica priključena na izvor napajanja koji upotrebljava adapter za napajanje
izmjeničnom strujom ili se napaja putem PoE++, bez obzira na to je li jedinica uključena ili
isključena. Punjiva baterija u potpunosti je prazna nakon dva mjeseca ako adapter za napajanje
izmjeničnom strujom nije priključen na izvor napajanja. Upotrijebite jedinicu nakon punjenja
baterije. Međutim, čak i ako punjiva baterija nije napunjena, to ne utječe na rad jedinice sve dok
ne trebate datum snimanja.

Upotreba i prostor za spremanje
Spremite u ravan, prozračan prostor.
Izbjegavajte upotrebu ili spremanje jedinice na sljedećim mjestima.

Mjesta izložena kiši ili vodi (uključujući ispod nadstrešnica)
Vanjska područja te područja koja premašuju 40 °C (104 °F) 
Imajte na umu kako tijekom ljeta u vrućim područjima temperature u automobilu sa
zatvorenim prozorima mogu lako prekoračiti 50 °C (122 °F).
Područja hladnija od 0 °C (32 °F).
Na vlažnim ili prašnjavim lokacijama. Lokacije na kojima jedinica može biti izložena kiši
Područja podložna vibracijama ili udarima
Područja na kojima se stvaraju zračenje, rendgenske zrake i snažna magnetna polja.
Blizu radijskih ili televizijskih odašiljača koji proizvode jaka elektromagnetska polja.
Dugotrajno na izravnoj sunčevoj svjetlosti ili u blizini grijača

Napomena o laserskim zrakama
Laserske zrake mogu oštetiti slikovni senzor CMOS. Ako snimate scenu koja obuhvaća
lasersku zraku, budite pažljivi i nemojte je usmjeriti izravno u objektiv jedinice. Posebice snažne
laserske zrake medicinskih ili drugih uređaja mogu uzrokovati oštećenja zbog reflektiranja i
loma svjetlosti.

Sprječavanje elektromagnetskih smetnji od prijenosnih komunikacijskih
uređaja
Upotreba prijenosnih telefona i drugih komunikacijskih uređaja u blizini ove jedinice može
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uzrokovati kvarove i smetnje zvučnih signala i videosignala. Preporuča se isključiti prijenosne
komunikacijske uređaje u blizini jedinice.

Ne približavajte uređaj medicinskim uređajima
Ovaj proizvod (uključujući dodatnu opremu) sadrži magnete koji mogu uzrokovati smetnje na
elektrostimulatorima srca, programibilnim ventilima pumpe za liječenje hidrocefalusa ili drugim
medicinskim uređajima. Ne približavajte uređaj osobama koje upotrebljavaju medicinske
uređaje. Prije upotrebe proizvoda savjetujte se s liječnikom ako upotrebljavate takav medicinski
uređaj.

Sigurnosne mjere opreza
SONY NE SNOSI ODGOVORNOST ZA BILO KOJU VRSTU ŠTETE PROISTEKLE IZ
NEPOŠTIVANJA ODGOVARAJUĆIH SIGURNOSNIH MJERA NA UREĐAJIMA ZA
PRIJENOS, NEIZBJEŽNOG CURENJA PODATAKA PROUZROČENOG
SPECIFIKACIJAMA PRIJENOSA NI SIGURNOSNIH PROBLEMA BILO KOJE VRSTE.
Ovisno o radnoj okolini, neovlaštene treće strane na mreži mogu ostvariti mogućnost
pristupa jedinici. Kada jedinicu povezujete s mrežom, obavezno provjerite je li mreža
pravilno zaštićena.
Sadržaj komunikacije mogu neprimjetno presresti neovlaštene treće strane u blizini signala.
Kada upotrebljavate bežičnu komunikaciju mrežom LAN, pravilno primijenite sigurnosne
mjere kako biste zaštitili sadržaj komunikacije.
Kada ovaj proizvod povezujete na mrežu, povežite ga putem sustava koji pruža funkciju
zaštite poput usmjerivača ili vatrozida. Ako je povezan bez takve zaštite, može doći do
problema sa sigurnošću.

Napajanje
Jedinica nije opremljena prekidačem napajanja. Kako biste isključili jedinicu, provjerite da su
sve radnje dovršene i da je jedinica u stanju pripravnosti napajanja, a zatim isključite
adapter za napajanje izmjeničnom strujom. Kad upotrebljavate PoE++ izvor napajanja,
isključite LAN kabel.
Kad je moguće, upotrijebite izvor napajanja na mjestu na kojem lako možete umetnuti i
ukloniti utikač napajanja.
Ako upotrebljavate utikač na prašnjavom mjestu, redovito očistite područje oko utikača.

Mjere opreza za dijelove koji se pomiču
Pobrinite se da strane tvari ne ulaze u dijelove koji se pomiču.
Nemojte stavljati prekomjerno opterećenje kad rukom pomičete dijelove. Zbog toga može
doći do kvara.
Nemojte ometati rad dijelova dok se pomiču. Na taj način može doći do ozljede ili kvara.
Dijelovi koji se pomiču možda neće uobičajeno raditi ako se jedinica ne upotrebljava tijekom
duljih vremenskih razdoblja. Redovito rukujte funkcijama pomicanja/nagibanja jedinice.
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Mjere opreza za funkciju snimanja
Uvijek snimite testnu snimku i provjerite je li pravilno snimljena. SONY NE SNOSI
ODGOVORNOST NI ZA KAKVE ŠTETE , UKLJUČUJUĆI, BEZ OGRANIČENJA,
KOMPENZACIJU ILI POVRAT NOVCA USLIJED KVARA OVOG UREĐAJA ILI NJEGOVIH
MEDIJA ZA SNIMANJE ILI BILO KAKVIH MEDIJA ILI SUSTAVA ZA POHRANU RADI
SNIMANJA SADRŽAJA BILO KOJE VRSTE.
Prije upotrebe obavezno provjerite funkcionira li jedinica pravilno. SONY NE ODGOVARA
NI ZA KAKVE ŠTETE, UKLJUČUJUĆI, BEZ OGRANIČENJA, KOMPENZACIJU ILI
POVRAT NOVCA USLIJED GUBITKA SADAŠNJEG ILI MOGUĆEG PRIHODA NASTALOG
ZBOG KVARA OVE JEDINICE TIJEKOM JAMSTVENOG RAZDOBLJA ILI NAKON
NJEGOVA ISTEKA KAO NI ZBOG BILO KOJEG DRUGOG RAZLOGA.
SONY NE ODGOVARA NI ZA KAKVE IZJAVE KORISNIKA OVE JEDINICE NI TREĆIH
STRANA.
SONY NE ODGOVARA NI ZA KAKAV GUBITAK, POPRAVAK ILI REPRODUKCIJU BILO
KAKVIH PODATAKA SNIMLJENIH NA INTERNI SUSTAV ZA POHRANU, MEDIJE ZA
SNIMANJE NI BILO KAKVE MEDIJE ILI SUSTAVE ZA POHRANU.
SONY NE ODGOVARA ZA OBUSTAVLJANJE NI UKIDANJE BILO KOJE USLUGE
POVEZANE S OVOM JEDNICOM NASTALO USLIJED BILO KAKVIH OKOLNOSTI.

[272] Dodatak

Izlazni formati i ograničenja

Ova tema opisuje izlazne formate i ograničenja.

Note

Razlučivost izlaznog formata ograničena je postavkama [Project] > [Rec Format] > [Frequency],
[Codec] i [Video Format] u web-izborniku ili izborniku fotoaparata.

Razlučivost izlaznog formata također je ograničena kombinacijom brzine sličica usporenog i
ubrzanog načina snimanja. Dodaci tablici SDI OUT / HDMI OUT izlaznih formata priključaka u
nastavku, HDMI izlaz mijenja se na Full HD ili manje kad su zadovoljeni svi sljedeći uvjeti.

Funkcija [Shooting] > [S&Q Motion] > [Setting] je postavljena na [On]
Funkcija [Shooting] > [S&Q Motion] > [Frame Rate] je veća od 60fps

Kad su zadovoljeni svi uvjeti koji su gore navedeni, opcije izbora HDMI izlaza 4096×2160P i
3840×2160P za [Monitoring] > [Output Format] > [SDI/HDMI] su zasivljene i ne mogu se odabrati.

Slika se ne može emitirati ako je konfigurirana veća razlučivost od razlučivosti reprodukcije.

Izlazni formati SDI OUT/HDMI OUT priključaka
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Kad je frekvencija sustava 50/59,94 Hz

Setting Izlazni format koji se može odabrati

Način
snimanja/reprodukcije

RAW izlazna
razlučivost/

razlučivost internog
snimanja

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160 RAW)

4096×2160P 
3840×2160P 
1920×1080P
(zadano) 
1920×1080i

3840×2160 
(RAW)

(3840×2160 RAW)

3840×2160P 
1920×1080P
(zadano) 
1920×1080i

XAVC-I 
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P 
1920×1080P 
1920×1080i

3840×2160 (2SI)
3840×2160P 
1920×1080P 
1920×1080i

1920×1080P (Razina
A) (zadano)

1920×1080P
(zadano) 
1920×1080i

1920×1080P (razina B)
1920×1080P 
1920×1080i

3840 × 2160

3840×2160 (2SI)
3840×2160P 
1920×1080P 
1920×1080i

1920×1080P (Razina
A) (zadano)

1920×1080P
(zadano) 
1920×1080i

1920×1080P (razina B)
1920×1080P 
1920×1080i

1920×1080i 1920×1080i
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Kad je frekvencija sustava 25/29,97 Hz

1920×1080

1920×1080P (Razina
A) (zadano)

1920×1080P
(zadano) 
1920×1080i

1920×1080P (razina B)
1920×1080P 
1920×1080i

1920×1080i 1920×1080i

(Emitiranje
zaustavljeno)

720×480P1) 
720×576P2)

Kad je frekvencija sustava 59,941)
Kad je frekvencija sustava 502)

Setting Izlazni format (razlučivost izlaza)

Način
snimanja/reprodukcije

RAW izlazna
razlučivost/

razlučivost internog
snimanja

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160 RAW)

4096×2160P 
3840×2160P 
1920×1080P 
1920×1080i
(zadano)

3840×2160 
(RAW)

(3840×2160 RAW)

3840×2160P 
1920×1080P 
1920×1080i
(zadano)

XAVC-I 

4096×2160

4096×2160 (2SI)
4096×2160P 
1920×1080P

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(zadano)

1920×1080i
(zadano)
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Kad je frekvencija sustava 23,98 Hz

XAVC-L

3840 × 2160

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(zadano)

1920×1080i
(zadano)

1920×1080
1920×1080P 
1920×1080PsF

1920×1080P 
1920×1080i

Setting Izlazni format (razlučivost izlaza)

Način
snimanja/reprodukcije

RAW izlazna
razlučivost/

razlučivost internog
snimanja

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160
RAW)

4096×2160P 
3840×2160P 
1920×1080P
(zadano)

3840×2160 
(RAW)

(3840×2160
RAW)

3840×2160P 
1920×1080P
(zadano)

XAVC-I 
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P 
1920×1080P

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P
(zadano)

1920×1080P
(zadano)

3840 × 2160

3840×2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P
(zadano)

1920×1080P
(zadano)

1920×1080
1920×1080P
(zadano)

1920×1080P
(zadano)
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Kad je frekvencija sustava 24 Hz

[273] Dodatak

Rješavanje problema

Napajanje

Setting Izlazni format (razlučivost izlaza)

Način
snimanja/reprodukcije

RAW izlazna
razlučivost/

razlučivost internog
snimanja

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160
RAW)

4096×2160P 
1920×1080P
(zadano)

XAVC-I 4096×2160
4096×2160 (2SI) 
1920×1080P
(zadano)

4096×2160P 
1920×1080P
(zadano)

Simptom Uzrok Rješenje

Jedinica
se ne

Adapter za napajanje izmjeničnom
strujom nije dovoljno dobro priključen u
DC IN priključak.

Do kraja umetnite kabel napajanja.

Kabel napajanja izmjeničnom strujom nije
čvrsto umetnut u adapter za napajanje
izmjeničnom strujom ili utičnicu.

Do kraja umetnite kabel napajanja.

LAN kabel nije dovoljno čvrsto priključen
između PoE++ uređaja izvora napajanja i
jedinice.

Provjerite da je kabel umetnut sve
dok ne sjedne na mjesto.

LAN kabel je priključen na priključak
OPTION, ali ne na LAN priključak.

Ispravno priključite LAN kabel u
LAN priključak.

Priključite na uređaj izvora
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Emitiranje slike

uključuje.
Jedinica je priključena na uređaj izvora
napajanja koja ne podržava PoE++
(IEEE802.3bt, Vrsta 4, Klasa 8 sukladna).

napajanja koji podržava PoE++
(IEEE802.3bt, Vrsta 4, Klasa 8
sukladno).

Ukupna potrošnja energije premašuje
maksimalnu nazivnu energiju za PoE++
uređaj izvora napajanja.

Pogledajte upute za rad za PoE++
uređaj izvora napajanja.

Mrežni kabel nazivne kategorije koji ne
podržava PoE++ izvor napajanja je
priključen.

Upotrijebite mrežni kabel Kategorije
5e ili više te priključite na LAN
priključak.

Fotoaparat, PoE++ uređaj izvora
napajanja i periferni uređaji nisu
priključeni na uzemljenje.

Priključite fotoaparat, PoE++ uređaj
izvora napajanja i periferne uređaje
na uzemljenje.

Simptom Uzrok Rješenje

Slika se ne
emitira.

Povezani uređaji nisu ispravno povezani.
Ispravno priključite
povezane uređaje.

Početno postavljanje nije dovršeno.

Dovršite početno
postavljanje s
pomoću web-
aplikacije.

Slika se ne
emitira s HDMI
priključka.

Signal ne podržava uređaj odredišta HDMI izlaza
koji emitira.

Promijenite
postavku formata
HDMI izlaza ili
upotrijebite uređaj
koji podržava
izlazni signal.

Kabel ne podržava izlazni HDMI standard koji se
upotrebljava.

Upotrijebite kabel
koji podržava
izlazni HDMI
standard za
upotrebu.

Kabel ne podržava izlazni SDI standard koji se
upotrebljava.

Upotrijebite kabel
koji podržava
izlazni SDI standard
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Slika se ne
emitira s SDI
priključka.

za upotrebu.

Povezani monitor na SDI priključak ne podržava
izlazni signal.

Upotrijebite monitor
koji podržava
izlazni SDI
standard.

Format snimanja postavljen je na RAW format.

Promijenite format
snimanja na
postavku koja nije
RAW izlaz.

HDMI izlaz postavljen je na SD razlučivost.
Postavite HDMI
izlaz na razlučivost
koja nije SD.

Slika se ne
emitira s
optičkog kabela
ili je slika
izobličena.

Modul koji se upotrebljava nije sukladan s SFF ili
SMPTE standardima ili ne zadovoljava razinu
napajanja I (1,0 W).

Pogledajte odjeljak
„Slanje signala
optičkog kabela”.

Slika se ne
emitira ili je
izobličena kad
se upotrebljava
vanjska
sinkronizacija.

Signal vanjske sinkronizacije prikladan za format
konfiguriranog videosignala se ne emitira.

Postavite signal
vanjske
sinkronizacije
prikladan za format
konfiguriranog
videosignala.

Postoji buka u
zvuku.

Fotoaparat, PoE++ uređaj izvora napajanja i
periferni uređaji nisu priključeni na uzemljenje.

Priključite
fotoaparat, PoE++
uređaj izvora
napajanja i
periferne uređaje
na uzemljenje.

Jedinica se upotrebljava u okruženju s uređajima
koji stvaraju snažna električna i magnetna polja
(poput televizora / odašiljači radioantena, amaterski
radioodašiljači, motori klimatizacijskih uređaja,
transformatori napajanja).

Držite ih podalje od
uređaja koji stvaraju
snažna električna i
magnetna polja.

Objektiv, nosač za objektiv i jedinica pogona

Ispravno
pričvrstite
objektiv.
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Daljinski upravljač

Infracrveni daljinski upravljač

RM-IP500

dodiruju jedinicu ili predmet u okruženju i emitira se
neuobičajena buka.

Provjerite ima li
prepreka u
blizini
fotoaparata.

Simptom Uzrok Rješenje

Infracrveni daljinski
upravljač ne radi
kad se pritisne.

Rad infracrvenog daljinskog
upravljača je onemogućen.

Postavite funkciju [Technical] > [IR
Remote] > [Setting] na [On] u web-
izborniku.

Baterija je prazna ili je
neispravan pol baterije.

Rukujte infracrvenim daljinskim
upravljačem u blizini infracrvenog
senzora jedinice. Ako LED napajanje
treperi, zamijenite bateriju.

Početno postavljanje nije
dovršeno.

Dovršite početno postavljanje s
pomoću web-aplikacije.

Brzina rada
pomicanja/nagibanja
je spora.

Brzina pomicanja/nagibanja s
infracrvenog daljinskog
upravljača postavljena je na
normalan način rada.

Postavite prekidač SETUP
(Postavljanje) 4 na položaj ON
(Uključeno) na stražnjoj ploči.

Radnja je ciljala na
drugi fotoaparat
umjesto na
namijenjeni.

Infracrveni signal koji prima
od fotoaparata, a koji nije
namijenjeni fotoaparat.

Postavite funkciju [Technical] > [IR
Remote] > [Setting] na [Off] u web-
izborniku fotoaparata kojim ne želite
upravljati.

Simptom Uzrok Rješenje

Izvor napajanja
fotoaparata nije
priključen.

Provjerite da žaruljica POWER svijetli
zelenom ili narančastom bojom.

Fotoaparat ili
daljinski

Provjerite priključke fotoaparata i
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Web-aplikacija

Fotoaparatom se ne može
rukovati s pomoću daljinskog
upravljača RM-IP500.

upravljač nisu
povezani na
mrežu.

daljinskog upravljača.

Početno
postavljanje
fotoaparata nije
dovršeno.

Dovršite početno postavljanje s pomoću
web-aplikacije.

Komunikacija
VISCA over IP
nije
omogućena.

Postavite prekidač SETUP (Postavljanje)
3 na položaj ON (Uključeno) na ploči
priključaka fotoaparata i ponovno
pokrenite jedinicu.

IP adresa
fotoaparata se
promijenila.

Provjerite IP adresu fotoaparata s
pomoću funkcije [Network] > [Wired LAN]
u web-izborniku ili izborniku fotoaparata.

IP adresa fotoaparata se
promijenila s pomoću funkcije
AUTO IP SETUP na
daljinskom upravljaču RM-
IP500.

Proteklo je
barem 20
minuta otkad
se fotoaparat
pokrenuo.

Ponovno pokrenite fotoaparat. IP adresa
se može promijeniti s pomoću funkcije
AUTO IP SETUP unutar prvih 20 minuta
od pokretanja fotoaparata.

Simptom Uzrok Rješenje

Nije priključen
LAN kabel
kategorije 5e ili
više.

Priključite LAN kabel kategorije 5e ili više.

Nije ispravno
priključeno na LAN
ili povezana mreža
ne radi ispravno.

Provjerite svijetli li LINK LED za LAN
priključak. Ako LINK LED ne svijetli, obratite
se administratoru mreže.

Izvor napajanja
fotoaparata nije
priključen.

Pogledajte gornji odjeljak „Izvor napajanja”.

Valjana IP adresa
ne može se
konfigurirati za

Izvršite ponovno postavljanje mreže.
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Ne može se povezati s
pomoću web-
preglednika.

jedinicu.

Konfiguriranu IP
adresu
upotrebljava drugi
uređaj.

Provjerite jesu li IP adrese perifernih uređaja
jedinstvene.

Konfigurirana
maska podmreže
ne odgovara
upotrijebljenoj
podmreži mreže.

Izvršite ponovno postavljanje mreže.

Jedinici se može
pristupiti na istoj
lokalnoj mreži
putem proxyja.

Promijenite konfiguraciju tako da se proxy
poslužitelj ne upotrebljava.

Konfigurirani
zadani pristupnik
za jedinicu nije
ispravan.

Izvršite ponovno postavljanje mreže.

Uneseni URL nije
ispravan.

Unesite ispravni URL i pokušajte ponovno.

HTTP ulaz nije
ispravan.

Prikažite izbornik fotoaparata na vanjskom
monitoru i provjerite postavke [Network] >
[Wired LAN] > [HTTP Port]. Ako nije
konfigurirana vrijednost 80, dodajte HTTP broj
ulaza nazivu domaćina ili unesenoj IP adresi
u web-preglednik.
Primjer: ako je HTTP ulaz postavljen na 8080,
unesite http://<IP Address>:8080

Broj HTTP ulaza
jedinice se filtrira ili
blokira.

Promijenite broj HTTP ulaza jedinice na ulaz
koji se ne filtrira ili blokira.

Stara
predmemorija
web-preglednika
negativno utječe.

Obrišite predmemoriju iz web-preglednika.

Uređaj koji se
Upotrijebite uređaj koji podržava mDNS. 
Ako upotrebljavate uređaj koji ne podržava
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Ne može se povezati
na web-aplikaciju s
pomoću 2D koda (QR
kod).

upotrebljava ne
podržava mDNS.

mDNS, unesite IP adresu izravno u web-
preglednik.

Tablet ili računalo
je povezano na
drukčiju mrežu od
fotoaparata.

Povežite tablet ili računalo na istu mrežu na
kojoj je fotoaparat.

Ne može se ručno
povezati na web-
aplikaciju ručnim
unosom URL-a.

Uređaj koji se
upotrebljava ne
podržava mDNS.

Upotrijebite uređaj koji podržava mDNS.

Tablet ili računalo
je povezano na
drukčiju mrežu od
fotoaparata.

Povežite tablet ili računalo na istu mrežu na
kojoj je fotoaparat.

Zaslon autentifikacije
se stalno prikazuje.

Niste unijeli
ispravno
korisničko ime ili
lozinku.

Unesite registrirano korisničko ime i lozinku.
Ako ste zaboravili podatke o registriranom
korisniku pogledajte odjeljka „Prekidač
RESET” u dijelu „Blok priključaka” kako biste
ponovno postavili korisničke podatke za
mrežnu vezu.

Korisničko ime i
lozinku možda je
promijenio
prijavljen korisnik
u drugi web-
preglednik.

Provjerite ispravno korisničko ime i lozinku s
administratorom fotoaparata.

Slika fotoaparata se ne
prikazuje u web-
aplikaciji.

HDMI ulaz
fotoaparata
postavljen je na
720×480 ili
720×576.

Promijenite razlučivost HDMI izlaza
fotoaparata.

HDMI monitor koji
ne podržava signal
HDMI izlaza
fotoaparata je
priključen.

Uklonite HDMI monitor ili upotrijebite HDMI
monitor koji podržava signal HDMI ulaza.

Jedinica se
ponovno pokreće i Pričekajte jednu minutu i ponovno učitajte
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sesija je
isključena.

web-preglednik.

Stara
predmemorija
web-preglednika
negativno utječe.

Obrišite predmemoriju iz web-preglednika.

Razlučivost slike
fotoaparata prikazana
na web-aplikaciji je
niska.

Razlučivost za
videousmjeravanje
3 koje upotrebljava
web-aplikacija je
postavljena na
nisko.

Povećajte vrijednost s pomoću funkcije
[Stream] > [Video Stream] > [Size 3] u web-
izborniku.

Izbornik fotoaparata se
ne pojavljuje kad
pritisnete gumb
[MENU].

Izbornik
fotoaparata je
konfiguriran tako
da nije ugrađen u
signal HDMI
izlaza.

Postavite funkciju [Monitoring] > [Output
Display] > [HDMI/Stream] na [On] u web-
izborniku.

Vrijednost postavke
zaslona postavki nije
ispravno
ažurirana/prikazana.

Zaslon postavki
web-aplikacije
automatski ne
odražava
promijenjene
postavke u drugoj
web-aplikaciji.

Pritisnite gumb [Reload] na dnu zaslona
postavki web-aplikacije. Vrijednosti postavke
prikazanog zaslona postavljanja ponovno se
učitavaju i ažuriraju.

Utječu na
postavke
privremenih
mrežnih datoteka.

Obrišite predmemoriju iz web-preglednika.

Ne može preuzeti
datoteku ili zapisnik
konfiguracije.

Funkcija
preuzimanja
datoteke web-
preglednika je
onemogućena.

Omogućite funkciju datoteke preuzimanja
web-preglednika.

Možete pristupiti
zaslonu postavki web-
aplikacije, ali ne
možete izvršiti radnje
na zaslonu rada uživo i

Zaslon rada web-
aplikacije je
zaključan.

Postavite prekidač zaključavanja na gornjem
desnom dijelu web-aplikacije u položaj 
(Otključaj rad).
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Snimanje

Fotoaparat

Pomicanje/nagibanje

zaslonu reprodukcije.

Zaslonu web-aplikacije
potrebno je određeno
vrijeme za prikaz.

Sliku usmjeravanja
jedinice
istovremeno
pregledava više
korisnika.

Smanjite broj korisnika koji istovremeno mogu
pristupiti web-aplikaciji.

Simptom Uzrok Rješenje

Slika izgleda izobličeno na
početku i kraju
pomicanja/nagibanja.

Slika je možda izobličena ako je
funkcija stabilizacije slike
objektiva uključena.

Isključite funkciju
stabilizacije slike
objektiva.

Kut prikaza se promijenio
bez rada korisnika.

Došlo je do promjene žarišne
duljine objektiva.

Pogledajte odjeljak
„Kompenzacija promjene
žarišne duljine”.

Ne radi fokus, zumiranje ili
blenda.

Postavke prekidača objektiva nisu
ispravne.

Pogledajte odjeljak
„Provjera prekidača
objektiva”.

Simptom Uzrok Rješenje

Ne može se ponovno
postaviti
pomicanje/nagibanje.

Poluga zaključavanja
pomicanja/nagibanja u
položaju LOCK.

Pomaknite polugu zaključavanja
pomicanja/naginjanja u položaj UNLOCK.

Fotoaparat se ne
zaustavlja u

Blok fotoaparat nije
uravnotežen.

Pomaknite blok fotoaparata prema
naprijed/natrag u odgovarajući položaj
opisan u odjeljku „Pričvršćivanje
objektiva”, a zatim ponovno uključite
jedinicu.

Objektiv koji ne podržava
pomicanje/nagibanje je
pričvršćen.

Pogledajte informacije o kompatibilnosti
objektiva i pričvrstite objektiv koji
podržava pomicanje/nagibanje, a zatim
ponovno uključite jedinicu.
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očekivanom
položaju.

Ne može se izvršiti
ponovno postavljanje
pomicanja/nagibanja.

Izvršite ponovno postavljanje
pomicanja/nagibanja opisano u odjeljku
„Ponovno postavljanje
pomicanja/nagibanja”.

Primijenila se
neočekivana sila na
kućište fotoaparata stoga
se pojavila kontrola
pogreška
pomicanja/nagibanja.

Fotoaparat se ne
vraća u prednji
položaj kad se
pritisne gumb [Pan-
Tilt Home].

Aktiviran je način
montaže na strop.

Odaberite funkciju [Pan-Tilt] > [P/T
Direction] > [Ceiling] u web-izborniku u
skladu sa stvarnim postavljanjem, a
zatim ponovno uključite jedinicu. Kad se
montira na strop, blok priključaka nalazit
će se na prednjem dijelu fotoaparata.

Rad
pomicanja/nagibanja
je ograničen.

Ograničenje raspona
pomicanja/nagibanja je
konfigurirano.

Obrišite postavke ograničenja raspona
pomicanja/nagibanja, kako je potrebno,
opisano u odjeljku „Ograničenje raspona
pomicanja/nagibanja”.

Primijenila se
neočekivana sila na
kućište fotoaparata stoga
se pojavila pogreška
pomicanja/nagibanja.

Izvršite ponovno postavljanje
pomicanja/nagibanja opisano u odjeljku
„Ponovno postavljanje
pomicanja/nagibanja”.

Rad
pomicanja/nagibanja
pomiče se u
suprotnom smjeru.

Postavka načina
montaže na strop
drukčija je od stvarnog
montiranja.

Postavite funkciju [Pan-Tilt] > [P/T
Direction] > [Ceiling] u web-izborniku u
skladu sa stvarnom montažom.

Promijenile su se
postavke povezane sa
smjerom
pomicanja/nagibanja.

Provjerite postavke [Pan-Tilt] > [P/T
Direction] u web-izborniku.

Slika se ne pomiče
glatko na početku i
kraju

Postavka
ubrzavanja/usporavanja
rada pomicanja

Smanjite postavku
ubrzavanja/usporavanja rada
pomicanja/nagibanja kako bi rad na
početku i kraju pomicanja/nagibanja bio
glađi s pomoću postavke [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] u web-
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pomicanja/nagibanja. nagibanja je previsoka. izborniku ili izborniku fotoaparata. Imajte
na umu da to znači da će objektivu treba
više vremena da dosegne maksimalnu
brzinu.

Zaustavilo se
pomicanje/nagibanje.

Blok fotoaparat nije
uravnotežen.

Pomaknite blok fotoaparata prema
naprijed/natrag u odgovarajući položaj
opisan u odjeljku „Pričvršćivanje
objektiva”, a zatim ponovno uključite
jedinicu.

Postavka krivulje nagiba
(ubrzavanje/usporavanje)
je previsoka za
pričvršćen objektiv.

Ako je pričvršćen veliki objektiv, smanjite
vrijednost postavke [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] u web-
izborniku ili izborniku fotoaparata.

Upotrebljava se veliki
objektiv.

Obratite se predstavniku za podršku
tvrtke Sony.

Jedinicu ometa rad
pomicanja/nagibanja.

Poluga stezaljki vijka za
pričvršćivanje postolja
nosača za objektiv udara
fotoaparat.

Okrenite polugu stezaljki vijka za
pričvršćivanje postolja nosača za objektiv
tako da je usmjerena prema gore.

Poluga stezaljki nosača
za objektiv udara
fotoaparat.

Okrenite polugu stezaljki nosača za
objektiv prema gore.

Poluga zaključavanja
kućišta fotoaparata udara
fotoaparat.

Provjerite da je poluga zaključavanja
kućišta fotoaparata u potpunosti u
položaju LOCK.

Neuobičajeni zvuk se
pojavljuje tijekom
pomicanja/nagibanja.

Fotoaparat nije
uravnotežen.

Pomaknite glavu fotoaparata prema
naprijed/natrag u odgovarajući položaj
tako da je postolje klizača vodoravno.

Postavka krivulje nagiba
(ubrzavanje/usporavanje)
je previsoka za
pričvršćen objektiv.

Ako je pričvršćen veliki objektiv, smanjite
vrijednost postavke [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] u web-
izborniku ili izborniku fotoaparata.

Kućište fotoaparata nije
fiksirano na položaj i čuje
se zvuk pomicanja
tijekom rada.

Postavite polugu zaključavanja kućišta
fotoaparata u položaj LOCK.
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Snimanje/reprodukcija

Unaprijed
postavljena postavka
se ne može spremiti
ili učitati.

Spremanje i učitavanje
unaprijed postavljene
postavke nije dostupno
kad je funkcija [Zoom
Type] postavljena na
[On(Clear Image Zoom)].

Postavite funkciju [Technical] > [Zoom] >
[Zoom Type] na [Optical Zoom Only] u
izborniku fotoaparata.

Upravljačka ploča
kadra web-aplikacije
zasivljena je i ne
može se
upotrebljavati.

Pomicanje/nagibanje nije
dostupno dok se
prikazuje zaslon
minijatura i tijekom
reprodukcije.

Napustite zaslon minijatura ili zaustavite
reprodukciju.

Pomicanje/nagibanje nije
dostupno kad se slika
fotoaparata ne prikazuje
u web-aplikaciji.

Pogledajte web-aplikaciju u odjeljku
„Rješavanje problema”.

Poluga zaključavanja
pomicanja/nagibanja u
položaju LOCK.

Pomaknite polugu zaključavanja
pomicanja/naginjanja u položaj UNLOCK.

Funkcija „Execute
Pan-Tilt Reset”
prikazuje se ispod
upravljačke ploče
kadra u web-
aplikaciji.

Primijenila se
neočekivana sila na
kućište fotoaparata stoga
se pojavila pogreška
pomicanja/nagibanja.

Izvršite ponovno postavljanje
pomicanja/nagibanja opisano u odjeljku
„Ponovno postavljanje
pomicanja/nagibanja”.

Simptom Uzrok Rješenje

Snimanje ne
započinje kada
pritisnete gumb za
snimanje
START/STOP.

Memorijska kartica je puna.
Zamijenite memorijsku karticu
karticom s dovoljno prostora.

Potreban je oporavak
memorijske kartice.

Oporavite memorijsku karticu kako
je opisano u odjeljku „Oporavak
memorijske kartice”.

Jedinica se pokreće s pomoću
PoE++ napajanja.

Izvor napajanja na DC IN priključak
s pomoću adaptera za napajanje
izmjeničnom strujom.

Žaruljica snimanja/signalizacije Konfigurirajte žaruljicu



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Prijenos datoteka

IP usmjeravanje

konfigurirana je kao žaruljica
signalizacije tako da status
snimanje ne može odrediti
žaruljica.

snimanja/signalizacije tako da radi
kao žaruljica snimanja kako je
opisano u odjeljku „Priključivanje
signalizacije”.

Snimanje zvuka
nije moguće.

Mikrofon nije priključen.
Priključite mikrofon ili audiouređaj u
AUDIO IN priključak na bloku
priključaka.

Postavka [Master Input Level] je
pri maksimalnoj vrijednosti.

Prilagodite [Master Input Level].

Snimljeni je zvuk
izboličen.

Postavka razine ulaza zvuka je
previsoka.

Prilagodite postavku [CH1 Input
Level] na [CH4 Input Level] i [Master
Input Level].

Snimljeni zvuk
ima visoku razinu
šuma.

Postavka razine ulaza zvuka je
preniska.

Prilagodite postavke [Audio Input
Level] i [Audio] > [Audio] > [Audio
Input] > [AUDIO IN CH1 MIC Ref.] ili
[AUDIO IN CH2 MIC Ref.].

Isječak nije
moguće
reproducirati.

Isječak se uređuje.

Isječke nije moguće reproducirati
ako ste izmijenili nazive ili datoteke,
ili ako se isječak upotrebljava na
računalu. To nije kvar.

Isječak se snimio s pomoću
fotoaparata koji nije ova jedinica.

Snimljeni isječci s drugim
fotoaparatom možda se neće moći
reproducirati ili prikazati u ispravnoj
veličini. To nije kvar.

Simptom Uzrok Rješenje

Prijenos
datoteka nije
uspio.

Nisu ispravni korisničko ime i
lozinku na poslužitelju.

Korisničko ime i lozinka poslužitelja
možda su neispravni. Unesite točne.

Simptom Uzrok Rješenje
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Usmjeravanje nije
dostupno.

Korisničko ime i lozinka
koje ste unijeti u
aplikaciji klijenta za
pregled usmjeravanja s
jedinice nisu ispravni.

Ako je format usmjeravanja jedinice postavljen
na [RTSP], [SRT-Listener] ili [NDI|HX],
potrebno je unijeti korisničko ime i lozinku za
ovu jedinicu u aplikaciju klijenta. Unesite
ispravno korisničko ime i lozinku.

Protokol usmjeravanja
nije konfiguriran kad je
način usmjeravanja
postavljen na
[RTSP/SRT] ili
[Listener/NDI].

Odaberite ciljni protokol s pomoću funkcije
[Stream] > [Stream Setting] u web-izborniku.

Postavljeno je šest ili
više RTSP sesija.

Postavite broj sesija na pet ili manje.

Broj UDP ulaza nije
ispravno postavljen.

Postavite broj ulaza i ostale postavke za ciljni
protokol s pomoću funkcije [Stream] >
[Stream] > [Stream Setting] u web-izborniku.

UDP komunikacija je
blokirana.

Provjerite postavke softvera zaštite.

Zvuk se ne
usmjerava.

Usmjeravanje ulaza
zvuka postavljeno je na
[Off].

Postavite funkciju [Stream] > [Audio Stream] >
[Setting] na [On] u web-aplikaciji.

Usmjeravanje je
isključeno.

Postavka protokola ili
postavke kodeka
usmjeravanja
promijenile su se
tijekom usmjeravanja.

Postavite postavku protokola i postavke
kodeka usmjeravanja prije početka
usmjeravanja.

Veličina se slike
[Video Stream 1]
ne može postaviti
na 4096×2160 ili
3840×2160.

Veličina slike je
1920×1080 kad je
funkcija [Output
Format] postavljena na
HDMI.

Veličina slike za usmjeravanje ne može se
postaviti više od veličine HDMI slike.
Promijenite veličinu HDMI slike s pomoću
funkcije [Monitoring] > [Output Format] u web-
izborniku.

Brzina sličica
postavke [Video
Stream 1] ne
može se postaviti
na 60 FPS ili 50
FPS.

Brzina sličica
usmjeravanja je
postavljena na 29,97 ili
manje.

Korištena brzina sličica za usmjeravanje
ograničena je frekvencijom sustava.
Promijenite frekvenciju sustava s pomoću
postavke [Rec Format] > [Frequency] u web-
izborniku.
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Priključivanje s vanjskim uređajima

Vanjska sinkronizacija

Postavci
usmjeravanja
[Video Stream 3]
se ne može
pristupiti.

Postavka [Video
Stream 3] ne podržava
RTSP/SRT/NDI.

Upotrijebite [Video Stream 1] ili [Video Stream
2].

Zaslon
RTSP/SRT nije
se ispravno
ažurirao/prikazao.

Korišteni broj ulaza za
RTSP ili SRT filtrira se
ili blokira.

Promijenite broj ulaza RTSP ili SRT na ulaz
kojeg ne blokiraju ili filtriraju uređaji koji
primaju usmjeravanje. Ili promijenite broj ulaza
koji se upotrebljavaju za RTSP ili SRT na
jedinici.

Slike se izobličuje
ili trza.

Informacije o
videozapisu se
ispravno ne odašilju
zbog zagušenja na
komunikacijskom putu.

Smanjite brzinu bitova usmjeravanja ili
postavite [Video Stream 2] kodek ([Codec 2])
na [OFF] kako biste stvorili marginu u
komunikacijskom pojasu.

Redoslijed paketa
videozapisa se mijenja
unutar komunikacijskog
kanala.

Upotrijebite istog mrežnog uslužnog
poslužitelja na fotoaparatu i prijamniku.

Nije otkriven kao
NDI uređaj.

Protokol usmjeravanja
nije postavljen na
NDI|HX.

Protokol usmjeravanja mora se postaviti na
NDI|HX kako bi otkrio jedinicu kao NDI uređaj.
Postavite [Stream] > [Stream Setting] na
[NDI|HX] u web-izborniku.

Ne može
upotrebljavati kao
NDI uređaj.

NDI|HX licenca nije
instalirana.

Instalirajte NDI|HX licencu. Možete provjeriti
upotrebljava li se NDI|HX licenca s pomoću
[Stream] > [Stream] > [Stream Setting] >
[NDI|HX] > [License] u web-izborniku.

Simptom Uzrok Rješenje

Ne može se
sinkronizirati
na vanjski
izvor.

Signal vanjske sinkronizacije
prikladan za format
konfiguriranog videosignala se
ne emitira.

Postavite signal vanjske sinkronizacije
prikladan za format konfiguriranog
videosignala.

Jedinica ima ugrađeni prekidač od 75 ?.
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Tally

[274] Dodatak

Poruke o pogrešci/upozorenju

Ako se upozorenje, oprez ili stanje rada koje zahtijeva potvrdu dogodi na jedinici, prikazuje se
poruka na ploči fotografija fotoaparata, a žaruljica POWER i NETWORK na prednjoj ploči te
žaruljica snimanja/signalizacije počnu treperiti.

Note

Naznaka treperenja žaruljice snimanja/signalizacije samo je omogućena kad je funkcija [Technical] >
[Tally] > [Tally Control] postavljena na [Internal] i funkcija [Tally Lamp Brightness] postavljena na [Off]
u web-izborniku ili izborniku fotoaparata.

Poruke o greškama

Ako žaruljice POWER i NETWORK trepere kako je opisano u nastavku, poduzmite sljedeće

Jedinica je dvostruko prekinuta. Priključite izravno na izvor signala (jedan-
na-jedan) ili upotrijebite razdjelnik.

Simptom Uzrok Rješenje

Žaruljica
signalizacije
ne svijetli.

Svjetlina žaruljice signalizacije
postavljena je na Off
(Isključeno).

Postavite odgovarajuću svjetlinu s pomoću
funkcije [Technical] > [Tally] > [Tally Lamp
Brightness] u web-izborniku.

Žaruljica snimanja/signalizacije
konfigurirana je kao žaruljica
snimanja.

Konfigurirajte žaruljicu
snimanja/signalizacije tako da radi kao
žaruljica signalizacije „Priključivanje
signalizacije”.

RM-IP500 je priključen i
komunikacija VISCA over IP je
onemogućena.

Postavite prekidač SETUP (Postavljanje) 3
na položaj On (Uključeno) na bloku
priključaka.

Veza priključka OPTION nije
ispravna ili se nije proveo kratki
spoj na ciljnom izvodu na GND.

Provedite kratki spoj izvoda 7 ili 8 na
priključku OPION na GND kako je opisano
u odjeljku „Priključivanje signalizacije”.
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mjere.

Jedinica će prestati raditi kad se sljedeći prikaz pojavi.

Poruke upozorenja

Ako se prikaže sljedeći zaslon, pratite priložene upute.

Žaruljica
POWER

Žaruljica
NETWORK Uzrok i rješenje

Sporo
treperi
narančasto

Sporo
treperi
zeleno

Jedinicom se ne može normalno rukovati. Pojedinosti pogledajte
u dijelu [Maintenance] > [System Log] u web-izborniku. Ako se
problem nastavi čak nakon postavljanja jedinice u stanje
pripravnosti ili isključivanja napajanja pa ponovnog uključivanja,
obratite se predstavniku za servis tvrtke Sony.

Brzo
treperi
narančasto

Brzo treperi
zeleno

Pojavio se kvar na jedinici. Obratite se predstavniku za servis
tvrtke Sony.

Prikaz
poruke

Lampica
snimanja/signalizacije Uzrok i rješenje

E +
error
code

Iznimno brzo treperenje

Ukazuje na neuobičajeno ponašanje jedinice. Snimanje
se zaustavlja čak kad je ?REC prikaza na ploči
fotografija fotoaparata. 
Isključite jedinicu i provjerite ima li problema s
priključenim uređajima, kabelima ili medijima. Ako se
pogreška i dalje pojavljuje po ponovnom uključenju
jedinice, obratite se servisnom predstavniku tvrtke Sony.
Ovisno o statusu jedinice, može se prikazati pogreška ili
oglasiti zvuk upozorenja.

Prikaz poruke Lampica
snimanja/signalizacije Uzrok i rješenje

Temperature
High

Treperi
Unutarnja temperatura je visoka. 
Isključite videokameru i prije ponovnog rada
pričekajte da se ohladi.

Visoka
temperatura Treperi

Temperatura CFexpress kartice je visoka. 
Zamijenite karticu ili prije ponovne upotrebe
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medija pričekajte da se ohladi.

Voltage Low Treperi
Napon na DC IN je nizak (1. razina). Provjerite
izvor napajanja.

Insufficient
Voltage

Iznimno brzo treperenje
Napon na DC IN je prenizak (2. razina).
Snimanje je onemogućeno. 
Priključite drugi izvor napajanja.

Media Near Full Treperi
Preostali kapacitet memorijske kartice je
malen. 
Zamijenite prvom prilikom.

Media Full Iznimno brzo treperenje
Isječke nije bilo moguće snimiti ili kopirati jer je
istrošen kapacitet memorijske kartice. 
Odmah zamijenite.

Clips Near Full Treperi
Broj dodatnih isječaka koje je moguće snimiti
na memorijsku karticu je malen. 
Zamijenite prvom prilikom.

Clips Full Iznimno brzo treperenje

Dosegnut je maksimalan broj dodatnih isječaka
koje je moguće snimiti na memorijsku karticu. 
Snimanje ili kopiranje dodatnih isječaka nije
moguće. Odmah zamijenite.

Last Clip
Recording

Treperi

Budući da je dostignut maksimalni broj
isječaka, trenutačno snimani isječak posljednji
je isječak koji je moguće snimiti. 
Pripremite novu memorijsku karticu.

Gotovo prazan
medij (A)1) Treperi

Približava se kraj vijeka trajanja memorijske
kartice. Zamijenite prvom prilikom.

Prazan medij
(A)1) Iznimno brzo treperenje

Memorijska kartica dosegla je kraj vijeka
trajanja. Odmah zamijenite.

Gotovo pun
medij (A)1) Treperi Pri upotrebi funkcije Simul Rec

Pun medij (A)1) Iznimno brzo treperenje Pri upotrebi funkcije Simul Rec

Gotovo
popunjeni isječci
medija (A)1)

Treperi Pri upotrebi funkcije Simul Rec
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Poruke za oprez i rad

Na sredini zaslona mogu se prikazati sljedeće poruke za oprez i rad. Pratite upute za rješavanje
problema.

Puni isječci
medija (A)1) Iznimno brzo treperenje Pri upotrebi funkcije Simul Rec

Snimanje
zadnjeg isječka
medija (A)1)

Treperi Pri upotrebi funkcije Simul Rec

Slovo „B” prikazuje se za karticu u utoru B.1)

Poruka na zaslonu Uzrok i rješenje

Prazna rezervna baterija
Promijenite

Preostali kapacitet rezervne baterije je nedovoljan. 
Promijenite rezervnu bateriju.

Nepoznati medij (A)1)

Promijenite

Umetnuta je particionirana memorijska kartica ili
memorijska kartica koja sadrži više isječaka no što
jedinica može savladati. 
Karticu nije moguće upotrebljavati u jedinici i morate je
zamijeniti.

Ne može se upotrijebiti medij (A)1)

Nepodržani sustav datoteka

Umetnuta je kartica s drugim podatkovnim sustavom ili
neformatirana kartica. 
Karticu nije moguće upotrebljavati u jedinici i morate je
zamijeniti ili formatirati u jedinici.

Pogreška medija
Treba se oporaviti medij (A)1)

Došlo je do pogreške na memorijskoj kartici i karticu je
nužno oporaviti. 
Oporavite memorijsku karticu.

Pogreška medija
Ne može se snimati na medij (A)1)

Memorijska kartica možda je oštećena i više se ne
može upotrebljavati za snimanje. 
Reprodukcija je moguća, stoga se preporučuje napraviti
kopiju i zamijeniti memorijsku karticu.

Pogreška medija
Ne može se upotrebljavati medij
(A)1)

Memorijska kartica možda je oštećena i više se ne
može upotrebljavati za snimanje ili reprodukciju. 
Karticu nije moguće upotrebljavati u jedinici i morate je
zamijeniti.

1) Snimanje i reprodukcija zaustavljeni su jer je došlo do
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[275] Dodatak

Popis stavki izbornika

Sljedeće tablice navode stavke izbornika jedinice.

Pogreška medija (A)
Zaustavljeno snimanje
Zaustavljena reprodukcija

pogreške tijekom upotrebe memorijske kartice. 
Ako se problem nastavi pojavljivati, zamijenite
memorijsku karticu.

Dosegnuto ograničenje
prepisivanja medija
Promijenite medij (A)1)

Memorijska kartica dosegla je kraj vijeka trajanja. 
Napravite rezervnu kopiju i odmah zamijenite karticu.
Ako nastavite upotrebljavati karticu, snimanje i
reprodukcija možda neće biti mogući. 
Pojedinosti potražite u uputama za upotrebu
memorijske kartice.

Navedena adresa nije valjana.
Navedena adresa nije valjana. 
Provjerite je li postavka ispravna.

Cannot Use Specified Port
Number

Navedeni broj ulaza nije valjan. 
Provjerite je li postavka ispravna.

Lens I/F Error(xx:xx)

Otkrivena je pogreška objektiva u komunikaciji I/F
objektiva kada je postavljen objektiv E-mount. 
Provjerite status veze s objektivom E-mount. 
Ako se problem nastavi pojavljivati, sa šifrom pogreške
obratite se servisnom predstavniku tvrtke Sony (pet
znakova u zagradi).

Cannot add auto upload job of
Proxy file because maximum
number of upload jobs was
reached.

Dostignut je maksimalan broj zadataka prijenosa. 
Obrišite nepotrebne zadatke. Postavka odredišta za
automatski prijenos datoteka proxy također može biti
neispravna. Provjerite je li postavka ispravna.

Fan Stopped

Ventilator se ne pokreće. 
Provjerite da nema prašine ili stranih tvari. 
Ako je pogreška i dalje prisutna nakon uklanjanja
prašine ili stranih predmeta, obratite se servisnom
predstavniku tvrtke Sony.

Slovo „B” prikazuje se za karticu u utoru B.1)
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Legenda
„Izbornik fotoaparata” i „web-izbornik”
?: dostupno
^: neke stavke dostupne
–: nije dostupno

„All File” i „Scene File”
Da: spremljena stavka u datoteci ALL ili datoteci scene
Ne: stavka nije spremljena

„All Reset (except for Network Settings)”
Kad se funkcija [Reset]> [Reset] > [All Reset (except for Network Settings)] u web-izborniku
izvršava:
Da: inicijalizirana stavka (bez mrežnih postavki)
Ne: nije primjenjivo

„Network Reset”
Kad je funkcija [Reset]> [Reset] > [Network Reset] u web-izborniku izvršena:
Da: inicijalizirana stavka (mrežna postavka)
Ne: nije primjenjivo

„Factory Default”
Da: stavka ponovno postavljena na tvorničke postavke
Ne: nije primjenjivo

Snimanje

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

ISO/Gain/EI ? – Da Da Da Da Da

ND Filter ? – Da Da*1 Da Ne Da

Shutter ? – Da Da Da Ne Da

Blenda ? – Da Da Da Ne Da

Auto
Exposure

? – Da Da*2 Da Ne Da
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Project

Bijeli ? – Da Da*3 Da Ne Da

White
Setting

? – Da Ne Da Ne Da

Offset White ? – Da Ne Da Ne Da

Focus ? ^ Da Ne Da Ne Da

S&Q Motion ? – Da Ne Da Ne Da

LUT On/Off ? – Da Ne Da Ne Da

Noise
Suppression

? – Da Da Da Ne Da

Flicker
Reduce

? – Da Ne Da Ne Da

SteadyShot ? – Da Ne Da Ne Da

[Mode] nije primjenjiv*1
[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V
Position] nije primjenjiv

*2

[Preset White] nije primjenjiv*3

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Base
Setting

? ? Da Ne Da Ne Da

Rec
Format

? ? Da Ne Da*1 Ne Da

Cine EI
Setting

? – Da Ne Da Ne Da

Simul Rec ? ? Da Ne Da Ne Da

Proxy
Rec

? ^ Da Ne Da Ne Da
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Paint/Look

Interval
Rec

? ? Da*2 Ne Da Ne Da

Picture
Cache
Rec

? ? Da*2 Ne Da Ne Da

SDI/HDMI
Rec
Control

? – Da Ne Da Ne Da

Gumb za
dodjelu

? – Da Ne Da Ne Da

All File – ? Ne Ne Ne Ne Ne

[Frequency] nije primjenjiv*1
[Setting] nije primjenjiv*2

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi

sve
(osim

mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Scene File ? – Ne Ne Ne Ne Ne

Base Look ? ^ Da*1 Ne Da*1 Ne Da*1

Ponovno
postavljanje
postavki boje

? – Ne Ne Ne Ne Ne

Crni ? – Da Da Da Ne Da

Komprimiranje ? – Da Da Da Ne Da

Detalj ? – Da Ne Da Ne Da

Matrix ? – Da Da Da Ne Da

Multi Matrix ? – Da*2 Da*2 Da Ne Da



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Pan-Tilt

TC/Media

LUT podaci uvezeni kao osnovni izgled nisu primjenjivi*1
[Axis] nisu primjenjivi*2

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

P/T Speed – ? Ne Ne Da Ne Ne

P/T
Acceleration

? ? Ne Ne Da Ne Ne

P/T Range
Limit

– ? Ne Ne Da Ne Ne

P/T
Direction

– ? Ne Ne Da Ne Ne

P/T Preset – ? Ne Ne Da Ne Ne

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Vremenski
kod

? – Da*1 Ne Da Ne Da

TC
Display

? – Da Ne Da Ne Da

Users Bit ? – Da*1 Ne Da Ne Da

HDMI TC
Out

? – Da Ne Da Ne Da

Clip Name
? – *2 Ne Da Ne Da
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Monitoring

Audio

Format

Update
Media

? – Ne Ne Ne Ne Ne

Format
Media

? – Ne Ne Ne Ne Ne

Media Life ? – Ne Ne Ne Ne Ne

[Setting] nije primjenjiv*1
[Auto Naming] primjenjiv, [Camera ID] nije primjenjiv*2

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi

sve
(osim

mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Output Format ? ? Da Ne Da Ne Da

Output Display – ? Da Ne Da Ne Da

Prikaz -
uključeno/isključeno

? – Da Ne Da Ne Da

Video Signal
Monitor

? – Da Ne Da Ne Da

Marker ? – Da Ne Da Ne Da

Stavka
(razina

2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Audio
ulaz

? ^ Da Ne Da Ne Da

Audio



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Thumbnail (Sličica)

Technical

Output
? ^ Da Ne Da Ne Da

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Display Clip
Properties

? – Ne Ne Ne Ne Ne

Set Clip
Flag

? – Ne Ne Ne Ne Ne

Lock/Unlock
Clip

? – Ne Ne Ne Ne Ne

Delete Clip ? – Ne Ne Ne Ne Ne

Transfer
Clip

? – Ne Ne Ne Ne Ne

Transfer
Clip (Proxy)

? – Ne Ne Ne Ne Ne

Filter Clips ? – Ne Ne Ne Ne Ne

Customize
View

? – Da Ne Da Ne Da

Stavka 
(razina

2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Color
Bars

? – *1 Ne *1 Ne Da

Genlock ? – Ne Ne Ne Ne Ne
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Network

Tally ? ? Da Ne Da Ne Da

Rec
Review

? – Da Ne Da Ne Da

Zoom ? – Da Ne Da Ne Da

IR
daljinski
upravljač

– ? Ne Ne Da Ne Da

Objektiv ? – Da Ne Da Ne Da

APR ? – Ne Ne Ne Ne Ne

[Type] primjenjiv, [Setting] nije primjenjiv*1

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi sve

(osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Naziv
fotoaparata

– ? Ne Ne Ne Ne Da

User – ? Ne Ne Ne Da Da

Žičani
LAN*1 ^ ? Ne Ne Ne Da Ne

File
Transfer

? ^ Da Ne Da Da Da

FTP Server
1

– ? Ne Ne Da Ne Da

FTP Server
2

– ? Ne Ne Da Ne Da

FTP Server
3

– ? Ne Ne Da Ne Da

SSL – ? Ne Ne Ne Da Da



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

Usmjeravanje

Održavanje

Provjera
reference

– ? Ne Ne Ne Da Da

Zaštita od
nasilnog
napada

– ? Ne Ne Ne Da Da

Ne može se konfigurirati s pomoću izbornika fotoaparata (samo prikaz)*1

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi

sve (osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Postavke
usmjeravanja

– ? Ne Ne Da*1 Ne Da*1

Usmjeravanje
videozapisa

– ? Da Ne Da Ne Da

Usmjeravanje
zvuka

– ? Da Ne Da Ne Da

[NDI|HX] > [License] nije primjenjiv*1

Stavka 
(razina 2)

Izbornik
fotoaparata

Web-
izbornik

All
File

Scene
File

Ponovno
postavi

sve (osim
mrežnih
postavki)

Network
Reset

Tvorničke
postavke

Language ? ? Da Ne Da Ne Da

Pristupačnost – ? Da Ne Ne Ne Da

Clock Set ? ? Da*1 Ne Da*2 Ne Da

Reset – ? Ne Ne Ne Ne Ne



ILME-FR7 / ILME-FR7K | Vodič za pomoć

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/HR/print.html[11/16/2022 1:54:32 PM]

[276] Dodatak

Stavke spremljenih unaprijed postavljenih položaja

„Da” naznačuje postavku koja se sprema za unaprijed postavljeni položaj, a „Ne” naznačuje
postavku koja se ne sprema.

Stavke pomicanja/nagibanja

Hours Meter ? – Ne Ne Ne Ne Ne

Information – ? Ne Ne Ne Ne Ne

Zapisnik
sustava

– ? Ne Ne Ne Ne Da

HTTP
zapisnik
pristupa

– ? Ne Ne Ne Ne Da

Service – ? Ne Ne Ne Ne Ne

EULA – ? Ne Ne Ne Ne Ne

Softver – ? Ne Ne Ne Ne Ne

Informacije o datumu i vremenu nisu primjenjive*1
Informacije o funkciji [Time Zone], datumu i vremenu nisu primjenjive*2

Mjesto prikaza Stavka Spremi cilj

Upravljačka ploča kadra zaslona rada uživo
Položaj pomicanja/nagibanja Da

[Pan-Tilt Speed] Ne1)

[Pan-Tilt] u web-izborniku

[P/T Speed] Ne

[P/T Acceleration] Ne

[P/T Range Limit] Ne

[P/T Direction] Ne

[P/T Preset] Ne
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Stavke zumiranja

Stavke fokusa

Može se zasebno konfigurirati za svaki unaprijed postavljeni položaj. Pojedinosti pogledajte u dijelu [Pan-Tilt] >
[Preset] u web-izborniku.

1)

Mjesto prikaza Stavka Spremi
cilj

Upravljačka ploča kadra zaslona rada
uživo

Položaj zumiranja (udaljenost
fokusa)

Da

[Zoom Speed] Ne1)

[Technical] > [Zoom] u izborniku
fotoaparata

[Zoom Type] Ne

Pomiče se pri maksimalnoj brzini prilikom oporavka unaprijed postavljenog položaja.1)

Mjesto prikaza Stavka Spremi
cilj

Ploča fotografija fotoaparata
zaslon rada uživo

Određen cilj praćenja za automatski fokus
praćenja u stvarnom vremenu

Ne

Određene koordinate za fokus točke Ne

Kartica  (Fokus) zaslon rada
uživo

Prekidač [Touch Focus] Ne

Prekidač [Auto Focus] Da

Status gumba [Focus Hold] Ne

Status gumba [Push AF/MF] Ne

[Face/Eye Detection AF] Da

[AF Subj. Shift Sens.] Da

[AF Transition Speed] Da

Položaj fokusa Da1)

[Push AF Mode] (uključujući postavke s pomoću
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[277] Dodatak

Dijagrami bloka

Audio ulaz

Audio Output

[Shooting] > [Focus] u web-
izborniku

dodjeljivih gumbi)
Ne

[Touch Function in MF] Ne

[AF Assist Control] Ne

[Shooting] > [Focus] u
izborniku fotoaparata

Postavite veličinu i položaj fokusa s pomoću
funkcije [Focus Area]

Da

Postavite položaj fokusa s pomoću funkcije
[Focus Area (AF-S)]

Da

Nije oporavljeno kad je prekidač [Auto Focus] postavljen na uključeno. Oporavljeno kad je isključeno.1)
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[278] Dodatak

Ažuriranje objektiva E-mount

Softver objektiva E-mount moguće je ažurirati s pomoću jedinice.
Na web-mjestu s objektivima potražite objektive koje je moguće ažurirati i odgovarajući softver.
Softver se ažurira s pomoću web-izbornika.

Note

Nemojte izvršavati sljedeće radnje sve dok se ažuriranje ne dovrši.
Isključivanje mreže
Uklanjanje objektiva
Isključivanje napajanja

Pričvrstite objektiv E-mount na jedinicu.1

Provjerite funkcije [Maintenance] > [Information] > [Lens] > [Model Name] i [Version
Number] u web-izborniku.

Broj verzije softvera objektiva E-mount prikazuje se sa strane.
Provjerite broj verzije softvera i zatim ažurirajte softver po potrebi.

2

Preuzmite datoteka ažuriranja softvera objektiva za Windows (ekstenzija .exe) na
uređaj koji pokreće web-aplikaciju.

3

U [Maintenance] > [Information] > [Lens] > [Version Up], pritisnite gumb [Choose
File] i odaberite preuzetu datoteku ažuriranja.

4

Slijedite upute na zaslonu.5
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Ako se prikaže poruka koja naznačuje ažuriranje nije uspjelo, provjerite prikazani opis i ponovno
pokušajte ažurirati.

[279] Dodatak

Pričvršćivanje o poklopcu gumba za otpuštanje
objektiva

Možete spriječiti nenamjerno uklanjanje objektiva pričvršćivanjem poklopca gumba otpuštanja
objektiva isporučenog s nosačem za zid CIB-PCM1 (dodatno) za gumb za otpuštanje objektiva.

Pričvrstite objektiv.

Pojedinosti o pričvršćivanju objektiva pogledajte u „Pričvršćivanje objektiva”.

1

Povucite polugu zaključavanja pomicanja/nagibanja u položaj LOCK kako biste
zaključali pomicanje/nagibanje glave fotoaparata.

2

Pomaknite blok fotoaparata na položaj tako da se poklopac uklanjanja objektiva
može pričvrstiti.

3

Pričvrstite poklopac uklanjanja objektiva tako da prekriva gumb otpuštanja
objektiva.

4

Osigurajte poklopac uklanjanja objektiva s pomoću vijka za zadržavanje poklopca
uklanjanja objektiva.

5
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Note

Na taj se način neće u potpunosti ukloniti objektiv.

[280] Dodatak

Licence

Licenca portfelja patenta MPEG-4 AVC

OVAJ JE PROIZVOD LICENCIRAN POD PORTFELJEM PATENTA AVC ZA OSOBNU
UPOTREBU POTROŠAČA ILI DRUGIH UPOTREBI ZA KOJE NE DOBIVA NAKNADU ZA
(i) ŠIFRIRANJE VIDEOZAPISA U SKLADU SA STANDARDOM AVC („AVC VIDEOZAPIS“) I/ILI
(ii) DEKODIRANJE AVD VIDEOZAPISA KOJI SU KODIRALI POTROŠAČI ZA OSOBNE
SVRHE DOBIVENE OD DAVATELJA VIDEOSADRŽAJA S LICENCOM ZA PROIZVODNJU
AVC VIDEOZAPISA.
LICENCA SE NE DAJE NITI ĆE SE PODRAZUMIJEVATI NI ZA KOJU DRUGU SVRHU.
DODATNE SE INFORMACIJE MOGU DOBITI OD TVRTKE MPEG LA, L.L.C. POGLEDAJTE
HTTP://WWW.MPEGLA.COM

Preuzimanje softvera pod licencom GPL/LGPL

U proizvodu se upotrebljava softver na koji se primjenjuje GPL/ LGPL. Time vam se daje do
znanja da imate pravo na pristup, izmjenu i redistribuciju izvornog koda ovih softverskih
programa u skladu s uvjetima GPL-a/LGPL-a.
Izvorni kod dostupan je na internetu. Pristupite sljedećem URL-u i pratite upute za preuzimanje.
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https://oss.sony.net/Products/Linux/
Cijenili bismo kad nam se ne bi obraćali s pitanjima o sadržaju izvornog koda.

Izvorni kod µT-Kernel

Ovaj proizvod upotrebljava izvorni kod µT-Kernel pod licencom T-License 2.1 kojeg jamči TRON
Forum (www.tron.org).

[281] Dodatak

Specifikacije

General

Masa
Pribl. 4,6 kg (10 lb 2,3 oz) (samo kućište)
Pribl. 6,0 kg (13 lb 3,6 oz) (uključujući objektiv SELP28135G)

Dimenzije
Pogledajte „Vanjske dimenzije”

Zahtjevi napajanja
19,5 V istosmjerno
PoE++ (IEEE802.3bt Type 4 Class 8, sukladno)

Potrošnja energije
19,5 V DC: 80,0 W (maks)
PoE++: 71,3 W (maks)

Radna temperatura
od 0 °C do 40 °C (od 32 °F do 104 °F)

Temperatura pohrane
-20 °C do +60 °C (-4 °F do +140 °F)

Format za snimanje (videozapis)
XAVC Intra
XAVC-I 4K/QFHD način: VBR, 600 Mbps (maks) brzina bitova, MPEG-4 AVC/H.264
XAVC-I HD način: CBG, 223 Mbps (maks), MPEG-4 AVC/H.264

https://oss.sony.net/Products/Linux/
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XAVC Long
XAVC-L QFHD način: VBR, 150 Mbps (maks) brzina bitova, MPEG-4 H.264/AVC
XAVC-L HD 50 način: VBR, 50 Mbps (maks), MPEG-4 H.264/AVC
XAVC-L HD 35 način: VBR, 35 Mbps (maks), MPEG-4 H.264/AVC

Format za snimanje (zvuk)
LPCM 24-bit, 48 kHz, 4-kanalni

Brzina sličica za snimanje

XAVC Intra
XAVC-I 4K način: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD način: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD način: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD način: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50 način: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 35 način: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Vrijeme snimanja/reprodukcije
XAVC Intra
XAVC-I QFHD način: 59.94P, pribl. 30 minuta (upotrebljavajući CEA-G160T)
XAVC-I HD način: 59.94P, pribl. 78 minuta (upotrebljavajući CEA-G160T)

XAVC Long
XAVC-L QFHD način: 59.94P, pribl. 115 minuta (upotrebljavajući CEA-G160T)
XAVC-L HD 50 način: 59.94P, pribl. 155 minuta (upotrebljavajući CEA-G80T)
XAVC-L HD 35 način: 59.94P, pribl. 210 minuta (upotrebljavajući CEA-G80T)

Note

Vrijeme snimanja/reprodukcije može se razlikovati ovisno o uvjetima upotrebe i značajkama
memorije. Vremena snimanja i reprodukcije odnose se na neprekidno snimanje jednog isječka.
Stvarna vremena mogu se razlikovati ovisno o broju snimljenih isječaka.

Pogonski dio pomicanja/naginjanja

Minimalna brzina pomicanja: 0,02 stup./s
Minimalna brzina nagibanja: 0,02 stup./s
Maksimalna brzina pomicanja: 60 stup./s
Maksimalna brzina nagibanja: 60 stup./s
Raspon pomicanja: -170 stup. do + 170 stup.
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Raspon nagibanja: -30 stup. do +195 stup.
Nazivni kriterij buke: NC35 ili manje
Unaprijed postavljeni položaji: 100

Odjeljak kamere

Uređaj za slike
CMOS senzor punog kadra Exmor R od 35 mm (35,6 x 23,8 mm)

Broj piksela
Pribl. 12,9 megapiksela (ukupno piksela)
Pribl. 10,3 megapiksela (učinkoviti pikseli)

Automatsko izoštravanje
Metoda detekcije: faza detekcije / detekcija kontrasta

Interni ND filtri
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Linearno varijabilni ND: 1/4ND do 1/128ND

ISO osjetljivost
ISO 800/12800 (način rada Cine EI mode, izvor svjetlosti D55)

Element za montažu objektiva
E-mount nosač

Zemljopisna širina
15+ točaka

Brzina zatvarača
Od 64F do 1/8000 sek (23.98P)

Kut okidača
od 5,6° do 360°, 2 do 64 sličice

Usporene i ubrzane snimke
XAVC QFHD: 1 fps do 120 fps
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XAVC HD: 1 fps do 240 fps
XAVC 4K: 1 fps do 60 fps
XAVC HD (S35): 1 fps do 120 fps

Ravnoteža bijele boje
od 2000 K do 15000 K

Razina signala
od –3 dB do +30 dB (u koracima od 1 dB)

Osnovni izgled
S-Cinetone, Standard, Still, ITU709, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Audioodjeljak

Frekvencija uzorkovanja
48 kHz

Kvantizacija
24-bitni

Frekvencijski odaziv
XLR ulaz MIC načina: 20 Hz do 20 kHz (±3 dB ili manje)
XLR ulaz LINE načina: 20 Hz do 20 kHz (±3 dB ili manje)

Dinamički raspon
XLR ulaz MIC način: 80 dB (tipično)
XLR ulaz LINE način: 90 dB (tipično)

Izobličenje
XLR ulaz MIC način: 0,08 % ili manje (-40 dBu razina ulaza)
XLR ulaz LINE način: 0,08 % ili manje (+14 dBu razina ulaza)

Odjeljak za ulaz/izlaz

Ulazi
DC IN

EIAJ sukladno, 19,5 V istosmjerno

AUDIO IN
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XLR vrsta, 5 izvoda, ženski
LINE / MIC / MIC+48V, može se prebacivati
MIC: referenca -30 dBu do -80 dBu

GENLOCK IN

BNC priključak, 1.,0 Vp-p, 75 ?

TC IN

BNC priključnica

Izlazi
SDI OUT

BNC priključak, 12G-SDI, 6G-SDI, 3G-SDI (razina A/B), HD-SDI

HDMI

Type-A priključnica

Izlazni priključak OPTICAL

SFP+ sukladno
* Jedinica ne podržava ulazni optički signal.

Ulaz/izlaz
LAN priključnica

RJ-45, 1000BASE-T

OPTION priključnica

RJ-45 ulaz signalizacije / izlazni priključak

Odjeljak za multimedijske utore

CFexpress Type A / SD utor kartice (2)

Dodatna oprema u kompletu

Adapter za izmjeničnu struju (1)
Kabel za napajanje (1)
Infracrveni daljinski upravljač (1)
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Poklopac kućišta (1) (pričvršćen na jedinicu)
Nazivna pločica HDMI kabela (1)
Prije upotrebe ovog uređaja (1)
Knjižica s jamstvom (1)

Vanjske dimenzije

Dimenzije su približne vrijednosti.
Jedinica: mm (inči)

Dizajn i specifikacije podložne su promjenama bez prethodne obavijesti.
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Zaštitni znakovi

 zaštitni je znak tvrtke Sony Group Corporation.
XAVC i  registrirani su zaštitni znakovi tvrtke Sony Group Corporation.
Izrazi HDMI i HDMI High-Definition Multimedia Interface te logotip HDMI zaštitni su znakovi
ili registrirani zaštitni znakovi tvrtke HDMI Licensing Administrator, Inc u Sjedinjenim
Američkim Državama i drugim državama.
Microsoft i Windows registrirani su zaštitni znakovi ili registrirani zaštitni znakovi tvrtke
Microsoft Corporation u Sjedinjenim Američkim Državama i/ili drugim zemljama.
Mac i Mac OS zaštitni su znakovi tvrtke Apple Inc. registrirani u SAD-u. i drugim zemljama.
Logotip „Catalyst Browse” zaštitni je znak ili registrirani zaštitni znak tvrtke Sony Group
Corporation.
IOS je zaštitni znak ili registrirani zaštitni znak tvrtke Cisco u SAD-u i ostalim državama te se
upotrebljava pod licencom.
iPadOS, Safari i iPad registrirani su zaštitni znakovi tvrtke Apple Inc., registrirani u SAD-u i
ostalim državama i regijama.
Android i Google Chrome zaštitni su znakovi ili registrirani zaštitni znakovi tvrtke Google
LLC.
Wi-Fi zaštitni je znak tvrtke Wi-Fi Alliance.
Logotip SDXC zaštitni je znak tvrtke SD-3C, LLC.
Logotipi CFexpress i CFexpress Type A zaštitni su znakovi tvrtke CompactFlash
Association.
NewTek™ i NDI® zaštitni su znakovi ili registrirani zaštitni znakovi tvrtke NewTek, Inc.
JavaScript registrirani je zaštitni znak tvrtke Oracle i/ili njezinih podružnica.
Intel, logotip Intel i Intel Core zaštitni su znakovi tvrtke Intel Corporation ili njezinih
podružnica.
QR kôd registrirani je zaštitni znak tvrtke Denso Wave Inc.
Svi drugi nazivi tvrtki i nazivi proizvoda registrirani su zaštitni znakovi ili zaštitni znakovi u
vlasništvu svojih vlasnika. U ovom dokumentu stavke s zaštitnim znakovima nisu označene
sa simbolom ™ ili ®.
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